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Introduction About This Guide

| ntroduction

Welcome  Welcome to IBM® Sterling Gentran: Server® for Microsoft Windows Application
Integration subsystem, IBM’s Electronic Data | nterchange (EDI) mapping software for the
Microsoft® Windows® operating system.

Sterling Gentran:Server provides you with the tools you need to tranglate:

» your application filesto EDI standard formats for documents you send to your
partners (outbound mapping)

» EDI standard formats to your application format for documents that you receive from
your partners (inbound mapping)

We believe that you will find this software and the supporting materials easy to use and
directly beneficial to your business.

Sterling Gentran:Server — May 2011 Application Integration User Guide



About This Guide What'sin This Manual

What’sin This Manual

Assumptions  Thismanual assumesthat you are familiar with using a PC and with Microsoft® Windows
functions, including:

» Theterminology used to describe mouse and cursor actions.

» Theterminology used to describe Microsoft Windows-specific attributes, including
dialog boxes, icons, windows, and buttons.

Thismanual also assumesthat you are familiar with EDI concepts, EDI standard structure,
your internal application format, data mapping concepts, and the Sterling Gentran: Server
product.

Description of ~ The majority of the Sterling Gentran: Server Application Integration documentation is
contents  contained in the online Help system. Thismanual isintended to support the online Help by
assisting you in performing various tasks in the Application Integration subsystem. This
task-oriented approach is intended to answer any questions you may have about Sterling
Gentran: Server with step-by-step instructions.

This guide is organized into chapters. A brief description of the chapter contents follows.

» Chapter 1, Application Integration Basics, explains the content, organization, and
conventions in this guide, as well as the system requirements. This chapter also
describes how to use the extensive online Help system, how to get technical support,
and a brief outline of how to build maps using the Application Integration subsystem,
and gives you an introduction to mapping and Sterling Gentran: Server.

» Chapter 2, Designing your Map, explains how to perform basic functionsin the
Application Integration subsystem, including creating a new map; using fixed-format,
EDI, and Cl1 files; opening, saving, and naming a map; compiling amap; and printing
amapping report. This chapter also explains customizing display options; setting the
default date format; selecting which map components to use; cutting, copying, and
pasting; setting up the document name and reference; formatting your data; and using
field-to-field linking.

» Chapter 3, Customizing the Properties of Map Components, explains how to
customize the properties of record, segments, looping structure, fields, elements,
composite elements, and TFDs. This chapter also explains how to use loop start (LS)
and loop end (LE) segments.

» Chapter 4, Using Sandard Rules, explains how to use the Application Integration
standard rules: select, update, constant, use accum, loop count, and use code. This
chapter also illustrates examples of when you would use certain standard rules.

» Chapter 5, Setting Up the Import Process, explains al the facets of the import
process, defines import file restrictions, and describes how to create a system import
map.

» Chapter 6, Setting Up the Export Process, explains all the export process and
describes how to use envelope information.

» Chapter 7, Using Extended Rules, defines what extended rules are and when they are
used, and explains the proprietary programming language syntax.

Application Integration User Guide Sterling Gentran:Server — May 2011



What'sin This Manual About This Guide

» Appendix A, Error Messages, describes Sterling Gentran:Server - Application
Integration error messages and specifies corrective actions.

» Appendix B, User EXits, explains how to use user exits with Sterling Gentran: Server.

» Appendix C, Using GentranEx.DLL, describes how to use GentranEx.DLL, the
Sterling Gentran: Server in-process automation server.

» Appendix D, Using the Translator Command Line Interface, describes how to use the
command line to invoke the services of the TX32.EXE trandator to perform
trandlation outside Sterling Gentran: Server, including generating atransator report in
XML format.

» The Glossary contains mapping and Sterling Gentran: Server terms and concepts.

OnlineHelp  The magjority of the documentation for Sterling Gentran: Server is contained in the online
System Help system. Thisincludes al the dialog box element definitions, detailed processing
information, and all the “how to” information from this manual.

Sterling Gentran:Server — May 2011 Application Integration User Guide



About This Guide

Getting Support

Getting Support

Introduction Sterling Gentran: Server software is supported by trained product support personnel who
are available to help you with product questions or concerns.

Note

Sterling Gentran: Server Customer Support does not support non-IBM products (e.g., SQL
Server, Oracle, etc.), but can assist you in configuring non-1IBM products to work with

Sterling Gentran: Server.

Phone number For assistance, please refer to your IBM® Serling Gentran: Server® for Microsoft
Windows Getting Sarted Guide to determine which support phone number you should

use.

Beforecalling  To help us provide prompt service, we ask that you do the following:

support
events.

» Attempt to recreate any problem that you encounter and record the exact sequence of

» Whenyou call product support, you should be prepared to provide us with the

information below.

Infor mation

Description

Identification

Your company name, your name, telephone number and
extension, and the case number (if the question refersto a
previously reported issue).

System Configuration

The Sterling Gentran:Server version (and any service
packs installed) and information about the primary
Sterling Gentran: Server system controller and all
machines experiencing problems, including: the
Microsoft Windows operating system version, amount of
memory, available disk space, database version,
Microsoft Data Access (MDAC) version, and Internet
Explorer version.

Also, please describe any recent changesin your
hardware, software, or the configuration of your system.

System Data Store

Which machines contain foldersin the system data store?

Error Messages

Record the exact wording of any error messages you
receive and the point in the software where the error
occurred, aswell asany log files.

Attempted Solutions

Record any steps that you took attempting to resolve the
problem and note all the outcomes, and provide an
estimate on how many times the problem occurred and
whether it can be reproduced.

Application Integration User Guide
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Getting Support About This Guide

How To Get Help

IBM® Sterling Customer Center provides awealth of online resources that are
available around the clock to enrich your business experiencewith IBM® Sterling
Gentran®. By using Sterling Customer Center, you gain access to many self-
support tools, including a Knowledge-Base, Documentation, Education, and Case
Management. Access this site at: Sterling Customer Center. (http://
customer.sterlingcommerce.com)

Once logged in, select Support Center from the top navigation menu, and then
locate Sterling Gentran produc-specific support information from the | eft
navigation menu.

Additionally, our Customer Support Reference Guide outlines our support hours,
contact information, and key information that will enhance your support
experience with us. For detailed information about Customer Support, please refer
to the Customer Support Reference Guide accessible from the login page. (http://
customer.sterlingcommerce.com)

Sterling Gentran:Server — May 2011 Application Integration User Guide


http://customer.sterlingcommerce.com
http://customer.sterlingcommerce.com
http://customer.sterlingcommerce.com
http://customer.sterlingcommerce.com

CHAPTER

1

Application Integration Basics

Contents  IntroducingMapping .. ....oo it e e 1-2
P KeyTermsand Concepts .. ...ovviiiineii i i i eiaenn 1-2

» HowtoUseApplication and FormsIntegration. .................. 1-4

» Inbound and Outbound Tranglation Process. ..................... 1-5

» ApplicationFileFormat ......... ... .. . . 1-6

» EDIFileFormat ... 1-7

Introducing the Application Integration Subsystem ................. 1-10

D OVEIVIBW . oo 1-10

» Howto Navigatein Application Integration. ... ................. 1-11

» How to Build aMap with Application Integration................ 1-12

Application Integration User Guide Sterling Gentran: Server — May 2011



Contents
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|ntroducing Mapping

Key Termsand Concepts

Map

Inbound mapping

Outbound
mapping

Source

A map isaset of instructions you define in the Sterling Gentran: Server Application
Integration subsystem that indicates the corresponding relationship between your
application file and the EDI standards (including the Japanese Center for the Information
of Industry (ClI) standard), and defines how the system should translate data.

For inbound mapping, the system translates your trading partner’s EDI standard formatted
business document to your application file format. To translate inbound data, you need to
create an export map in Sterling Gentran: Server Application Integration (because the
system is exporting to your application file).

For outbound mapping, the system trandates your application file format to EDI standard
formats, so you can send documentsto your partners. To trand ate outbound data, you need
to create an import map and a system import map in the Sterling Gentran: Server
Application Integration subsystem.

Import map

You need to create an import map because the system isimporting from your application
file. The import map defines how to move data from your application file (flat file
definition), which may contain multiple documents, to the EDI standard-formatted
documents that your partners expect to receive from you.

System import map

You need to create a system import map to determine which trading relationship
(established in Partner Editor) corresponds to each document in the application file, so the
system knows which import map to use to process the document.

Reference
See How to Create a System Import Map on page 4 - 6 for more information.

After you create amap in the Application Integration subsystem, this map is the source
from which you compile atrand ation object.

Sterling Gentran:Server — May 2011 Application Integration User Guide
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Tranglation object A trandation object isaset of rulesthat instruct the translator how to convert afile from
one format to another. Every function performed during translation requires atranslation
object. Translation objects are used to control al the functions of Sterling Gentran: Server
EDI trandation. Translation objects can belong to the following two categories: system
tranglation objects or user translation objects.

System translation objects

System translation objects control the creation and separation of interchanges, functional
groups, and transaction sets. They are also used to generate and reconcile functional
acknowledgements.

User translation objects

User tranglation objects control data entry, importing, exporting, document turnaround,
and creating printed reports. All the required system trandlation objects are automatically
installed with the Sterling Gentran:Server system.

Application Integration User Guide Sterling Gentran: Server — May 2011
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How to Use Application and Forms Integration

Introduction The Sterling Gentran: Server Application Integration subsystem enables you to generate
import, export, and document turnaround transl ation objects. The Sterling Gentran: Server
Forms Integration subsystem enables you to generate data entry and print translation
objects.

Registering Once you generate atrandation object using the Sterling Gentran:Server Application
trandation objects  Integration subsystem (or the Sterling Gentran:Server Forms I ntegration subsystem), you
must register the translation object with Sterling Gentran:Server.

Reference
See Using Tranglation Objects in the IBM® Serling Gentran: Server® for Microsoft
Windows User Guide for more information.

Partner In addition, you must establish correct trading relationships for all trading partners from
relationships ~ which you receive or to which you send data. During the process of establishing atrading
relationship, you need to specify the name of the appropriate trandation object that the
tranglator uses to trandlate the data.

Reference
See Using Partnersin the IBM® Serling Gentran: Server® for Microsoft Windows User
Guide for more information.

Sterling Gentran:Server — May 2011 Application Integration User Guide
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|nbound and Outbound Trandation Process

Diagram Thisillustration depicts the inbound and outbound translation process:

Export Translation Object

'

Application
Inbound L pp_»
Sterling
Outbound -e.—— Gentran:Server -
EDI Application

!

Import Translation Object

Outbound  When you create an import map, you need to define to Sterling Gentran:Server your
trandation application file format (your data that you send to your partners) and the EDI standard
format in which your partners expect to receive the documents.

Inbound  When you create an export map, you need to define to Sterling Gentran: Server the EDI
trandation standard format in which your partners sends documents to you and your application file
format (how the data needs to be formatted for your application to process it).

Application Integration User Guide Sterling Gentran: Server — May 2011
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Application File Format

I ntroduction

Map components

Before you begin

If you are creating an import or export map, you must define your application to the
Sterling Gentran:Server Application Integration subsystem. In Sterling Gentran: Server
terminology, your application file is aso referred to as a fixed-format file or a positional
file. Your application file must contain all the information that you either need to extract
from your partner’s document (if the map isinbound) or need to send to your partner (if
the map is outbound), so that your system can accurately process the data.

Thistable lists the icons that visually represent the map components you use to define
your application file.

Icon Description

& A group isalooping structure that contains related records and/or
groups that repeat in sequence until either the group data ends or the
maximum number of times that the loop is allowed to repeat is
exhausted.

If you create a group that is subordinate to another group (a
subgroup), this corresponds to a nested looping structure (aloop
within aloop).

0 A record contains agroup of related fields. A record can occur once
or can repeat multiple times.

] A field isthe smallest piece of information defined in the application
file. A field isthe application map component that is mapped (linked)
to acorresponding EDI element to move data to and from your
application file.

When afield has a mapping operation performed against it, ared
checkmark is displayed over the field icon.

Before you define your application, you should obtain alayout of the necessary records,
fields, and groups. Each map component is arranged sequentially in the order that it is
most logical for the system to process. Therefore, each level of your application must be
created sequentially.

Example

Your application file contains records and groups. The records contain fields and the
groups contain records and/or subgroups. This means that you must create records and
groups before you create the subordinate fields.

Reference
See Using a Fixed-Format File on page 2 - 51 for more information about defining your
application file format.
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EDI File Format

I ntroduction

Before you begin

Map components

The EDI file must contain all the information that you expect to receive from your partner
(if the map isinbound) or need to send to your partner (if the map is outbound), so that
your system can accurately process the data.

For non-ClI standards, the Sterling Gentran:Server Application Integration subsystem
generates an EDI file for you, based on the standard (agency), version, transaction set, and
release (for the TRADACOMS standard only) you selected. The system includes all the
groups, segments, composites, and elements that are defined by the standards agency for
the version of the document you selected. Please see How to Create a New Map on

page 2 - 20 for more information about generating an EDI file when you create a new

map.

If you are creating an import or export map, you typically need to customize the system-
generated EDI file by modifying the properties of the map components, and using
specialized Sterling Gentran: Server functions to manipulate the EDI file structure.

However, if you want to use a specialized version of an EDI standard that is not available
in the Sterling Gentran:Server standards database (including the Cll standard), you must
define the EDI file yourself.

Regardless of whether the system generates the EDI file or you define it, the specific EDI
map components that you use depend on the type of map you are creating. This includes
the standard, version, and transaction set (document) selected, and which groups,

segments, TFDs (for the Cll standard), composites, and elements your company requires.

We recommend that you determine which map components you are using before
generating or defining an EDI file.

Thistablelists the map componentsthat Sterling Gentran: Server usesto visually represent
the EDI file format.

Icon Description

&) A group isalooping structure that contains related segments and/or
groups that repeat in sequence until either the group data ends or the
maximum number of times that the loop is allowed to repeat is
exhausted.

Groups are defined by the EDI standards. A group that is subordinate
to another group is a subgroup (this corresponds to a nested looping
structure — aloop within aloop).
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(Contd)
Icon Description
| A segment contains a group of related elements or composite data
elements that combine to communicate useful data. Segments are
defined by the EDI standards. A segment can occur once or can repeat
multiple times.

T] A TFD (Transfer Form Data) is used only in the Cll standard. A TFD
consists of a datatag (data identifier), data element length, and the
variable-length data element TFD.

& A composite is adata element that contains two or more component

data elements or subelements. Composites are defined by the EDI
standards that use them (EDIFACT, TRADACOMS, and certain ANSI
X12 standards).

A repeating compositeis arelated group of EDI subelements that
have the ability to loop as awhole (occur more than once) within a
particular EDI segment. To allow a composite to repeat multiple times
within a segment, each occurrence of the composite must be separated
by a specia delimiter, known as the repeating element delimiter.

Example

Your delimiters are set as follows:
Segment ~

Element *

Tag *

Sub Element

Repeating Ele »

Then, if aBGM segment contains a repeating composite that occurs 3
timeswithin the datafollowed by 1 regular element, and the composite
contains 2 subelements, the segment isin the following form:

BGWF SubA- 1: SubB- 1" SubA- 2: SubB- 2”SubA- 3: SubB-
3*Fi el d2~
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- An element isthe smallest piece of information defined by the EDI
standards. An individual element can have different meanings
depending on the context. Therefore, elements are normally not
considered to have useful meaning until they are combined into
segments.

An element isthe EDI map component that is mapped (linked) to a
corresponding application field to move data to and from the EDI file.

A repeating element isan EDI elementswith the ability to loop (occur
more than once) within a particular EDI segment. To allow asingle
element to repeat multiple times within a segment, each element must
be separated by a special delimiter, known as the repeating element
delimiter. The use of this delimiter prevents the system from mistaking
the repeating elements for normal elements.

Example
Your delimiters are set as follows:

Segment ~

Element *

Tag *

Sub Element

Repeating Ele »

Then, if aBGM segment contains 3 elements and the second element is

arepeating element that occurs 4 times, the segment isin the following
form:

BAGWr Fi el d1*Fi el d2. 17Fi el d2. 2*Fi el d2. 3"Fi el d2. 4*Fi el d
3~

Reference

See Using an EDI File on page 2 - 68 and Using a Cll File on page 2 - 88 for more
information about customizing the properties of the map components and using
speciaized Sterling Gentran: Server functions to manipulate the EDI file structure.
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|ntroducing the Application Integration Subsystem

Overview

Introduction The Sterling Gentran: Server Application Integration subsystem enables you to translate
your application filesto EDI standard formats for documents you send to your partners
(outbound mapping), and to translate EDI standard formats to your application format for
documents that you receive from your partners (inbound mapping).
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How to Navigate in Application Integration

Introduction The Sterling Gentran: Server Application Integration Window allows you to accessits
functionality in four different ways:

Click the menu option from the Main Menu Bar.

Click the appropriate button on the Main Toolbar.

Click the appropriate part of the map.

Click amap component with the right mouse button to access a shortcut menu that
contains all the functions that are currently available for that map component. The
shortcut menus enable you to quickly and easily access available functionality. The
content of the shortcut menus varies, depending on the type and level of the selected
map component.

Note
When you start Sterling Gentran: Server Application Integration, the Main Menu Bar
contains a subset of menu items. The full set of menu itemsis displayed after you create a
new map or open (load) an existing map.

Application  Thistableliststhe parts of the Sterling Gentran:Server - Application Integration Window.

Integration
Window

Part

Function

Main menu bar

Contains drop-down menus. Unavailable items are dimmed.

Reference
Detailed descriptions of each of the commands on these menus are
found in the online Help.

Main Toolbar

Enables you to access some of the most common functionsin the
Application Integration subsystem. Unavailable items are dimmed.

Note
The Main Toolbar is a dockable toolbar, so you can affix it to any
edge of the client window.

Status bar

Displays status information about a selection, command, or process,
defines menu items as you highlight each item in the menu, and
indicates any current keyboard-initiated modes for typing.

Application Integration User Guide
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How to Build a Map with Application Integration

Map Building  Thistable defines how to proceed with building a map using the Sterling Gentran: Server
Process  Application Integration subsystem.

Sage

Description

1

Prepare and analyze

» Obtain alayout of your application file and determine how it
corresponds with the EDI standard you are using.

» Determine how you move data to or from each application field.

Set global defaults (one time only)

Thefirst time you use the Sterling Gentran: Server Application
Integration subsystem, you should establish the default date format that
the system uses.

Reference
See How to Set the Default Date Format on page 2 - 18 for more
information.

Create a new map

Reference
See How to Create a New Map on page 2 - 20 for more information.

Activate the appropriate EDI groups, segments, and elements or auto
trim based on asample EDI file

or

Define your ClI EDI file

References
» SeeHowto Activate EDI Map Components on page 2 - 37 for more
information.

» SeeHowto Use Auto Trimon page 2 - 39 for more information.
» SeeUsingacCll Fileon page 2 - 88 for more information.

Define your application

Reference
See Using a Fixed-Format File on page 2 - 51 for more information.
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6 Map the appropriate data for each application field
References
» SeeHow to Create Smple Links on page 2 - 113 for more

information.

» SeeUsing Standard Rules, chapter 3, for more information.
» SeeUsing Extended Rules, chapter 6, for more information.

7 Compile the translation object
Reference
See How to Compile a Map on page 2 - 119 for more information about
compiling the translation object and translation object naming
conventions.

8 Print the mapping report
Validate and review the map, and make modifications as needed.
Reference
See How to Print a Mapping Report on page 2 - 123 for more
information.

9 Register the tranglation object with Sterling Gentran: Server
Reference
See How to Register a New Translation Object in the IBM® Serling
Gentran: Server® for Microsoft Windows User Guide for more
information.

10 Create the appropriate trading relationship
Establish the appropriate trading relationship in Sterling Gentran: Server
for your trading partners.
Reference
See Using Partnersin the IBM® Serling Gentran: Server® for
Microsoft Windows User Guide for more information about creating
trading relationships.

11 Testing the translation object
Obtain test data from your partners and process the data. Verify
acknowledgement processing (if applicable). Verify communications
with your network.

Application Integration User Guide
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Designing your Map Introduction

Overview

| ntroduction

What'sin this  This chapter explains some of the basic mapping functions. Some of the mapping
chapter functions are performed initially (creating a map), some are performed as you define the
map, and some are performed after the map is completed (compiling and printing a
mapping report).
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Preparation and Analysis

Introduction Thefirst step in creating amap is the analysis of the mapping requirements. Thisisthe
most important step in creating a successful map. If the analysisyou perform is complete,
you have all the information you need to create the map in an efficient and logical manner.
If you omit this critical step and proceed directly to creating the map, it islikely that
creating the map is a much longer and arduous task, and the map may be invalid due to
oversights and omissions.

Regardless of whether you are tranglating data inbound or outbound, this table lists the
stages of mapping analysis.

Sage Description
1 Analyzing your application file format
2 Analyzing your partners EDI file format
3 Correlating your application and the EDI file formats

After you complete these steps, you can begin creating the map.

Analyzing your Thefirst step of mapping analysisisanalyzing your application file format, because thisis
application file  probably the component that is the most familiar to you. Your application file format
format contains all the information that you need to extract from the purchase order your partner
sends you, so that your system can correctly process the purchase order, and your
company can fill the order correctly.

You must define your application file format to Sterling Gentran:Server. If your company
has an existing application file format, you should obtain the record layout from the
appropriate person. If you did not have an existing application file format, you need to
create one by determining which fields are necessary to process the data correctly, and
then grouping the fields logically under records.

Analyzing the EDI To analyze the EDI file, you must first determine what your trading partners are sending
file  you. You and your partners need to agree on which standard, version, and transaction set
you are using. It isimportant to know the information that your partners are sending you

within the purchase order, and what datais contained in each element used.

It isvery helpful to review the EDI standards that you are using before analyzing the EDI
file. Obtain an EDI standards manual for each standard and version that you are using.
Standards manuals are available from EDI standard agencies.

After discussing with your partners what they are sending, determining which segments
and elements your company requires, and reviewing the EDI standard, you can list the
map components that you need to make available for use (activate).
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Reconciling your  To reconcile your application file format with the EDI file, you must identify each
application fileand application file with its corresponding element in the EDI file and select a method for
the EDI file  mapping it. To map information to afield, you use linking, standard rules, extended rules,
or acombination of al three.

Linking

Linking (simple mapping) enables you to map afield or element from the input side of the
map to afield or element on the output side of the map. The link between two map
components (fields) is visually represented with aline connecting the two fields.

Standard rules
Standard rules give you access to mapping operation functions that are more complex than
simple linking, but lessinvolved than extended rules.

Extended rules
Extended rules enable you to use a Sterling Gentran: Server proprietary programming
language to perform virtually any mapping operation you require.

Additionally, you may determine that you need to establish temporary storage (work)
areas for the map to handle items such as Ship To and Bill To name and address
information, which is extracted using extended rules from agroup in the EDI data.

Recommendation
Determine which mapping operations are required on afield-by-field basis for your
application file.

After your analysis  After you finish correlating your application file format and EDI file on paper, you can
iscomplete  begin creating the map.

Application Integration User Guide Sterling Gentran: Server — May 2011



Customizing Y our Display Designing your Map

Setting Global Defaults

Customizing Your Display

Introduction The Sterling Gentran: Server Application Integration subsystem allows you to customize
the display of mapsin severa different ways:

Customizing global display options
Customizing colours (global option)
Customizing fonts (global option)
Displaying links (global option)
Customizing the auto-increment map version
Making the two sides of a map equal

The Preferences dialog box enables you to set global defaults for Sterling Gentran: Server.
The map display options can be set or changed at any time.
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How to Customize Global Display Options

Procedure  Usethis procedure to customize globa (for all maps) display options.

Sep Action

1 From the Options menu, select Preferences.

System response
The system displays the Preferences dialog box (Tree tab displayed by

default).

Preferences
Tree |Links I Standard Formatsl PositionalDefauItsI Files I Eonfirmationsl Versionl

These seftings customize the look of the file format tree.

W Show group descriptions Colours... |
¥ Show record descriptions Font... |

¥ Show field descriptions

Cancel Help
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(Contd)
Sep

Action

2

Do you want to turn on the default display of group, record (segment),
and field (element) descriptions?

» If yes, click the check box in front of each in the List section of the
dialog box (so the system displays a checkmark in the check box).

To turn off the default display of group, record (segment), and field
(element) descriptions, click the appropriate check box again to
remove the checkmark.

» If no, continue with the next step.

Notes

Typically, you want to have all the descriptions displayed for reference.
However, for avariety of reasons, you may not want the descriptions
displayed. Depending on the size of your monitor, it may be easier to
view the entire map if the descriptions are not displayed.

You may want to experiment with shrinking the size of the font for the
map. See How to Customize Global Fonts on page 2 - 11 before you
turn off the display of descriptions.

Do you want to change the default display colors?

» If yes, see How to Customize Global Colourson page 2 - 9 for more
information.

» If no, continue with the next step.

Do you want to change the default display font?

» If yes, see How to Customize Global Fonts on page 2 - 11 for more
information.

» If no, continue with the next step.

Click OK to save changes and exit the Preferences dial og box.
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How to Customize Global Colours

Introduction The Colours feature enables you to select foreground and background coloursto visually
define the various map components. The use of colour is optional.

Procedure  Usethis procedure to customize colours for all maps.

Sep Action

1 From the Options menu, select Preferences.

System response
The system displays the Preferences dialog box (Tree tab displayed by
default).

Preferences

Tres |Links I Standard Formatsl PositionalDefauItsI Files I Eonfirmationsl Versionl

These settings customize the look of the file format tree.

W Show group descriptions Colours... |
¥ Show record descriptions Font... |

¥ Show field descriptions

Cancel Help
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(Contd)
Sep

Action

2

Click Colours.

System response
The system displays the Colours dialog box.

[tenn

eord.ﬂ'Segmer _I Cancel |

Cormposite

Aftributes

A onditional
Active, Mandataony
Inactive, Conditional
Inactive, Mandatany

- Sample Text -

Fareqround calaur

Backimund colour

From the Item list, select the type of map component (Group, Record/
Segment, Composite, Field/Element).

Further define the type of map component by selecting whether it is
active or inactive and conditional or mandatory from the Attributes list.

The valid selections are;
» Active, Conditiona
» Active, Mandatory

» Inactive, Conditional
» Inactive, Mandatory

Select the foreground and background colors.

Click OK to globally define the selected colours for all maps.
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How to Customize Global Fonts

Introduction The Font feature enables you to globally change the font that is used in the display of al
maps. The default font that Sterling Gentran:Server usesis M S Sans Serif 9 point.

The Font feature enables you to change the font type, style, and point size. This givesyou

the flexibility to shrink the font if you need to view more of the map on your monitor,
enlarge the font, or change the type and style to be more easily readable by you.

Procedure  Usethis procedure to customize the display font for all maps.

Sep Action

1 From the Options menu, select Preferences.

System response
The system displays the Preferences dialog box (Tree tab displayed by
default).

Preferences

Tree |Links I Standard Folmatsl PositionalDefauItsI Files I Confirmationsl Versionl

These zettings customize the look of the file format tree.

¥ Show record descriptions Fant...

¥ Shaw group descriptions Calours. .. |

V¥ Show field descriptions

Cancel Help
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(Contd)
Sep

Action

2

Click Font.

System response
The system displays the Font dialog box.

Font HE
Fant style: Size:
IFieguIar 9 0K I
] alfs = l
M5 Sert Italic 10 Cancel_|
Foman Bold 12
Script Bold [talic 14
T Small Fonts 13
Syrnbal 24
Syztem LI LI LI
— Sample
| AaBbYylz
Script:
IWestern LI

From the Font box, select the type of font.

Note
The default is M S Sans Serif.

From the Font Style box, select the style.

Note
The default is Regular.

From the Size box, select the point size.

Note
The default is 9.

Click OK to make the global font change to all maps and exit the Font
dialog box.
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How to Customize Global Display of Links

Introduction Mapping Links are the visua linesthat connect each field/element/TFD on the Input side
of the map that is mapped to afield/element/TFD on the Output side of the map.

Procedure  Usethis procedure to customize the global display of mapping links.

Sep Action

1 From the Options menu, select Preferences.

System response
The system displays the Preferences dialog box (Tree tab displayed by
default).

2 Select the Links tab.

System response
The system displays the linking options.

Preferences

Tree  Links |Standard Formatsl PositionalDefauItsI Files I Eonfirmationsl

These seftings control how links are shown between the input and output file farmats.

& Show no links
= Show links tooor from the curently selected element.

= Sheow links to or from all wisible elements

Cancel Help
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(Contd)
Sep Action
3 Select the linking option that you want to set as the default for all maps.
» Show nolinks
Do not visualy display mapping links.
» Showlinkstoor from the currently selected element
Display only the mapping links for the currently selected field (this
option enables you to concentrate on the selected field and removes
the confusion of viewing many links at once).
» Showlinkstoor from all visible elements
Display all the mapping links.
4 Click the OK button to save changes and exit the Preferences dialog
box.
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How to Customize the Auto-increment Map Version

How to Customize the Auto-increment Map Version

I ntroduction

Setting auto-
increment

Sterling Gentran: Server supports automatically incrementing the version number of amap
based on a global option you can set. Previously, the version number of a map could only
be set or incremented manually, on the Application Integration Trandation Object Details
dialog box.

You can set aglobal option on the Application Integration Preferences dialog box to
specify when map version numbers are incremented. This list describes the available
options for automatically incrementing the map version number.

» Never auto-increment.

» Ask whether to increment when saving a map.

» Ask whether to auto-increment when compiling a map.

» Alwaysauto-increment when saving a map.

» Alwaysauto-increment when compiling a map.

Note

The auto-increment function updates the minor version number of the map on the
Tranglation Object Details dialog box, up to 255. If the minor version number exceeds

255, the system updates the minor version number to zero and increases the major version
numbey.

Example
Version number 1.255 will be auto-incremented to 2.0.

Use this procedure to set the auto-increment map version function.

Sep Action

1 From the Options menu, select Preferences.

System response
The system displays the Preferences dialog box (Tree tab displayed by
default).
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Designing your Map
(Contd)
Sep Action
2 Select the Version tab.
System response
The system displays the auto-increment version options.
Preferences

Tiee I Lirks I Standard Formatsl PositionalDefaultsI Files I Corfimations  ersion |

when should a map's version number be incremented 7

@ [Only when manually changed

™ Agk whether bo increment when saving a map
= gk whether bo increment when compiling a map
£ Always increment when saving a map

 Always increment when compiling a map

Cancel Help

3 Select the appropriate option and click OK.

System response
The system sets the global auto-increment option you selected.
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How to Makethe Two Sides of a Map Equal

Introduction ~ When you open amap, the Input and Output sides of amap are displayed in equal
dimensions. After manipulating a map and moving the center bar that divides the display
of the Input and Output sides, you may wish to again make the two sides equal .

The Equalize function enables you to reinstate the two sides of the map with focusin
equal dimensions. The use of the Equalize function is optional.

Procedure  Usethis procedure to make the two sides of amap equal.

Sep Action

1 From the View menu, select Equalize.

Note
This moves the center dividing bar between the two sides of the map
with focus, so that the two sides of the map are equally proportioned.
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How to Set the Default Date For mat

Introduction You typically establish the default date format for all date fields onetime only. This default
is used when EDI documents are initially loaded from the standard. This default can be
overridden on the Field Properties dial og box.

This global option changes the default date format for all maps. However, the format of
the existing date fields do not change; the default is only used for new maps.

Procedure  Usethis procedure to establish the default date format.

Sep

Action

From the Options menu, select Preferences.

System response
The system displays the Preferences dialog box (Tree tab displayed by
default).

Select the Sandard Formats tab.
System response
The system displays the date format options.

FPreferences
Tree I Links ~ Standard Formats | PositionaIDefauItsl Files I Eonfirmationsl

These settings contral the default data formats used when elements are read from the
shandards database.

Siw-character dates IWM MDD 7 I
Eight character dates IMM;’DDNY 'I

Cancel | Help |

From the Six-character dates and Eight character dateslists, select the
appropriate six-character and eight-character default date formats.
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(Contd)
Sep Action
4 Click OK to accept the default date formats for the six- and eight-

character date boxes and exit the Preferences dialog box.
Tip
To change the order in which the date formats appear in the Six-

character dates and Eight character dates lists or to add a new date
format to the lists, select Date Formats from the Options menu.
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Creating aMap and Defining Details

How to Create a New M ap

Introduction You can create four different types of maps: System Import (containing the header
information for an Import map), Import (for Outbound Maps), Export (for Inbound Maps),
or Turnaround (for EDI to EDI maps). Theinitial procedures for creating a new map of
each of the four typesisthe same.

Procedure  Usethis procedure to create a new map.

Sep Action

1 From the File menu, select New.

System response
The system displays the New Map Wizard.

2 Answer the following questions and then click Next.

» What kind of map are you creating?
The following table defines the selections:

Part Function
Import Used for outbound maps.
Export Used for inbound maps.
Interchange break Used in advanced mapping to separate

interchanges.

Functional Used in advanced mapping to reconcile
Acknowledgement functional acknowledgements.
Inbound
Functional Used in advanced mapping to generate
Acknowledgement functional acknowledgements.
Outbound

System Import Header | Used to determine which trading relationship
(established in Partner Editor) corresponds to
each document in the application file, so the
system knows which import trandlation object to
use to process the document.
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(Contd)
Sep

Action

2
(contd)

Turnaround

Used for EDI to EDI maps.

Transaction build

Used in advanced mapping to build transaction
envelopes.

Transaction break

Used in advanced mapping to separate
documents.

Functional group
build

Used in advanced mapping to build functional
group envelopes.

Functional group
break

Used in advanced mapping to separate functional
groups.

Interchange build

Used in advanced mapping to build interchange
envelopes.

Direct Map

Warning

This map function is not used by any IBM®
Sterling Gentran: Server® for Microsoft
Windows component or by any IBM product that
may connect to IBM® Sterling Gentran: Server®
for Microsoft Windows. This function will be
removed in afuture release.

Recommendation
Any existing maps that are configured with the
Direct Map type should be switched to another

appropriate type.

» What isthe name of the map?
Type the unique name of the map. The system adds the . MAP

extension.
» Whatisyour name?

Type your nameiif it differs from the user name prompted by the

system.

System response

The system displays the New Map Wizard - Input Format dialog box.

Note

You need to complete the format of the Input side of the map. Thisisthe

format of the datathat is

trandated by the Sterling Gentran:Server system.

Application Integration User Guide
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(Contd)
Sep

Action

3

For the input side of the map: do you want to create a new data format
using asyntax that you define?

If yes, select one of the following input format options and continue
with step 4:

Delimited EDI (Electronic Data Interchange fil€)

Positional (VDA, GENCOD, application files, etc.)

Cl1 (Japanese standard)

Cl1 Positional (for CIl Build/Break maps)

Note
For Inbound maps (Export), the Input Format Typeis*“CII” or “EDI".

For Outbound maps (System Import or Import), the Input Format
Typeis*“Positional.”
For Turnaround maps, the Input Format Typeis“EDI” or “CI1.”

If no (you want to load the dataformat from a saved definition), select
the Load the data format from a saved definition option, and type the
path and file name of the saved definition (or click Browse to display
the Open File Definition dialog box). Continue with step 6.

Did you select “Delimited EDI” or “CII” and want to customize the
format?

System response
The system displays the New Map Wizard - Output Format dialog box.

If yes, click Customize and continue with the next step.

System response
The system displays the New Delimited EDI Wizard or New ClI

Wizard dialog box.

Note
The Delimited EDI and ClI wizards enable you to create your format

from the standards database.

If no, click Next and continue with step 7.
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(Contd)
Sep Action
5 Follow the steps for the appropriate dialog box and then continue with
step 7.
| F the dialog box
displayed is... THEN follow thisprocedure...
New Delimited EDI a. Click Next.
Wizard
b. Select the ODBC data source that contains
the standards database.
c. Select the standards agency, version,
transaction set, and release (for
TRADACOMS only) and click Next.
d. Click Finish.
New CIl Wizard a.  Click Next.

b. Select the ODBC data source that contains
the standards database.

c. If youwant to use Japanese descriptions,
select the check box (the default is English
descriptions).

d. Click Next.

e. Select the standards agency, version,
transaction set, and release (for
TRADACOMS only) and click Next.

f.  Select the appropriate Multi-detail header
and click Next.

g. Click Finish.

System response
The system displays the New Map Wizard - Output Format dialog box.
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6

Did you choose to load the data format from a saved definition and click
Browse to display the Open File Definition dialog box?

» If yes, typethe file name and click Open to load the selected file
format definition, and then continue with step 7.

Note
You can now select either a.DDF or .IFD file.

» If no, continue with step 7.

Note
If the DDF isinvalid, the system displays a message box explaining
the problem and terminates the import.

For the output side of the map: do you want to create a new data format
using asyntax that you define?

» If yes, select one of the following output format options and continue
with step 8:
Delimited EDI (Electronic Data Interchange fil€)
Positional (VDA, GENCOD, application files, etc.)
Cl1 (Japanese standard)
Cl1 Positional (for CIl Build/Break maps)

Note
For Inbound maps (Export), the Output Format Typeis “Positional.”
For Outbound maps (System Import or Import), the Output Format
Typeis“CIIl” or “EDI.”
For Turnaround maps, the Output Format Typeis“EDI” or “CII.”

» If no(youwant toload the dataformat from asaved definition), select
the Load the data format from a saved definition option and type the
path and file name of the saved definition (or click Browse to display
the Open File Definition dialog box). Continue with step 9.

Did you select “Delimited EDI” or “ClI” and want to customize the
format?

» If yes, click Customize and continue with the next step.

System response
The system displays the New Delimited EDI Wizard or New Cl|

Wizard dialog box.

Note
The Delimited EDI and ClI wizards enable you to create your format

from the standards database.

» If no, click Finish to load the standards information you selected and
create the new map (this may take a few seconds).

System response
The system displays the new map in the Application Integration Window.
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Sep Action
9 Follow the steps for the appropriate dialog box and then continue with

step 11.
| F the dialog box
displayed is... THEN follow thisprocedure...
New Delimited EDI a. Click Next.
Wizard

b. Select the ODBC data source that contains
the standards database.

c. Select the standards agency, version,
transaction set, and release (for
TRADACOMS only) and click Next.

d. Click Finish.

New CIl Wizard a.  Click Next.

b. Select the ODBC data source that contains
the standards database.

c. If youwant to use Japanese descriptions,
select the check box (the default is English
descriptions).

d. Click Next.

e. Select the standards agency, version,
transaction set, and release (for
TRADACOMS only) and click Next.

f.  Select the appropriate Multi-detail header
and click Next.

g. Click Finish.

System response

The system displays the New Map Wizard dialog box.

10 Did you choose to load the data format from a saved definition and click

Browse to display the Open File Definition dialog box?

» If yes, typethe file name and click Open to load the selected file
format definition, and then continue with step 11.
Note
You can now select either a.DDF or .IFD file.

» If no, continue with step 11.
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11

Click Finish to load the standards information you selected and create the

new map (this may take a few seconds).

System response

The system displays the new map in the Application Integration Window.

Note

After you finish creating and saving a new map, you need to define the
Input and Output sides of the map. The steps you take are different,
depending on whether the map is an Import, System Import, Export, or

Turnaround map.
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How to Define Trandation Object Details

Introduction

Rule execution
prior toversion 3.0

The Translation Object Details dialog box enables you to edit the details of the trandation
object, including the description and version information. This dialog box enables you to
instruct the trandlator to use the pad character and alignment settings of each string field
when reading a positional or ClI positional file, to determine how to trim pad characters
from the string data.

The Tranglation Object Details dialog box also enables you to specify whether you want
the trandator to execute standard and extended rules as it did for Sterling Gentran: Server
prior to version 3.0. The standard behavior for Sterling Gentran: Server prior to version 3.0
isasfollows: if an output record/segment is linked to an input field in a record/segment
that does not contain databut is at the same hierarchical level as an input record/segment
that does contain data, the standard and extended rules on the output field will be executed
even though there is no data present.

Example

In the example diagram below, the extended rule on the DEMO5 field on the output side
of the map is executed even though there is no data for the field to which it is linked
(DEMO1:2 on the input side of the map). The rule is executed because there is data
present for afield in the DEMO1 record on the input side of the map, and that record is at
the same level as DEMO2.

#*Gentran Application Integration - [RuleDemo3.map]

ﬁ' File Edit Functions “iew Optiohs Window Help _|5|£|
E Lo e s o e e e e e e Y
IMPUT -4 - 1 - OUTPUT - M - 1 -

DEMOT -C- 1 DEMO3-C- 1
DEMOZ-C- 1 DEMO4-C- 1
¥ (01 DEMOT:2-C - String 10— 01 DEMOS - C - String 10 #®
¥ 02 DEMOZ2-C - String 10— 02 DEMOE - C - String 10

| | v 1 |iv

For Help, press F1 LIk v

Note

For any map that was compiled with Sterling Gentran:Server prior to version 3.0, the
system emulates the previous behavior by automatically selecting the “ Gentran: Server for
Windows 2.x Compatible Rule Execution” check box on the Translation Object Details
dialog box on page 2 - 29. You can modify this default if you wish, but you would then
need to re-map any instances where you want standard or extended rules to run on an
output record/segment that does not contain fields that will be popul ated with data.
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Rule executionin  Inversion 3.0, the standard rule execution behavior is as follows: standard and extended
version 3.0 and rules for arecord/segment on the output side of the map are only executed if any of its
above links populate the output map component with data.

Note

For any map created with Sterling Gentran: Server version 3.x or greater, the system
default isto clear the “Gentran:Server for Windows 2.x Compatible Rule Execution”
check box on the Translation Object Details dialog box.

Example

In the example diagram below, the extended rule on the DEMO5 field on the output side
of the map is not executed because there is no data for the field to which it is linked
(DEMO1:2 on the input side of the map). The ruleis not executed even though there is
data present for afield in the DEMOL record on the input side of the map, and that record
is at the same level as DEMO2.

#*Gentran Application Integration - [RuleDemo3.map]

ﬁ' File Edit Functions “iew Optiohs Window Help _|5|£|
E Lo e s o e e e e e e Y
IMPUT -4 - 1 - OUTPUT - M - 1 -

DEMOT -C- 1 DEMO3-C- 1
DEMOZ-C- 1 DEMO4-C- 1
¥ (01 DEMOT:2-C - String 10— 01 DEMOS - C - String 10 #®
¥ 02 DEMOZ2-C - String 10— 02 DEMOE - C - String 10

| | v 1 |iv

For Help, press F1 LIk v

Recommendation
We recommend that you do not select this check box for version 3.x and greater, asthis
differs from the prescribed behavior.
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Translation Object
Details dialog box

How to Define Tranglation Object Details

This diagram illustrates the Trand ation Object Details dialog box.

Translation Object Details E3

— Summarny = =
Authar Description Tranzlation Object Function
|5terling [FET % 3030 850 Export | |Export =l Carcel |

[ oo Gentrar:Server for windows 2

g g entran: S erver for windows 2.
[~ Swstem [ Use Configurable Trimming [ Compatible Rule Execution

—Werzion Contral

hd ajor version I'I tinor version IIJ

Compiled on |D2-Mar-2DDD

— EDI Azzociations

InpLit Output

=

IANSIX12VEHSIDN

|F'UF|EHASE ORDE

Agency F |><12
Yersion {03030
Transaction IBED
Release ID_

F Group IF'D

2ARE

The following table lists the parts of the Tranglation Object Details dialog box and their

Function

Identifies the person or department that created the map.

Note
This box is mandatory.

Partsand
functions  functions.
Part
Author
Description

Contains a unique description of the map.

Note

Thisbox is mandatory. This description is used by the system
to identify the map. We strongly recommend that you use the
following identifying characteristics of the map: the partner
that this map is used for, the standard, the version, the type of
transaction this map uses, and the direction of the map (i.e.,
Import, Export, etc.).

Example

“MWT X 3030 850 Export” isthe description of a map used
with partner MWT, for an ANSI X.12 version 003030
Purchase Order (850), that is sent Inbound (Export).

Application Integration User Guide
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Part Function
Translation Object Verify the type of map from thelist. Valid values are:
Function » Import - choose this type for outbound maps (application
to EDI)
» Export - choose this type for inbound maps (EDI to
application)

» Turnaround - choose this type for EDI to EDI maps

» Transaction build (thistype used in advanced mapping to
build transaction envelopes)

» Transaction break (thistype used in advanced mapping to
separate documents)

» Functional group build (this type used in advanced
mapping to build functional group envel opes)

» Functional group break (thistype used in advanced
mapping to separate functional groups)

» Interchange build (thistype used in advanced mapping to
build interchange envel opes)

» Interchange break (thistype used in advanced mapping to
separate interchanges)

» F/A Inbound (this type used in advanced mapping to
reconcile functional acknowledgements)

» F/A Outbound (this type used in advanced mapping to
generate functional acknowledgements)

Note
This box is mandatory.

System Designates this map as a system translation object (one that
will be used internally by the system).

Warning

You should only select this check box if you are certain that
you want to define this translation object as a system
translation object. Once a system trandation object is
registered with Sterling Gentran:Server, it cannot be deleted.
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Part

Function

Use Configurable
Trimming

Instructs the transl ator to use the pad character and alignment
settings of each string field when reading a positional or ClI
positiona file, to determine how to trim pad characters from
the string data.

Example

If the alignment setting indicates that the datais aligned in the
left of the field, then pad characters are trimmed from the
right of the field. If the alignment setting indicates that the
dataisaligned at the right of the field, then pad characters are
trimmed from the | eft of the field. Finally, if the alignment
setting indicates that the field datais aligned in the center of
the field, then pad characters are trimmed from both the | eft
and right of thefield.

If thisoption is cleared (which is the default) pad characters
are always trimmed from both the |eft and right of each
positional string field, which isthe current system behavior.

Example
Use configurable trimming to preserve either trailing or
leading spaces in your application data.

Gentran:Server for
Windows 2.x
Compatible Rule
Execution

Enables you to specify how the translator executes standard
and extended rules on the output side of a map.

Reference

See Rule execution prior to version 3.0 on page 2 - 27 and
Rule execution in version 3.0 and above on page 2 - 28 for
more information.

Major version/
Minor version

Enables you to designate different versions of atranslation
object.

Note

Thevalid valuesfor each box is“0” - “255". These two boxes
are available for your use only. They are not used by the
system.

Example
If youtype“5” inthe Mgjor box and “45” in the Minor box,
the Trand ation Object Version Number is“5.45".

Compiled on

Displays the date when the translation object was compiled.

Note
It will be blank if the translation object has not been compiled
yet.

Application Integration User Guide
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Part Function

EDI Associations If you selected “Delimited EDI” for the input and/or output

section sides of the map, this section contains the EDI information.
Warning
You should change these boxes only if you want to change the
EDI agency, version, transaction, release, or functional group
of an existing map. This enables you to copy and alter an
existing map.

OK Saves changes and exits the dialog box.

Cancel Exits the dialog box without saving changes.

Procedure  Usethis procedure to specify translation object details.

Step

Action

From the Edit menu, select Details.

System response
The system displays the Trandation Object Details dialog box on
page 2 - 29.

Do you want to change the map description?

» If yes, type the new description in the Description box and continue
with the next step.

» If no, continue with the next step.

Do you want to change the compatibl e rule execution specification?

» If yes, usethe following table to determine your action and continue
with the next step.

Reference

See Rule execution prior to version 3.0 on page 2 - 27 and Rule
execution in version 3.0 and above on page 2 - 28 for more
information.

| Fyouwant thesystem | THEN the Gentran:Server for Windows 2.x
to executerulesbased | Compatible Rule Execution check box
on thisbehavior... should be...

prior to version 3.0, selected.

version 3.0 and above, cleared.

» If no, continue with the next step.
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4 Do you want to change the map version?

» If yes, type the appropriate version numbers in the Major and Minor
boxes and continue with the next step.

» If no, continue with the next step.

5 Click OK.
System response
The system saves your changes and exits the Trandation Object Details
dialog box.
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How to Load a File Definition

Introduction Sterling Gentran: Server enables you to load an individual file format definition that you
previously saved. This feature provides you with a quick way to build either side of your

map.

Reference
See How to Save a File Definition on page 2 - 36 for more information.

Note
Loading afile definition replaces the selected side of the map. Please be certain that is
your intent before performing this task.

Procedure  Usethis procedure to load afile format definition.

Sep Action

1 Right-click the File Format icon (either the INPUT or OUTPUT side of
the map) and select Open File Definition from the shortcut menu.

Note

If you aready used Sterling Gentran:Server to create that side of the map,
you are prompted with a message that warns you that the existing file
format will be replaced. Click Yesto continue.

System response
The system displays the Open File Definition dialog box.

Open File Definition
Laak in: I 3 Bin
Ea321_ard.ifd

File name:  [E921_ard.ifd

Files of tupe: IFiIe Drefimitions [*.1FD) j Cancel |

2 Doesthe Look in list reflect the drive\folder where Sterling
Gentran:Server isinstalled (the default is GENSRVNT)?

» If yes, continue with step 3.
» If no, select the appropriate folder and continue with step 3.

3 From the Files of type list, select the type of file that you want to display.
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Sep Action
4 From the list, select the file definition that you want to load into the
system or type the file name in the Filename box.
5 Click Open.
System response
The system loads the selected file format definition.
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How to Save a File Definition

Introduction Sterling Gentran: Server enablesyou to save an individual file format definition so that you
can use it as aguide in future maps. This provides you with a quick way to build either
side of your map.

Reference

See How to Load a File Definition on page 2 - 34 for more information.

Procedure  Usethis procedure to save an individual file format definition.

Step

Action

1

Right-click the File Format icon (either the INPUT or OUTPUT side of
the map) and select Save File Definition from the shortcut menu.

System response
The system displays the Save File Definition dialog box.

Save File Definition K ER

Save jn: IaBin j ﬁl E

File narme: IEEI2‘I_DF|D.IFD

Save as lype: [File Definitions [*IFD) =l Baneal |

Doesthe Save in list reflect the drive\folder where Sterling
Gentran: Server isinstalled (the default is GENSRVNT)?

» If yes, continue with step 3.
» If no, select the appropriate folder and continue with step 3.

Type the file name in the Filename box (one to eight characters) or from
thelist, select the file definition that you want to save.

Click Save.

System response
The system saves the file format definition.
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How to Activate EDI Map Components

Introduction ~ When Sterling Gentran: Server generates the EDI sides of the map, the system includes all
the groups, segments, composites, and elements that are defined by the standard agency
for the version of the document you selected. The system activates all the groups,
segments, composites, and elements that are defined as “ mandatory” (must be present) by
the standard. The system does not enable you to deactivate the mandatory groups,
segments, composites, and elements.

When translating data, the system does not process groups, segments, composites, and
elements (or records and fields) that are not activated. Therefore, you must activate the
groups, segments, composites, and elements that are not defined as mandatory by the
standard, but that you have determined that you need to use in mapping.

Tip

As an dternative to activation, you can use the Auto Trim feature if you have a sample
EDI file defined.

Reference

See How to Use Auto Trim on page 2 - 39 for more information.

Procedure  Usethis procedure to activate groups, segments, composites, and elements.

Step

Action

From the Functions menu, select Activate.

Open (double-click) each group that contains segments or groups that
need to be activated.

Note

Asan alternative to opening each map component (steps 2, 5, and 7), you
can select Expand All from the View menu to open every map
component. You can also select amap component and select Expand
Branch from the View menu to open that map component.

Select each inactive group that you need to use. This activates the
groups.

Note

If you accidentally click a group, segment, composite, or element that
you did not mean to activate, right-click the map component and select
Deactivate from the shortcut menu.

Select each inactive segment that you need to use.

Note
This activates the segments.

Application Integration User Guide
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5 Open (double-click) each segment that contains composites or elements
that need to be activated.

6 Select each inactive composite that you need to use.
Note
This activates the composites.

7 Open (double-click) each composite that contains elements that need to
be activated.

8 Select each inactive element that you need to use.
Note
This activates the elements.

9 Once you have activated all the necessary groups, segments, and
elements, select Activate from the Functions menu to turn activation
mode off.
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How to Use Auto Trim

I ntroduction

Caveats

Procedure

Instead of activating map components manually, you can use the Auto Trim feature to
modify the EDI side of the map according to a sample EDI file that you select (you must
have previously created this EDI fil€).

The Auto Trim feature examines the EDI file that you specify and then activates and
deactivates map components on the EDI side of the map, so that the two files match. The
sample EDI file must be the same standard, version, and transaction set (message) as the
map for Auto Trim to match map components.

To use Auto Trim, you must define the Segment and Element Delimiters. If you do not
supply the Tag Delimiter, the system substitutes the Segment Delimiter. If you want to use
composite elements, you must specify the Sub Element Delimiter. If you want to use
release characters, you must specify the Release Character.

Reference
See How to Verify EDI Delimiters on page 2 - 69 for more information.

Warning
The sample EDI file must be compliant and must not contain envel ope segments.

Use the following procedure to use Auto Trim:

Sep Action

1 » Right-click the EDI Fileicon onthe EDI side of the map and
» select Auto Trim from the shortcut menu.

System response
The system displays the Auto-trim Sample EDI File dialog box.

Auto-trim Sample EDI File E E
Laak i Ia Bin j il I:_
Archive, exe q Dirgen.exe Genmsg.dil @ Mapper.ex
cercindl  FllEdmgrexe Genzec.dl MEEwnt10
a Commpost. exe B Forms.exe @ Gentran.hip Mbfile10.d
Canfig exe FSEvnt10.dl &P Glom hip MEMAPITI

CTT 288 tmp GenCamPL. di Gmapper.gid A MClient. ex
CTT241.tmp GerComlUldl @ Gmapperhip Mercuil e

|« | i

File hane: I".“

Files of type: I.-’-‘n.IIFiles["."] j Caticel |
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2

Fromthe Look in list, select the drive\folder where the EDI fileis stored.

Note
The default is GENSRVNT\BIN.

If necessary, select the type of file that you want to display from the Files
of typelist.

From the list, select the sample EDI file that you want to load into the
system.

Click Open to begin the auto trim process.

Note
When auto trim is compl ete, the system displays a message stating
whether or not auto trim was successful. Click OK to acknowledge the

message.
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How to Promote Groups and Repeating Segments

Introduction The Promote function extracts one iteration (instance) of a group or repeating segment.
This enables you to map unique data from your application file, and/or enter a specialized
definition. Sterling Gentran:Server specifies that only one-to-one (no loops) or many-to-
many (loop) mapping relationships are valid.

Note
The Promote function is only availableif agroup or repeating segment is selected.

Promote vs. copy vs. split

You can use the Copy and Paste functions (and change the number in the maximum usage
box) to accomplish the same task. However, Promote is a specialized function that
guarantees the integrity of your EDI structure. Depending on the circumstances, you may
use the Split or Copy/Cut and Paste functions instead.

References
» SeeHow to Split Groups and Repeating Segments on page 2 - 44 for more
information.

» SeeHowto Use Copy, Cut, and Paste on page 2 - 48 for more information.

Procedure  Usethis procedure to promote a group or repeating segment.

Sep Action
1 Select the group or repeating segment from which you want to extract
oneiteration
2 Click Promote on the Main Toolbar.

System response
This extracts one iteration (instance) of the looping structure.
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Outbound In thisexample, your application file contains a Ship To record that groups all the shipping
Example information and aBill To record that groups all the billing information. Your Ship To and
Bill To records both occur only once in the application. The EDI file containsa N1 group
(for ANSI) or aNAD group (for EDIFACT) that repeats 200 times. If the Entity Identifier
Code of the NI/NAD is“BT,” that meansthe NI/NAD group contains billing information.

If the Entity Identifier Codeis*“ST,” the NI/NAD group contains shipping information.

Example Procedure
This procedureis an example of how to map unique data to your application file.

Sep Action

1 Activate the NI/NAD loop and the appropriate ssgments and elements,
if you have not aready done so. If you already activated the NI/NAD
group, just highlight it.

Reference
See How to Activate EDI Map Components on page 2 - 37 for more
information.

2 Click Promote on the Main Toolbar to extract a single instance of the
N1/NAD group.

3 From the Edit menu, select Properties.

System response
The system displays the Group Properties dialog box (the Nametabis
displayed by default).
Group Properties
Name I Loopingl Loop Extended Rules I

Please enter the name :
|01 00_N1:2

Flease enter a short description :

Cancel | Appli | Help |

4 In the description box, type aspecialized definition to identify this group
as containing billing information.
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5 Click OK.

System response
The system saves the change and exits the Group Properties dialog box.

6 » Right-click the original NI/NAD group (that now repeats 199
times) again and

» from the Edit menu, select Properties.
System response

The system displays the Group Properties dialog box (the Nametabis
displayed by default)

7 In the description box, type aspecialized definition to identify this group
as containing billing information.

8 Click OK.

System response
The system saves the change and exits the Group Properties dialog box.

9 » Click the Deactivate button on the Main Toolbar and then

» click theoriginal N1I/NAD group (that now repeats 198 times), so
the system does not processiit.

10 Now you can link the elements in the single occurrence of the NI/NAD
that contains billing information to the fields in your Bill To application
record.

And, you can link the elementsin the single occurrence of the NI/NAD
that contains shipping information to the fields in your Ship To
application record.
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How to Split Groups and Repeating Segments

Introduction The Split function enables you to split (break) a group or repeating segment into two
loops. You typically use this function when you need more than one instance of the same
map component that still occurs multiple times.

Split vs. copy and paste

You can use the Copy and Paste functions (and change the number in the maximum usage
box) to accomplish the same task. However, Split is a specialized function that guarantees
the integrity of your EDI structure.

Note

The Split function is only available if a group or repeating segment is selected.

Procedure  Usethis procedure to split a group or repeating segment.

Step

Action

Highlight the group or repeating segment from which you want to extract
oneiteration.

Click Split on the Main Toolbar.

System response
The system displays the Split dialog box.

5 plit <]

First Loop Entries IU

Cancel |

In the First Loop Entries box, type the number that indicates the
sequential number of iterations where you want the group or repeating

segment split.

Example

If the X loop repeats amaximum number of 5 times, and you type“2” in
the First Loop Entries box, the resulting split generates one X loop that
repeats a maximum of 2 times and a second X loop that repeats a
maximum of 3 times.

Note
The number you enter in the First Loop Entries box must be greater than
zero and less than the maximum number of iterations of the loop.

Click OK.

System response
Exits the Split dialog box.
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How to Split Groups and Repeating Segments

Outbound In this example, your application file contains an Allowance record that groups all the
Example  alowanceinformation and a Charge record that groups all the charge information. Your
Allowance and Charge records can repeat up to five timesin the application file. The EDI
file contains a AL C repeating segment that repeats 10 times. If you split the ALC segment
in two, you can map allowance information directly to your Allowance application record
and map charge information directly to your Charge application record.

Example procedure
This procedure is an example of how to split the ALC segment.

Step

Action

1

Activate the ALC segment and the appropriate elements, if you have not
already done so. If you already activated the AL C segment, just highlight
it.

Reference

See How to Activate EDI Map Components on page 2 - 37 for more
information.

Click Split on the Main Toolbar.

System response
The system displays the Split dialog box.

Split

First Loop Entries ID

In the First Loop Entries box, type “5.”

Note
Thisisthe number of sequential iterations where you want the repeating

segment split.

Click OK.

System response
Exits the Split dialog box.

Application Integration User Guide
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(Contd)
Sep

Action

5

From the Edit menu, select Properties.

System response
The system displays the EDI Segment Properties dialog box (Name tab).

EDI Segment Properties E
Name ITag I Fey FieIdI Speciall Loopingl

Please enter the name :
IALE

Please enter a short description ;
ALLOWwAMCE OR CHARGE

Cancel | Lppl | Help |

In the description box, type a specialized definition to identify this
segment as containing allowance information.

Click OK.

System response
The system saves the change and exits the EDI Segment Properties
dialog box.

Highlight the original ALC segment (that now repeats 5 times).

From the Edit menu, select Properties.

System response
The system displays the EDI Segment Properties dialog box (Name tab).

10

In the description box, type a specialized definition to identify this
segment as containing allowance information.

11

Click OK.

System response
The system saves the change and exits the EDI Segment Properties
dialog box.
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(Contd)
Sep Action
12 Now you can link the elementsin the ALC segment that contains
allowance information to the fieldsin your Allowance application
record.

And, you can link the elementsin the AL C segment that contains charge
information to the fieldsin your Charge application record.
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How to Use Copy, Cut, and Paste

Introduction The Copy, Cut, and Paste functions are typically used to move EDI information in the
map. You may need to use these functions if you are using an EDI standard differently, or
if you need to create nested looping structures.

You can cut or copy a single map component (loop, segment, composite, element, record,
or field) and paste it in another location in the map. Copied map componentsretain al the
information of the original map component. If the copied map component contains
subordinate map components (like a segment contains subordinate el ements), the
subordinate map components are also copied.

You can also cut, copy, and paste a map component from one map to another.

Procedure  Usethis procedure to cut, copy, and paste a map component.

Step

Action

1

Select the map component that you want to cut or copy.

From the Edit menu, select Copy.

Note
If you are pasting the map component in another map, open that map, if
it is not already open.

Select the map component that you want the cut or copied selection
pasted after.

Note

If you cut or copied an EDI component, you can only paste that
component into the EDI side of amap. Conversely, if you cut or copied a
positional component, you can only paste that component into the
positional side of a map.

Click Paste on the Main Toolbar to paste the contents of the Clipboard.

System response

If the map component that you selected is agroup, Sterling

Gentran: Server prompts you to specify whether you want the contents of
the Clipboard pasted asachild (subordinate) of the group or pasted at the
same level asthe group. Select the appropriate option and click OK.
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Example  Inthisexample, you are defining an ANSI X 12 Ship Notice/Manifest (856). When the
system generates the 856 document, it contains one HL group. The HL group identifies
dependencies between and the content of hierarchically-related groups of segments.

However, for your EDI file, you need to define additional levels of detail information. The
details that you need to define include shipment, order, and line item information. In order
to modify the structure of your EDI file to accommodate these requirements, you need to
use the Copy and Paste functions to create a nested looping structure for the HL group.

Example procedure
This procedure is an example of how to create a nested looping structure.

Sep Action

1 » Highlight the HL group and
» click Copy on the Main Toolbar.

2 From the Edit menu, select Properties.

System response
The system displays the Group Properties dialog box.
Group Properties
Harne | Loopingl Loop Extended Hulesl

Pleass enter the name :
|u1 00_HL

Flease enter a shart description :

Cancel | Al | Help |

3 In the second box on the Name tab, type a specialized definition to
identify this group as containing shipment information.

4 Click OK.

System response
Saves the change and exits the Group Properties dialog box.
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(Contd)
Sep

Action

5

» Select the map component in the HL that you want the nested HL
group (order information) pasted after and

» click Paste.

System response
The second HL group is added as a nested |oop to the original HL loop.

From the Edit menu, select Properties.

System response
Displays the Group Properties dialog box for the second HL group.

In the second box on the Name tab, type a specialized definition to
identify this group as contai ning shipment information.

Click OK.

System response
Saves the change and exits the Group Properties dialog box.

Double-click the second HL group (order information) to open it.

10

» Select the map component in the HL that you want the nested HL
group (item information) pasted after, and

» click Paste.
System response

Thethird HL group (item information) is added as a nested loop of the
second HL group.

11

From the Edit menu, select Properties.

System response
Displays the Group Properties dialog box for the third HL group.

12

In the second box on the Name tab, type a specialized definition to
identify this group as contai ning shipment information.

13

Click OK.

System response
Saves the change and exits the Group Properties dialog box.

14

Now you can activate the appropriate groups, segments, and elementsin
the new HL nested looping structure.

Reference
See How to Activate EDI Map Components on page 2 - 37 for more
information.
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Overview

Using aFixed-Format File

Overview

Introduction

Before you begin

Create Sub and
Insert functions

If aside of your map is positional (fixed-format), you must either define your application
to Sterling Gentran: Server or load a previously-saved file definition. Your application file
must contain all the information that you need to extract from your partner’s document (if
the map isinbound) or send to your partner (if the map is outbound).

Before you define your application, you should obtain alayout of the necessary records,
fields, and groups. The records contain related fields and the groups contain related
records. For example, your application contains records and groups. The records contain
fields and the groups contain records, subgroups, or both. This meansthat you must create
records and groups before you create the subordinate fields.

Each map component is arranged sequentially in the order that it is most logical for the
system to process. Therefore, each level of your application must be created sequentialy.

You will use two different Sterling Gentran:Server functions to create the necessary group
and records—Create Sub and Insert. This table explains when you use each of these
functions.

I F you want to create a group THEN right-click the map component above
or record... and select...
at the same level (equal), » Insert from the shortcut menu, and

» select Group or Record from the submenu.

that is subordinate to the selected » Create Sub from the shortcut menu, and
map component, » select Group or Record from the submenu.
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How to Adjust File Format Properties

Changingrecord  To set the record delimiters:

delimiters
Sep Action
1 In Application Integration, open the positiona file.
2 Right-click the file format icon and select Properties from the shortcut
menu.

System response
The Positional File Properties dialog box is displayed.

3 In the Record tab, change the Record Delimiters 1 and 2 as needed.

4 Click OK. You must click OK, even if the delimiter fields are empty, to
reset the delimiters.

5 Save the map.

6 Compile the map.

System response
The end-of-line delimiters are changed

Changing decimal If you need to specify that each decimal point in your datais defined and generated as a
points  something other than the default period (.), you can do so on the Decimal Point tab.

To change the default decimal point setting:

Sep Action
1 In Application Integration, open the positional file.
2 Right-click the file format icon and select Properties from the shortcut
menu.

System response
The Positional File Properties dialog box is displayed.

3 In the Decimal Point tab, select the Define Decimal Point check box.

4 In the Decimal Point Character box, type the value you want Sterling
Integrator to use as adecimal point—for example, acomma(,). This
resets the decimal point default to use what you specified instead of a
period.

5 Click OK. You must click OK, even if the delimiter fields are empty, to
reset the delimiters.
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Sep

Action

6

Save the map.

7

Compile the map.

System response

The decimal point setting is now correctly set to use your specification.

Application Integration User Guide
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How to Createthe First Record

Introduction Thefirst record in your application is generally the header record. Thefirst record is
subordinate to the icon in the application side of the map. This shows how the records (and
groups) are contained within it.

Tip
We recommend that you include a header record in each application file. The header
record is mandatory and repeats only once (not a looping structure).

Procedure  Usethis procedure to create the first application record.

Sep Action

1 » Click the Positional Fileicon to highlight it (OUTPUT for an
inbound map and INPUT for an outbound map).

» From the Edit menu select Create Sub.
» Select Record from the submenu.

System Response
The system displays the Positional Record Properties dialog box.

Poszitional Record Properties

MHame |Tag I Key FieIdI Speciall Loopingl

Please enter the name :

Pleaze enter a short description :

Cancel | Aol | Help
2 In the first box on the Name tab, type the record name.
3 In the second box on the Name tab, type a description of the record.

Note
Thisbox is used to provide a brief explanation of the record that allows
you to differentiate it from similar records.

4 Select the Tag tab to access tag information.
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(Contd)
Sep

Action

5

In the Tag box, type the record identification code <TAG>. The record
tag for each record enables the system to recognize that record and then
determine the mapping requirements.

Example
A record isrecognized by the system as:

<TAG>[Field_1][Field_2]

Recommendation

Define the record tag on the Positional Record Properties dialog box,
instead of defining fields with the purpose of explicitly containing the
record tag.

In the Position box, type the starting column position of the tag in the
data record.

Select the Special tab only if you want to specify floating (the record
does not have a fixed position in the file) or wildcard (generally only
used with build or break maps) options. Otherwise, accept the defaults.

Select the L ooping tab only if the record is alooping structure.
Otherwise, accept the defaults and continue with step 11.

Isthe record alooping structure?

» If yes, onthe Looping tab in the Min Usage box, type the minimum
amount of times the record must repeat.

Recommendation
Type “1” to make the header record mandatory.

Note

If the Min Usage box containsa“0" (zero), therecord is
“conditional.” If the Min Usage box containsa“1” or grester, the
record is“ mandatory.”

» If no, continue with step 11.

10

Is the record alooping structure?

» If yes, ontheLooping tab in the Max Usage box, type the maximum
amount of timesit can repeat.

Recommendation

For the header record, we recommend that you accept the default of
“1” soit remains arecord that only occurs once (not alooping
structure).

» If no, continue with step 11.

11

Click OK to create the record.

Application Integration User Guide
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How to Create Subsequent Records

Introduction  After you create the first record, you can define subsequent records at the same level. You
can also define groups, if your application includes looping structures. You may need to
define aloop if your application requires a group of related records (and/or subgroups)
that repeat in sequence.

Reference
See How to Create a Group on page 2 - 62 for more information.

Procedure  Usethis procedure to create additional application records.

Sep Action

1 » Highlight the map component which precedes the record you are
creating in the file layout.

» From the Edit menu select Insert or Create Sub, depending on the
level.

» Select Record from the submenu.

System Response
The system displays the Positional Record Properties dialog box.

2 In the first box on the Name tab, type the record name.
3 In the second box on the Name tab, type a description of the record.
Note

Thisbox is used to provide a brief explanation of the record that allows
you to differentiate it from similar records.

4 Select the Tag tab to access tag information.

5 In the Tag box, type the record identification code <TAG>. The record
tag for each record enables the system to recognize that record and then
determine the mapping requirements.

Example
A record isrecognized by the system as:

<TAG>[Field_1][Field_2]

Recommendation

Define the record tag on the Positional Record Properties dialog box,
instead of defining fields with the purpose of explicitly containing the
record tag.

6 In the Position box, type the starting column position of the tag in the
data record.
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(Contd)
Sep Action
7 Select the Special tab only if you want to specify floating (the record
does not have a fixed position in the file) or wildcard (generally only
used with build or break maps) options. Otherwise, accept the defaults.
8 Select the L ooping tab only if the record is alooping structure.
Otherwise, accept the defaults and continue with step 11.
9 Is the record alooping structure?
» If yes, onthe Looping tab in the Min Usage box, type the minimum
amount of times the record must repeat.
Recommendation
Type*“1” to make the header record mandatory.
Note
If the Min Usage box containsa“0” (zero), therecord is
“conditional.” If the Min Usage box containsa“1” or grester, the
record is“ mandatory.”
» If no, continue with step 11.
10 Click OK to create the record.
Note
Use this procedure to create any additional records.
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How to Create a Temporary Record

Introduction You may need to use temporary records and fields when you cannot use asimplelink or if
you need to extract only specific occurrences of arecord from your datafile. A simplelink
allowsyou to join data from the Input and Output sides of the map in either a one-to-one
relationship (map components that both do not repeat) or a many-to-many relationship
(map components that repeat the same number of times).

Reference
See How to Create Smple Links on page 2 - 113 for more information.

Whentouse If link asingleiteration of a map component on the Input side of a map to a map
temporary records  component on the Output side that repeats multiple times, it causes an infinite loop when
and fiedlds  themapistrandated. And, if you link a map component on the Input side that repeats
multiple times to a map component on the Output side that does not repeat, the data from
the Input side never populates the Output side of the map. In either of these instances, you
should use temporary records and fields.

These are other common reasons why you would want to incorporate temporary records
and field into your map:

» Thelnput hierarchical level in a map does not match the Output hierarchical level.

» You only want to populate an Output field with dataif a specified qualifier is used or
if specific criteriais met.

You may need to use extended rules in addition to creating temporary records and fields.

Reference
See Using Extended Rules, chapter 6, for more information.

Wheretouse  You can add temporary records and fields at any hierarchical level in amap. However,
temporary records  when you use temporary records and fields, you must locate them immediately after the
and fidlds  map component that contains the necessary data.

The following caveats apply to temporary records:

» You must use arecord tag that you would never receivein your Input file, and the
recommended default is $53$.

» If youarecreating atemporary record for an XML file, use the tag XXX, because $$$
isnot permitted asatag in XML.

» Thesystem does not run standard or extended rules on temporary records.
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Example  To map the shipping information from the Input side of your map (from the N1 Group that
repeats a maximum of 200 times) to the ShipTo record in your application file format (that
does not repeat), you need to create atemporary storage record and fields on the EDI side
of the map that do not repeat. Then, you use an extended rule to extract the shipping and
billing information from the N1 group and move it to the appropriate temporary storage
elements. Finally, you map the shipping and billing information directly from the
temporary storage elements to your application fields.

Sepl  First, you need to create atemporary storage record and fields on the EDI side of the map
that do not repeat. The temporary record is located outside the N1 Group at the same
hierarchical level asit, and has a maximum repeat number of “1” (i.e., it does not repeat).
Then you will create the appropriate temporary fields.

Reference
See How to Create Fields on page 2 - 64 for more information.

Thistable lists the temporary storage record that you are creating.

Min
Name Description Tag Usage Max Usage

ShipToDet Ship To Details 55 0 1

Example procedure
Use this procedure to create the ShipToDet temporary storage record.

Sep Action

1 Highlight the N1 group. The two temporary storage segments are located
after the N1 group, at the same level.

2 From the Edit menu, select I nsert. From the submenu, select Segment
(you select Segment instead of Record because you are creating the
temporary record on the EDI side of the map).

System response
The EDI Segment Properties dialog box is displayed.

3 In the Name box, type ShipToDet.
4 In the Description box, type Ship To Details.
5 Select the Tag tab.
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(Contd)
Sep Action

6 In the Tag box, type $$3.
Note
The system does not read a segment with avalue of “$$$” in the Tag box.
Therefore, it does not flag this temporary storage segment as an error
during compliance checking.

7 Click OK to create the ShipToDet temporary storage segment.

8 Create the appropriate temporary fields.

Example
» SHIPTONAME

» SHIPTOADDR1
» SHIPTOADDR?2
» SHIPTOCITY

» SHIPTOSTATE
» SHIPTOPCODE

Note
See How to Create Fields on page 2 - 64 for more information.

Sep2  Create an ON_END extended rule for the N1 Group that assigns the necessary
information to the temporary fields.

Example procedure
Use this procedure to create the extended rule.

Sep Action
1 Right-click the N1 group to access the shortcut menu.
2 From the shortcut menu, select Extended Rules to display the Group

Properties dialog box.

3 Select the On End option. This specifies that the rule is executed when
the loop terminates. The system loads an occurrence of the N1 group
(containing the billing or shipping information), and then executes this
rule.
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Action

4

In the Editor list, type the following:

I F #0098 = “BT” THEN

BEG N
$850. #Bl LLTONAME = #0093;
$850. #BI LLTOADDR1 #0166;
$850. #Bl LLTOADDR2 #0166: 2;
$850. #BI LLTOCI TY = #0019;
$850. #Bl LLTOSTATE = #0156;
$850. #BI LLTOPCODE = #0116;

END

| F #0098 = “ST” THEN

BEG N
$850. #SHI PTONAME = #0093;
$850. #SH PTOADDR1 = #0166;
$850. #SHI PTOADDR2 = #0166: 2;
$850. #SHI PTOCI TY = #0019;
$850. #SHI PTOSTATE = #0156;
$850. #SH PTOPCODE = #0116;

END

Note

If a segment/record or element/field occurs more than oncein a
map, it isidentified by its name <ID>. The second and subsequent
occurrences are identified by <ID>:n, where ‘n’ is the number of
occurrences in the map.

Click Compile to validate the syntax of the extended rule. Every rulein
the map is compiled when you compile the translation object, after you
compl ete the map. However, the system allows you to compile each rule
individualy, so that you can verify the accuracy of the rule after you
create it.

Note

This compiles the rule interactively, and allows you to correct any
errorsthat are generated. Any errors or warnings generated in the
compilation process are displayed in the Errorslist.

Click OK to add the extended rule to the N1 group.

Sep 3 Link the temporary fields on the Input side of the map with the corresponding Output

fields.

Application Integration User Guide
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How to Create a Group

Introduction A group contains related records, groups, or both that repeat in sequence until either the
data ends or the maximum number of times that the loop is allowed to repeat is exhausted.
If you create a group that is subordinate to another group, this corresponds to a nested
looping structure (aloop within aloop).

Procedure  Usethis procedure to create a group.

Sep Action

1 » Highlight the map component which precedes the group you are
creating in the file layout.

» From the Edit menu select Insert or Create Sub, depending on the
level.

» Select Group from the submenu.

System Response
The system displays the Group Properties dialog box (Name tab

displayed by default).

Name | Looping | Loop Extended Rules |

Please enter the name :

Fleaze enter a short description ;

Cancel | Lapp i | Help

2 In the first box on the Name tab, type the group name.

Note
Do not use spaces or dashes (-) in the group name. You can use the
underscore () to separate words.
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Action

3

In the second box on the Name tab, type the loop description.

Note
Thisbox is used to provide a brief explanation of the loop.

Select the L ooping tab to access looping options.

In the Minimum Usage box, type the minimum number of timesthe loop
must be repeated.

Note
For a conditional loop, the minimum usage should always be “0” (zero).
For a mandatory loop, the minimum usage should be “1" or greater.

In the Maximum Usage box, type the maximum number of times the
loop can be repeated.

Isthisasingle iteration group?

» If yes, select Promote records to parent if you want to specify that
the subordinate records and groups should be extracted and located
in the parent group when the group is compiled.

» If no, continue with the next step.

Do you want to specify an extended rule for this group?
» If yes, select the Loop Extended Rulestab.

Reference
See Defining Extended Rules on page 6 - 12 for more information.

» If no, continue with the next step.

Click OK to create the group.

Application Integration User Guide
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How to Create Fields

I ntroduction

Procedure

Each record you create contains a group of logically-related application fields. These
fields define the structure and content of the datato the system.

The easiest way to add application fields to arecord isto use the Positional Field Editor.
Generally, you create the fields for the first record in the application file, and then proceed
with each sequentia record.

Recommendation

Do not define fields with the purpose of using thefield to explicitly contain the record tag.
Thisis because the system takes the tag that you define in the record into account when
the automatic sequencing (Auto Position) feature is used. We recommend that you define
the record tag on the Positional Record Properties dialog box.

Reference
See How to Create Subsequent Records on page 2 - 56 for more information about the
Positional Record Properties dialog box.

Use this procedure to create the application fields for arecord.

Sep Action

1 Right-click the application record and select Edit Fields from the
shortcut menu.

System response
The system displays the Positional Field Editor dialog box.

Positional Field Editor

— Record
oK |
TagPoz 1

Mame HEADER Tag HDR

Cancel I

e el et
f{Eme I I™ | i atom

[escristian I

DataT_l,lpeI 'l Farmat I Yl
StarbFos ID [ Lerath [0 & Leratt ID

— Field
Mame M/C Type Start  Length

Delete |
Auto Position |
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2

Isthe field you are creating the first field in the record?

» If yes, click New and continue with the next step.

» If no, highlight the field that precedes the field you are creating in
the record layout and click New.

System response
The system displays a highlight bar in the Fields section where the new
field is positioned.

Note
You need to fill in the field values in the Field Detail s section.

In the Name box, type the field name.

Notes

» Each application field must have a unique name. It is useful to tag
the end of the fields that occur in multiple records with a suffix that
identifies the record that containsit.

» Do not use spaces or dashes (-) in the field name. You can use the
underscore () to separate words.

Do you want to designate the field as “mandatory” (must be present)?
» If yes, select the Mandatory check box.
» If no, continue with the next step.

In the Description box, type a description of the field.

Note
The description is used to provide a brief explanation of the field that
alowsyou to differentiate it from similar fields.

From the Data Type list, select the type of the field.

Note

Valid values are:

» String = dphaelement

» Number = numeric or real element

» Date/Time = dateortimeeement

Application Integration User Guide
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Action

7

From the Format list, select how the field is formatted.

Note

The choices for this field depend on the type of field you selected from
the Data Typelist. If you choose Number or Date/Time in the Data Type
box, you can select the data format from the Format list. If you selected
String from the Data Type box, you should type a syntax token to denote
that this field must be formatted as the specified syntax token dictates
(the default syntax token is“X").

When you installed Sterling Gentran:Server, you assigned a default
format to the string fields. This format serves as the basis for character
validation. Most U.S. users use adefault format that corresponds to
ASCII characters (for example, the X syntax token). Most users of Asian
or European languages and encoded character sets should use the Free
Format (0x01-OxFF).

Reference
See How to Use Syntax Tokens on page 2 - 105 for more information.

Do you want to indicate the exact position of the field in the record?
» If yes, type the starting position of the field in the Start Pos box.
» If no, continue with the next step.

Note

You want to specify field start positionsif, for example, you are only
using afew fields but you want them positioned exactly in the record.
The aternative to specifying the start position of each field, isto add the
fields sequentially in the record and then use the Auto Position function.

Reference
See step 13 below for more information about the Auto Position
function.

In the Min Length box, type the minimum number of charactersthat is
acceptable for thisfield.

10

In the Max Length box, type the maximum length of the field.

11

Click New.

System response
The system adds the field and creates anew field with blank values ready
for you to identify, which is positioned below the field.

12

Create the rest of the fields according to your record layout.

Note
Click Deleteto stop adding fields.
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Sep

Action

13

After adding the last field, do you want the system to automatically
position the fieldsin the record?

» Ifyes, click Auto Position.

Note

Thisautomatically calculates the start position in the record of each
field based on the criteriathat each field is positioned directly after
the previous field and is of the length specified in the Max Length
box. Click Yesto acknowledge the warning message that fields are
sequenced in order.

Warning

It isonly valid to use the Auto Position function if you define a
record tag, and if you define every field in the record in the sequence
that each field occurs.

Reference
See How to Create Subsequent Records on page 2 - 56 for more
information.

» If no, continue with the next step.

14

Are you completely finished adding fields to the record?
» Ifyes, click Close.
» If no, repeat steps 2 through 13.

Note
Use this procedure to add fields to the other records you defined.

For inbound maps, you may want to use aliteral constant to move a
value into an application field that has no corresponding EDI data (you
cannot link the field directly to an EDI element).

Reference
See How to Map Literal Constants on page 3 - 32 for more information
about mapping a constant to afield.
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Using an EDI File

Overview

Introduction  Sterling Gentran:Server generates an EDI file for you, based on the standard (agency),
version, transaction set, and release you select. The system includes all the groups,
segments, composites, and elements that are defined by the standards agency for the
version of the document you select.

Reference
See How to Create a New Map on page 2 - 20 for more information about generating an
EDI file when you create a new map.

You can modify the system-generated EDI file by modifying the properties of the map
components, and using the promote, split, copy, cut, and paste functions.

However, if you want to use a specialized version of an EDI standard that is not available
in the Sterling Gentran:Server standards database, it may be appropriate for you to either
load an EDI file definition or define the EDI file yourself.

Reference
See Using a ClI File on page 2 - 88 for more information about defining a Cll file.

Regardless of whether the system generates the EDI file or you load or defineiit, the
specific EDI map components that you use depends on the type of map you are creating.
This includes the standard, version, and transaction set (document) selected, and which
groups, segments, composites, and elements your company requires. We recommend that
you determine which map components you are using before generating or defining an EDI
file
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How to Verify EDI Delimiters

I ntroduction

Procedure

If you are using an EDI standard that contains composite elements or subelements, you
must verify that Sterling Gentran: Server is specifying the correct delimiters. Delimiters
are flags that you define to the system as separating specific EDI components.

Delimiters are necessary for all variable field-length standards, because the datais
compressed (and the leading zeroes and trailing blanks are removed). Since the fields vary
in length, the system needs a flag to determine where one element ends and another
begins. For example, an element delimiter marks the beginning of a new element.

Recommendation

Although verifying EDI delimitersin Sterling Gentran: Server is mandatory only if you are
using a standard with composite elements or subelements, we recommend that you
perform this task regardless of which standard you use.

Use this procedure to verify EDI delimiters.

Sep Action

1 Right-click the EDI fileicon and select Properties from the shortcut
menu.

System response
The system displays the File Properties dialog box.

File Properties
MName | Drelimiters | Syntax Hecordl Loop Extended Flulesl

Please enter the name :
IDHDEHS

Flease enter & shart description :
FURCH&SE ORDER MESSAGE

DK‘ Cancel éIJIJL'r' HB||3
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Sep

Action

2

Select the Delimiter s tab to access delimiter options.

File Properties x|

Mame Delimiters I Syntax Record I Loop Extended Flulesl

™ Specify defaults

I— 5 eg\;nent [Elimiter I—
I— Sub Element Delimiter I—
Fepeating Element Delimiter I—

I_ [recimal Separator

Tiag Delimiter

Elerment Delimiter

o

Felease Character

Option:
" Default suppression and padding of leading zero on Humeric valies

{7 Suppress lzading zem on Nurmers B format values [e.g), 0025 > 25

) Padiwith eading zenm o Humeric values e, 25 - OO002E]

o]

Cancel | Lpply I Help |

Verify that the Specify defaults check box is selected.

Verify the required delimiters for the EDI standard you are using.

Note
If the delimiters differ from the defaults specified, type either the
character or the hexadecimal value in the correct box.

Areyou using an X12, EDIFACT, or TRADACOMS standard on the
output side of amap and you want to suppress leading zeros for the EDI
elements that use an R-format numeric (including decimal values less
than one)?

» If Yes, select the Suppress leading zero on Numeric R* format
values (e.g., 0.25---> .25) option.

» If No, continue with Step 6.

Areyou using an X12, EDIFACT, or TRADACOMS standard on the
output side of amap and you want to pad humeric values (regardless of
format) for the EDI elements with leading zeros?

» If Yes, select the Pad with leading zero on Numeric values (e.g.,
25---> 000025) option.

Note

When you select this option, Numeric values (regardless of format)
are padded with leading zeros out to the maximum length of the
field.

» If No, continue with Step 7.

Click OK to exit the File Properties dialog box.
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How to M odify Group Properties

Introduction A group contains related segments and/or groups that repeat in sequence until either the
group data ends or the maximum number of times that the loop is allowed to repeat is
exhausted. If you create agroup that is subordinate to another group, this correspondsto a
nested |ooping structure (aloop within aloop).

Procedure  Usethis procedure to modify the properties of a group.

Sep Action

1 Right-click the group you want to modify and select Properties from
the shortcut menu.

System Response
The system displays the Group Properties dialog box (Name tab

displayed by default).

Name | Loopingl Loop Extended Hulesl

Please enter the name :

Please enter a short description :

Cancel | Lopi I Help |

2 If you want to modify the group name, in the first box on the Name tab,
type the new name.

Note
Do not use spaces or dashes (-) in the group name. You can use the
underscore () to separate words.

3 If you want to modify the group description, n the second box on the
Name tab, type the new description.

4 Select the L ooping tab to access looping options.
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Sep Action

5 In the Minimum Usage box, type the minimum number of timestheloop
must be repeated.

Note
For a conditional loop, the minimum usage should always be“0” (zero).
For amandatory loop, the minimum usage should be “1” or greater.

6 In the Maximum Usage box, type the maximum number of times the
loop can be repeated.

7 Isthisasingleiteration group?

» If yes, select Promote recordsto parent if you want to specify that
the subordinate records and groups should be extracted and located
in the parent group when the group is compiled.

» If no, continue with the next step.

8 Do you want to specify an extended rule for this group?
» If yes, select the Loop Extended Rulestab.

Reference
See Defining Extended Rules on page 6 - 12 for more information.

» If no, continue with the next step.

9 Click OK to save changes to the group.
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How to M odify Segment Properties

Introduction You can modify the properties of any segment, including the minimum and maximum
number of times the segment can repeat, whether the segment is mandatory or conditional,
and whether it is aloop start or loop end segment.

Reference
See How to Use Loop Sart and Loop End Segments on page 2 - 76 for more information.

Procedure  Use this procedure to modify the properties of a segment.

Sep Action

1 Right-click the segment you want to modify and select Propertiesfrom
the shortcut menu

System Response
The system displays the EDI Segment Properties dialog box.

EDI Segment Properties 1]
Harme |Tag I Key Fieldl Speciall Loopingl

Please erter the name :
|N1

Fleaze enter a short dezcription :

MAME

Cancel I A | Help |

2 If you need to modify the name of the segment, type the segment name
in the first box on the Name tab.

Note

If a segment occurs more than oncein amap it isidentified by its name
<ID>. The second and subsequent occurrences are identified by <ID>:n,
where “n” isthe number of the occurrencein the map.

3 If you want to modify the description of the segment, type a new
description in the second box on the Name tab.

Note
Thisbox is used to provide a brief explanation of the segment that
allowsyou to differentiate it from similar segments.
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Sep Action

4 Select the Tag tab only if you want to access tag information.

5 If you want to modify the segment tag, type the segment identification
code <TAG> in the Tag box.

Note
The segment tag for each segment enables the system to recognize that
segment.

Example
A record isrecognized by the system as:

<TAG>[Delimeter]<DATA>[Delimeter]
<DATA>.......<DATA>[Segment Terminator]

6 Select the Key Field tab only if you want to use akey field.

Note

The key field function enables you to specify a second qualification in
selecting a segment (the segment name is the first qualification). Data
must be provided in the order designated through the use of key fields.

7 Select the Special tab only if you want to specify floating (the segment
does not have a fixed position in the file) or wildcard (generally only
used with build or break maps) options, or if you want to flag this
segment as containing binary data. Otherwise, accept the defaults.

Note

If you select “Binary,” you must define an element of data-type “Bin
Length” and another element of data-type “Bin Data.” The“Bin Length”
element must precede the “Bin Data’ element.

Reference
See How to Modify Element Properties on page 2 - 84 for more
information about defining an element data-type.

8 I's the segment a looping structure?
» If yes, select the L ooping tab.
» If no, accept the defaults and continue with step 12.

9 In the Min Usage box, type the minimum amount of times the segment
must repeat.

Note

If the Min Usage box containsa“ 0" (zero), the segment is“conditional .”
If the Min Usage box containsa“1” or greater, the segment is
“mandatory.”

Sterling Gentran:Server — May 2011 Application Integration User Guide



Designing your Map How to Modify Segment Properties

(Contd)
Sep Action
10 Do you want the segment to repeat (loop)?
» If yes, type the maximum amount of timesit can repeat in the Max
Usage box.
» If no, continue with the next step.
11 Do you want to indicate that the segment is the beginning of aloop
(Loop Start) or the end of aloop (Loop End)?
» If yes, select one of the following options.
Loop Sart (this segment marks the beginning of the loop)
L oop End (this segment marks the end of the loop)
» If no, accept the default of Normal for the Normal/Loop Start/L oop
End options, which indicates that this segment isin the loop but is
not the beginning or ending segment
12 Click OK to save changesto the segment.
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How to Use Loop Sart and Loop End Segments

Introduction  Certain EDI standards use Loop Start (LS) and Loop End (LE) segments. LSand LE
segments differentiate between two or more loops of the same type. If the transaction
contains LS and L E segments and depending on whether your map is inbound or
outbound, you need to define the LS and LE segments for the loops you are using in the
map in one of two different ways.

Tip

You need to communicate with your trading partner to determine which loop identification
code your partner sends you (for an inbound map), or expects to receive (for an outbound

map).

Procedure: Use this procedure to define an LS segment for an inbound map.

Action

Right-click the LS segment and select Properties from the shortcut
menu.

System response
The system displays the EDI Segment Properties dialog box.

» Select the L ooping tab to access the loop options and
» verify that the Loop Start option is selected.

definingal$S
segment inbound
Sep
1
2
3

Select the Key Field tab.

System response
The system displays the key field options.
EDI Segment Froperties

Mame I Tag K.y Figld I Speciall Loopingl

Fietdl | =l

I &kt e

) sz corstart I ¥ l Edif... |
= secodelist I ¥ l Edit... |

Ittt record when key does nobmateh

Cancel Sl Help
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4 From the Field list, select the “Loop Identifier Code.”

Note

Thislist contains all the elements that are contained in the segment and
gives you the ability to define the Loop Start segment definition, by
specifying that the loop identifier code must have the value you specify
in the Matching rules section.

5 Select the Use constant option.

Note
The Matching rules section enablesyou to access al the literal constants
and code lists currently defined for this map.

6 Click Edit (at theright of the Use constant list).

System response
The system displays the Map Constants dialog box.

Translation Object Constants [ %]

D Type Walue
Sub Table 1 Sting PRODCODE

Mew...

[ Gen |
[[Eeme

Change...

Delete

7 Click New.

System response
The system displays the Edit Constant dialog box.

Edit Constant

D Type
| |

Walue Cancel |

8 In the ID box, typetheliteral constant identifier.

9 From the Type list, select “String.” Thisisthe category of thisliteral
constant.
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(Contd)
Sep Action

10 In the Value box, type the value of the literal constant.
Note
For an inbound map, thisisthe loop identifier code that you expect to
receive from your trading partner.

11 Click OK to add the constant to the system.

12 Select the constant you created from the list.
Note
The system matches the selected constant against the loop identifier
code.

13 Click OK to exit the EDI Segment Properties dialog box.

Use this procedure to define an LE segment for an inbound map.

Sep Action
1 Right-click the LE segment and select Properties from the shortcut
menu.
System response
The system displays the EDI Segment Properties dialog box.
2 » Select the Looping tab to access the loop options and
» verify that the Loop End option is selected.
3 Select the Key Field tab.
System response
The system displays the key field options.
4 From the Field list, select the “Loop Identifier Code.”

Note

Thislist contains al the elements that are contained in the segment and
givesyou the ability to define the Loop End segment definition, by
specifying that the loop identifier code must have the value you specify
in the Matching rules section.
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Sep

Action

5

Select the constant you created for the LS segment from the list.

Notes
» The system matches the selected constant against the loop identifier
code.

» The Matching rules section enables you to access all the literal
constants and code lists currently defined for this map.

Click OK to exit the EDI Segment Properties dialog box.

Procedure: Use this procedure to define an LS segment for an outbound map.

Action

Double-click the Loop Identifier Code element in the LS segment.

System response
The system displays the Element Properties dialog box.

Select the Sandard Rule tab to access the standard rule options.

From the standard rule list, select “Use Constant.”

System response
The system displays the constant options.

Element Froperties

Mame I Validationl Extended Fule  Standard Rule IEonditionsl

Please select the standard rule to use : IUse Constant j
Please select a constant to stare in this figld :

f =l Edi. |

IF this constant is a qualifier for anather field, GEMTRAM can automatically use the
existence of data in that field to determine whether to execute this standard wile. To
take advantage of this featurs, simply select the field to be qualified :

Cancel Sl Help

definingal$S
segment outbound
Sep
1
2
3
4

Click Edit.

System response
The system displays the Map Constants dialog box.

Application Integration User Guide
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Sep Action
5 Click New.
System response
The system displays the Edit Constant dialog box.

6 In the ID box, typethe literal constant identifier.

7 From the Typelist, select “String.” This the category of this literal
constant.

8 In the Value box, type the value of the literal constant. For an outbound
map, thisisthe loop identifier code that your partner is expecting to
receive from you.

9 Click OK to add the constant to the system.

10 Click Close to exit the Map Constants dialog box.

11 From the constant list, select the constant that you created.
Note
The system matches the selected constant against the loop identifier
code.

12 Click OK to exit the Element Properties dialog box.

Procedure: Use this procedure to define an LE segment for an outbound map.
defininga LE
segment outbound

Sep Action

1 Double-click the Loop Identifier Code element in the LE segment.

System response
The system displays the Element Properties dialog box.

2 Select the Sandard Rule tab to access the standard rule options.

3 From the standard rule list, select “Use Constant.”

System response
The system displays the constant options.

4 From the constant list, select the constant that you created.
Note
The system matches the selected constant against the loop identifier
code.

5 Click OK to exit the Element Properties dialog box.
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How to M odify Composite Properties

Introduction A compositeis a data element that contains two or more component data elements or
subelements. You can modify the composite name and description, and whether or not it is

mandatory.

Note

Composite elements are only used for EDI maps.

Procedure  Use this procedure to modify the properties of a composite.

Sep

Action

Right-click the composite you want to modify and select Properties
from the shortcut menu.

System response
The system displays the Composite Properties dialog box.

Composite Properties

Name | Validation |

Please enter the name :
|cnnz

Fleasze enter a short description :

Cancel | Appli | Help |

If you want to change the composite name, type the data element
identification number in the first box on the Name tab.

Note

If acomposite occurs more than onceinamap it isidentified by its name
<ID>. The second and subsequent occurrences are identified by <ID>:n,
where “n” isthe number of the occurrence in the map.

If you want to change the composite description, type the new
description in the second box on the Name tab.

Select the Validation tab if you want to specify that the compositeis
mandatory.
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5 Select the check box on the Validation tab to indicate whether this
composite must be present.
6 Click OK to save the changes to the composite.
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How to Modify Element Properties

I ntroduction

Procedure:
modifying element
properties

Each segment or composite contains agroup of logically-related elements. These elements
define the structure of the EDI data that your system needs to process the document.

Use this procedure to modify the properties of an element.

Step

Action

Double-click the element you want to modify.

System response
The system displays the Element Properties dialog box.
Element Froperties

Hame |Validati0n| Extended Fiulel Standard Hulel Eonditionsl

Please enter the name :
|03?3:5

Fleasze enter a short description :
DATE

Cancel I e[ | Help I

To change the name of the element, type the new name in thefirst box on
the Name tab. The name istypically the element sequence number.

Note

If an element occurs more than oncein amap it isidentified by its name
<ID>. The second and subsequent occurrences are identified by <ID>:n,
where“n” isthe number of the occurrence in the map.

To change the description of the element, type the new description in the
second box on the Name tab.

Note
The description is used to provide a brief explanation of the element that
allowsyou to differentiate it from similar elements.

Select the Validation tab to access validation options.

If you want to designate the element as “mandatory” (must be present),
select the first check box on the Validation tab.
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Sep

Action

6

To change the minimum length of the element, type the minimum length
in the Minimum box.

Note
If the datais less than the minimum length, a compliance error is
generated when translation occurs.

To change the maximum length of the element, type the maximum length
in the Maximum box.

From the Data Type list, select the type of the element.

Note

Valid values are:

» String = aphaelement

» Number = numeric or real element

» Date/Time = date or time element

» BinData = binary data(only available if you select “Binary” on
the Special tab of the EDI Segment Properties
dialog box)

» BinLength = length of binary data (only available if you select
“Binary” on the Special tab of the EDI Segment
Properties dialog box)

Reference

See How to Modify Segment Properties on page 2 - 73 for more
information about selecting “Binary” on the Special tab.

From the Format list, select how the data element is formatted.

Note

The choices for thisfield depend on the type of field you selected from
the Data Type list. If you choose Number or Date/Timein the Data Type
box, you can select the data format from the Format list. If you selected
String from the Data Type box, you should type a syntax token to denote
that this field must be formatted as the specified syntax token dictates.

When you installed Sterling Gentran: Server, you assigned a default
format to the string fields. This format serves as the basis for character
validation. Most U.S. users use a default format that corresponds to
ASCII characters (for example, the X syntax token). Most users of Asian
or European languages and encoded character sets should use the Free
Format (0x01-OxFF).

Reference
See How to Use Syntax Tokens on page 2 - 105 for more information.

10

Click OK to save the changes to the element.
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Procedure: You can use relational conditions to connect fields together for syntax or compliance
defining and reasons. For example, Field A isinvalid unless Field B is present. Therefore, if you set up
modifying  acondition that pairs Fields A and B, the system generates a compliance error if one of

relational  thosefieldsis not present.
conditions , - ] , ,
You can a'so view the conditional relationships between elements, as provided by the
standard.

Warning
The system enables you to edit EDI conditional relationships, but if you do, you generates
a compliance error. We recommend that you view EDI conditions only.

Procedure  Usethis procedure to define, modify, and view field and element relational conditions.

Sep Action

1 Double-click the field or element you want to modify.

System response
The system displays the Field (or Element) Properties dialog box.

2 Select the Conditions tab.

System response
The system displays the relational condition options.

Element Properties

Marme I Validationl Extended Hulel Standard Fule  Conditions |

Fleaze chooze the type of relationship to use

I Conditional A I

Please select the condition fisld :
|D235 FRODUCT/SERVICE ID QUALIFIER j

Available fields : Fields uzed in relationzhip :
0350 A5SIGMED IDENTIFIEﬂ 0234 PRODUCT/SERWICE 1D

0330 QUANTITY ORDERE
0355 UNIT OR BASIS FOR
0212 UNIT PRICE

0E39 BASIS OF LUMIT PRICE
0235:2 PRODUCTASERVICE I < Hemove

n’nn 2 RPROM IF‘TJC:I:I:!\.I’IF‘

k. Cancel Annly Help
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3

Select the field connection condition from the type of relationship list.

Note
Valid values are:

» Paired/Multiple—if any of the specified fields are present then all
fields must be present

» Required —at least one of the specified fields must be present

» Exclusion —no more than one of the specified fields may be present

» Conditional —if thefirst Condition field is present, the rest of the
fields must also be present

» List Conditional —if thefirst Condition field is present, at least one
of the specified fields must also be present

Select the first field from the condition field list.

Notes

» Thisisthefield on which the conditional relationship hingesif you
chose “ Conditional” or “List Conditional” from the type of
relationship list.

» Theconditionfield list isonly activeif you chose either
“Conditional” or “List Conditional” from the type of relationship
list.

From the Available fields list, select afield or fields and click Add.

System response
The system moves the fields to the Fields used in relationship list, to
include the fields as a part of the conditional relationship.

Notes
» TheAuvailablefieldslist contains all the fieldsin the trandation
object that are valid to be used in a condition at this point.

» TheFieldsusedinrelationship list contains the fields that you
selected to be a part of the conditional relationship.

» Toremovethefieldsfrom the conditional relationship, select afield
or fields from the Fields used in relationship list and click Remove
to move the fields back to the Available fields list.

Click OK to add the conditional relationship to the field.
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UsngaCll File

Overview

Introduction  If asideof your map is Cll, you must either define it to Sterling Gentran:Server or load a
previously-saved file definition. A ClI message consists of one message header, one TFD
area, and one message trailer

Before you define the Cll file, you should determine which groups and TFDs you will
need to use. The groups contain related groups and TFDs. This means that you must create
groups before you create the subordinate subgroups and TFDs.

Each map component is arranged sequentially in the order that it is most logical for the
system to process. Therefore, each level of your application must be created sequentialy.
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How to Modify CIl File Properties

Introduction The Cll File Properties dialog box enables you to modify setting for the Cll or CllI-
Positional sides of amap. This dialog box enables you toggle the use of dividing mode (a
method of formatting Cll datainto fixed-length 251-byte records), non-transparent mode
(encodes charactersin the Cll data so that they do not cause problems with some
communications file-transfer protocols). This dialog box aso enables you to specify
single- or double-byte character setsto use in data trand ation.

Procedure  Usethis procedure to modify Cll File Properties.

Step

Action

Right-click the ClI fileicon and select Properties from the shortcut
menu.

System response
The system displays the CI1 File Properties dial og box.
Cll File Properties
Name |M0de I EharacterSetsI Loop Estended Hulesl

Please enter the name :
pNPUT

Please enter a short description :

Cancel | Al | Help |

Note
The system displays the Name tab by default. On this tab, you can
modify the name and description of the ClI file.

Select the M ode tab to access mode options.

Will you be communicating with atransmission system that is unable to
process variable length records?

» If yes, select the dividing mode (amethod of formatting Cll datainto
the plural number of 251-byte fixed records) On option.

» If no, continue with the next step.
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4

Do you want to use non-transparent mode to encode charactersin the Cl|
data so they do not cause problems with some communications file-
transfer protocol communications control characters?

» If yes, select the Non-Transparent Mode check box.

» If no, the default is cleared, which means you are using transparent
mode.

Select the Character Setstab to access character set options.

Do you want to use single- or double-byte character trandation?

» If yes, select the appropriate option from the 8 bit Character Set and
16 Bit Character Set lists.

» If no, continue with the next step

Do want to specify an extended rule for this group?
» If yes, click the Loop Extended Rulestab.

Reference
See Defining Extended Rules on page 6 - 12 for more information.

» If no, continue with the next step.

Click OK.

System response
The system saves your modifications and exits the Cll File Properties
dialog box.
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How to Create a Group

Introduction A group containsrelated TFDs, groups, or both that repeat in sequence until either the data
ends or the maximum number of times that the loop is allowed to repeat is exhausted. If
you create a group that is subordinate to another group, this corresponds to a nested
looping structure (aloop within aloop).

Procedure  Usethis procedure to create a group.

Sep

Action

» Highlight the map component which precedes the group you are
creating in the file layout.

» From the Edit menu select Insert or Create Sub, depending on the
level.

» Select Group from the submenu.

System Response
The system displays the Group Properties dialog box (Name tab
displayed by default).
Group Properties
Harne | Loopingl Loop Extended Hulesl

Pleass enter the name :

Flease enter a shart description :

Cancel | Al | Help

In the first box on the Name tab, type the group name.

Note
Do not use spaces or dashes (-) in the group name. You can use the
underscore (_) to separate words.

In the second box on the Name tab, type the loop description.

Note
Thisbox is used to provide a brief explanation of the loop.

Application Integration User Guide
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(Contd)
Sep Action

4 Select the L ooping tab to access looping options.

5 In the Minimum Usage box, type the minimum number of timesthe loop
must be repeated.

Note
For a conditional loop, the minimum usage should always be “0” (zero).
For a mandatory loop, the minimum usage should be “1" or greater.

6 In the Maximum Usage box, type the maximum number of times the
loop can be repeated.

7 Isthisasingle iteration group?

» If yes, select Promote records to parent if you want to specify that
the subordinate records and groups should be extracted and located
in the parent group when the group is compiled.

» If no, continue with the next step.

8 Do you want to specify an extended rule for this group?
» If yes, select the Loop Extended Rulestab.

Reference
See Defining Extended Rules on page 6 - 12 for more information.

» If no, continue with the next step.

9 Click OK to create the group.

Sterling Gentran:Server — May 2011 Application Integration User Guide



Designing your Map How to Createa TFD

How to Createa TFD

Introduction Thefirst TFD in your Cll file is subordinate to the icon on the Cll of the map. This
graphic representation shows how the TFDs (and groups) are contained within the Cll file.

After you create thefirst TFD, you can define subsequent TFDs at the same level. You can
also define groups, if your application includes looping structures. You may need to define
agroup if your application requires agroup of related TFDs (and/or subgroups) that repeat
in sequence. Please see How to Create a Group on page 2 - 62 for more information.

Note

When you create a TFD, the default data type is “String,” so the system displays the
Character Set tab. If you change the TFD data type to “Number” or “Date/Type,” the
system removes the Character Set tab.

Procedure  Usethis procedure to create a TFD.

Sep Action

1 Areyou creating the first TFD in your file?

» If yes, select the Cll Fileicon (INPUT for an inbound map and
OUTPUT for an outbound map), and select Create Sub from the
Edit menu. Then, select TFD from the submenu.

» If no(you are creating a subsequent TFD), select the TFD which
precedes the TFD you are creating in the file layout. Then, select
Insert from the Edit menu and select TFD from the submenu.

System response
The system displays the ClI TFD Properties dialog box.
Cll TFD Properties
Mame | Tag | Looping | Walidstion | Standard Fiule | Extended Rule | Character et |

Please enter the name :

Pleaze enter a shat description :

=50 Cancel ool Help
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Sep

Action

2

In the first box on the Name tab, type the TFD name.

Warning
Do not use spaces or dashes (-) for the TFD name. You can use the
underscore (_) to separate words.

In the second box on the Name tab, type a description of the TFD.

Note
Thisbox is used to provide a brief explanation of the TFD that allows
you to differentiate it from similar TFDs.

Select the Tag tab to access tag information.

Note
The datatag isan identifier that expresses attributes of a data element.

Select either the Hex or Decimal option, depending on how you want to
enter the data tag.

Note
The default is Hex.

If you want to use an extended range of values for the tag, select the
Extended Mode check box.

Notes

» If you select the Extended Mode check box, you can enter up to hex
7FFF (decimal 524287) in the Tag box. In compressed mode, you
can only use up to hex EF (decimal 239).

» Thedefault is cleared, which means that the data tag will be
expressed in compressed mode.

» InExtended Mode, the range that you can use for the TFD tag is
restricted to decimal 61440 - 65535 and hex FOOO - FFFF.

In the Tag box, type the identification tag. You must enter atag in this
box.

Select the L ooping tab to access the loop options.

Accept the default of Normal, unless you want to indicate that the
segment is the beginning of aloop (Loop Start), the end of aloop (Loop
End), or that the loop repeats (Loop Repeat).

Note
If you select Loop Start, the system displays the Key Field tab.

10

Select the Validation tab to access validation options.

11

If you want to designate the TFD as“mandatory” (must be present),
select the first check box on the Validation tab.
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12 To change the minimum length of the TFD, type the minimum length in
the Minimum box.
Note
If the datais less than the minimum length, a compliance error is
generated when tranglation occurs.

13 To change the maximum length of the TFD, type the maximum lengthin
the Maximum box.

14 From the Data Type list, select the type of the TFD.
Note
Valid values are:
» String = aphabetic
» Number = numericor red
» Date/Time = dateortime

15 From the Format list, select how the TFD is formatted.
Note
The choices for this field depend on the type of field you selected from
the Data Typelist. If you choose Number or Date/Time in the Data Type
box, you can select the data format from the Format list. If you selected
String from the Data Type box, you should type a syntax token to denote
that this field must be formatted as the specified syntax token dictates
(the default syntax token is“X").
When you installed Sterling Gentran: Server, you assigned a default
format to the string fields. Thisformat serves as the basis for character
validation. Most U.S. users use adefault format that corresponds to
ASCII characters (for example, the X syntax token). Most users of Asian
or European languages and encoded character sets should use the Free
Format (Ox01-OxFF).
Reference
See How to Use Syntax Tokens on page 2 - 105 for more information.

16 If the TFD data-type is Number or String and you want the data read/
written in binary format:
» Select the raw bytes check box,
» From the Width list (Number format only), select how many bytes

should be used to represent the number,
» Select either the little-endian or big-endian option to specify in
which order the bytes should be read.
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(Contd)
Sep Action
17 If the Character Set tab isavailable, it enables you to set the single-
double-byte character trandlation for this string. The default character set
is 8-hit. Select the appropriate option from the 8 bit Character Set and 16
Bit Character Set lists.
18 Click OK to create the TFD.
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Formatting Your Data

Overview

Introduction ~ When you define or modify afield, element, or TFD, you must specify the type and
format. The options that are available for the format of the field, element, or TFD depend
on which type you select (string, number, or Date/Time).
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How to Usethe Sring Type

Introduction A string-type field or element contains one or more printable characters. If you specify
that afield or element is a string type, you must designate the format by specifying a
syntax token.

Syntax tokens enable you to designate a “token” that defines ranges of characters and
numbers that are allowed to be used for a string-type element or field. You can then use
the syntax tokens in the Format field of the Field Properties dialog box. This enables you
to define the type of characters to be used while compliance checking each element/field
(e.g., alphanumeric within a certain range or numeric within a certain range).

Note
When you set up atoken, it applies only to that map. You may need to set one up for each
map that you create.

Character ranges  Sterling Gentran: Server uses the ANSI Character Set when determining the start-end
range.

For Western European languages, consult the ANSI character chart (1252 Windows Latin
1). This chart also displays ranges so that you can enter appropriate ranges for the
charactersin your language. If no chart is available, use the following guidelines:

» Toinclude all the accented charactersin the major languages of Western Europe, add
the following ranges:

Sart End
0xCO0 0xD6
0xD8 OxF6
OxF8 OxFC

» Scandinavian users should also add the following in order to include (E and ce

Sart End

0x8C 0x8C

0x9C 0x9C

» Toincludethe euro symbol (€), use the following.

Sart End

0x80 0x80
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Procedure:
creating or editing

Use this procedure to create a syntax token.

How to Use the String Type

a syntax token

(Western Step

Action

European
languages)

From the Edit menu, select Syntax Tokens.

System response

The system displays the Syntax Tokens dialog box.

Syntax Tokens

Taken

Allowed character ranges

& &Zaz
N 09,.-—++
* BZaz09. e ([ AN
Mew... |
Change... |
Delete |
P I I _.I [HBEE: |
Notes

» The Token column containsthe value designated as the syntax token
for each existing syntax token. The Token contains a range of
characters that, when applied to an element, dictate the way that
element must be formatted. If the element is not formatted as
specified, the system generates a compliance error.

» TheAllowed character ranges column contains the ranges of
characters that are permitted for each existing syntax token. Each
range consists of a pair of characters that define the start and end

characters.

DBCSisonly available if you are executing a double-byte version

of Microsoft Windows 2000.

Areyou creating a new syntax token?

» If yes, click New.

» If no, select the token you want to edit and click Edit.

System response

The system displays the Edit Syntax Token dialog box.

Edit Syntax Token

Token I_

Character Fanges

Cancel

Start End

Mew...

Change...

Delete

i

Application Integration User Guide
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3

In the Token box, type the unique one-character alphanumeric value that
the system recognizes as containing the allowed range of charactersyou
designate.

Notes

» The Token can only be one unique character, upper- or lower-case
alphabetic or numeric “1" - “9”.

» The Character Ranges list contains the character range or ranges
that you define for this token. You can define more than one
character range for each token. For example, you can define the
token “A” as alowing the character range “A” through “Z” and the
character range “a’ through “z”. Thisindicates that token “A” only
allows upper-case and lower-case alphabetics.

Do you want to create a new character range?
» Ifyes, click New.

System response
The system displays the Edit Character Range dialog box.

Edit Character Range
Start character I ;
End character I Cancel |

» If no, continue with step 8.

In the Start character box, type the character that begins the allowed
token range.

Example
For example, if the character range you want to defineis“B” through
“D,” type“B” in the Start character box.

Notes

» If youtypeacharacter, such asé, that is not accepted, you need to
enter it in hex code. To enter hex characters, “0(zero)x” or “0X,”
followed by the hex code. For example, the hex equivalent of éis
OXEO.

» The Start character and End character can only be one (1) character,
upper- or lower-case alphabetic or numeric “1" - “9.”

In the End Character box, type the character that terminates the allowed
token range. Use the guidelines from step 5.

Click OK to return to the Edit Syntax Tokens dialog box.

To add additional character rangesto the syntax token, repeat steps4 - 7
as many times as necessary.
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Action

9

Click OK to save the syntax token and return to the Syntax Tokens
dialog box.

10

Click Close to exit the Syntax Tokens dialog box.

Procedure. The DBCS syntax token function enables you to create a map that accepts double-byte
creating or editing characters. If you are running Sterling Gentran:Server on a Chinese, Japanese, or Korean
a syntax token version of Microsoft Windows/Windows 2000 or Windows 98/Me, the DBCS button on
(Far Eastern the Syntax Tokens dialog box is available.

languages)

DBCStokens are displayed only in the DBCS Syntax Tokens dialog box, not inthelistin

the Syntax Tokens dialog box.

Note

When you set up aDBCS token, it applies only to that map. You may need to set one up
for each map that you create.

Use this procedure to create a DBCS syntax token.

Sep

Action

1

From the Edit menu, select Syntax Tokens.

System response
The system displays the Syntax Tokens dialog box.

Syntax Tokens

Token  Allowed character ranges
A Aaz

M 09.-++
% AZaz00, -+ [N S

Mew.

Change...

Delete

_Charge..|
_ Dol |
q | | e |
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2

Click DCBS.

System response

The system displays the DCBS Syntax Token dialog box.

vtax Tokens

Click New.

System response

The system displays the Edit DCBS Syntax Token dialog box.

c
Lead-EByte on - %
Trail-Bytes

0001|0203 (04 08 [090a 0B 0c|n E
oo [N BN ] 1 1
nnnjnn A RN RR RN BR
200 AN |+ -
o012 3{A[5(a[7{8B]9[:]:]<[=]>]%
A@ | ABICIDIEIFIGIHITIJIEIL IMIN]OD
S0P (O RISITIUIY [WIX[Y[Z]] L1~
all " lalble elflalblili mlolo
0 p|q g z "
TR | 1 1
CIiEH | | | (B0 ] AN AN
e | . I3 lglalalalelalalw
BOl- |71 o2& 1R[] 7[H[I[F[3[A[E]Y
col Al F (g F] ARSI ETTIAm]Y
DOl E A [ HEEEIEDE o9
Ell 1 1 11 1 [N |
FOIR N/ R(R (N R(h (N /n(nn(nininfnin

Note

Double-byte characters are composed of a lead byte and atrail byte. In
the above example, the character A is code point 0041.

In the Token box, type the unique one-character al phanumeric value that
the system recognizes as containing the allowed range of charactersyou

designate.

Do you want to include al charactersin the Trail-Bytes section of the
dialog box?

If yes, continue with step 7.

If no, continue with step 6.
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6 » UsethelLead-Bytelist to view other charactersin the code page on
your system.
» Toexcludeindividual characters or groups of characters from the
token, select them (grey them out).
7 Click Close to save the syntax token and return to the Syntax Tokens
dialog box.
8 Click Close to exit the Syntax Tokens dialog box.
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How to Delete a Syntax Token

Introduction
range from a syntax token.

Designing your Map

You can delete a syntax token from the system. You can also delete a specific character

Use this procedure to delete a syntax token.

Action

From the Edit menu, select Syntax Tokens.

System response
The system displays the Syntax Tokens dialog box.

Syntax Tokens
Token  Allowed character ranges
A AFaz
M 09..-++
# A7 az03, e ([ AN
Mew...
Change... |
Delete |
4 I I _,I LEES.. |

Select the token that you want to delete and click Delete.

System response
The selected entry is deleted without warning.

Use this procedure to delete a character range from a syntax token.

Action

From the Edit menu, select Syntax Tokens.

System response
The system displays the Syntax Tokens dialog box.

Select a syntax token and click Change.

System response
The system displays the Edit Syntax Tokens dialog box.

Procedure:
deleting a syntax
token Sep
1
2
Procedure:
deleting a
character range Sep
1
2
3

Select the character range that you want to delete and click Delete.
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How to Use Syntax Tokens

Introduction You can use syntax tokens in the Format box of the Field (or Element or Cll Record)
Properties dialog box. This enables you to designate a “token” that defines ranges of
characters and/or numbers that are allowed to be used for a string-type field, element, or
TFD. The use of a syntax token enables you to define what characters should be used
while compliance checking thisfield, element, or TFD (i.e., alphanumeric within acertain
range, numeric within a certain range, etc.).

Procedure  Usethis procedure to use syntax tokens.

Sep Action

1 Double-click an existing field, element, or TFD, or create a new one.

Reference

See Using a Fixed-Format File on page 2 - 51, Using an EDI Fileon
page 2 - 68, or Using a Cll File on page 2 - 88 for more information
about creating fields, elements, or TFDs.

System response
The system displays the Element (or Field or ClI Record) Properties
dialog box.

2 Select the Validation tab.

System response
The system displays the validation options.
Element Froperties
Mame “alidation IEHtended Hulel Standard Hulel Eonditionsl

Check here if thiz field iz mandatoy: T

Flease zet the allowed lengths of this field :

b iriimvim : I1 b aimuimn : IBD

Fleasze chooze the data-type of this field : IString 'l
Please choose the format of the data in this field : I>< 'I

" Datais read/written as raw bytes L el I vl

) e (itHEenam byte ardenng

) Uise Bimreniar byte ardenhg

Cancel | Al Help

3 From the data-type list, select String.

Note
Thisindicates that the field, element, or TFD contains characters.
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4 From the dataformat list, select free format or a predefined syntax token
to denote that thisfield, element, or TFD must be formatted as the
specified syntax token dictates.

Notes

» Whenyouinstalled Sterling Gentran: Server, you assigned a default
format to the string fields. Thisformat serves as the basis for
character validation. Most U.S. users use a default format that
corresponds to ASCI| characters (for example, the X syntax token).
Most users of Asian or European languages and encoded character
sets should use the Free Format (0x01-0OxFF).

» FreeFormat indicatesthat any characters are acceptable in thefield.
The translator does not check the characters for compliance.

Reference
See Procedure: creating or editing a syntax token (\Western European
languages) on page 2 - 99 for more information.

5 Click OK to exit the Element (or Field or CIl Record) Properties dialog
box.
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How to Usethe Number Type

Introduction A number typefield, element, or TFD contains either an implied decimal or real number
that can be mathematically manipulated. If you specify that afield, element, or TFD isa
number type, you must designate the format by specifying aformat of either “N” (implied
decimal) or “R” (real) and the number of decimal places.

Real or numeric  An N-formatted number has an implied decimal point (for example, 2.01 formatted as N2
is201). An R-formatted number has an explicit decimal point and truncatestrailing zeros
(for example, 2.123 formatted asR2is 2.12 and 3.10 formatted as R2 is 3.1). Whether you
use the N or R format depends on the requirements of the document. Regardless of
whether you usethe N or R format, you must also indicate the number of decimal placesin
thefield.

Thislists the available real and numeric options.
» RO (thisfield/element/TFD has an explicit decimal point and no decimal places)
» Rl (thisfield/element/TFD has an explicit decimal point and up to one decimal place)

» R2(thisfield/element/TFD has an explicit decimal point and up to two decimal
places)

» R3(thisfield/element/TFD has an explicit decimal point and up to three decimal
places)

» R4 (thisfield/element/TFD has an explicit decimal point and up to four decimal
places)

» R5(thisfield/element/TFD has an explicit decimal point and up to five decimal
places)

» RG6 (thisfield/element/TFD hasan explicit decimal point and up to six decimal places)

» RY7 (thisfield/element/TFD has an explicit decimal point and up to seven decimal
places)

» R8(thisfield/element/TFD has an explicit decimal point and up to eight decimal
places)

» RO (thisfield/element/TFD has an explicit decimal point and up to nine decimal
places)

» NO (thisfield/edlement/TFD has an implied decimal point and no decimal places)
» N1 (thisfield/element/TFD hasan implied decimal point and up to one decimal place)

» N2 (thisfield/edlement/TFD has an implied decimal point and up to two decimal
places)

» N3 (thisfield/edlement/TFD has an implied decimal point and up to three decimal
places)

» N4 (thisfield/element/TFD has an implied decimal point and up to four decimal
places)

» N5 (thisfield/element/TFD has an implied decimal point and up to five decimal
places)

» N6 (thisfield/element/TFD has an implied decimal point and up to six decimal
places)
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» N7 (thisfield/element/TFD has an implied decimal point and up to seven decimal

places)

» N8 (thisfield/edlement/TFD has an implied decimal point and up to eight decimal
places)

» NI (thisfield/edlement/TFD has an implied decimal point and up to nine decimal
places)

Note

If you select an implicit decimal (“N” format) for afield and the datain that field has less
than the specified number of decimal places, the translator pads the datawith zeroesto the
left so that it still interprets the data within the specified format. For example, if you
specify aformat of “N3” for afield, and the datain that field is“1", the trandator
interprets the dataas “.001".

Procedure  Usethis procedure to use the number type.

Sep Action

1 Double-click an existing field, element, or TFD, or create a new one.

Reference

See Using a Fixed-Format File on page 2 - 51, Using an EDI File on
page 2 - 68, or Using a Cll File on page 2 - 88 for more information
about creating fields, elements, or TFDs.

System response
The system displays the Element (or Field or Cll Record) Properties
dialog box.

2 Select the Validation tab.

System response
The system displays the validation options.

3 From the data-type list, select Number.

Note
Thisindicates that the field, element, or TFD is anumeric or real
number that can be mathematically manipulated.

4 From the data format list, select the appropriate real or numeric option.
5 Click OK to exit the Element (or Field or Cll Record) Properties dialog
box.
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How to Usethe Date/Time Type

Introduction A Date/Timetypefield, element, or TFD contains a date or time. If you specify that a
field, element, or TFD is aDate/Time type, you must specify exactly how the date or time
must be formatted.

Note
Additional date and time formats can be created and added to the Map Editor.

Date/timeformats  Thistable liststhe valid date and time formats.

Format Description

YYMMDD Two-digit year, two-digit month, two-digit day

MMDDYY Two-digit month, two-digit day, last two digits of year (example:
121599)

YYYYMMDD Four-digit year, two-digit month, two-digit day (example:
19991215)

DDMMYYYY Two-digit day, two-digit month, four-digit year (example:
15121999)

MMDDYYYY Two-digit month, two-digit day, four-digit year (example:
12151999)

DDMMYY Two-digit day, two-digit month, last two digits of year (example:
151299)

YYMMMDD Last two digits of year, three-letter abbreviation of the month,

two-digit day (example: 99JANO02)

DDMMMYY Two-digit day, three-letter abbreviation of the month, last two
digits of year (example: 02JAN99)

MMMDDYY Three-letter abbreviation of the month, two-digit day, last two
digits of year (example: JAN0299)

YYYYMMMDD | Four-digit year, three-letter abbreviation of the month, two-digit
day (example: 2003JUL04)

DDMMMYYYY | Two-digit day, three-letter abbreviation of the month, four-digit
year (example: 04JUL2003)

MMMDDYYYY | Three-letter abbreviation of the month, two-digit day, four-digit
year (example: JUL042003)

YYDDD Last two digits of year, three-digit Julian day (example: 99349 for
the 349th day of 1999)
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Format Description

DDDYY Three-digit Julian day, last two digits of year (example: 34999)

YYYYDDD Four-digit year, three-digit Julian day (example: 1999349)

DDDYYYY Three-digit Julian day, four-digit year (example: 3491999)

YY/MM/DD Last two digits of year, separator, two-digit month, separator, two-
digit day (example: 99/12/05)

DD/MM/YY Two-digit day, separator, two-digit month, separator, last two
digits of year (example: 05/12/99)

MM/DD/YY Two-digit month, separator, two-digit day, separator, last two
digits of year (example: 12/15/99)

YYYY/MM/DD Four-digit year, separator, two-digit month, separator, two-digit
day (example: 1999/12/15)

DD/MM/YYYY Two-digit day, separator, two-digit month, separator, four-digit
year (example: 15/12/1999)

MM/DD/YYYY Two-digit month, separator, two-digit day, separator, four-digit
year (example: 12/15/1999)

YY/MMM/DD Two-digit year, separator, three-letter abbreviation of the month,
separator, two-digit day (example: 99/JUL/20)

DD/MMM/YY Two-digit day, separator, three-letter abbreviation of the month,
separator, two-digit year (example: 20/JUL/99)

MMM/DD/YY Three-letter abbreviation of the month, separator, two-digit day,
separator, two-digit year (example: JUL/20/99)

YYYY/MMM/DD | Four-digit year, separator, three-letter abbreviation of the month,
separator, two-digit day (example: 2003/JUL/25)

DD/MMM/YYYY | Two-digit day, separator, three-letter abbreviation of the month,
separator, four-digit year (example: 25/JUL/2003)

MMM/DD/YYYY | Three-letter abbreviation of the month, separator, two-digit day,
separator, four-digit year (example: JUL/25/2003)

YY/DDD Last two digits of year, separator, three-digit Julian day (example:
99/349)

DDD/YY Three-digit Julian day, separator, last two digits of year (example:
349/99)

YYYY/DDD Four-digit year, separator, three-digit Julian day (example: 1999/

349)
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Format Description

DDD/YYYY Three-digit Julian day, separator, four-digit year (example: 349/
1999)

MONTH Month (example: December)

DAY Day of the week (example: Friday)

HHMM Two-digit hour, two-digit minutes (example: 0330 for 30 minutes
past 3 o'clock)

HHMMSS Two-digit hour, two-digit minutes, two-digit seconds (example:
033045 for 30 minutes and 45 seconds past 3 0’ clock)

HH:MM Two-digit hour, separator, two-digit minutes (example: 03:30)

HH:MM:SS Two-digit hour, separator, two-digit minutes, separator, two-digit
seconds (example: 03:30:45)

SO-8601 YYYYMMDDTHHMMSS.mmmZ format: Four-digit year, two-
digit month, two-digit day, T (time) indicator, two-digit hour,
two-digit minutes, two-digit secondsin Universal Time (also
called Zulu Time or Greenwich Mean Time), Z (Zulu time)
indicator (example: 20031209T123000.000Z)

YYYYMMDDZ I SO-8601 date format: Four-digit year, two-digit month, two-digit
day, Z (Zulu time) indicator (example: 200312092)

MM/DD/YY Two-digit month, separator, two-digit day, separator, last two

HH:MM:SS digits of year, two-digit hour, separator, two-digit minutes,
separator, two-digit seconds (example: 12/15/99 03:30:45)

YYMMDD Last two digits of year, two-digit month, two-digit day, two-digit

HHMMSS hour, two-digit minutes, two-digit seconds (example: 991025
033045)

YYYY-MM- Four-digit year, separator, two-digit month, separator, two-digit

DDTHH:MM:SS | day, T represents ablank separator, two-digit hour, separator, two-
digit minutes, separator, two-digit seconds (example: 2002-02-02
03:30:45)

YYYY-MM-DD Four-digit year, separator, two-digit month, separator, two-digit
day (example: 2002-02-02)

YYYY-MM Four-digit year, separator, two-digit month (example: 2002-02)

YYYY Four-digit year (example: 2002)

--MM-DD Two dashes, two-digit month, separator, two-digit day (example: -
-12-02)

---DD Three dashes, two-digit day (example: ---02)

Application Integration User Guide
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Procedure  Usethis procedure to use the Date/Time type.

Sep Action

1 Double-click an existing field, element, or TFD, or create a new one.

Reference

See Using a Fixed-Format File on page 2 - 51, Using an EDI File on
page 2 - 68, or Using a Cll File on page 2 - 88 for more information
about creating fields, elements, or TFDs.

System response
The system displays the Element (or Field or Cll Record) Properties
dialog box.

2 Select the Validation tab.

System response
The system displays the validation options.

3 From the data-type list, select Date/Time.

Note
Thisindicates that the field, element, or TFD is adate or time.

4 From the data format list, select the appropriate date or time option.
5 Click OK to exit the Element (or Field or Cll Record) Properties dialog
box.
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How to Create Simple Links

How to Create Simple Links

Introduction The Link function enables you to map afield, element, or TFD from the Input side of the
map to afield, element, or TFD on the Output side of the map. The link between two map
components (hereafter referred to asfields) isvisually represented with aline connecting

the two fields.

If you need to link two input fields to the same output field because of conditions
established in your map, you must use an extended rule.

Note

You must have at least one direct link (using the Link function) to every record or segment
on the Output side of the map, so the tranglator can create the record/segment.

Procedure  Usethis procedureto link two fields.

Step

Action

1

From the Functions menu, select Link.

Select afield on the Input side of the map (or TFD if the Input sideis
Cll).

System response
The cursor changesto a“Link Arrow”: | e

Select the field on the Output side of the map (or TFD if the Output side
is Cll) that the data from the field selected on the Input side of the map
is mapped to.

System response
A line connects the two fields to visually represent the link.

Note
If aline does not appear when the two fields are linked, check the
Preferences dialog box.

Reference

See How to Customize Global Display of Links on page 2 - 13 for more
information. On the Linkstab of the Preferences dialog box, you should
specify “ Show all links possible.”

Application Integration User Guide
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How to Map Binary Segments

Introduction Certain EDI standards use binary segments and Sterling Gentran: Server enables you to
create and configure map components to process binary data.

When you load a EDI standard that contains binary segments from the Standards CD
supplied with Sterling Gentran:Server, your system automatically creates the required
elements. However, if you need to manually create binary segments, use the proceduresin
thistopic.

Example

When you load the ANSI X 12 275 transaction set into the Output side of a map, you will
notice that it contains a binary data segment with two elements—one for the length of the
binary data and one for binary data. The default data type for the length element is
“Number” and the maximum length is set to “15.” The default datatype for the binary data
element is“String” and the default length is“760.”

Required segments  To handle binary data received for an inbound EDI segment, you must create or configure
and elements regular segments and elements on the Input side of your map.

To generate an EDI segment containing binary data, you must create a binary data
segment on the Output side of your map. Then, you must create two elementsin the binary
segment for these data types:

» Bin_Len, whichisfor the length (in characters) of the binary segment
» Bin_Data, whichisfor the binary data

This table summarizes the input and output elements of your map for binary data

Input Data Type Link Status Output Data Type
Number Not Linked Bin Len
String Linked Bin Data

Settingup the  Use this procedure to create the components on the Input side of the map.

Input side
Sep Action
1 On the Input side of the map, create or select a segment for the data.
2 Right-click the component and select Properties from the shortcut
menu.

System Response
The system displays the Properties dialog box for the component.
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(Contd)
Sep Action
3 Set the component properties using the dialog box tabs.
Note
You must compl ete the Name tab and L ooping tab.
4 Add anew element or field to the component you just created.
5 Right-click the element or field and select Properties from the shortcut
menu.
System Response
The system displays the Properties dialog box for the component.
6 Set the component properties using the dialog box tabs.
Note
On the Validation tab, you must specify Number as the data type.
7 Add a second new element or field to the segment or record.
8 Right-click the component and select Properties from the shortcut
menu.
9 Set the component properties using the dialog box tabs.
Note
On the Validation tab, you must specify Sring as the data type.

Settingup the  Use this procedure to create the components on the Output side of the map.

Output side
Sep Action
1 On the Output side of the map, create or select a segment or record for
the binary data.
2 Right-click the component and select Properties from the shortcut
menu.

System Response
The system displays the Properties dialog box for the component.

3 Set the component properties using the dialog box tabs.

Note
On the Special tab, click the Binary check box.

4 Add anew element or field to the binary component or select the
existing element or field.
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Sep

Action

Right-click the component and select Properties from the shortcut
menu.

System Response
The system displays the Properties dialog box.

Set the component properties using the dialog box tabs.

Note
On the Validation tab, you must specify Bin_L en as the data type.

Add a second new element or field to the segment or select the existing
element or field.

Right-click the component and select Properties from the shortcut
menu.

Set the component properties using the dialog box tabs.

Note
On the Validation tab, you must specify Bin_data as the data type.

10

Link the components on the input side of the map to the components on
the output side of the map.

Important

You must link the string field on the input side of the map (the field
created to contain the file name of the binary datafile) to the bin_data
field on the output side of the map.

11

Complete the map and compile it to create the tranglation object.
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How to Set the Auto-register Option

Introduction The auto-register option allows you to automatically register atranslation object when you
compileit.

Procedure  Usethis procedure to set the auto-register option.

Sep Action

1 From the Options menu, select Preferences.

System response
The system displays the Preferences dialog box.

2 Select the Files tab.

System response
The system displays the Files preferences.

x

Tree I Links I Standard Formatsl Positional Defaults  Files IEonfirmationsI \.-"ersionl

Thesze settings allow vou to zpecify the default locations for mapsz.

¥ Back up mapsz to BAK files befare saving:

I &utomatically register bemplates after compilation.

When browsing for maps, start in this folder :

IE:\GENSHVNT\MapS Brawse... |

“When compiling a map, save to this folder :

IC:\GENSHVNT\TranSDbi Browse. . |

ak, I Cancel I Help I

3 Select the Automatically register template after compilation box.
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(Contd)
Sep Action

4 Enter (or Browser and select) the path name for the location of the maps.
Warning
If you are on aclient in adistributed environment, the path name for the
map location must be a network path on the primary server. If not, you
will receive an error when you compile.

5 Click OK to exit the dialog box.
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How to CompileaMap

Introduction The Compile function compiles the map and creates atranslation object. The map that you
create using Sterling Gentran: Server is a source map. When that source map is compiled,
the result is a compiled translation object.

This translation object needs to be registered with the Sterling Gentran:Server system
before you can useit. You use the Compile function after the map is completed and saved.

Procedure  Usethis procedure to compile a map and generate a translation object.

Sep Action

1 From the File menu, select Compile.

System response
The system displays the Run-Time Translation Object Name dialog box.

Run-Time Translation Object Mame

Save it IaTlansDbi j gl IE

File name: IPET_EDFID.TF‘L

Save as hupe: ITransIation Objects [+ TPL) j Cancel |
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(Contd)
Sep

Action

2

In the File name box, type the name of the transl ation object.

Note
The name of the translation object is 1-8 characters. Use the default
.TPL file extension.

Recommendation

Name the tranglation object (.TPL file) the same file name (one to eight
characterslong) as you named the map ((MAPfile). Preserving the same
file name (with different file extensions) means that the relationship
between the source map and the compiled translation object remains
evident.

Example
If the source map nameis MWT_850.M AP, the compiled translation
object nameis MWT_850.TPL.

Warning

Be very careful not to overlay the source map with the compiled
tranglation object. Usethe .TPL file extension to distinguish the
tranglation object.

From the Savein list, change the drive\folder where the compiled
tranglation object is stored, if necessary.

Warning

Do not store the compiled tranglation object in the
GENSRVNT\RegTransObj folder. Thisfolder is reserved for storing a
copy of each trandation object you register with Sterling
Gentran:Server.

Click Save.

System response
The system compiles the map and generate a translation object. The
system displays the Compile Error dialog box.

Verify that no errors occurred and click OK to exit the dialog box.

Note

The date that the translation object was compiled on is automatically
loaded into the “Compiled on” box on the Trandation Object Details
dialog box.

From the File menu, select Save to save the source map with the
Compiled on date.

System response

If you are using the auto-register option, the map will automatically be
registered after it compiles and a confirmation dialog box will display. If
you are not using the auto-register option, continue with Step 7.
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(Contd)
Sep Action
7 The translation object needs to be registered with the Sterling

Gentran: Server system before you can useit.

Reference

See How to Register a New Trandation Object in the IBM® Serling
Gentran: Server® for Microsoft Windows User Guide for more
information.

Application Integration User Guide Sterling Gentran: Server — May 2011



How to Compile Maps Using the Command Line Designing your Map

How to Compile Maps Using the Command Line

Introduction  The Sterling Gentran: Server Application Integration subsystem (MAPPER.EXE) enables
you to automatically compile a single map (or maps located in a specified directory) from
the command line.

Note
The compiled translation objects are written to same directory as the map source files.

Syntax  The command line syntax (from the GENSRVNT\Bin subdirectory) is as follows:

mapper . exe -c [mapSourceFil e]

Note

The [mapSourceFil€] is either a single map or amap file name that contains a wildcard
character (*). Using the wildcard character causes MAPPER.EXE to compile al mapsin
the designated directory with that file name pattern. MAPPER.EXE does not recurse
through subdirectories.

Examplel  nmapper.exe -c¢ c:\GENSRVNT\tutorial\*. map

Note
In this example, all mapsin the tutorial directory are compiled.

Example 2 mapper.exe -c¢ c:\GENSRVNT\tutori al \ pet*. map

Note
In this example, all maps with names beginning with “pet” in the tutorial directory are
compiled.
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How to Print a Mapping Report

Introduction The Print function enables you to print a mapping report for the current map.
Note

You can print amapping report to afile by selecting Print to File from the File menu.
Change the defaults on the Print Options dialog box and click OK to display the Print to
File dialog box. Type the name of the file to which you want the report printed and click
OK.

Use this procedure to print a mapping report.

Sep Action

1 From the File menu, select Print.

System response
The system displays the Print Options dialog box.

Print Options

Repart sections

W Frint branching diagram :
¥ Print record details ﬂl
W Frint mapping detailz
V¥ Print extended rules

¥ Print code lists

¥ Include arly active objects

2 » Select the reports that you want by clicking the appropriate check
boxes in the Report section, and
» clickOK

System response
The system displays the Print dialog box.

3 Set the appropriate options and click OK if you do not need to change
Setup options.

System response
The system prints the mapping report.
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Using Standard Rules Introduction

| ntroduction

What isastandard  The Sterling Gentran: Server Application Integration subsystem provides you with
rule?  standard rulesthat you can apply to fields and elements. Standard rules give you access to
functions that are necessary for mapping operations that are more complex than ssimple
linking, but less involved than extended rules.

Each of the standard rules are mutually exclusive (you can use only one on a particular
field, element, or TFD).

Note
When an element contains a standard rule a black asterisk appears to the right of the
element icon.

Related topic ~ Extended rules enable you to use a Sterling Gentran: Server proprietary programming
language to perform virtually any mapping operation you require.

References
See How to Create Smple Links on page 2 - 113 and Introducing Extended Rules on
page 6 - 4 for more information.
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Using the Sdect Standard Rule

Overview

Introduction

Sandard Ruletab
(Select)

The Select function enables you to select entries from alocation table, cross-reference
table, partner table, or lookup table (al tables created in the Sterling Gentran: Server
Partner Editor). You can then map the fields in those tables to one or more fieldsin the
data. The Select function uses the value of the current field, element, or TFD to perform
the selection.

The Select function allows you to use information from the Sterling Gentran: Server
Partner Editor in your maps. You can map information from your partner’s profile or
Internal System Partner in the Partner Editor to a selected element or field in the map. The
definition information and location tables that you define for the internal system partner
can be used for al partners. The information that you can use includes:

» Partner or Internal System Partner Definition (Name, EDI Code, Application Code)
» Partner or Internal System Partner Location Table Fields

» Lookup Table Fields

» Cross-Reference Table Fields

» Interchange, Group, or Document Record

This diagram illustrates the Standard Rule tab with the Select function selected.

Mame I Validationl Positionl Estended Fule  Standard Rule I Conditionsl

Please select the standard rule to use : ISeIect j

Fleaze chooze the table and key [or group] to uze when selecting data :

| =

Elease erten the name of the suttable touse (i apprapniate] |

[~ Raize a compliance ermor if matching data iz not found

‘r'ou can map the data that was selected. Click on data in the left list then click the
fields in the right list that you would like it ko be mapped to. Repeat to map mare data.

Cancel A Help
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Parts and This table describes the parts of the Select standard rule and their functions.
functions

Part Function

table and key (or Specifies the table and key the system uses to select data. Thistable
group) liststhe valid values.

name of sub-table Contains the sub-table name if appropriate.

Note

The sub table box is only active if you select Partner Lookup, Partner
cross-reference by my item, Partner xref by partner item, Division
lookup, Division cross-reference by my item, or Division cross-
reference by partner item from the table and key list.

Part Function

Partner by EDI code | Indicatesthat the key isthe partner's EDI Code
and enables you to map from one of three
fieldsfor this partner (Name, EDI Code,
Alternate Code) from the partner table.

Partner by aternate | Indicates that the key isthe partner's

code Application Code and enablesyou to map from
one of threefields for this partner (Name, EDI
Code, Alternate Code) from the partner table.

Partner by partner Indicates that the key isthe partner's Profile ID
key enablesyou to map from one of threefieldsfor
thispartner (Name, EDI Code, Alternate Code)
from the partner table.

Partner location by Indicates that the name on the L ocations dialog
name box (for the current partner) of the Partner
Editor is the key and enables you to map from
any field in that table.

Partner lookup Indicates that the key is the partner lookup
table name for this partner and enables you to
map from any field in that table.

Partner cross- Indicates that the key isthe your item (value)

reference by my on the partner cross-reference table for this

item partner and enables you to map from any field
in that table.
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(Contd)
Part

Function

name of sub-table
(contd)

Partner cross-
reference by partner
item

Indicates that the key is the your partner'sitem
(value) on the partner cross-reference table for
this partner and enables you to map from any
field in that table.

Division

Enables you to map from one of threefields
(Name, EDI Code, Alternate Code) for the
<Internal System User> (system partner) in
that table.

Division location by
name

Indicates that the key is the name on the
Locations dialog box of the Partner Editor for
the <Internal System User> and enables you to
map from any field in that table.

Division lookup

Indicates that the key is the partner lookup
table name for the <Internal System User>
partner and enables you to map from any field
in that table.

Division cross-
reference by my
item

Indicates that the key isthe your item (value)
on the partner cross-reference table for the
<Internal System User> partner and enables
you to map from any field in that table.

Division cross-
reference by partner
item

Indicates that the key isthe your partner'sitem
(value) on the partner cross-reference table for
the <Internal System User> partner and

enables you to map from any field in that table.

Document record

Enables you to map from any of thefields
within the current document record.

Note

This sub-table can only be accessed from the
following map types; Transaction Break/Build,
Import, Export, Print, Screen, Group Build,
and Interchange Build.

The information that is accessed will be the
information of the last document that was
processed at the table level accessed by the
rules. This must be taken into consideration
when using rules that access these tables.

See Table access examples on page 3 - 8 for
examples.
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(Contd)
Part Function
name of sub-table Generic envelope Enables you to map from any of thefields
(contd) segment within the current envelope information,

regardless of the EDI standard used.

Note

Thisfunction is normally not used unless you
are familiar with the generic envelope table
structure for a given standard.

Interchange Enables you to map from any of thefields
within the current interchange record.

Note

This sub-table can only be accessed from the
following map types:. Interchange Break or
Build, Group Break, Transaction Break, and
Export.

The information that is accessed will be the
information of the last interchange that was
processed at the table level accessed by the
rules. This must be taken into consideration
when using rules that access these tables.

See Table access examples on page 3 - 8 for
examples.

Group Enables you to map from any of thefields
within the current group record.

Note

Can only be accessed from the following map
types. Group Break or Build, Transaction
Break, Export, and Interchange Build.

The information that is accessed will be the
information of the last group that was
processed at the table level accessed by the
rules. This must be taken into consideration
when using rules that access these tables.

See Table access examples on page 3 - 8 for
examples.

Raise compliance Specifies whether you want the system to generate an error if the
error Select does not find avalid table entry.

Note
The default is cleared (do not generate an error if the Select is not
successful).
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(Contd)
Part Function

Map from Specifies the element/field/TFD from the specified table entry from
which you want to map the contents.
Note
Entries are displayed in the map from list only after you select atable
and key.

Map to Specifies the element/field/TFD to which you want to map the

contents of the map from box.

Notes

» The system displays each element/field/TFD from the side of the
map with which you are currently working (input or output) in
thislist.

» A total of eight fields can be mapped using one Select rule.

» Entriesaredisplayed inthe maptolist only after you select atable
and key, and these entries are activated only after you highlight an
entry in the map from box.

Tableaccess Examplel
examples  When accessing the Document table from the Interchange build map, the information
retrieved will be from the last document processed through the Transaction Build map. If
an import map updates a unique value to appfield6 for each document and the interchange
build map tries to retrieve thisinformation, and if all documents are sent in the same
interchange, the only information retrieved in the Interchange Build map will be the
information from appfield6 for the last document sent.

To retrieve the value in appfield6 for each document, the documents must be sent in their
own interchange. Thisis set in the outbound partner relationship in the Interchange
Definition under advanced settings (Set M ax number of documents per interchange
must be set to 1).

Example 2

When accessing the Group table from an Export map, the information retrieved will be
from the last group processed through the Group Break map. If an inbound interchange
file contained two groups: the first group contains 850 information and the second group
contains 810 information, the rule in the 850 Export map will retrieve 810 information
because the last group processed through the Group Break map was the 810 group.
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How to Use Information from the Partner Definition

I ntroduction

Procedure

The Sterling Gentran: Server Application Integration subsystem allows you to use selected
information from the Sterling Gentran:Server Partner Editor in your maps via a Select
standard rule. You can map information from your trading partner's profile in the Partner
Editor to aselected element, field, or TFD in the map. The information that you can usein
the map includes any field in atable (location, lookup, or cross-reference) or datafrom the
partner table.

For this example, you need to pull information from the partner definition in order to
populate the Customer Number field (CUSTNUMHDR) on the application side of the
map. Your partner’s customer number identifies which trading partner sent the purchase
order. This customer number is already part of the partner definition for this partner, so
you can map it from the partner definition to the customer number field.

Use this procedure to use the Select function to map the customer number from the partner
definition.

Sep Action
1 Double-click an existing element or field, or create anew element or
field.
Reference

See Using a Fixed-Format File on page 2 - 51 and Using an EDI Fileon
page 2 - 68 for more information on creating fields and elements.

System response
The system displaysthe Field (or Element or Cll TFD) Properties dialog

box.
2 Select the Standar d Rule tab to access standard rule options.
3 From the standard rule list, choose “ Select.”
4 From the table and key list, select “ Document record.”

Note

Thisindicates that the system updates this field with selected
information from the document record.

5 Select the compliance error check box to indicate that a compliance
error should be generated if the select does not find avalid entry.

6 From the map from list, choose “ Partner Key.”

Note
Thisisthefield that contains the customer number for this partner.
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(Contd)
Sep Action

7 From the map to list, choose “CUSTNUMHDR.”
Note

Thisisthefield to which the information from the partner key of the
document record is mapped.

System response
This diagram illustrates how the Standard Rules tab should look.

Field Properties

Name I Validationl Positionl Extended Fule  Standard Rule IConditionsl

Please select the standard rule to use : ISeIect ﬂ

Fleaze choose the table and key [or group] to uze when selecting data :
I Dacument record j
Elease erten the mame of the sut-table to uee (i apprapniate] |

V¥ Raise a compliance emor if matching data is not found

‘r'ou can map the data that was zelected. Click on data in the left list then click the
fieldz in the right list that pou would like it to be mapped to. Repeat to map more data.
CUSTNUMHDE Customer Mumber |98
PODATEHDR Purchase Order D ate
FOMUMHDR Purchase Order Mumb
FOTYPCODE Puchase Order Type F
SHIPTOMAME Ship To Mame
SHIPTOADD Ship ToAddress Line
SHIPTDADDZ Ship Todddress Line
Control Mumber bl SHIPTOCITY Ship Ta City bl

Cancel | Al | Help |

8 Click OK to add the standard rule.
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How to Use Information from a Cross-reference Table

I ntroduction

Procedure

For this example, you need to map information from a cross-reference table to translate
your partner’s code for a purchased item into your code for the item. Your partner uses a
customer product code (CUSTPROCODE) for each item that is meaningful to him.
However, your company uses a UPC code (UPCCODE) for each item. After you and your
partner determine what the equivalent customer product code is for each UPC code, you
can create a cross-reference table in Partner Editor and use that information in your map.

A cross-reference table is used when you and your partner each reference an item by a
different name (or number). For example, if your unique name for a“widget” is“wid” and
your partner’s unique name for the same “widget” is“1234.” The system uses the cross-
reference table to trand ate the two names for the “widget” item.

In this example, you have one code (UPC code) for each item ordered. Your partner refers
to the same item by a different code (customer product code). You need to map the
customer product code from the Product/Service ID element to the customer product code
field (CUSTPROCODE) on the application side of the map. Also, you must create a cross-
reference table to trand ate the customer product code to your UPC code.

Tip

Before you create the cross-reference table, you and your partner must determine what the
equivalent customer product codeis for each UPC code. Then you can create the cross-
reference table in Partner Editor and use that information in your map.

Finally, you need to use a standard rule to map the translated value from the
CUSTPROCODE field to the UPCCODE field.

Use this procedure to translate your partner’s customer product code to your UPC Code
for each item your partner ordered.

Sep Action

1 Map the customer product code from the Product/Service ID element to
your CUSTPROCODE field.

Reference
See How to Create Smple Links on page 2 - 113 for more information.
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(Contd)
Sep

Action

2

In the Partner Editor, create a cross-reference table named
“PRODCODE.”

Reference

See How to Create a Table in the IBM® Serling Gentran: Server® for
Microsoft Windows User Guide for more information on creating a
cross-reference table.

Notes

» Thecrossreference table you create only contains six entries. This
isan example —an actual table would contain all of the items
manufactured by your company that your partner purchases.

» Inthecrossreferencetable, the“My Value’ box contains your UPC
code for theitem. The “Partner Value” box contains your partner’s
customer product code for the item. The “ Description” box contains
adescription (and size, if applicable) of the item, and the Reference
Data box contains additional quantity or color information.

Double-click the CUSTPROCODE field.

System response
The system displays the Field Properties dialog box.

Select the Sandard Rule tab to access standard rule options.

From the standard rule list, choose “ Select.”

From the table and key, select “ Partner cross-reference by partner item.”

Note
Thisindicates that you are using a cross-reference table and trandlating
by your partner’sitem.

In the sub table box, type “PRODCODE.”

Note
Thisisthe name of the cross-reference table you created.

Select the compliance error check box to signal the system that if this
trangdation fails, you want the system to generate an error.

From the map from list, choose “My Item.”

Note
Thisisthe field from which the contents is mapped.
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(Contd)
Sep

Action

10

From the map to list, choose “UPCCODE.”

Note
Thisisthefield to which the information from the lookup tableis

mapped.

System response
This diagram illustrates how the Standard Rule tab should look.

Field Properties

M ame I Validationl F'ositionl Extended Rule  Standard Rule | Eonditionsl

Please select the standard rule to use : ISeIect j

Please chooze the table and key [or group] to uze when selecting data :

IF'artner crosseference by partner item j
Pleaze enter the name of the sub-table ta uze [if appropriate] :

IPHDDEDDE

V¥ Raise a compliance emor if matching data iz not found

*f'ou can map the data that waz selected. Click on data in the left list then click the
fields in the right lizt that wou would like it to be mapped to. Repeat to map more data.

CUSTHUMDET Customer Nurnber

Partrier Item PODATEDET Purchase Order Date
Description POMUMDET Purchase Order Mumber
Teut1 CUSTPROCODE Customer Product Coc
Teut 2 |JPCCODE LJPC Code

Text 3 U0M Unit of Measure

Text 4 UMITPR Unit Price

ATYORD Quantity Ordered

Cancel Annly Help

Application Integration User Guide
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How to Use Information from L ocation Tables

Introduction Each Partner Profile and the Internal System Partner Profile can have many associated
location tables. The location table can be used to contain address-related information
about the partner. You can store your partner’s store addresses, warehouse addresses, or
“invoice to” addresses.

To use information from alocation table, you must have created that table already in the
Partner Editor. See How to Create a Table in the IBM® Serling Gentran: Server® for
Microsoft Windows User Guide for more information on creating a partner location table.

Procedure  Usethis procedure to map information from alocation table.

Sep

Action

Double-click an existing element or field, or create anew element or
field.

Reference
See Using a Fixed-Format File on page 2 - 51 and Using an EDI Fileon
page 2 - 68 for more information on creating fields and elements.

System response
The system displaysthe Field (or Element or Cll TFD) Properties dialog
box.

Select the Standar d Rule tab to access standard rule options.

From the standard rule list, choose “ Select.”

From the table list, select the key that is used to look up the Partner
Location entry.

Note
You are allowed to map from any field on the Locations dialog box.
Valid selections are;

» Partner location by name
» Division location by name

If you want the system to generate an error if the lookup fails, select the
compliance error check box.

From the map from list, select the field from which the contents are
mapped.

Note

You can select from the following fields. Name, Address 1, Address 2,
Address 3, City, State, Zip, Country, Telephone Number, Fax Number,
Contact Name, Primary Reference, Secondary Reference.
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(Contd)
Sep Action
7 From the map to list, select the element, field, or TFD to which the
information from the Partner Editor is mapped.
8 Click OK to add the standard rule.
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How to Use Information from L ookup Tables

Introduction A lookup tableis used to select information related to avalue in inbound or outbound data.
Each partner profile and the internal system partner profile can have many lookup tables
associated with it.

To use information from alookup table, you must have created that table already in the
Partner Editor. See How to Create a Table in the IBM® Serling Gentran: Server® for
Microsoft Windows User Guide for more information on creating Partner lookup tables.

Procedure  Usethis procedure to map information from a L ookup Table.

Step

Action

1

Double-click an existing element or field, or create a new element or
field.

Reference
See Using a Fixed-Format File on page 2 - 51 and Using an EDI File on
page 2 - 68 for more information on creating fields and elements.

System response
The system displaysthe Field (or Element or CIl TFD) Properties dialog
box.

Select the Sandard Rule tab to access standard rule options.

From the standard rule list, choose “ Select.”

From the table list, select the key from which the system looks up the
trading partner.

Note
Valid selections are:

» Partner lookup
» Division lookup

In the sub table box, type the name of the lookup table.

If you want the system to generate an error if the lookup fails, select the
compliance error check box.

From the map from list, select the field (Item, Description, Text 1, Text
2, Text 3, Text 4) from which the contents are mapped.

From the map to list, select the element, field, or TFD to which the
information from the Partner Editor is mapped.

Click OK to add the standard rule.
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Using the Update Standard Rule

Overview

Introduction

Standard Ruletab
(Update)

The Update function enables you to update a specific field in adocument record, envelope
segment, interchange, group, current partner, or document (if the map side format typeis
EDI), with the contents of the element, field, or TFD.

Warning

Thisfunction updatestheinternal Sterling Gentran: Server database tables. We recommend
that you use thisfunction only if you want to update the internal database tables. Typically,
you use this function only if you want to update the document name and reference in the
document table.

This diagram illustrates the Standard Rule tab with the Update function selected.

Field Properties
Mame I ‘v"alidationl Positionl Estended Fule ~ Standard Rule | Conditionsl
Fleaze zelect the standard rule to uze : IUpdate ﬂ
Fleaze select the table [or group] to update
| =]
Pleaze select the colurmn [or field] to update :
Cancel Help
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Parts and This table describes the parts of the Update standard rule and their functions.

functions

Part

Function

table

Containsthetable that the system updates with the contents of the
current field/element/TFD. Valid values are:

See Table access examples on page 3 - 8 for examples.

Document record (use to update the document name and
reference.

Note

This stable can only be accessed from the following map
types; Transaction Break/Build, Import, Export, Print,
Screen, Group Build, and Interchange Build.

The information that is accessed will be the information of
the last document that was processed at the table level
accessed by the rules. This must be taken into consideration
when using rules that access these tables.

Generic envel ope segment (advanced use only)
Interchange

Note

This sub-table can only be accessed from the following map
types: Interchange Break or Build, Group Break, Transaction
Break, and Export.

The information that is accessed will be the information of
the last interchange that was processed at the table level
accessed by the rules. This must be taken into consideration
when using rules that access these tables.

Group

Note
Can only be accessed from the following map types: Group
Break or Build, Transaction Break, Export, and Interchange
Build.

The information that is accessed will be the information of
the last group that was processed at the table level accessed
by the rules. This must be taken into consideration when
using rules that access these tables.

Partner (advanced use only)

Document (advanced use only - if the format type of thisside
of the map isEDI)

column

Contains the database field from the column (or field) list that the
system updates with the contents of the current field/element.

Note
Thefieldsthat are available in this list depend on the table
selected.
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How to Set Up the Document Name and Reference

Introduction The Document Name and Reference are two recommended fields that you can specify in
the Application Integration subsystem. For an Invoice thisfield is typicaly the Invoice
Number, and for a Purchase Order thisfield istypically the Purchase Order Number. If
you specify either the Document Name or Reference, the corresponding field in Sterling
Gentran: Server document browsers (In Documents, ?In Documents, Out Documents, ?0ut
Documents, Workspace, In Drawer, Out Drawer, Send Queue, Interchanges) is populated.
The Document Name and Reference makes the identification of adocument created by the
map easier in Sterling Gentran: Server.

Setting up the Document Name is strongly recommended if you want to be able to
differentiate between documents in the document browsersin Sterling Gentran:Server. If
you set up the Document Name in the Application Integration subsystem, the Name box of
the document browsers that contain this document in Sterling Gentran: Server contains the
data from that mapped field. If you set up the Reference in the Application Integration
subsystem, the RefData box of the document browsers that contain this document in
Sterling Gentran: Server contains the data from that mapped field.

You can select any element as the Document Name, but we strongly recommend that you
choose an element that only occurs once in the map. The element that you select should
have a datatype of “string” (datatype is specified on the Element Properties dialog box).
If you need to use an element with a data type of Date/Time or Number for the Document
Name or Reference, you can either:

» Changethe datatypeto “String” on the Element Properties dialog box.
» Set up an extended rule to update the document record.
Warning

If you change a Date/Time or Number element’s data type to “ String,” you lose the data
type compliance checking for the original type.

Procedure: setting  Use this procedure to set up the Document Name.
up the document
name

Sep Action

1 Select a non-recurring element from the header or trailer segment of the
EDI side of the document.

Note

The element that you select varies for each type of document. The
selected element should be something that identifies this document
meaningfully in Sterling Gentran: Server.

Example
» ForanlInvoicethisistypicaly the Invoice Number.

» For aPurchase Order thisistypically the Purchase Order Number.
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(Contd)
Sep Action

2 Right-click the appropriate element and select Properties from the
shortcut menu.
System response
The system displays the Element Properties dialog box (Name tab).

3 Select the Sandard Rule tab to access the standard rule options.

4 From the standard rule list, select “ Update.”

5 From the table to update list, select “Document record.”

6 From the column to update list, select “Document Name.”

7 Click OK to set up the Document Name.

Procedure: setting  Usethis procedure to set up the Reference.
up thereference

Sep Action
1 Select an element from the first segment of the EDI side of the
document.
Note

The element that you select varies for each type of document. The
selected element should be something that identifies this document
meaningfully in Sterling Gentran:Server

Example
» Foranlnvoicethisistypically the Purchase Order Number.
» For aPurchase Order thisistypically the Purchase Order Date.

However, to use Purchase Order Date, you must use an extended
rule on that element, instead of following the steps bel ow.

2 Right-click the appropriate element and select Properties from the
shortcut menu.

System response
The system displays the Element Properties dialog box (Name tab).

3 Select the Standard Rule tab to access the standard rule options.
4 From the standard rule list, select “Update.”

5 From the table to update list, select “ Document record.”

6 From the column to update list, select “ Reference Data.”

7 Click OK to set up the Reference.
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Using the System Variable Standard Rule

Overview

Introduction  The Use System Variable function enables you to set a variable that maps the current date
and time to the selected element, field, or TFD. The selected map component must have a
datatype of “Date/Time.”

Sandard Ruletab  Thisdiagram illustrates the Standard Rule tab with the System Variable function selected.
(System Variable)

Field Properties
Mame I Validationl F'ositionl Extended Fule  Standard Rule | Eonditionsl
Fleaze select the standard rule to use : IUse System Variable j
Flease select a spstem variable to store in this field
| |
Cancel Sl Help

Sandard ruletab  Thistable describes the parts of the System Variable standard rule and their functions.

(System Variable)
partsand Part Function

functions

System variable Allows you to map “Current date and time” variablesto
the element, field, or TFD.
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How to Usethe System Dateand Time

Procedure  Usethis procedure to use the system date and time.

Sep Action

1 Double-click an existing element, field, or TFD, or create a new one.

Reference

See Using a Fixed-Format File on page 2 - 51, Using an EDI File on
page 2 - 68, and Using a Cl| File on page 2 - 88 for more information on
creating fields, elements, and TFDs.

System response
The system displaysthe Field (or Element or Cll TFD) Propertiesdialog

box.
2 Select the Sandard Rule tab to access standard rule options.
3 From the standard rule list, select “Use System Variable.”
4 Select “ Current date and time” from the system variable list to map

those variables to the element, field, or TFD.

5 Click OK to set up the system variable.
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Using the Use Constant Standard Rule

Overview

Introduction The Use Constant function enables you to move aliteral constant value to the specified
element, field, or TFD and indicate a qualifying relationship with another element, field,
or TFD.

Why constantsare  Constants are used in maps to hold information that is needed | ater in the map, either to be
used moved to an output field or used in a conditional statement. Typically, constants are used
to movealiteral constant value to the specified element, field, or TFD on an inbound map.
Outbound EDI qualifiers are typically generated from constants (to indicate a qualifying
relationship with another element or field).

Literal constants are used by the system as arepository to store information that is used
later in the map. Typically, constants are used to load common data into each application
record on amap. You create the literal constant and nameit. You can “hard code” (enter) a
valuethat isloaded into the element, field, or TFD that uses the constant. However, to use
aconstant (the information that is stored in it), you need to use an standard rule, as
explained bel ow.

For an inbound map, constants are typically used to define the record types. For an
outbound map, constants are typically used to define qualifying relationships.

A qualifying relationship establishes a rel ationship between an element and its qualifier. A
qualifier contains a code that further defines the element. Qualifying relationships are
typically defined in outbound maps.
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Standard Ruletab
(Use Constant)

Sandard ruletab
(Use Constant)
partsand
functions

Using Standard Rules

This diagram illustrates the Standard Rule tab with Use Constant selected.

Element Properties

Mame | Validationl Hepeatl Extended Rule  Standard Rule | Conditionsl
Please select the standard rule to use: Usze Constant j

Please select a constant o stare in this fisld :

If thiz constant iz a qualifier for another field, the translator can automatically use the
exiztence of data in that field to determine whether to execute this standard nule. To
take advantage of thiz feature, simply select the field to be qualified ;

x| Edi. |

=

(1]4 I Cancel | Help |

Thistable lists the parts of the Standard Rule tab (with the Use Constant standard rule
selected) and their functions.

Part Function

constant Lists the available constants. The selected constant is mapped to
the current element, field, or TFD.
Note
If the necessary constant is not present in the constant list, you
need to create it by using the Map Constants dialog box, which
you can access by clicking Edit.

Edit Access the Map Constants dialog box, which alows you to
create, edit, and delete literal constants.

quaifier Liststhe elements, fields, or TFDs that you can use to qualify the

selected map component to establish a qualifying relationship
between the two map components.

Note
If the qualified element is not generated because of alack of data,
the constant is not moved to the current element, field, or TFD.
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Map Constants  Thisdiagram illustrates the Map Constants dial og box.
dialog box

Map Constants 5[

D Type “alue

Sub Table 1 String PRODCODE

Change... |
Delste |

Map Constants  Thistablelists the parts of the Map Constants dialog box and their functions.
dialog box parts

and functions Part Function

Constants list Containsalist of all literal constants currently defined in the
system.

Close Exits the Map Constants dialog box.

New Access the Edit Constant dialog box, which allow you to create a
new constant.

Edit Accessthe Edit Constant dial og box, which alows you to edit the
selected constant.

Delete Removes the selected constant from the system.

Edit Constant  Thisdiagram illustrates the Edit Constant dialog box.
dialog box

Edit Constant E3

[n] Type

Walue
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Edit Constant  Thistablelists the parts of the Edit Constant dialog box and their functions.

dialog box parts

and functions

Part

Function

Contains the literal constant identifier.

Note

Thisistypically adescription of thefield or element in which the
constant is used. If you need to refer to the constant in an
extended rule, you should use the data from this field.

Type

Specifies the category of thisliteral constant. Valid selections
are:

» Integer (select for numeric constants that are a positive or
negative natural (non-fraction) number or “0" (zero)

» Real (select for numeric constants that are a positive or
negative integer with an explicit decimal point)

» String (select for aphanumeric constants)

Value

Specifies the actual constant expression.

Note
Thisisthe value of the literal constant.
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How to Usea Constant in aMap

Procedure  Usethis procedure to use a constant in your map..

Step

Action

1

Double-click an existing element, field, or TFD, or create a new one.

Reference

See Using a Fixed-Format File on page 2 - 51, Using an EDI File on
page 2 - 68, and Using a Cl| File on page 2 - 88 for more information on
creating fields, elements, and TFDs.

System response
The system displaysthe Field (or Element or Cll TFD) Propertiesdialog
box (Name tab).

Select the Sandard Rule tab to access standard rule options.

From the standard rule list, select “Use Constant.”

System response
The system displays the constant options.

Do you need to create or edit a constant to use for the current element,
field, or TFD?

» If yes, click Edit to access the Map Constants dialog box.

Reference
See How to Define and Edit Literal Constants on page 3 - 30 for
more information on creating and editing constants.

» If no, continue with the next step.

From the constants list, select the constant that you want to map to the
current element, field, or TFD.

Do you want to establish a qualifying relationship between the current
map component and another component?

» If yes, from the qualifieslist, select the element, field, or TFD that
the system uses to determine whether to execute this standard rule
(if the qualifying component contains data).

» If no, continue with the next step.

Click OK to save the standard rule and exit the Properties dialog box.

Application Integration User Guide
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How to Define a Qualifying Relationship

Introduction Literal constants are used by the system as arepository to store information that is used at
alater point in the map. Typically, constants are used in an outbound map to generate a
qualifier. A qualifier isan element that has avalue expressed as a code that gives a specific
meaning to the function of another element. A qualifying relationship is the interaction
between an element and its qualifier. The function of the element changes depending on
which code the qualifier contains.

In this example, you use a constant to define a qualifier for a Product/Service ID.

Procedure  Usethis procedure to define a qualifying relationship.

Sep

Action

Double-click the Product/Service ID Qualifier that you want to use to
further define (qualify) the Product/Service ID.

System response
The system displays the Element Properties dialog box (Name tab).

Select the Sandard Rule tab to access standard rule options.

From the standard rule list, select “Use Constant.”

Click Edit.

System response
The system displays the Map Constants dialog box.

Click New.

System response
The system displays the Edit Constant dialog box.

Inthe ID box, type the literal constant identifier.

Note

Thisistypically adescription of the field or element in which the
constant isused. If you need to refer to the constant in an extended rule,
you should use the data from this box.

From the Type list, select String.

Note
The Product/Service ID Qualifier isformatted as a string data type. This
indicates the category of the literal constant.
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(Contd)
Sep Action

8 In the Vaue box, type “Ul".
Note
Thisindicates that the Product/Service ID field must contain the UPC
Code. Thisisthe value of the literal constant.

9 Click OK to add the constant to the system.

10 Click Close to exit the Map Constants dialog box.

11 From the qualifies|list, select Product/Service ID. Thisisthe element
that the Product/Service ID Qualifier qualifies.
Note
Thislist contains only the other active fields or elementsin the same
record or segment as the qualifying field.

12 Click OK on the Element Properties dialog box and the qualifying
relationship between the two elements is established.
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How to Define and Edit Literal Constants

Procedure  Usethisprocedureto create or edit aliteral constant so you can useit to store information.

Sep Action

1 From the Edit menu, select Constants.

System response
The system displays the Map Constants dialog box.

2 Do you want to create a new constant?

» Ifyes, click New.

» If no (you want to edit an existing constant), select the constant and
click Edit.

System response
The system displays the Edit Constant dialog box.

3 IntheID field, typethe literal constant identifier.

4 From the Type list, select the category of thisliteral constant.
5 In the Vaue field, type the actual constant expression.

6 Click OK to add the constant to the system.

7 Click Close to exit the Map Constants dialog box.
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How to Delete Literal Constants

Procedure  Usethis procedure to delete aliteral constant.

Sep Action

1 From the Edit menu, select Constants.

System response
The system displays the Map Constants dialog box.

2 Select the constant you want to delete.

3 Click Delete.

System response
The system removes the constant without warning.
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How to Map Literal Constants

Using Standard Rules

Procedure  Usethis procedure to map a constant in which you previously stored information using an

extended rule.

Step

Action

1

Double-click the element, field, or TFD in which you want to use the

constant.

System response

The system displaysthe Field (or Element or Cll TFD) Properties dialog

box.

Select the Standar d Rule tab to access standard rule options.

From the standard rule list, select “Use Constant.”

From the constant list, select the constant that you want to use.

Click OK.

System response

The data that was stored in the selected constant is loaded in the

element, field, or TFD.
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How to Generate Qualifiers

Introduction A qualifier is an typically an element that has a value expressed as a code that gives a
specific meaning to the function of another element. A qualifying relationship isthe
interaction between an element and its qualifier. The function of the element changes
depending on which code the qualifier contains.

Procedure  Usethis procedure to define qualifying relationships.

Sep Action

1 Double-click the element you want to use to further define (qualify)
another element.

System response
The system displays the Element Properties dialog box.

2 Select the Sandard Rule tab to access standard rule options.

3 From the standard rule list, select “Use Constant.”

4 From the qualifies list, select the element that this element qualifies.
Note

Thislist contains only the other active elements in the same record or
segment as the qualifying element.

5 Click OK.

System response
The system establishes the qualifying relationship between the two
elements.
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Using the Loop Count Standard Rule

Overview

Introduction The Loop Count function enables you to count the number of times aloop is repeated, if
the element, field, or TFD is part of aloop. If the loop isa nested loop, you can track the
current loop or the outer loop. For example, if the Y loop is nested within the X loop, and
the Y loop has cycled through 15 iterations and the X loop has cycled through 3 iterations,
you can choose to count either the “15” (Y loop) or the “3” (X loop).

Sandard Ruletab  Thisdiagram illustrates the Standard Rule tab with Loop Count selected.
(Loop Count)

Element Properties
Name | Walidation | Estended Rule ~ Standard Rule | Conditions |
Fleaze select the standard rule to uze : ILoop Count j
Pleaze select a group to count :
| =l
Cancel Al Help

Sandard ruletab  Thistableliststhe parts of the Standard Rule tab (with the Loop Count standard rule
(Loop Count)  selected) and their functions.

partsand
functlons Part Function
group Contains the loop that you want to count.
Note
If theloop is a hested loop, you can track the current loop or the
outer loop.
Example

If the'Y loop is nested within the X loop, and the Y loop has
cycled through 15 iterations and the X loop has cycled through 3
iterations, you can choose to count either the “15” (Y loop) or the
“3" (X loop).
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How to Usethe L oop Count Function

Procedure  Usethis procedure to use the Loop Count function.

Sep Action

1 Double-click an existing element, field, or TFD, or create a new one.

Reference

See Using a Fixed-Format File on page 2 - 51, Using an EDI File on
page 2 - 68, and Using a Cll File on page 2 - 88 for more information on
creating fields, elements, and TFDs).

System response
The system displaysthe Field (or Element or CIl TFD) Propertiesdialog

box.
2 Select the Sandard Rule tab to access standard rule options.
3 From the standard rule list, select “Loop Count.”
4 Select the loop that you want to count.
5 Click OK to add the standard rule.
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Using Standard Rules

Using the Use Accumulator Standard Rule

Overview

Introduction

Sandard Ruletab
(Use Accumulator)

The Use Accumulator function gives you access to a set of numeric variables that you can
mani pulate via numeric operations, and then transfer to and from fields. This function
enables you to add, change, or delete calculations for the element, field, or TFD, including
hash total's (used to accumulate numeric field values, i.e., quantity, price, etc.). This
function also enables you to map the accumul ated total into a control total field, and use
accumulators. Accumulators are used generally for counting the occurrences of a specific
element or generating increasing or sequential record or line item numbers.

Notes

Accumulators are global variables.
Accumulators are set to zero prior to being used in calculations.

The order in which accumulator operations are performed depends on the hierarchical
order of the map components.

This diagram illustrates the Standard Rule tab with Use Accumulator selected.

Element Froperties

Mame I Validationl Extended Fule  Standard Rule IEonditionsl

Please select the standard rule to use : IUse Accumulator j

Frimary &ccumulator Op1 Op2 0Op3d Opd

MNew...

Change...

i

Delete

Cancel Sl Help
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Sandard ruletab  Thistableliststhe parts of the Standard Rule tab (with the Use Accumulator standard rule
(Use Accumulator)  selected) and their functions.

partsand

functions Part Function
Primary Contains all existing calculations that were created for this
accumulator element, field, or TFD.
New Accesses the Edit Accumulator Entry dialog box to create a new

calculation for this element, field, or TFD.

Change Highlight a calculation in the Primary Accumulator list and click
thisto access the Edit Accumulator Entry dialog box to edit the
selected calculation.

Delete Highlight a calculation in the Primary Accumulator list and click
thisto delete the selected calculation.

Warning
The selected calculation is deleted without warning.

Edit Accumulator  Thisdiagram illustrates the Edit Accumulator Entry dialog box.

Entry dialogbox oy
Frimary Accumuister | [2] wame | | il |
peralicrs [ Canca |
Frsl | [2] Htemate tozum | [=]
Sezand | [
Thd | 1]
Foulh | [

Application Integration User Guide Sterling Gentran: Server — May 2011



Overview

Edit Accumulator
Entry dialog box
partsand
functions

Using Standard Rules

Thistable lists the parts of the Edit Accumulator Entry dialog box and their functions.

Part Function
Primary Specifies the primary accumulator.
accumulator

Notes

» Beforeany calculations are performed on an accumulator, its
content is“0” (zero). When you use an accumul ator, the
system adds a new accumulator to the bottom of thislist.

» Thereisonly one set of accumulators for each map. This
means that accumulator “0,” whether it isused in the
Primary Accumulator or Alternate Accum box is the same
accumulator with the same contents. If you assign
calculations to accumulator “0” at the beginning of the map
and then use accumulator “0” again later in the map, the
content of that accumulator is the result of the earlier
calculation. Any additional calculations you assign to that
accumulator are performed on the contents resulting from an
earlier calculation.

Name Contains a descriptive alias that enables you to differentiate what
the accumulators you create are used for.
First Specifies the first operation that the system performs.

Notes

» TheFirst box isactive only after you select a Primary
Accumulator.

» Beforeany calculationsare performed on an accumulator, its
content is“0” (zero). When you use an accumul ator, the
system adds a new accumulator to the bottom of this list.

Reference

See Accumulator operations on page 3 - 39 for more

information.

Second Specifies the second operation that the system performs, after the

First operation is completed.

Note
The Second box is active only after you select a First operation
that does not involve the Alternate Accum.

Reference
See Accumulator operations on page 3 - 39 for more
information.
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(Contd)
Part Function

Third Specifies the third operation that the system performs, after the
Second operation is complete.

Note
The Third box is active only after you select a Second operation.

Reference
See Accumulator operations on page 3 - 39 for more
information.

Fourth Specifies the fourth operation that the system performs, after the
Third operation is complete

Note
The Fourth box is active only after you select a Third operation.

Reference
See Accumulator operations on page 3 - 39 for more
information.

Alternate Accum Specifies an alternate accumulator that participatesin the
accumulator operation.

Note
The Alternate Accum box isonly activeif you select an operation
from the First field that involves an aternate operand.

Reference
See Accumulator operations on page 3 - 39 for more
information.

Accumulator Thistable lists the available accumulator operations and their functions.
operations

Part Function

Increment primary | Adds“1” (one) to the contents of the Primary Accumulator (i.e.,
Primary = Primary + 1).

Decrement primary | Subtracts“1” (one) from the contents of the Primary
Accumulator (i.e., Primary = Primary - 1).

Sum in primary Addsthe numeric value (takes the positive or negative sign of the
numbers into account) of the field to the contents of the Primary
Accumulator (i.e., Primary = (+/-)Primary + (+/-)Field).

Hash sumin Adds the absolute value (does not take the positive or negative
primary sign of the numbers into account) of the field to the contents of
the Primary Accumulator (i.e., Primary = Primary + Field).
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(Contd)
Part Function

Load primary L oads the contents of the field into the Primary Accumulator
(i.e., Primary = Field).

Use primary L oads the contents of the Primary Accumulator into the field
(i.e., Field = Primary).

Zero primary Sets the value of the Primary Accumulator to zero (i.e., Primary
=0).

Multiply with Multiplies the field with the contents of the Primary

primary Accumulator, and stores the result in the Primary Accumulator

(i.e., Primary = Primary * Field).

Divide by primary

Divides the field with the contents of the Primary Accumulator,
and stores the result in the Primary Accumulator (i.e., Primary =
Field / Primary).

Divide primary by
field

Divides the contents of the Primary Accumulator with the field,
and stores the result in the Primary Accumulator (i.e., Primary =
Primary / Field).

Modulo with
primary

Divides the contents of the Primary Accumulator with the
contents of thefield, and storesthe remainder of that operationin
the Primary Accumulator (i.e., Primary = Field % Primary).

Modulo with field

Divides the contents of the field with the contents of the Primary
Accumulator, and stores the remainder of that operation in the
Primary Accumulator (i.e., Primary = Primary % Field).

Negate primary

Makes the contents of the Primary Accumulator negative (i.e.,
Primary = Primary * -1).

Note

The only way to subtract the Primary Accumulator from thefield
isto“Negate”’ the Primary Accumulator and then usethe“Sumin
primary” operation to add the negative Primary Accumulator to
thefield.

Move primary to
aternate

Copies the contents of the Primary Accumulator to the Alternate
Accum. This overwrites the current contents of the Alternate
Accum field (i.e., Alternate = Primary).

Add primary to
aternate

Adds the contents of the Primary Accumulator to the contents of
the Alternate Accum, and stores the result in the Primary
Accumulator (i.e., Primary = Primary + Alternate).

Multiply primary
by alternate

Multiplies the contents of the Primary Accumulator with the
contents of the Alternate Accum, and stores the result in the
Primary Accumulator (i.e., Primary = Primary * Alternate).
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Part Function

Divide primary by | Divides the contents of the Primary Accumulator with the
dternate contents of the Alternate Accum, and stores the result in the
Primary Accumulator (i.e., Primary = Primary / Alternate).

Modulo primary Divides the contents of the Primary Accumulator with the

with alternate contents of the Alternate Accum, and stores the remainder of that
operation in the Primary Accumulator (i.e., Primary = Primary %
Alternate).
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How to Count Line Items

Using Standard Rules

How to Count Lineltems

Introduction In this example, you want an incremental count of the number of lineitems, and you want
to use that total value in the Number of Line Items Total field.

Procedure  Usethis procedure to count line items and generate a control total for an outbound ANS
X12 purchase order.

Step

Action

1

Double-click the P0101 element (in the PO1 segment in the PO1 group).

Note
Thisisthe element that you typically use to count the line items.

System response
The system displays the Element Properties dialog box.

Select the Sandard Rule tab to access standard rule options.

From the standard rule list, select “Use Accumulator.”

Click New.

System response
The system displays the Edit Accumulator Entry dialog box to create a
new calculation for this element.

From the Primary Accumulator list, select “0.”

Note

Thereis only one set of accumulators for each map. This means that
accumulator “0,” whether it is used in the Primary Accumulator or
Alternate Accum box is the same accumulator with the same contents. If
you assign calculations to accumulator “0” at the beginning of the map
and then use accumulator “0” again later in the map, the content of that
accumulator is the result of the earlier calculation. Any additional
calculations you assign to that accumulator are performed on the
contents resulting from an earlier calculation.

In the Name box, type “Line Item Number.”

Note
Thisisadescriptive alias that enables you to differentiate what the
accumul ators you create are used for.

From the First list, select Increment Primary. Thisisthefirst operation
that the system performs. This specifies that the system will increment
the PO101 element by one.
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How to Count Line Items

(Contd)
Sep

Action

8

From the Second list, select “Use primary.”

Note

Thisisthe second operation that the system performs, after the First
operation is completed. This specifies that the system loads the current
value of the accumulator into the PO101 (Assigned Identification)
element.

Click OK to add the accumulator.

10

Click OK on the Element Properties dialog box to add the standard rule
to the PO101 element.

11

Double-click the CTTO1 element (in the CTT segment).

Note
Thisisthe element that typically contains the total number of line items.

System response
The system displays the Element Properties dialog box.

12

Select the Sandard Rule tab to access standard rule options.

13

From the standard rule list, select “Use Accumulator.”

14

Click New.

System response
The system displays the Edit Accumulator Entry dialog box to create a
new calculation for this element.

15

From the Primary Accumulator list, select primary accumulator “0.”

Note
This accumulator currently contains the total number of lineitems.

Application Integration User Guide
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(Contd)
Sep

Action

16

From the First list, select “Use primary.”

Note
This specifies that the system loads the current value of the accumulator
into the CTTO1 (Number of Line Items Total) element.

System response
This diagram illustrates how the Edit Accumulator dialog box should
look.

it Accum C kryr
Piiman: #ccuruisor [0 [2] hama ILireIha'nNu'nl:e( | i |

Firsl Uze prmaw Bllemabe Acoum
Sezond I :I

Thind | .
Fouh | |

17

Click OK to add the accumulator.

System response
This diagram illustrates how the Standard Rule tab should look.

Element Froperties

Mame I Validationl Extended Rule  Standard Rule IEonditionsl

Flease select the standard rule to use : IUse Acoumnulator j
Frimary Accumulator Op1 Op2 0Op3d Opd
O-Line [tem Mumber Usze Mew...

Change...

i

Delete

0k I Cancel I ] | Help |

18

Click OK on the Element Properties dialog box to add the standard rule
to the CTTO1 element.

Note
The CTTO01 element now contains the total number of line itemsin the
purchase order.
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How to Calculate Hash Totals

Introduction In this example, you want to count the quantity ordered for each line item and load the
total quantity inthe CTTO02 (Hash Total) element.

Procedure  Usethis procedureto count the quantity ordered and generate a hash total for an outbound
ANSI X12 purchase order.

Sep Action

1 Double-click the P0102 element (in the PO1 segment in the PO1 group).

Note
Thisisthe element that you typically use to count the line items.

System response
The system displays the Element Properties dialog box.

2 Select the Sandard Rule tab to access standard rule options.
3 From the standard rule list, select “Use Accumulator.”
4 Click New.

System response
The system displays the Edit Accumulator Entry dialog box to create a
new calculation for this element.

5 From the Primary Accumulator list, select “1.”

6 In the Name box, type “ Total Quantity.”

7 From the First list, select Hash Sum in Primary.
Note

Thisisthefirst operation that the system performs. This specifies that
the system will add the numeric value of the PO102 element to the
contents of the Primary Accumulator.

8 Click OK to add the accumulator.
9 Click OK on the Element Properties dialog box to add the standard rule
to the P0102 element.
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(Contd)
Sep Action

10 Double-click the CTT02 element (in the CTT segment).
Note
Thisisthe element that typically contains the total quantity of the
purchase order.
System response
The system displays the Element Properties dialog box.

11 Select the Standar d Rule tab to access standard rule options.

12 From the standard rule list, select “Use Accumulator.”

13 Click New.
System response
The system displays the Edit Accumulator Entry dialog box to create a
new calculation for this element.

14 From the Primary Accumulator list, select primary accumulator “1.”
Note
This accumulator currently contains the total quantity.

15 From the First list, select “Use primary.”

Note
This operation specifies that the system loads the current value of the
accumulator into the CTTO02 (Hash Total) element.

System response
This diagram illustrates how the Edit Accumulator dialog box should

look.

Edil Al Entis
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Using Standard Rules How to Calculate Hash Totals
(Contd)
Sep Action
16 Click OK to add the accumulator.
System response
This diagram illustrates how the Standard Rule tab should |ook.
Element Froperties
Mame I Validationl Extended Rule  Standard Rule | Eonditionsl
Please select the standard rule to use : IUse Accumulator j
Frimary Accumulator Opl 0Op2 Op3 Opd
1-Tatal Quantity Use Mew. ..
Change... |
Delete |
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17 Click OK on the Element Properties dialog box to add the standard rule
to the CTTO2 element.
Note
The CTT02 element now contains the total quantity of the purchase
order.
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How to Reset and Calculate a Value Total

I ntroduction

Procedure:
multiplying
quantity invoiced
by unit price

In this example, you want to multiply the quantity invoiced for each line item by the unit
price to obtain the extended price. Then, you want to generate a running total of extended
price and load the final total into the TDS01 (Total Invoice Amount) element.

Use this procedure to multiply the quantity invoiced for each line item by the unit price to
obtain the extended price for an outbound ANSI X 12 invoice.

Sep Action

1 Double-click the IT102 element (in the IT1 segment in the IT1 group).
Note
Thisisthe element that you typically use to count the quantity invoiced.
System response
The system displays the Element Properties dialog box.

2 Select the Sandard Rule tab to access standard rule options.

3 From the standard rule list, select “Use Accumulator.”

4 Click New.
System response
The system displays the Edit Accumulator Entry dialog box to create a
new calculation for this element.

5 From the Primary Accumulator list, select “2.”

6 In the Name box, type “Extended Price.”
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How to Reset and Calculate aValue Tota

(Contd)
Sep

Action

7

From the First list, select “Load primary.”

Note
This operation specifiesthat the system loads the contents of the element
into the Primary Accumulator for each iteration of the I T1 group.

System response
This diagram illustrates how the Edit Accumulator dialog box should
look.

Edit Accumulatar Entry [x]

Fiman Acaurmlatee |2 [] Mama [Extanded Frize |
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Click OK to add the accumul ator.

System response
This diagram illustrates how the Standard Rul

etab should |ook.

Element Properties E
Mame I \.-"alidationl Extended Fule  Standard Rule | Eonditionsl
Please select the standard rule to use IUse Accumulator j
PFrimary Accuniulator Op1 0Op2 0Op3 O0Opd
2-Eutended Price Load Mew...
Change... |
Delete |
Cancel | Lopni I Help |

Click OK on the Element Properties dialog box to add the standard rule

to the IT102 element.
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Using Standard Rules

(Contd)
Sep

Action

10

Double-click the IT104 element (in the IT1 segment in the IT1 group).

Note
Thisisthe element that contains the unit price for each lineitem.

System response
The system displays the Element Properties dialog box.

11

Select the Standar d Rule tab to access standard rule options.

12

From the standard rule list, select “Use Accumulator.”

13

Click New.

System response
The system displays the Edit Accumulator Entry dialog box to create a
new calculation for this element.

14

From the Primary Accumulator list, select primary accumulator “2.”

15

From the First list, select “Multiply with primary.”

Note

This operation specifiesthat the system multipliesthe value of the IT104
(Unit Price) element with the contents of the primary accumulator, and
store the result in the primary accumulator for each iteration of the IT1

group.

System response
This diagram illustrates how the Edit Accumulator dialog box should
look.

Edit Accumulatar Entry
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(Contd)
Sep Action
16 Click OK to add the accumulator.
System response
This diagram illustrates how the Standard Rule tab should |ook.
M arne: I Validationl Extended Fule  Standard Rule | Eonditionsl
Please select the standard rule to use IUse Accumulator j
Frimary Accumulator Op1 DOp2 0Op3 Opd
2-Extended Price ult Mew...
Change... |
Delete |
Cancel | Al I Help |
17 Click OK on the Element Properties dialog box to add the standard rule
to the IT104 element.
Tip
If thereis an extended price element in your EDI file, you could load the
total from the extended price calculation into that element. To do this,
you need to use an accumulator on that extended price element that
specifies“Use primary” for accumulator 2.
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How to Reset and Calculate a Value Total

Procedure:
generating a
running total of
extended price

Using Standard Rules

Use this procedure to generate a running total of the extended price.

Sep

Action

Double-click the IT104 element (in the IT1 segment in the IT1 group).

Note
Thisisthe element that contains the unit price for each lineitem.

System response
You already established one accumulator that the system displaysin the
list on the Standard Rule tab.

Element Properties

Mame I Validationl Exterded Fule  Standard Rule I Eonditionsl

Please select the standard rule to use : IUse Accumulatar j

Primary Accumulatar Op1 0Op2 0Op3 0Opd
2-Extended Price hult Mew...

Change...

i

Delete

Cancel Aol Help

Click New.

System response
The system displays the Edit Accumulator Entry dialog box to create a
new calculation for this element.

From the Primary Accumulator list, select “3”.

In the Name box, type “Running Total.”

From the First list, select “ Add primary to aternate.”

Note

This operation specifies that the system adds the contents of the primary
accumulator to the contents of the alternate accumulator, and stores the
result in the primary accumulator for each iteration of the I T1 group.
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How to Reset and Calculate aValue Tota

(Contd)
Sep

Action

6

From the Alternate Accum list, select “2.”

Note

This operation specifies that the system add the value of accumulator
“2" (which contains the extended price for aline item) to the value of
accumulator “3.” The system stores the sum in accumulator “3,” which
therefore contains a running total of the extended price with each
iteration of the IT1 group.

System response
This diagram illustrates how the Edit Accumulator dialog box should
look.

Edit Accumulatar Entry
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Click OK to add the accumul ator.

System response
This diagram illustrates how the Standard Rule tab should look.

Element Properties
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Click OK on the Element Properties dialog box to add the standard rule
to the IT104 element.
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How to Reset and Calculate a Value Total Using Standard Rules

Procedure: loading  Usethis procedure to load the running total of the extended price into the TDS01 (Total
arunningtotal of  Invoice Amount) element.

extended price

Sep Action
1 Double-click the TDS01 €l ement.
Note
Thisisthe element that contains the total invoice amount for each line
item.

System response
The system displays the Element Properties dialog box.

2 Select the Standar d Rule tab to access standard rule options.
3 From the standard rule list, select “Use Accumulator.”
4 Click New.

System response
The system displays the Edit Accumulator Entry dialog box to create a
new calculation for this element.

5 From the Primary Accumulator list, select “3.”
6 From the First list, select “Use primary.”
Note

This operation specifies that the system loads the contents of the
primary accumulator into the TDSO1 (Total Invoice Amount) element.

System response
This diagram illustrates how the Edit Accumulator dialog box should

look.
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(Contd)
Sep

Action

7

Click OK to add the accumulator.

System response

This diagram illustrates how the Standard Rule tab should |ook.
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Click OK on the Element Properties dialog box to add the standard rule

to the TDSO01 element.
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Using the Use Code Standard Rule

Overview

Introduction  The Use Code function enables you to match an element, field, or TFD against a
predefined code table and specify whether or not a compliance error is generated if the
map component does not contain one of the values in the code table. This function also
allows you to store a code’s description in another element, field, or TFD. You can also
create a unigue code table, use code values from a code table, and flag whether or not the
system generates an error if avalidation against the code table fails. You can import and
export code lists and copy and paste code lists between maps.

The Sterling Gentran: Server Application subsystem enables you to create code tablesto be
used with the current map. You can set up code tables in the Application Integration
subsystem to function like the partner cross-reference and lookup tablesin Sterling
Gentran: Server. However, code tables that are set up in the Application subsystem can be
used only for the current map. Code tables that you create in Sterling Gentran: Server can
be used globally for all maps.

Code List Tables are used by EDI standards as repositories for lists of codes. Each EDI
standard provides a code list for each element that can be further defined with a code.
Sterling Gentran: Server allows you to load code lists from the standard. You can either
load all the codes in the table, or you can select only one or more codes from the table.
Once you load a code table, you can use a“Use Code” standard rule to either look up a
value from a code table or validate the contents of an element, field, or TFD against the
valuesin the code table.

A element, field, or TFD with a Use Code rule enables values to either be checked against
or selected from the codes in a specified code table. Codes are typically used to further
qualify another element. For example, if the XX element contains address information,
you can further qualify that element by choosing the code “ SU” from the 0222 table. Inthe
0222 table, the code “ SU” is described as a“supplier's address.” Therefore, by using this
code with the XX element, you are indicating that the XX element is not just address
information, but address information for the supplier.
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Sandard Ruletab  Thisdiagram illustrates the Standard Rule tab with Use Code selected.
(Use Code)

Element Froperties

M ame I Validationl Exterded Fule  Standard Rule I Eonditionsl

Please select the standard rule to use : IUse Code j

Please select the code list to use

f =l Edit.. |

™ Raise a compliance eror if the eode is not found in the list

IF pou would like the degcription of the code to be stored in a field, pleasze
zelect that field below :

| =

Cancel Al Help

Sandard ruletab  Thistableliststhe parts of the Standard Rule tab (with the Use Code standard rule
(UseCode) parts  selected) and their functions.

and functions

Part Function
Code list Contains all the code tables.
Note
If the necessary code tableis not listed, click Edit to load or
create a code table.
Edit Accesses the Edit Code List dialog box, which enables you to

create and edit code list tables.

Raise compliance Indicates that, for compliance reasons, the element, field, or TFD
error must contain one of the codes from the specified table (nothing
elseisvalid for that field).

Example

If afield is defined as containing only “YES’ or “NO,” you can
set up an exclusive code table that contains only YES and NO.
Then if you receivea“MAYBE” in that field, the system flags it
as an error.
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CodelList dialog
box

Edit CodelList
dialog box parts
and functions

Using Standard Rules

(Contd)
Part

Function

Code description

Contains the element, field, or TFD where you want the
description of the code (that is used) to appear when the selection
is made.

Example

If the codeis“SU,” it is much more useful to view the
description of the code (“ Supplier's Address). If you selected
element “XX” from the store description list, the description for
the code used is mapped to element “ X X.”

Thisdiagram illustrates the Code List dialog box.

Thistable lists the parts of the Edit Code List dialog box and their functions.

Part Function

Tablelist Specifies the table identifier.

New Accesses the Edit Code List dialog box, which alows you to
create anew code list.

Change Accesses the Edit Code List dialog box, which allows you to edit
the selected code list.

Delete Deletes the selected code list

Import Accesses the Open dialog box, which allows you to import a
code list.

Export Accesses the Save As dialog box, which allows you to export the

selected code list.
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(Contd)
Part Function
Copy Copies the selected code list.
Paste Pastes a previoudly-copied code list in amap.

Edit CodeList  Thisdiagramillustratesthe Edit Code List dialog box.
dialog box

Falit Taple 1 izt

rTable Oelais
Table IO [eac

ki

Hlhwed Codes Cancel
CodaWala Dezciphion

=1

i

Delata

Laad...

Edit CodeList  Thistableliststhe parts of the Edit Code List dialog box and their functions.
dialog box parts

and functions Part Function
Table ID Contains the name of the field or element for which this code list
tableis used.
Desc Contains the description of the field or element for which this

code list table is used.

Allowed Codes Specifies the codes that are allowed for thistable.

New Accesses the Edit Code List Entry dialog box, which allows you
to create a new code.

Change Accesses the Edit Code List Entry dialog box, which allows you
to edit the selected code.

Delete Accesses the Edit Code List Entry dialog box, which allows you
to delete the selected code.

Load Accesses the Load Code List dialog box, which alows you to

select, from astandard code table, specific codes that you want to
load or select the entire list of codes.
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Edit CodeList
Entry dialog box

Edit CodeList
Entry dialog box
partsand
functions

Using Standard Rules

This diagram illustrates the Edit Code List Entry dialog box.

Edit Codc Lizt Entry

vabe [

D' e=cripbion |

Thistable lists the parts of the Edit Code List Entry dialog box and their functions.

Part Function
Value Specifies the actual value of the code.
Description Contains the code value description.

Note

The description is used if you specify an element or field (in the
Store Fieldslist on the Field Properties dial og box) to which you
want the code description mapped.
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How to Validate Data Against a Code List Table

How to Validate Data Against a Code List Table

Introduction For this example you need to map the customer product code from the Product/Service ID
to the customer product code field (CUSTPROCODE) on the application side of the map.
To ensure that the data that is mapped from the Product/Service ID element really is your
partner’s customer product code, you need to establish and use a code table with the
Product Service ID Qualifier.

Procedure  Usethis procedure to validate the datain the Product/Service ID field against a code list

table.

Step

Action

1

Load the code list table from the standard for the Product/Service ID
Qualifier element.

Reference
See How to Load a Code List Table from the Sandard on page 3 - 66 for
more information.

Note

The standards provide code list tables only for elements that use them.
For example, in the TD4 segment, the TD401 (Special Handling Code)
and TD403 (Hazardous Material Class Code) have code tables provided
by the standard.

Defineacode list table for the Product/Service ID Qualifier element that
only contains the code value “BP” (Buyer’s Part Number).

Reference
See How to Define and Modify a Code List on page 3 - 62 for more
information.

Double-click the element for which you need to validate data against a
code table (Product/Service ID Qualifier).

System response
The system displays the Element Properties dialog box.

Select the Sandard Rule tab to access standard rule options.

From the standard rule list, select “Use Code.”

From the code list, select the code list table that the datain thisfield is
validated against (0235).

If you need to specify that, for compliance reasons, the element must
contain one of the codes from the specified table (nothing elseisvalid
for that field), select the compliance error check box.

Click OK to add this standard rule to the field.

Application Integration User Guide
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How to Define and M odify a Code List

Procedure  Usethis procedure stepsto define or modify acode list table.

Step

Action

1

From the Edit menu, select Code Lists.

System response
The system displays the Code Lists dialog box.

Do you want to create a new code list?

» If yes, click New.

» If no(youwant to edit acodelist), select acodelist and click
Change.

System response
The system displays the Edit Code List dialog box.

In the Table ID box, type the name of the field or element for which this
code list table is used.

In the Description box, type the description of the field or element for
which this code list table is used.

Do you want to create a new code?
» If yes, click New.
» If no(youwant to edit acode), select a code and click Change.

System response
The system displays the Edit Code List Entry dialog box.

In the Value box, type the actual value of the code.

In the Description box, type a description of the code value.

Click OK to save the code list entry.

Repeat steps 5 through 8 to add more code list entries to the code list
table.

10

Click Close to save and exit the Edit Code List dialog box.

11

Click Closeto exit the Code Lists dialog box.

Sterling Gentran:Server — May 2011

Application Integration User Guide



Using Standard Rules How to Delete a Code List or Code List Entry

How to Deletea Code List or CodelList Entry

Procedure: Use this procedure steps to delete a code list table.
deleting a code list

Sep Action

1 From the Edit menu, select Code Lists.

System response
The system displays the Code Lists dialog box.

2 Select the code list you want to delete.

3 Click Delete to delete the code list table.

System response
The selected table is deleted without warning.

Procedure: Use this procedure steps to delete a code list entry.
deleting a code list
entry Sep Action

1 From the Edit menu, select Code Lists.

System response
The system displays the Code Lists dialog box.

2 » Select the code list from which you want to delete an entry and
» click Change.

System response
The system displays the Edit Code List Entry dialog box.

3 Select the entry and click Delete to remove the entry.

System response
The selected entry is deleted without warning.

4 Click OK to save the code list table.
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Using Standard Rules

How to Import a Code List

Introduction The Code List Import function enables you to import code lists created for another map
and share code lists with other users of Sterling Gentran: Server.

Procedure  Usethis procedure stepsto import a code list table.

Step

Action

1

From the Edit menu, select Code Lists.

System response
The system displays the Code Lists dialog box.

Click Import.

System response
The system displays the Open dialog box.

DOpen (7] %]

Laook jm: IaBin j gl E =

File name: I

Files of bype: ICode Tables [*.CDE] j Cancel |

Select the location of the code list file.

Note
The default location is Application Integration install folder (the default
is GENSRVNT). The default file extension for code listsis“.CDE.”

Select the code list file from the list and click Open.

System response
The system imports the code list and returns to the Code Lists dialog
box. Theimported code list is available for your use.

Click OK to exit the Code Lists dialog box.
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How to Export a Code List

Introduction The Code List Export function enables you to export code lists to file. This enablesyou to
define a code list for one map and use that code list in another map. This function also
allows you to share code lists with other users of Sterling Gentran:Server.

Procedure  Usethis procedure steps to export acode list table.

Sep Action

1 From the Edit menu, select Code Lists.

System response
The system displays the Code Lists dialog box.

2 Select acode list and click Export.

System response
The system displays the Save As dialog box.

Save As HE

Save in: IaBin j gl IE

File name:  [0235.CDE

Save astype: [Cade Tables (*CDE) =l o] |

3 Do you want to change the name?

» If yes, type the export file name in the “File name” box.

» If no, continue with the next step.

Note

Thefile name defaults to the table ID with a“.CDE” file extension. The

default location is Application Integration install folder (the default is
GENSRVNT).

4 Click Save.

System response
The system exports the code list and returns to the Code Lists dialog
box.

5 Click Closeto exit the Code Lists dialog box.
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How to Load a Code List Table from the Sandard

Procedure  Usethis procedure steps to load a code list table from the standard.

Sep Action

1 Double-click the element for which you need to use a code table.

System response
The system displays the Element Properties dialog box.

Note

The standards provide code list tables only for elements that use them.
For example, in the TD4 segment, the TD401 (Specia Handling Code)
and TD403 (Hazardous Material Class Code) have code tables provided

by the standard.
2 Select the Sandard Rule tab to access standard rule options.
3 From the standard rule list, select “Use Code.”
4 Click Edit.

System response
The system displays the Edit Code List dialog box.

5 Click L oad.

System response
The system prompts you to select a data source name (DSN) from which
to access the EDI standard.

6 Select the appropriate DSN and click OK.

System response
The system displays the Load Code List dialog box.

7 Select either specific codes that you want to load or select the entire list
of codes.

» To select specific codes only, from the Codes in Standard list,
highlight each code that you want to be loaded. Click Add to move
it to the Codes Selected list.

» Toloadtheentirecodelist, click Add All to select all the codes and
move them to the Codes Selected list.

Recommendation

Only add the codes that you and your trading partners are able to create
or accept. Adding all codesin the code table (using the Add All) creates
amuch larger translation object than if you only use selected codes.

8 Click OK to load the code list.

9 Click Close to exit the Code Lists dialog box.
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How to Copy and Paste Code Lists

How to Copy and Paste Code Lists

Introduction The Code List Copy and Paste function enables you to copy code lists to from one map to
another.

Procedure  Usethis procedure steps to copy and paste a code list table.

Sep Action
1 From the Edit menu, select Code Lists.
System response
The system displays the Code Lists dialog box.
2 Select acode list and click Copy.
System response
The system copies the code list to the clipboard.
3 Click Closeto exit the Code Lists dialog box.
4 Open the map in which you want to use the code list, if the map is not
already open.
5 From the Edit menu, select Code Lists.
System response
The system displays the Code Lists dialog box.
6 Click Paste.
System response
The system adds the copied code list to this map.
7 Click Close to exit the Code Lists dialog box.
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How to Validate Data Against Code List Tables

Procedure  Usethis procedure stepsto validate data against a code list table.

Sep Action

1 Double-click the element for which you need to validate data against a
code table.

System response
The system displays the Element Properties dialog box.

Note

The standards provide code list tables only for elements that use them.
For example, in the TD4 segment, the TD401 (Specia Handling Code)
and TD403 (Hazardous Material Class Code) have code tables provided

by the standard.
2 Select the Sandard Rule tab to access standard rule options.
3 From the standard rule list, select “Use Code.”
4 From the code list, select the code list table that the data in this element

isvalidated against.

Note
If thislist is empty, you need to load a code table.

Reference
See How to Load a Code List Table from the Sandard on page 3 - 66 for
more information.

5 If you need to specify (for compliance reasons) that the element must
contain one of the codes from the specified table (nothing elseisvalid
for that field), select the compliance error check box.

6 Click OK to add this standard rule to the element.

Sterling Gentran:Server — May 2011 Application Integration User Guide



Using Standard Rules

How to Map Code Item Descriptions

How to Map Code Item Descriptions

Procedure  Use this procedure steps to map a code item description.

Step

Action

1

Double-click the element for which you need to map a code description.

System response
The system displays the Element Properties dialog box.

Select the Sandard Rule tab to access standard rule options.

From the standard rule list, select “Use Code.”

From the code list, select the code list table that the datain this element
isvalidated against.

Note
If thislist is empty, you need to load a code table.

Reference
See How to Load a Code List Table from the Sandard on page 3 - 66 for
more information.

If you need to specify (for compliance reasons) that the element must
contain one of the codes from the specified table (nothing elseisvalid
for that field), select the compliance error check box.

From the store description list, the element to which you want the
description of the code item (that is used) to be mapped to when the
selection is made.

Click OK to add this standard rule to the element.
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Overview Setting Up the Import Process

Overview

Introduction Theimport processis part of the outbound trandation process. In the outbound translation
process, the system translates your application file format to EDI standard formats, so you
can send documents to your partners.

Import trandation To tranglate outbound data, you need to create an import translation object and a system
object import trandation object in the Sterling Gentran: Server Application Integration
subsystem. The import translation object defines how to move data from your application
file (flat file definition), which may contain multiple documents, to the EDI standard-
formatted documents that your partners expect to receive from you.

System import You need to create a system import translation object to determine which trading
trandation object relationship (established in Partner Editor) corresponds to each document in the
application file, so the system knows which import translation object to use to process the
document.
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Setting Up the Import Process Importing Data

| mporting Data

Introduction During the import process, Sterling Gentran:Server imports a specified application file
into the Workspace. An import file can contain multiple flat file definitions (documents)
that need to be sent to multiple trading partners.

What you can You can import any type of flat file, including TDF (Transaction Data File). TDF isaflat
import file representation of the EDI standard document. The flat file characteristics can include
multiple record types (more than one record definition) and records delimited by carriage

returng/line feeds.

Restrictions  You cannot import EDI or field-delimited files. The field and record lengths for import
files are defined in the Application Integration subsystem application file definition. For
exampl e, the maximum length of afield in an import file must not exceed the maximum
length (Max) specified on the Field Properties dialog box for that field. And, the
maximum length of arecord in an import file must not exceed the record length (if
specified) on the Positional File Format Properties dialog box for that record. The system
default is variable length records. If you specify record delimiters on the Positional File
Format Properties dialog box, the records in the import file must begin and end with those
delimiters. If you do not specify record delimiters, the default delimiters are carriage
return and line feed.

Determining  The system must determine which trading rel ationship (established in Partner Editor)
trading  corresponds to each document in the application file, so the system knows which import
relationships  translation object to use to process the document. Each application file must have a
corresponding system import map. For each document in the application file, the system
import trandlation object identifies the partner and locates the trading relationship. The
trading relationship for that partner must have an import translation object associated with
it.

Trandatingthe  After the system import translation object determines which trading relationship
document corresponds with a document, it ascertains which import translation object is specified in
that relationship. The translator uses the import translation object to translate the
document. If the document is compliant (valid), it is moved to the Workspace. If the
document is not compliant (invalid), it is moved to the ?0ut Documents. Then, if thereis
another document remaining in the application file, the trand ator repeats this process until
al the documents are processed.
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Import process  Thisdiagram illustrates the import process (translator not pictured).
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How to M odify System Configuration

Introduction ~ When you import afile, the system checks the Imports tab of the System Configuration
program (shipped with Sterling Gentran:Server) to verify that the file is matched with a
registered system import tranglation object. Your system administrator may need to add
the match to the System Configuration program.

Reference

See How to Edit an Import Specification in the IBM® Serling Gentran: Server® for
Microsoft Windows Administration Guide for more information on defining or modifying
import specifications.
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How to Create a System Import Map

Introduction A system import map is used by the system to find the partner relationship for a document
(flat file definition), to determine which import map is used to trandlate the data. The
system import map builds the key that the translator uses to find the partner relationship.
The sole function of the system import map is to identify the appropriate partner
relationship; the system import map does not map any data.

Building a key: There are two ways to build the key in a system import map. The method that we
method 1 recommend requires six EDI-specific fields in the header record: partner key, standard,
version, transaction set, release (for TRADACOMS only), and test/production status. The
combination of these six fields defines a unique key that identifies the appropriate partner
relationship. We recommend using this method because it is very flexible. You typically
use this method when you are defining your application from scratch and can easily add
the EDI-specific fields that are not already present in the header record.

Buildingakey:  The second method is easier to build because it only requires three fields in the header
method 2  record (partner key, application ID or application alias value, and test/production status).
The combination of these three fields defines a unique key that identifies the appropriate
partner relationship. However, because only three fields are combining to build the key,
this method is not as flexible as the preferred method. You typically use this method when
you are using alegacy (existing) application definition, and you do not want to add EDI-
specific information.

Procedure: Use this procedure to create a system import map.
creating a system
import map

Sep Action

1 From the File menu, select New.

System response
The system displays the New Map Wizard.

2 From the type of map list, select System Import.
3 In the name box, type the name of the map.
4 Verify that your nameis already entered in the name box and click Next.

System response
The system displays the New Map Wizard - Input Format dialog box.

5 From the Create anew data format list, select Positional and click Next.

System response
The system displays the New Map Wizard - Output Format dialog box.
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How to Create a System Import Map

(Contd)
Sep

Action

6

From the Create a new dataformat list, select Positional and click Next.

Note
The system actually ignores the Output side of the map and only
processes the Input side.

Click Finish to create the new system import map (this may take afew
seconds).

System response
The system displays the new map in the Sterling Gentran:Server -
Application Integration Window.

After creating the system import map, you need to define the header
record for the system import map. You can use either asix-field key (this
is the preferred method) or the alternate key method.

Reference
Continue with How to Define the Sx-Field Key on page 4 - 8.

Application Integration User Guide
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How to Definethe Six-Field Key

Introduction To use the preferred method of building the system import key, you need to define at |east
five fields for the header record (partner key, standard, version, transaction, and test/
production status). If itisa TRADACOMS map, you must also define arelease field.
Thesefields do not have to be in any order or sequence, but they must be part of the header
record.

If you want to also define the other fields that the corresponding import map header record
contains, you can do so at thistime.

Reference
» SeeHowto Create the First Record on page 2 - 54 for more information.

» SeeHowto Create Fields on page 2 - 64 for more information.

After definingthe  Once you define the header record and fields, you can set up the mapping operations that
key  definesthe key that the translator uses to find the partner relationship.

Procedure: Use this procedure to define the partner key.
defining the
partner key

Sep Action

1 Double-click the partner key field.

System response
The system displays the Field Properties dialog box (Name tab).

2 Select the Standard Rule tab to access standard rule options.

3 From the standard rule list, choose Select.
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(Contd)
Sep Action
4 From the table and key list, select Partner by EDI Code, Partner by
Alternate code, or Partner by Partner Key.
Note
Thisindicates that the system updates this field with the indicated
partner key.
System response
Thisis an example how the Standard Rule tab of the Field Properties
dialog box should look.
Field Properties
Mame I Validationl F'ositionl Extended Fule  Standard Rule IEonditionsl
Fleaze select the standard rule to use : ISeIect j
Please chooze the table and key [or group] to uze when selecting data :
IPartner by ED code j
Elease enter the name af the: suts-tatile to wee (it approprate] ¢
™ Raise a compliance ermor if matching data i not found
‘f'ou cah map the data that was selected. Click on data in the left list then click the
fieldz in the right list that pou would like it to be mapped to. Repeat to map more data.
Mame FARTHER_ID Partrer [dentifier
Edi Code STaMDARD Standard
Alternate Code WERSIOM “ersion
TRAMSACTION_SET Tranzaction Set
TEST_PROD Test/Praduction Flag
Cancel I Sl | Help |
5 Click OK to add the standard rule to the partner key field.

Procedure: Use this procedure to define the EDI standard field.
defining the
standard field

Sep Action

1 Double-click the standard field.

System response
The system displays the Field Properties dialog box (Name tab).

2 Select the Standard Rule tab to access standard rule options.

3 From the standard rule list, choose Update.
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(Contd)
Sep Action

4 From the table list, choose Document record.

Note

Thisindicates that you are updating the document record in the Sterling
Gentran: Server internal system buffer (because the translator is not
mapping data at this point in the process).

5 From the column list, choose Agency.

Note
Thisindicates that you are updating the agency (standard) field in the
system buffer.

System response
Thisis an example how the Standard Rule tab of the Field Properties
dialog box should look.

Field Properties

M ame I Validationl F'ositionl Exterded Fule  Standard Rule I Eonditionsl

Fleaze select the standard rule to uge : IUpdate j

Flease zelect the table [or group) to update :
I Drocument record j

Flease zelect the column [or field] to update :

IAgency j

Cancel | Al | Help |

6 Click OK to add the standard rule to the standard field.

Procedure: Use this procedure to define the version.
defining the
version field

Sep Action

1 Double-click the version field.

System response
The system displays the Field Properties dialog box (Name tab).

2 Select the Standard Rule tab to access standard rule options.

3 From the standard rule list, choose Update.
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(Contd)
Sep Action

4 From the table list, choose Document record.

Note

Thisindicates that you are updating the document record in the Sterling
Gentran: Server internal system buffer (because the translator is not
mapping data at this point in the process).

5 From the column list, choose Version.

Note
Thisindicates that you are updating the version field in the system
buffer.

System response
Thisis an example how the Standard Rule tab of the Field Properties
dialog box should look.

Field Properties

M ame I Validationl F'ositionl Exterded Fule  Standard Rule I Eonditionsl

Fleaze select the standard rule to uge : IUpdate j

Flease zelect the table [or group) to update :
I Drocument record j

Flease zelect the column [or field] to update :

IVersion j

Cancel | Al | Help |

6 Click OK to add the standard rule to the version field.

Procedure: Use this procedure to define the transaction set (document).
defining the
transaction field

Sep Action

1 Double-click the transaction set field.

System response
The system displays the Field Properties dialog box (Name tab).

2 Select the Standard Rule tab to access standard rule options.

3 From the standard rule list, choose Update.
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Setting Up the Import Process

(Contd)
Sep

Action

4

From the table list, choose Document record.

Note

Thisindicates that you are updating the document record in the Sterling
Gentran: Server internal system buffer (because the translator is not
mapping data at this point in the process).

From the column list, choose Transaction Set ID.

Note
Thisindicates that you are updating the transaction set field in the
system buffer.

System response
Thisis an example how the Standard Rule tab of the Field Properties
dialog box should look.

Field Properties %]

Warme I Validationl Positionl Extended Fule  Standard Rule | Eonditionsl

Fleaze zelect the standard rule to use IUpdate j

Flease zelect the table (or group) to update :
I Document record j

Fleaze zelect the column [or field] to update :
I Tranzaction Set |D ﬂ

Cancel | Lopi I Help |

Click OK to add the standard rule to the transaction set field.

Procedure: Use this procedure to define the release of the selected standard version (TRADACOMS

definingthe  only).
release field

Step

Action

1

Double-click the release field.

System response
The system displays the Field Properties dialog box (Name tab).
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How to Define the Six-Field Key

(Contd)
Sep

Action

2

Select the Standard Rule tab to access standard rule options.

3

From the standard rule list, choose Update.

From the table list, choose Document record.

Note

Thisindicates that you are updating the document record in the Sterling
Gentran: Server internal system buffer (because the translator is not
mapping data at this point in the process).

From the column list, choose Release.

Note
Thisindicates that you are updating the release field in the system
buffer.

System response
Thisis an example how the Standard Rule tab of the Field Properties
dialog box should look.

Field Properties %]

Warme I Validationl Positionl Extended Fule  Standard Rule | Eonditionsl

Fleaze zelect the standard rule to use IUpdate j

Flease zelect the table (or group) to update :
I Document record j

Fleaze zelect the column [or field] to update :

I Relzaze ﬂ

Cancel | Lopi I Help |

Click OK to add the standard rule to the release field.
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Procedure: Use this procedure to define the test or production status field.
defining the test/ .
production field Step Action

1 Double-click the test or production field.

System response
The system displays the Field Properties dialog box (Name tab).

2 Select the Standard Rule tab to access standard rule options.
3 From the standard rule list, choose Update.
4 From the table list, choose Document record.

Note

Thisindicates that you are updating the document record in the Sterling
Gentran: Server internal system buffer (because the translator is not
mapping data at this point in the process).

5 From the column list, choose Test Mode.

Note
Thisindicates that you are updating the test field in the system buffer.

System response
Thisis an example how the Standard Rule tab of the Field Properties
dialog box should look.

Field Properties %]

Warme I Validationl Positionl Extended Fule  Standard Rule | Eonditionsl

Fleaze zelect the standard rule to use IUpdate j

Flease zelect the table (or group) to update :
I Document record j

Fleaze zelect the column [or field] to update :
I Test Mode ﬂ

Cancel | Lopi I Help

6 Click OK to add the standard rule to the test field.
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How to Definethe Alternate Key

I ntroduction

After defining the
key

Procedure:
defining the
partner key

To use the alternate key method of building the system import key (formerly referred to as
the three-key method), you need to define (create new or update existing) three or four
fields for the header record. You must define afield for partner key, afield for either one
or both application ID and application alias value (you only need to use one of these two
fields), and afield for test/production status. If you define all four fields, you are using the
alternate key method; if you use only one of the application ID or application alias value
fields, you are actually using athree-field key. These fields do not have to be in any order
or sequence, but they must be part of the header record.

Tip
You do not have to define new fields to use this key. You can add the necessary standard

rulesto three fields that already exist in your application file.

If you want to also define the other fields that the corresponding import map header record

contains, you can do so at thistime.

Tip

» SeeHowto Create the First Record on page 2 - 54 for more information on how to
define the header record.

» SeeHowto Create Fields on page 2 - 64 for more information on how to define the
fieldsin the record.

Once you define the header record and fields, you can set up the mapping operations that
defines the key that the translator uses to find the partner relationship.

Use this procedure to define the partner key.

Sep Action

1 Double-click the partner key field.

System response
The system displays the Field Properties dialog box (Name tab).

2 Select the Standard Rule tab to access standard rule options.

3 From the standard rule list, choose Select.
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(Contd)
Sep Action

4 From the table and key list, select Partner by EDI Code, Partner by
Alternate code, or Partner by Partner Key.

Note
Thisindicates that the system updates this field with the indicated
partner key.

System response
Thisis an example how the Standard Rule tab of the Field Properties
dialog box should look.

Field Properties %]

Warme I Validationl Positionl Extended Fule  Standard Rule | Eonditionsl

Please select the standard rule to use : ISeIect j

Please chooze the table and key [or group) to uge when selecting data :
IPartner by EDI code j
Eleaze ententhe name of the sub-atle o use i appropnate]

™ Raise a compliance erar if matching data is nat found

*f'ou can map the data that was selected. Click on data in the left list then click the
fields i the right lizt that you would like it to be mapped ta. Repeat ta map mare data.

Mame FARTHER_ID Partrer |dentifier

EdiCode STANDARD Standard

Alternate Code YERSION Yersion
TRAMSACTION_SET Transaction Set
TEST_PROD Test/Production Flag

Cancel | Lopi I Help |

5 Click OK to add the standard rule to the partner key field.

Procedure: Use this procedure to define the application ID field.
defining the

application 1D Note

fidld You must define either the application ID field or the Application Alias Value field (three-
: field key). You may define both of these fieldsif you wish to use the aternate key method.

Sep Action

1 Double-click the application ID field.

System response
The system displays the Field Properties dialog box (Name tab).

2 Select the Standard Rule tab to access standard rule options.

3 From the standard rule list, choose Update.
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(Contd)
Sep Action
4 From the table list, choose Document record.
Note
Thisindicates that you are updating the document record in the Sterling
Gentran: Server internal system buffer (because the translator is not
mapping data at this point in the process).
5 From the column list, choose Application Field 1.
Note
Thisindicates that you are updating an optional key field in the system
buffer.
System response
Thisis an example how the Standard Rule tab of the Field Properties
dialog box should look.
Field Properties
MHame I \-"alidationl Positionl Extended Fule  Standard Rule I Eonditionsl
Fleaze zelect the standard rule to uze IUpdate ﬂ
Fleaze select the table [or group] to update :
IDocument record j
Pleaze select the column [or field) to update :
| Application Field 1 =l
Cancel | Aol | Help |
6 Click OK to add the standard rule to the application ID field.
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Setting Up the Import Process

Procedure: Use this procedure to define the application alias value field.

defining the
application alias
valuefield

Note

You must define either the application ID field or the Application Alias Value field (three-
field key). You may define both of these fields if you wish to use the aternate key method.

Sep

Action

1

Double-click the application aias value field.

System response
The system displays the Field Properties dialog box (Name tab).

Select the Standard Rule tab to access standard rule options.

From the standard rule list, choose Update.

From the table list, choose Document record.

Note

Thisindicates that you are updating the document record in the Sterling
Gentran: Server internal system buffer (because the translator is not
mapping data at this point in the process).

From the column list, choose Application Field 2.

Note
Thisindicates that you are updating an optional key field in the system
buffer.

System response
Thisis an example how the Standard Rule tab of the Field Properties
dialog box should look.

Field Properties E

Mame I Validationl Positionl Exterded Fule  Standard Rule | Conditionsl

Flease zelect the gtandard rule to uze IUpdate j

Fleaze select the table [or group] to update
I Document recard j

Pleaze select the column [or field] to update :
| Application Field 2 =l

Cancel | Lpply | Help |

Click OK to add the standard rule to the application alias value field.
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Procedure: If you do not define the test/production status field, the document record is set to
defining thetest/  production by default. In this situation, the system translation object can only locate the
production field  correct relationship if the test mode of the partner relationship isactually set to production.

Recommendation
Define the test/production status field.

Use this procedure to define the test/production status field:

Sep Action

1 Double-click the test or production field.

System response
The system displays the Field Properties dialog box (Name tab).

2 Select the Standard Rule tab to access standard rule options.
3 From the standard rule list, choose Update.
4 From the table list, choose Document record.

Note

Thisindicates that you are updating the document record in the Sterling
Gentran: Server internal system buffer (because the translator is not
mapping data at this point in the process).

5 From the column list, choose Test Mode.

Note
Thisindicates that you are updating the test field in the system buffer.

System response
Thisis an example how the Standard Rule tab of the Field Properties
dialog box should look.

Field Properties

Name | Validation | Position | Estended Rule  Standard Rule | Canditions |

Fleaze select the standard rule to uze IUpdate j

Flease select the table [or group] to update :
IDocument record j

Fleaze select the column [or field) to update :

ITest Mode j

Cancel | Sl | Help |

6 Click OK to add the standard rule to the test field.
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How to Compilethe System Import Translation Object

Introduction After you create, define, and save the system import map, you need to compile the map
and create a system import translation object.

Procedure  Usethis procedure to generate the system import translation object.

Sep Action

1 From the File menu, select Compile.

System response
The system displays the Run-time Translation Object Name dialog box.

2 In the File name box, type the name of the translation object, if
necessary.

Warning

Be very careful not to overlay the source map with the compiled
tranglation object. Usethe .TPL file extension to distinguish the
trand ation object.

3 From the Save in list, change the Drive and Folder where the compiled
tranglation object is stored, if necessary

4 Click Save.

System response
The system compiles the map and creates the system import translation
object.

5 The translation object must registered with the Sterling Gentran: Server
system before you can useiit.

Reference

See How to Register a New Translation Object in the IBM® Serling
Gentran: Server® for Microsoft Windows User Guide for information on
registering atranslation object.

6 If your system administrator has not already added this system import
translation object to the System Configuration program, do so now.

Reference

See How to Edit an Import Specification in the IBM® Serling

Gentran: Server® for Microsoft Windows Administration Guide for more
information.
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Overview

Introduction To trandlate inbound data, you need to create an export map in Sterling Gentran: Server
(because the system is exporting to your application fil€).

Export map  The export map defines how to move data from the EDI standard-formatted documents
that your partners send you to your application file (flat file definition). This map also
enables you to populate your application file fields with supplementary information from
the interchange, group, and transaction set envel opes.

Inthischapter  Thischapter explains how to set up the export process, including the following topics:
» Inbound process prior to exporting data
» Using supplementary envelope information
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Inbound Process Prior to Exporting Data

Introduction During the export process, the Communicator receives interchanges from your trading
partners via a network and passes the interchanges to the translator. The translator uses a
system interchange break translation object (shipped with Sterling Gentran:Server) to
unwrap the interchange envel opes and separate each group into temporary storage. The
tranglator uses a system group break translation object (shipped with Sterling
Gentran: Server) to unwrap the group envel opes and separate each transaction set into
temporary storage. The translator uses a system transaction break translation object
(shipped with Sterling Gentran:Server) to unwrap the transaction envel opes and separate
each document into the 2ln Documents in Sterling Gentran: Server.

Locatingtrading  Thetrandator attempts to locate the trading relationship for each document. If atrading
relationships  relationship islocated, the translator then attempts to identify the export, document

turnaround, or print translation object associated with that relationship. If the trandator
does not locate the trading relationship or tranglation object, the document staysin the ?2in
Documents. If the translator does locate a trading relationship and tranglation object, it
uses that tranglation object to compliance check the document. If the document is not
compliant with the EDI standard, it staysin the ?2ln Documents. If the document is
compliant with the EDI standard, the translator movesit to the In Documents. From the In
Documents, you can print (if there is an associated print translation object), or export valid
documents.

Generating acks  If you specify (in the trading rel ationship) that the system needs to generate a functional
acknowledgement (ack) for a document, the trandlator uses the system acknowledgement
translation object (shipped with Sterling Gentran: Server) to generate the
acknowledgement. If the generated acknowledgement was compliant, the translator moves
the acknowledgement to the Out Documents to be sent to the trading partner. If the
generated acknowledgement was not compliant or if an error occurred with the
acknowledgement trandlation object, the translator moves the acknowledgement to the
?20ut Documents.

Automatic export If you specified either automatic export or automatic turnaround in the trading
relationship, the translator uses the specified export or document turnaround tranglation
object to either export or generate the appropriate response document.
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Procedure  Usethis procedure to set up the export process.

Sep Action

1 Create an export map.

Reference
See How to Create a New Map on page 2 - 20 for more information on
how to create a new map.

2 Register the export map with Sterling Gentran: Server.

Reference

See How to Register a New Translation Object in the IBM® Serling
Gentran: Server® for Microsoft Windows User Guide for more
information on registering a translation object.

3 Create the appropriate inbound trading relationship.

Reference

See How to Create a New Inbound Relationship in the IBM® Serling
Gentran: Server® for Microsoft Windows User Guide for more
information on creating an inbound relationship.
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How to Use Supplementary Envelope Infor mation

Introduction The Sterling Gentran: Server Application Integration subsystem enables you to use a
Select standard rule to populate your application file fields (in an export map) with
information from the EDI envel opes associated with the documents your trading partner
sends you.

Thistablelists the correspondence between the sel ections available for the Select standard
rule and the envel ope information that you want to map to your application field.

I F you select this

value from the Map

from list... THEN the system maps thisinfor mation...
Field 1 Transaction Set ID

Field 2 Document Name

Field3 Group ID

Field 5 Partner Name

Field 6 Interchange Control Number
Field7 Group Control Number
Field 8 Document Control Number
Field9 Received Version

Field 15 Received Agency

Field 16 Used Agency

Field 17 Used Version

Field 22 |SA Test Mode

Field 23 Document Test Mode
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Procedure  Usethis procedure to use supplementary envelope information in your application file.

Sep Action
1 Double-click an existing application field or create a new field.
Reference
See Using a Fixed-Format File on page 2 - 51 for more information on
creating fields.

System response
The system displays the Field Properties dialog box (Name tab).

2 Select the Standard Rule tab to access standard rule options.

3 From the standard rule list, choose Select.

4 From the table and key list, select Generic envelope segment.
Note

This enables you to map from any of the fields within the current
envelope information, regardless of the EDI standard used.

5 Select the compliance error check box.

Note
Thisindicates that a compliance error should be generated if the select
does not find avalid entry.

6 From the map from list, choose the envel ope information that you want
to map to your application field.

Note
See the table on the previous page for selection definitions.

Warning

Verify that you select the correct map from selection. Any selection that
isnot listed in the above tableis currently reserved and should not be
selected under any circumstances.

7 From the map to list, choose the field to which you want to map the
contents of the Map From field.

Note
The system displays each field from the output side of the map in this
list.

8 If you want to map additional envelope information, repeated steps 7
and 8 as many times as necessary.

Note
A total of eight fields can be mapped using one Select rule.

9 Click OK to add the standard rule to the application field.
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Using Extended Rules

|ntroducing Extended Rules

Overview

In thischapter

What are extended
rules?

Uses of extended
rules

What comprisesan
extended rule?

This chapter explains how to use extended rules, including the following topics:
» What rules are and when they are processed

» Defining extended rules

» Extended rule syntax

» Alphabetic language reference guide

Extended rules enable you to use a Sterling Gentran: Server proprietary programming
language to perform virtually any mapping operation you require.

You can use these rules to define more complex trangl ations than are available through the
link function (simple mapping) and standard rules. You can use extended rules to define
operations that are not possible using standard rules.

You define extended rules with the Sterling Gentran:Server proprietary programming
language. Thisisafull programming language that gives you access to the entire Sterling
Gentran: Server internal storage area.

Any variablesthat are not already defined as part of theinput or output specification of the
map, that you usein arule must be declared before you use those variables.

Therefore, an extended rule consists of two sections, a declarations section followed by a
statements section.

The declarations section is only required if you use additional variables. Thisiswhereyou
declare the names and types of any variables you use either in thisrule or in any other rule
that iswithin the scope of thisrule.

The statements section is where you define the actions that you want the rule to execute.
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Declar ations and I nitialization

I ntroduction

Supported data
types

Declarations and Initialization

The variables that you define in the declarations section are used to store values. Variables
consist of aname and a data type. Variable names can include al phanumeric characters
and the colon (:) and underscore (_). The first character in a variables name may not be a

numeric. All variable names are case-sensitive.

Note

» A declaration must be terminated with a semicolon (;). To improve readability, you
typically include a blank link in between the declaration and statement sections.

» The Trandator does not initialize extended rule variables. You must initialize all
variables after declaring them. Variables that are not initialized can cause incorrect

results or trandlation failures.

This table describes data types that are supported by extended rules.
Data Type Description Example
Integer awhole number withno | Declarei asan integer and initialize.
decimal component.
integer i; //Declaration
i=0; /lInitialization of ‘i’
Real awhole number that Declarer asarea number and initialize.
may have adecimal
component. real r; /[Declaration
r=0; [nitialization of ‘r’
String contains one or more Declare s as a 20-character string and initialize.
printable characters.
string[20] s; //Declaration
s=""; [Initialization of ‘s
Datetime | containsadate or time. | Declared as adate or time and initialize.
datetimed,; //Declaration
d =date(0,0,0); //nitialization of ‘d’

Application Integration User Guide
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Data Type Description Example
Array defines atable of Declare a as an array of 10 integers and initialize.
multiple occurrences of
asingle datatype. integer a[10]; //Declaration
integer i; /[Declaration of ‘i’, which is
/lused toinitializearray ‘a’
i=1; [lInitialization of ‘i’

[Initialization of thevariablearray ‘a’
whilei <11 do
begin
afi] =0;
i=i+1
end

Declare p asan array of 50 10-character strings and
initialize.

string[10] p[50]; //Declaration

integer i; /[Declaration of ‘i’, which is
/lused toinitializearray ‘p’
i=1; /I nitialization of ‘i’

[lInitialization of thevariablearray ‘p’
whilei <51 do
begin
plil ="
i=i+1
end

Object isused for user exits; it | Declare ob as an object and initialize.
exposes the internal
functions of an ActiveX | object ob; //Declaration

Automation Server to ob = CreateObject(* ADODB.Connections’);
Sterling Gentran: Server. /I nitialization of ‘ob’
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Satements

Introduction The actual work performed by an extended rule is defined in the statements section. A rule
consists of a statement or a combination of statements (to perform more complex
operations). A statement is a single operation that consists of a combination of
expressions, keywords, commands, operators, and symbols.

What isan  Anexpressionisalogical unit (e.g., A =B or A + B) that the system evaluates. The
expression?  statements section consists of a sensible combination of keywords, operators, and
symbols.

Reference
Each of these componentsis explained in detail in Extended Rule Syntax on page 6 - 17.
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When Extended Rules are Processed

I ntroduction

L evels of extended
rules

Scope

You can specify pre- and post-session rules on the Session Rules dialog box. Pre-session
extended rules are processed before the trandation object, and are in scope for every
extended rule defined in the translation object. Post-session rules are executed after the
trandlation object is processed.

You can attach extended rules to three different levels of map components:
» EDI fileand application file groups, using the Loop Level Extended Rules dialog box.

»  Groups, sub-groups, repeating records, and repeating segments, using the Loop Level
Extended Rule dialog box.

» Fieldsand elements, using the Field Level Extended Rule dialog box.

The scope of an extended rule determines which variables are accessible from within a
given extended rule. The scope varies depending on the current state of the map. Thislist
defines the scope of an extended rule.

» Pre-session extended rules (defined on the Session Rules dialog box) are in scope for
every rulein the translation object.

» On Begin extended rules (defined on the Loop Level Extended Rules dialog box) are
in scope until the conclusion of its companion On End rule (also defined on the Loop
Level Extended Rules dialog box).

» Fieldlevel extended rules are only in scope for the duration of the field or element.

An extended rule attached to the current map component depends on the type and state of
the map component.

Example

If acurrent group to which the ruleis attached is subordinate to another group, the parent
group is automatically in scope for the duration of the entire child group, and the current

hierarchical structureisalso in scope for the duration of the child by using an addressing

method that is explained on 6 - 21.

An extended rule that is attached to afield or element is only in scope for the duration of
the field or element. Field level extended rules are always processed after standard rules.

A variableis considered to be “in scope” if it was declared in the current rule, in the On
Begin rule of agroup that contains the current map component, or in the Pre-Session rule.

The translator builds the data storage area for a map based on the structure of the Input
side of the map (the source side of the map). Therefore, extended rules address the map
based on the hierarchy of the Input side. When you use extended rules, you must be
careful to always address the Input side of the map so the translator can locate the map
component that the rule accesses. On the Output side of a map, extended rules only have
access to the current record and the entire Input side of the map. However, from the Input
side of amap, you have access to the entire file structure. Aslong as you address the
source end of alink, you can write to any field on the Output side, even fields that have
aready been written.
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When Extended Rules are Processed

Input rule  Thetranslator processes the Input side of the map first and then the Output side. Thistable
processing liststhe sequence of how the translator processes rules on the Input side of a map.

Sep Action

1 Load the Input definition.

2 Read the Input file.

3 Determine if datais present for the first/next group and then run the
group On_Beginrule, if present.

4 Load each field within the first/next record within the current group and
then execute field level rules (for each field) in the following sequence:
» standard rules
» extended rules

5 At the end of the group, execute the On_End rule, if present.

6 Repeat steps 2 - 5 for each group in the Input file.

Application Integration User Guide
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Output rule  Thistable lists the sequence of how the translator processes rules on the Output side of a
processing  map.

Sep Action
1 Verify whether or not data exists for the first/next record.
2 If the record isthe first record of agroup, run On_Begin rule, if present.
3 For each field in the record, execute field level rules (for each field) in

the following sequence:
» Runstandard rules
» Runextended rules

4 Format data according to specified field properties (on Field Properties
dialog box).

5 Write the record to the Output file.

6 At the end of the group, execute On_End rule, if present.

7 Repeat steps 1 - 6 for each record in the Output file.

8 Create or update the document entry in the database.

Sterling Gentran:Server — May 2011 Application Integration User Guide



When Extended Rules are Processed

Using Extended Rules

This diagram illustrates when loop level (On Begin and On End) extended rules and field

level extended rules are processed in relation to the system process flow.

Rule processing

diagram
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Defining Extended Rules

Overview

Introduction The map component that an extended rule accesses depends on what you want the scope
of the rule to be. You also need to determine when you want the rule to be executed (e.g.,
before or after the map component is processed.

The process you need to follow to define an extended rule varies dightly, depending on
whether you are defining a session rule or arule for amap component. You can define
extended rules to access three different levels of map components.

» theentiresession (input and output sides of the map)
» looping map components (groups, segments, etc.)
» fields
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How to Define a Session Rule

Introduction Pre-session rules are used to define variables that must have global scope (can be accessed
from any other extended rule in the map). Pre-session extended rules are processed before
the trandlation object, and are in scope for every extended rule defined in the translation

object.

Post-session rules are executed after the trandation object is processed and thus have no
permanent scope.

You can define both a Pre-session and a Post-session rule for a given session.

Procedure  Usethis procedure to define asession rule.

Sep

Action

From the Edit menu, select Session Rules.

System response
The system displays the Session Level Extended Rules dialog box.

Do you want to define a pre-session rule?
» If yes, click the Pre-session option.

» If no (you want to define a Post-session rule), click the Post-session
option.

In the Editor list, type the extended rule.

Note

The Session Level Extended Rules dialog box contains line and
character number (within aline) indicators. These indicators, which are
displayed to the lower right of the Editor box (the first indicator
references the line number and the second references the character
number), enable you to easily debug compile errors.

Do you want to check the rule for errors?
» If yes, click Compileto compile the extended rule.

System response
Any warningsor errors are displayed in the Errorslist. Double-click
an error to instantly navigate to the line containing the error.

» If no, continue with step 6.

Note

The Compile function gives you immediate feedback about the accuracy
of your rule. Therule is compiled when you compile the entire
trandation object.

Application Integration User Guide
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Using Extended Rules

(Contd)
Sep Action
5 Correct any errors that the system flagged and click Compile again.
Note
Repeat this process until there are no errors generated.
6 Click OK to add the extended rule.

Sterling Gentran:Server — May 2011

Application Integration User Guide



Using Extended Rules

How to Define a Map Component Rule

How to Definea Map Component Rule

Procedure  Usethis procedure to define an extended rule for amap component.

Sep

Action

Right-click the map component and select Rules (Extended Ruleif the
map component is afield, element, or TFD) from the shortcut menu.

System response

» Thesystem displaysthe Loop Level Extended Rules dialog box if
the map component is an EDI file, application file, group, sub-
group, repeating record, or repeating segment.

» Thesystem displaysthe Field Level Extended Rule dialog box if
the map component isafield or element.

Do you want the extended rule to be executed before the system
processes the map component?

» If yes, select the On Begin option.
» If no (you want the rule to be executed when the system concludes
its processing of that map component), select the On End option.

Note
You can define both an On Begin and an On End rule for the asingle
map component.

In the Editor list, type the extended rule.

Reference
See Alphabetic Language Reference on page 6 - 47 for more
information on rule syntax.

Note

The Extended Rules dialog boxes contain line and character number
(within aline) indicators. These indicators, which are displayed to the
lower right of the Editor box (the first indicator references the line
number and the second references the character number), enable you to
easily debug compile errors.
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(Contd)
Sep Action

4 Do you want to check the rule for errors?
» If yes, click Compileto compile the extended rule.

System response
Any warnings or errors are displayed in the Errorslist. Double-click
an error to instantly navigate to the line containing the error.

» If no, continue with step 6.

Note

The Compilefunction gives you immediate feedback about the accuracy
of your rule. Therule is compiled when you compile the entire

trangl ation object.

5 Correct any errors that the system flagged and click Compile again.

Note
Repeat this process until there are no errors generated.

6 Click OK to add the extended rule.

Note
When an element contains an extended rule a black asterisk appearsto
the right of the element icon.
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Extended Rule Syntax

Overview

Introduction The statements section of an extended rule consists of a sensible combination of

keywords, operators, and symbols. The correct syntax for each of these component is
explained bel ow.

Note

You use spaces and operators to separate keywords and symbols. You cannot string two
keywords sequentially together without an operator.
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Keywords and Commands

Introduction A keyword is afixed defined use of aword that indicates how the programming language
should beinterpreted. There are two types of keywords. Thefirst type of keyword controls
the flow of execution of the defined rule. These keywords are used to evaluate conditions
and perform looping operations.

The second type of keyword is a command. Commands perform actions on variables and
are responsible for the movement of data.

List of keywords  Thisisalist of Sterling Gentran: Server execution control keywords.

IF

THEN
ELSE
BEGIN
END
WHILE

DO
CONTINUE
BREAK

List of commands Thisisalist of Sterling Gentran:Server commands.

AUDITLOG
GET

SET
STRDATE
CONCAT
LEN
ATOI
ATON
CERROR
EMPTY
EXIST
INDEX
NTOA
COUNT)
DELETE
FSEEK
FTELL
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READBLOCK
UNREADBLOCK
READBYTES
LEFT

MID

RIGHT

SELECT
UPDATE
INSERT
WRITEBLOCK
WRITEBYTES
CREATEOBJECT
DELETEOBJECT
QUERY OBJECT
GETIID
WINEXEC
DATE

EXEC

PARAM

Note
A statement must be terminated with a semicolon (;).

Application Integration User Guide
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Operators

Introduction  Operators define the simplest operation in an expression.

List of keywords  Thistable liststhe operators that can be used in extended rules and their functions.

Part Function
+ addition, concatenation
- subtraction
* multiplication
/ division

= assignment, equality

> greater-than

< less-than

>= greater-than or equal to
<= less-than or equal to

I= not equal to

! logical not

& logical and

| logical or

<< date modification
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Symbols

I ntroduction

Symbol syntax

Symbols

Operations are performed on symbols. The symbols that you can use in Sterling
Gentran: Server extended rules are variables, constants, map components/internal storage,
arrays, and accumulators.

You can address existing map components and you also have the ability to create
additional instances of map components, as long as the map component is originally
defined ininternal storage.

Example
You can use this function to create extraline items when one line item field is already
defined ininternal storage.

You must address each type of symbol in the proper syntax.

String constant

To address a string constant, you must enclose the constant value in quotes:
#fieldname = "HDR";

where HDR is the constant value

Addressing or creating a field in internal storage

To address afield or create afield in internal storage, within the scope of the current
mapping action, the syntax is#FIELD_NAME

#ield_1=2;

where 2 isa numeric constant value

Addressing or creating a field in a group

To address afield within agroup or create afield within agroup in internal storage within
the scope of the current hierarchy, the syntax is SGROUP#FIELD_NAME

$N1.#0234
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Symbol syntax ~ Addressing or creating a group in internal storage

(contd.) To fully address a group in the entire internal storage area or create agroup in internal
storage, the syntax is $LOOP[index1][index2][index3] where the index entries indicate
the hierarchical structure of the loop and enable you to address specific instances of a
group:
$Group_C[3][2] #Field_2
where you are specifying the second instance of Group_C within the third instance of
Group_B:

Group A

Group B

Group C

TR

Addressing an array
To address an array (of any type), you address each element of the array individually. For
example, if array_lisan array (of integers) and is declared:

integer array_1[5]

With variables 0 through 4, each element of the array is addressed individually as follows:
array_1J0]

array_1J1]

array_1]2]

array_1[3]

array_1[4]

Accessing an accumulator

An accumulator can be accessed in the same manner as variables or internal storage. To
address an accumulator, use the syntax accum(n) where “n” is the number (not the name)
of the accumulator:

accum(2) =5;
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Symbol syntax
(contd.)

Application Integration User Guide

Symbols

Accessing repeating elements
You can access a specific occurrence of arepeating element (for EDI data) and access a
specific occurrence of afield within a repeating composite (for EDI data).

Thisisthe syntax for accessing a specific occurrence of arepeating field and afield within
arepeating composite.

field_name[index_variable] = string;
integer variable that indicates the

specific occurrence of arepeating field or field
within arepeating composite.

where: integer variable =

Thisis an example of accessing a specific occurrence of arepeating field and afield
within arepeating composite.

#*Gentran Application Integration - [ncp2e —10| =]
éﬁile Edit Functions  Wiew Oplions  Window  Help -2 =l

o e e Wt == [ e e ST ]

- CODE_E1-M- 1 =1 =
HEADER -C - 1 [
i f1-rv|-smngz.ﬂ]

gmﬂmmm -C- 1PATIEN

02f2-M- 105king 10 @
repeat - M - 10 B
03f3-C-Sking 10 @
044 -C-Sking 10 @
05f5-C-Shing 10 @

En

L b

-
3 4

4 |

For Help, press F1

string [32]strMsg;

strMsg = "Test";
#f2[ 1] = strMsg;
/laccess single repeating field

#f3[1] = strMsg;

/laccess a field within a repeating conposite

/1 The rule assigns a string value to 2 different fields, which are
/1displayed in the diagram above, #f2 and #f3 -- #f2 is a single
/lrepeating field that can loop up to 10 times and #f3 is a field
//within a repeating conposite where the conposite can loop up to
/110 tinmes.
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Exampleof a  Thisdiagram illustrates an example of a simple statement.
simple statement

I THE
: $Group_Name.#Field_Name| ?#Field_Namelz;
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Common Statements and Examples

Overview

Overview

Introduction  This section lists examples of some of the common statements.

assignment

datetime expressions
conditional logic

string conditions and functions
numerical functions

raise compliance error function
remove field value function
existence of data function

Application Integration User Guide
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Assignment

Introduction The assignment statement is the most powerful and most often used extended rule
statement. In the most simple form, it is written as follows:

variable=expression

However, you can use this statement in more flexible and complex ways, defined as
follows:

numeric_variable=numeric_expression
numeric_field=numeric_expression
string_variable=string_expression
string_field=string_expression
datetime_variable=datetime_expression
datetime_field=datetime_expression

Numeric A numeric expression can consist of numbers, numeric fields, numeric variables, and
expression numeric functions combined with the standard arithmetic operators.

Sring expression A string expression can consist of string constants, string fields, string variables, and
string functions concatenated with the “+” operator.

Datetime A datetime expression can consist of a datetime constant, datetime field or datetime
expression  variable.

Examples  Some examples of assignment expressions are as follows:

a = b5;

a=>b + c

s = "hello";

s =s + "world";
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Datetime Expressions

Datetime Expressions

I ntroduction

Date syntax

<< operator

Time syntax

Datetime expressions consist of a datetime variable and (optionally) datetime modifiers.
Datetime expressions can be written using datetime constantsif you are using the standard
syntax, as follows:

year/ nont h/ day
hour: m nut e: second
year/ nont h/ day/ hour : m nut e: second

Datetime expressions can also be written with datetime fields, variables, or using date and
time functions.

Date functions are written as follows (month specified as 1-12):
datetine d;
d

d
d

dat e( 1995, 4, 6) ;
dat e( 1995, 4, 6,12, 0);
dat e(" %/ % %d", "95/4/6");

Thed =date(" %y/% m/%d", " 95/4/6" ); format enables you to convert any string format
type into adatetime format type by indicating aformat mask (" %y/% m/%d" ) along with
the string (" 01/4/6") you want to convert. You use this function if you are using non-
standard syntax and need to specify the syntax you are using.

You can use the << operator to modify your datetime variable by adding time increments
(e.g., days, weeks, years). For example:

datetine d;
d=d <<weeks(2);
/1 This adds 2 weeks to d.

Time functions are written as follows:

d = time(12,0);
d = time(12,0,59);

You can use the << operator to modify your datetime variable by adding time increments
(e.g., seconds, minutes, years). For example:
datetine d;

d=d <<seconds(1);
/1 This adds 1 second to d.
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Get and set syntax ~ Theget and set functions enable you to access (get) or modify (set) individua components
of adatetime type. These functions are used as follows:

i nteger a;
datetine d;

a = get days (d);
a = get hours (d);
set hours(d, a);
set days (d, a);
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Conditional Logic

Introduction Sterling Gentran: Server uses conditional logic to test conditions and then, depending on
the results of the test, perform different operations. Conditions can be nested to any level.
Do not end conditions with a semicolon (;) — thisterminating syntax is necessary for
statements only.

IF..THEN...  YoucanusethelFFTHEN keywords to execute one or more statements conditionally. The
ELSE condition istypically acomparison, but it can be any expression that concludes with a
numeric value. Sterling Gentran: Server interprets the value as either true or false. The
system interprets a zero value as false and a nonzero value as true.

Note

If you include more than one statement in the body of an IF/THEN loop, you must
surround the statements with the BEGIN/END keywords. If you only use asingle
statement, you can omit the BEGIN and END.

Sterling Gentran:Server evaluates the IF/THEN condition, and if it is true, the system
executes all the statements that follow the THEN keyword. If the condition isfalse, none
of the statements following THEN are executed.

You can use the EL SE keyword in conjunction with IF/THEN to define several blocks of
statements, one of which is executed. Sterling Gentran:Server tests the first IF/ THEN
condition. If the condition is false, the system proceeds to test each sequential condition
until it finds one that istrue. The system executes the corresponding block of statements
for the true condition. If none of the IFFTHEN conditions are true, the system executes the
statements following the EL SE keyword.

Syntax
I F condition THEN
BEG N
statenent 1;
st at ement 2;
END
ELSE
BEG N
st at ement 3;
st at enent 4;
END
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Example

Using Extended Rules

An example of when you may use conditional logic isif you need to evaluate whether an

N1 or NAD group contains billing or shipping information (this depends on the qualifier
that afield in the group contains), and then map that information to the appropriate

application fields.

For this example, you need to add an On End extended rule to the NI/NAD. Theruleis
executed when the group terminates. An example of the syntax of the rule follows:

I F #0098 =
BEG N

"BT" THEN

$G oup_Nane. #BI LLTONAME = #0093;

$G oup_Nane.

#Bl LLTOADDRL = #0166,

$G oup_Nane. #Bl LLTOADDR2 = #0166: 2;

$Gr oup_Name. #BI LLTOCI TY

= #0019;

$G oup_Nane. #BlI LLTOSTATE = #0156;

$G oup_Nane.
END
| F #0098 = " ST"
BEG N

$G oup_Narme.
$G oup_Nane.
$G oup_Nane.
$G oup_Nane.
$G oup_Nane.
$G oup_Nane.

END

#Bl LLTOPCODE = #0116,

THEN

#SH PTONAME = #0093;

#SHI PTOADDRL = #0166;
#SHI PTOADDR2 = #0166: 2,
#SHI PTOCI TY = #0019;
#SHI PTOSTATE = #0156,
#SHI PTOPCODE = #0116,
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Sring Conditions and Functions

Introduction You can use string conditionsin IF/THEN and IF/THEN/EL SE statements to perform
comparisons between strings. Examples of the syntax are as follows:

IF s1 = s2 THEN
IF s1 < s2 THEN
IF sl > s2 THEN

The following string functions are also available for you to use:

» left

» right

» mid

» strdate
» concat
» strstr

Left, right, mid  Theleft, right, and mid functions enable you to extract substrings from a string. The left
syntax  function extracts a specified number of characters from the Ieft of the string variable or
field and returns the result as a string. The right function extracts a specified number of
character from the right of the string variable and returns the result as a string. The mid
function extracts from a specified position in the string to the right, for a specified number
of characters. Thisis an example of how the statements are used.

string[10] s;
string[3] si;
string[3] s2;
string[4] sS3;
string[7] s4;

s = "abcdefghij"

sl = left(s,3);
s2 = right(s,3);
s3 = md(s, 3,4);

Srdatesyntax  The strdate function converts a datetime type into a string using aformat that you specify.
This function allows you to include static characters such as a slash (/), which gives you
accessto full date support.

Syntax
datetine d;
string[8] s;

strdate(d, "%/ % %", s);
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Concat syntax  The concat function concatenates a specified number of characters from one string onto
the end of another string. The following example demonstrates the syntax to concatenate
five characters from string “s2” onto the end of string “s1”

string[10] s1,s2;
concat (s1,s2,5);

Srstr syntax  The strstr function finds a substring inside a string. This function returns the position of
the first instance of the designated substring. If this function does not find the specified
substring inside the string, it returns avalue of -1.

Syntax
i nteger d,

d = strstr("hello", "el");
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Numerical Functions

Introduction The numerical functions enable you to convert one data type to another. The numerical
functions that are available for you to use are the following:

» len
» &oi
» aton
» ntoa

Len syntax  Thelen function counts and returns the number of charactersin astring.

Example
i nteger a;
a = len("hello");

Atoi, aton, ntoa The atoi function converts stringsinto integers.

syntax
The aton function converts string into real numbers.

The ntoa function converts integers and real numbers into strings.

Example
i nteger a;
real b;

string[ 8]
a = atoi ("
b = aton("
ntoa(5.5, s

aaon

- 7 e

-~
-
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Raise Compliance Error Function (CERROR)

Introduction The cerror function raises a compliance error and reports the target statement (the
statement you specify) on the trandation report.

Syntax
cerror (100, $I LD 0] [ 1] [ 1] . #VATO);

The above example raises compliance error 100 on the VATC element of the specified
instance of the ILD group. You typically specify this function as a action to be performed
if acondition isfalse.

Sterling Gentran:Server — May 2011 Application Integration User Guide



Using Extended Rules Remove Field Value Function (EMPTY)

Remove Field Value Function (EMPTY)

Introduction The empty function sets the value of afield in internal storage to null. Thisfunction is not
the same as setting the value of afield to a zero length string (" ") or to zero.

Syntax
empty($I LD 0] [ 1] [1] . #VATO);

The above example sets the value of the specified instance of the VATC element to null.
Thisfunction istypically used to prevent output to the specified field.
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Existence of Data Function (EXIST)

Introduction The exist function tests to determine if afield is empty (null). It returns a non-zero (true)
valueif thereisdatain a specified field in internal storage. If datais not present in the
specified field, this function returns a zero (false) value. This function istypically used as
apart of acondition.

Syntax
I F exist($ILD{0][1][1].#VATC) THEN

The above example returns a non-zero value if the condition istrue (datais present in the
specified instance of the VATC element). A zero value isreturned if the condition is false
(no datais present in the specified instance of the VATC element).

There are some situations when the IF EXIST returns anon-zero (true) value whether or
not the condition is true. You can work around this by only using IF EXIST for date- and
number-type fields. Be certain that all references to the field which isinterrogated are

nested within the IF EXIST begin block. For string-type fields, use the following format:

IF Fieldl = " "
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Count Function (COUNT)

Introduction The count function returns the total number of times a group (or repeating record) has
iterated.

Syntax
count ( GROUPNAMVE] 3] [*]) ;

The above example returns the total iterations of the GROUPNAME group within the
third iteration of the parent group.
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Delete Function (DELETE)

Introduction The delete function del etes the specified iteration of arepeating record or group.

Syntax
del et e( GROUPNAME[ i teration]);
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File Pointer Functions (FSEEK, FTELL)

Introduction The fseek function moves the file pointer to anew location which is a specified number of
bytes (offset) from the designated point of origin in the file (the point of origin may be the
beginning of thefile or relative to either the end of the file or the current position).

To invoke the fseek function against the input file, the value for current_fileis“0.” To
invoke the fseek function against the output file, the value for current_fileis“1.” The
fseek function istypically only used in conjunction with the ftell, readblock, and
writeblock functions.

Syntax
fseek(current _file,offset,origin);

Theftell function obtains the current position of thefile pointer and returnsit as an integer.
To invoke the ftell function against the input file, the value for current_fileis“0.” To
invoke the ftell function against the output file, the value for current_fileis“1.” The fseek
function istypically only used in conjunction with the fseek, readblock, and writeblock
functions.

Syntax
nuneric_variable = ftell(current_file);
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Block of Data Functions (READBLOCK, WRITEBLOCK)

I ntroduction

The readblock function reads a block of data (segment or record) from the input file and
placesit into the argument of a string variable. The writeblock function writes the data
contains in the argument of a string variable to the output file.

The readblock and writeblock functions are used in conjunction with each other to pass a
block of datafrom the input file to the output file without compliance checking or testing
for proper EDI syntax. Together these functions provide a more efficient alternative of
using “wildcard” segments, which are typically implemented in build and break maps.

Syntax
readbl ock(string_variable);
writebl ock(string_variable);

Note

See the“XML Build and Break Maps’ appendix in the IBM® Serling Gentran: Server®
for Microsoft Windows XML User Guide for special considerations when using these
functions with XML data.
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Select Function (SELECT)

Introduction The select function allows information to be retrieved from the database tables. Only the
tables and fields available in the Select standard rule are available for the select extended
rule. In the command syntax “expression” and “receiverlist” can be a string field, string
variable, or string literal. It isimportant to note that the table and field names for the select
extended rule are slightly different than those depicted in the standard rule. A listing of
these table and field names can be found at the end of this chapter.

Syntax
select fieldname into receiverlist fromtabl enane where key =
expression [and key = expression];
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Update Function (UPDATE)

Introduction The update function allows information in the database tables to be updated. Thisfunction
issimilar to the Update standard rule, except that it provides more flexibility. Only the
tables and fields available in the Update standard rule are available for the update
extended rule. In the command syntax “expression” can be a string field, string variable,
or string literal. It isimportant to note that the table and field names for the update
extended rule are slightly different than those depicted in the standard rule. A listing of
these table and field names can be found at the end of this chapter.

Syntax
updat e tabl enane set fieldname =expression [fiel dnane =expression]
where key = expression [and key = expression];
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Insert Function (INSERT)

Introduction  Theinsert function allows information in the database tables to be updated.

Syntax
insert into tablenane [ (fieldlist) ] [ (valuelist) ];
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User Exit Function (EXEC)

What isa user A user exit isan extended rule that enables the map to temporarily exit trandation to
exit?  enhanceyour functionality or fulfill specific requirements that Sterling Gentran: Server
does not perform during normal trandation.

Reference
See the User Exits, Appendix B, for more information on user exits.

Placingthe  You can usethe exec function in an extended rule for amap component at any hierarchical
extended rule  leve, including field level extended rules, if appropriate.

Note
When you apply auser exit to a map component, subordinate map components may also
be able to execute the same user exit.

Allowabledata  These are the extended rule data types that you can use with exec:
types , |NTEGER

» REAL
» STRING
Note

You cannot use date and time data unless you process it as a string data type.

Sterling Gentran:Server — May 2011 Application Integration User Guide



Using Extended Rules

ActiveX and User Exit Functions

ActiveX and User Exit Functions

I ntroduction

ActiveX indexed
properties

Createobj ect
syntax

Sterling Gentran: Server now supports additional extended rule functionality to allow you
to use Microsoft's ActiveX Data Objects (ADO) from within extended rules, aswell as
providing enhancements to user exit support.

Sterling Gentran: Server now supports ActiveX indexed properties, specifically these types
of index:

» variant
» numeric
» string

Theindex support alows you to use these syntaxes (if they are supported by your
Automation server):
n

n
n

ob. property[1];
ob. property[“Count”];
ob. property[ob. nethod()];

Sterling Gentran: Server also supports chaining of ActiveX method calls and properties,
which simplifies extended rules for Automation servers with moderately complex object
models (e.g., ADO).

Example
The following is an example of chaining statements:

recordset.fields.iten]“Messageld’].val ue

The createobject function enables you to create an instance of an ActiveX Automation
Server.

Syntax

obj ect = createobject(“ProglD);

ProglD isthe programmatic identifier. An example of aProgID is:
“InternetExplorer.Application”
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Deleteobject  The deleteobject function enables you to delete an instance of an ActiveX Automation
syntax  Server. Anobject must be deleted before the end of the map that usesit. It is more efficient
to delete the object immediately on completion (using the DELETEOBJECT command),
although the Sterling Gentran: Server translator will delete the object automatically at the
end of the map. Also, if you assign one object to another one, both copies of the object
must be deleted for that object to be properly unloaded.

Syntax
del et eobj ect (obj ect) ;

Getiid syntax  The getiid function enables you to obtain the unique identifier for an interface, by using
the string-character name of the interface to return the globally unique identifier that is
used by software to run the interface.

Syntax
string_variable = getiid(“ProglD’, “InterfacelD");

Interfacel D (11D) isthe interface identifier. An example of an lID is:
“IWebBrowser 2’

Queryobject The queryobject function is used to request a different interface on an existing object.

ntax
¥ Syntax
obj ect2 = queryobj ect (objectl, "{IID");

Note

You may not use extended rulesthat compare two ActiveX properties or method results, or
any combination of properties or method results. This type of comparisonisinvalid
because property and method types are unknown prior to compilation and thusit is not
possible to generate the correct comparison code.
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Using Extended Rules

Overview

Alphabetic Language Reference

Overview

Introduction

Typeface
conventions

Typeface
conventions

This section contains an al phabetic reference for the Sterling Gentran: Server proprietary
programming language keywords and commands. This enables you to quickly and easily
refer to information on specific keywords or commands.

Thistable lists the typeface conventions used in this section.

| F the typeface follows this

example... THEN it isused to indicate...

While what you need to type.

condition in syntax, information that you need to provide.

[1] that, in syntax, itemsinside square brackets are
optional.

The following programming guidelines are utilized in this section:

Keywords and commands are shown in al lower case |etters.
Map components are shown in all upper case letters.
A double dash (//) introduces comments.

Linesthat are too long to fit on one line in this section may be continue on the next
line using a line-continuation character (A).
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atoi Using Extended Rules

atol

Introduction Theatoi functionisanumerical function that converts stringsinto integers. The numerical
functions enable you to convert one data type to another.

Syntax  int = atoi(string);

where: int = integer variable
string = string variable

Example integer a;
string[20] s;
s = "5",;
a = atoi(s);
// "a" contains the value 5
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Using Extended Rules aton

aton

Introduction The aton function is a numerical function that converts strings into real numbers. The
numerical functions enable you to convert one data type to another.

Syntax  read = aton(string);

where: red real number variable
string = string variable

Example real a;
string[20] s;
s = "5.5";
a = aton(s);
// "a" contains the value 5.5
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auditlog Using Extended Rules

auditlog

Introduction The auditlog function enables you to write user-defined audit messages to the Sterling
Gentran: Server Audit Log. When an extended rule that calls an auditlog operation is
executed, it writes the specified user-defined message to the Audit Log.

Note
This function does not return a value.

Syntax  auditlog(Messagel D, Type, Key, [, stringl] [, string2] [, string3] [, string4] [, string5]
[, string6] [, string7];

MessagelD  Thefirst parameter, Messagel D, is the user-defined audit message identifier, which much
be an integer value.

Type  Thesecond parameter, Type, isakeyword that identifies the type of audit message. These
pre-defined keywords are valid for Sterling Gentran: Server:

» AL_PROC (processing)
» AL_MSG (message)
Note

You may also supply an integer value to account for atype for which akeyword is
not currently defined.

Key  Thethird parameter, Key, isakeyword that is either zero (if the type of parameter two is
“AL_PROC") or the identification of a piece of data of the specified type. These pre-
defined keywords are valid for Sterling Gentran: Server:

» AL _KEY_INPUT
» AL_KEY_OUTPUT
Note

You may also supply an integer value to account for akey for which akeyword is
not currently defined.
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Using Extended Rules

Parameters4
through 10

Examplel

Example2

auditlog

Parameters four through ten are optional string values that the user-defined message may
requireto fill in variables defined in the audit message.

audi t| og(Messagel D, AL_PRCC, 0, ...);
//1ssues a processing nessage in any map.

audi t| og(Messagel D, AL_MSG, Oatoi(param(1)), ...);
/l1ssues a data audit for the nessage which is currently
/] processi ng.
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begin Using Extended Rules

begin

Introduction Sterling Gentran: Server uses conditional logic to test conditions and then, depending on
the results of the test, perform different operations. Conditions can be nested to any level.
You can use the if/then keywords to execute one or more statements conditionaly. If you
include more than one statement in the body of an if/then loop, you must surround the
statements with the begin/end keywords. If you only use a single statement, you can omit
the begin and end.

Note
Do not end conditions with a semicolon (;) — this terminating syntax is necessary for
statements only.

Syntax  if condition then
begin
statenent 1,
st at enent 2;
end
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Using Extended Rules break

break

Introduction The break function terminates the execution of the nearest enclosing while loop, and
passes control to the statement that follows the end keyword. The break keyword is
generally used in complex loops to terminate aloop before several statements have been
executed.

Example integer i
i =0

Wil e i <10 do

Begi n
#Total = Total + 50;
i =i + 1;

If #Total > 100000

Br eak;
El se
Cont i nue;
End
//While the value contained in the variable "i" is |l ess than ten,

//50 will be added to the field Total.

/11f the value in the field Total becones greater than 100000
/Ibefore "i" equals 10, break out of the while | oop else continue
/I processing until "i" equals 10.
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cerror

cerror

I ntroduction

Syntax

Example

Complianceerror
codes

Using Extended Rules

The cerror function raises a compliance error and reports the target statement (the
statement you specify) on the translation report. You typically specify thisfunction asa
action to be performed if a condition isfalse. Thistable describes when the cerror function

is supported in Sterling Gentran; Server.

| F the map/form is of

type... THEN thecerror function is...
Screen entry Not valid.
Print Not valid.
Export Only valid on the input side of the map.
Import Valid on the input or output side of the map.

Break (Interchange,
Group, or Transaction
Set)

Only valid on the input side of the map.

Build (Interchange,
Group, or Transaction
Set)

Not valid.

cerror(error_number,$GROUP_NAM EJindex][index][index].
A#FIELD_NAME);

cerror (100, $I LD O] [ 1] [ 1] . #VATO);
/1 This raises conpliance error 100 on the VATC el enent of the
//specified instance of the ILD group

The compliance error codes are as follows

Error
Number Error Generated
100 Mandatory Element
105 Conditional Element
110 Incorrect Element Format
111 Invalid Date
112 Invalid Time
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Using Extended Rules cerror

(Contd)
Error

Number Error Generated
113 Invalid String
114 Invalid Number
115 Incorrect Element Length
116 Element Too Short
117 Element Too Long
118 Invalid Overpunch Data
119 Invalid Numeric XData
120 Too Many Components
121 Too Many Elements
125 Element Delimiter
130 Conditional Relation
135 Element Code
140 Standard Rule Failure
145 Binary Substitution Failed
200 Mandatory Component
205 Conditional Component
210 Incorrect Component Format
215 Incorrect Component Length
220 Component Delimiter
225 Component Code
300 Mandatory Segment
305 Segment Sequence
310 Invalid Start End
315 Incorrect Block Format
320 Segment Terminator
330 Unexpected Segment
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cerror

Using Extended Rules

(Contd)
Error
Number

Error Generated

400

Session Error

405

Unknown Partner

410

Invalid Control Number

415

Invalid Sub Count

420

Unknown Relationship

425

Unknown Standard

430

Unknown Version

435

Unknown Transaction

440

Duplicate Control Number

445

Duplicate Doc Name

500

ActiveX Bad Param Count

505

ActiveX Bad Argument Type

510

ActiveX Unknown Name

515

ActiveX Type Mismatch

520

ActiveX Missing Required Param

525

ActiveX Server Unavailable

530

ActiveX Object Not Created

535

ActiveX Other Error

600

XML Element Type Match

601

XML Element Root Type

602

XML Element Required

620

XML Attribute Undeclared

621

XML Attribute Not Unique

622

XML Attribute Required

623

XML Attribute Fixed Error

624

XML Attribute ID Not Unique
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Using Extended Rules cerror

(Contd)
Error

Number Error Generated
625 XML Attribute ID REF Match
630 XML Attribute Parse Name Error
631 XML Attribute Parse Equal Error
632 XML Attribute Parse OQuote Error
633 XML Attribute Parse CQuote Error
640 XML Attribute Name Error
641 XML Attribute Names Error
642 XML Attribute NM Token Error
643 XML Attribute NMTokens Error
644 XML Attribute Entity Error
645 XML Attribute Entities Error
660 XML Reference Char Invalid
661 XML Reference Entity Recursion
662 XML Reference Entity Undeclared
699 XML Unknown Error
700 ODBC Data Source Open Error
701 ODBC Data Source Rollback
702 ODBC Data Source Commit Error
703 ODBC Data Source Rollback Error
710 ODBC Query Open Error
711 ODBC Command Error
712 ODBC Cursor Error
720 ODBC Output Table Error
721 ODBC Output Operation Error
730 ODBC Mandatory Element
731 ODBC Data Conversion Error
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Using Extended Rules

(Contd)
Error
Number

Error Generated

732

ODBC Incorrect Element Format

733

ODBC Standard Rule Failure

799

ODBC Unknown Error

800

NCPDP BFHS Missing

801

NCPDP BFHS Seg ID Error

802

NCPDP BFHS Transmission Type Error

803

NCPDP BFHS Sender ID Missing

804

NCPDP BFHS Batch ID Error

805

NCPDP BFHS File Type Error

806

NCPDP BFHS Receiver ID Mlssing

807

NCPDP BFDDR Missing

808

NCPDP BFDDR Seg ID Error

809

NCPDP BFDDR Transaction Ref Missing

810

NCPDP BFTR Missing

811

NCPDP BFTR Seg ID Error

812

NCPDP BFTR Batch ID Error

813

NCPDP BFTR Record Count Error

814

NCPDP BFTR Record Count Mismatch Error

815

NCPDP DR Repeating Segment Error

816

NCPDP DR Transaction Code Error

817

NCPDP DR Transaction Count Error

818

NCPDP DR Transaction Count Mismatch Error

819

NCPDP DR Header Response Code Error

820

NCPDP DR Transaction Response Code Error

830

NCPDP Null Char

832

NCPDP Invaid Char
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Using Extended Rules cerror

(Contd)
Error

Number Error Generated
833 NCPDP Unexpected EOF
835 NCPDP Unexpected STX
836 NCPDP Unexpected ETX
837 NCPDP Missing Stream Separator 1
838 NCPDP Missing Stream Separator 2
839 NCPDP Unexpected Separator
840 NCPDP Unexpected FS
841 NCPDP Unexpected GS
842 NCPDP Missing GS
845 NCPDP Positional Segment Tag Off
855 NCPDP Delimited Segment Empty
856 NCPDP Delimited Segment Missing First FS
857 NCPDP Delimited Field ID Invalid
858 NCPDP Delimited Field ID Invalid Char
859 NCPDP Delimited Field ID Null Char
860 NCPDP Delimited Field ID Incomplete
861 NCPDP Delimited Field Data Missing
862 NCPDP Delimited Field Data Null Char
863 NCPDP Delimited Field Data Invalid
864 NCPDP Delimited Field Data Invalid Char
865 NCPDP Delimited Segment ID Invalid
866 NCPDP Delimited Segment ID Invalid Char
867 NCPDP Delimited Segment ID Null Char
868 NCPDP Delimited Segment ID Incomplete
869 NCPDP Delimited Field ID Size
885 NCPDP Batch Nothing After STX
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(Contd)
Error

Number Error Generated
886 NCPDP Batch Unexpected STX
887 NCPDP Batch Missing ETX
888 NCPDP Batch Data File Open
890 NCPDP Data Field String Separator
891 NCPDP Data Field String No Filename
892 NCPDP Data Field String Start Byte
893 NCPDP Data Field String End Byte
894 NCPDP Data Field String Incomplete
895 NCPDP Data Field String Extra Characters
896 NCPDP Data Field Size Incorrect
897 NCPDP Data Field Start Out of Bounds
898 NCPDP Data Field Start Beyond End
899 NCPDP Unknown Error
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Using Extended Rules

concat

I ntroduction

Syntax

Example

concat

The concat function concatenates a specified number of characters from one string onto
the end of another string.

concat(string,string,num_char);

where: string = string variable
num_char = number of characters from the second string onto the
end of thefirst string

Note
You may not use an ActiveX property asthefirst parameter of the concat function because
the length of the property is unknown prior to compilation.

string[20] s1,s2;
sl = "IBM;
s2 = "Corporation";

concat (s1,s2, 8);
/] Concat enat e ei ght characters fromstring "s2" onto the end of

/lstring "s1"
/1 s1 will now contain the value "I1BM Corporat".
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continue

continue

I ntroduction

Example

Using Extended Rules

The continue function continues the execution of the innermost loop without processing
the statementsin the loop that follow the continue statement.

i nteger i
i =0;

Wil e i <10 do

Begi n
#Total = Total + 50;
i =i + 1;

If #Total > 100000

Br eak;
El se
Cont i nue;
End
//While the value contained in the variable "i" is less than ten,

/150 will be added to the field Total.

/11f the value in the field Total becones greater than 100000
/Ibefore "i" equals 10, break out of the while | oop else continue
/I processing until "i" equals 10.
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Using Extended Rules count

count

Introduction The count function counts and returns the number of iterations of agroup. An exampleis
asfollows:

integer i;

i = count ($N1[*]);

/1 The [*] is a wildcard that counts the nunber of iterations of the //
N1 group.
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createobject

createobj ect

I ntroduction

Syntax

Example

Using Extended Rules

The createobject function enables you to create an instance of an ActiveX Automation
Server.

object = createobject("ProglD");

where: ProgiD = programmatic identifier

obj ect ob;

ob = createobject("InternetExplorer. Application");

// Creates an instance of the default interface of an ActiveX

/1 Aut omati on Server.

/I Not e:

/1 The createobject command is nore efficient if you use the 11D
/linstead of the interface nane.
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Using Extended Rules

date

I ntroduction

Syntax

Example

Format specifiers

date

The date function converts a string type into a datetime type using aformat that you
specify. This function allows you to include static characters such asa dash (/), which
gives you access to full date support.

Datetime = date("format”,string);

where: datetime = datetime variable (month specified as 1-12)
format = desired date format
string = string variable

datetine d;

d = date(1995, 4, 6);

d = date(1995, 4,6, 12,0);

d = date(" %/ % %", " 95/ 4/ 6");

d = date("%/ %1 %", #strdate);

Thistable lists the format specifiers.

Format Specifier

Description

%8

1SO-8601 date format

Format
YYYYMMDDTHHMMSS.mmmZ

Four-digit year, two-digit month, two-digit day, T (time)
indicator, two-digit hour, two-digit minutes, two-digit
secondsin Universal Time (also called Zulu Time or
Greenwich Mean Time), Z (Zulu time) indicator (example:
20031209T123000.000Z2)

Note
This date format cannot be combined with any other
format specifier.

%a

Abbreviated weekday name

%A

Full weekday name

%b

Abbreviated month name

%B

Full month name

%d

Day of the month as a decimal number (01 — 31)

Application Integration User Guide
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date Using Extended Rules

(Contd)
Format Specifier Description

%D 1SO-8601 date format (date component only)
Format
YYYYMMDDZ
Note
This date format cannot be combined with any other
format specifier.

%H Hour in 24-hour format (00 — 23)

%l Hour in 12-hour format (01— 12)

%j Day of the year as a decimal number (001 — 366)

%m Month as adecimal number (01 —12)

%M Minute as a decimal number (00 — 59)

%S Second as adecimal number (00 — 59)

%U Week of the year as a decimal number, with Sunday as the
first day of the week (00 — 51)

%W Weekday as a decimal number (0 — 6, with Sunday as“0")
%W Week of the year asadecimal number, with Monday asthe
first day of the week (00 —51)

%y Year without the century as a decimal number (00 — 99)
%Y Year with the century as a decimal humber
%% Percent sign
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Using Extended Rules delete

delete

Introduction The delete function deletes a specified occurrence of a group.

Syntax  delete($§GROUP_NAME[N]);

where [n] is the occurrence of the group that you wan to delete.

Example delete($ILD2]);
/1 Del etes the second occurrence of the |LD group.
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del eteobject Using Extended Rules

deleteobj ect

Introduction The deleteobject function enables you to delete an instance of an ActiveX Automation
Server. An object must be deleted before the end of the map that usesit. It ismore efficient
to delete the object immediately on completion, although the Sterling Gentran: Server
translator will delete the object automatically at the end of the map. Also, if you assign
one object to another one, both copies of the object must be deleted for that object to be
properly unloaded.

Syntax  deleteobject(object);

Example  object ob;
ob = createobject("InternetExplorer. Application");
del et eobj ect (ob);
/1 Del etes the instance of the object.
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empty

I ntroduction

Syntax

Example

empty

The empty function setsthe value of afield in internal storage to null. Thisfunction is not
the same as setting the value of afield to a zero length string (" ") or to zero.

empty($GROUP_NAME[index][index][index]. #FIELD_NAME)

enmpt y($! LD. #VATO) ;
/1Set the value of the specified instance of the VATC el ement
/1to null
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end Using Extended Rules

end

Introduction Sterling Gentran: Server uses conditional logic to test conditions and then, depending on
the results of the test, perform different operations. Conditions can be nested to any level.
You can use the if/then keywords to execute one or more statements conditionaly. If you
include more than one statement in the body of an if/then loop, you must surround the
statements with the begin/end keywords. If you only use a single statement, you can omit
the begin and end.

Note
Do not end conditions with a semicolon (;) — this terminating syntax is necessary for
statements only.

Syntax  if condition then
begin
statenent 1,
st at enent 2;
end
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Using Extended Rules exec

exec

Introduction The exec function invokes the execution of abatch file or program. The tranglator waits
until the script finishes before continuing with tranglation. After the script runs and returns
anumeric return code, the exec function:

» Retrievesthe return code

» Returnsto transation

» Usesthereturn codein trandation.
Note

You must set an integer value equal to the return value of the exec (...) call for the
rule to compile.

Syntax  nReturn = exec(string)

where:
nReturn = return value
string = string variable or literal value that represents the shell script

Example integer nReturn;
nRet urn 0;
nRet urn exec (“c:\addrunmsh”);
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exist

I ntroduction

Syntax

Example

Using Extended Rules

The exist function tests to determine if afield is empty (null). It returns a non-zero (true)
valueif thereisdatain a specified field in internal storage. If datais not present in the
specified field, this function returns a zero (false) value. This function istypically used as
apart of acondition.

There are some situations (for example, if the field or element has a"Use Code" standard
rule applied to it) when the IF EXIST returns a non-zero (true) value whether or not the
condition istrue. You can work around this by only using IF EXIST for date- and number-
typefields. Be certain that all references to the field which isinterrogated are nested
within the |F EXIST begin block.

For string-type fields, use the following format:

IFFieldl=""

if exist($GROUP_NAMEJ[index][index][index]. #FIELD_NAME) then

if exist($lLD #VATC) then
#TEMP_FI ELD = #VATC

// Return a non-zero value if the condition is true (data is present
/1in the

//specified instance of the VATC elenent). A zero value is returned
/1if the condition is false (no data is present in the specified
//instance of

//the VATC el enent).
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fseek

I ntroduction

Syntax

Example

fseek

The fseek function movesthe file pointer to a new location which is a specified number of
bytes (offset) from the designated point of origin in the file (the point of origin may be the
beginning of thefile or relative to either the end of the file or the current position).

To invoke the fseek function against the input file, the value for current_fileis“0.” To
invoke the fseek function against the output file, the value for current_fileis“1.” The
fseek function istypically only used in conjunction with the ftell, readblock, and
writeblock functions.

fseek(current_file,offset,origin);

where: current_file = Oindicatestheinput file; 1 indicates the output file
offset = The position to which the file pointer is moved relative
to the origin.
origin = The keyword depends on the starting location:
begin = start at beginning of thefile
end = start at the end of thefile

current = start at the current position in thefile

string[1024]tenp_buffer;

I nteger Position;

Position = ftell (0);

whi | e readbl ock(tenp_buffer) do

begin
if left(tenp_buffer,3) = "IEA" then
begin
f seek(0, Posi tion, begin);
br eak;
end

writebl ock(tenp_buffer);

Position = ftell (0);
end
// Read a segnment frominput file and place in tenp_buffer. Look for
/1"1 EA" segment tag. If found, reset file pointer to where it was
/I before the "I EA" segnent was read. Wite contents of tenp_buffer
//to output file. Set "Position" = the current file pointer
/] position.
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ftell

I ntroduction

Syntax

Example

Using Extended Rules

The ftell function obtains the current position of the file pointer and returnsit as an
integer. To invoke the ftell function against the input file, the value for current_fileis“0.”
To invoke the ftell function against the output file, the value for current_fileis“1.” The
fseek function istypically only used in conjunction with the fseek, readblock, and
writeblock functions.

numeric_variable = ftell(current_file);

string[1024]tenp_buffer;

I nt eger Position;

Position = ftell (0);

whi | e readbl ock(tenp_buffer) do

begin
if left(tembuffer,3) = "IEA" then
begi n
f seek(0, Posi tion, begin);
br eak;
end

writebl ock(tenp_buffer);

Position = ftell (0);
end
/I Read a segnment frominput file and place in tenp_buffer. Look for
/1"1 EA" segment tag. |f found, reset file pointer to where it was
/I before the "I EA" segnent was read. Wite contents of tenp_buffer
//to output file. Set "Position" = the current file pointer
/] position.
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Using Extended Rules get

Introduction The get function enables you to access individual components of a datetime variable.

Syntax integer_variable = get datetime_component (datetime_variable);

where: integer_variable = integer variable
datetime_component = individual component of the datetime
variable

datetime_variable datetime variable of which you want to

access a component part

Example integer tenp_days;
i nteger tenp_hours;
datetine d;
tenp_days = O;
tenp_hours = 0;
d = '12/25/2001 12:15:30"';//A fields value in the map can be
/1 assigned to the datetinme variable "d"
/lor a hard coded val ue can be assi gned.

tenp_days = get days (d);
tenp_hours = get hours (d);

/] Accesses the days fromthe datetinme variable "d" and l|oads into
/lvariable " tenp_days ". Accesses the hours fromthe datetine
/lvariable "d" and loads into variable "tenp_hours".
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getiid

I ntroduction

Syntax

Example

Using Extended Rules

The getiid function enables you to obtain the unique identifier for an interface, by using
the string-character name of the interface to return the globally unique identifier that is
used by software to run the interface.

This creates an instance of the default interface of an ActiveX Automation Server.
string_variable = getiid("ProgID");

Thislooks up the Interfacel D (11D) of an interface.

string_variable = getiid("ProglD", "Interface_Name or { Interface ID}");

obj ect ob;

string[50] iid;

iid = getiid("InternetExplorer.Application", "IWbBrowser2");
ob = createobject("InternetExplorer. Application", iid);

ob. Visible = 1;
/1D splays the Internet Explorer on the desktop by setting a
//property value in an ActiveX Automation Server.
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Using Extended Rules if then...else

If then...else

Introduction Theif, then, and else keywords allow the use of conditional logic. Sterling Gentran: Server
uses conditional logic to test conditions and then, depending on the results of the test,
perform different operations. Conditions can be nested to any level. You can use the if/
then keywordsto execute one or more statements conditionally. The condition istypically
acomparison, but it can be any expression that concludes with a numeric value. Sterling
Gentran: Server interprets the value as either true or false. The system interprets a zero
value as false and a nonzero value astrue.

Sterling Gentran:Server evaluates the if/then condition, and if it istrue, the system
executes al the statements that follow the then keyword. If the condition is false, none of
the statements following then are executed.

You can use the else keyword in conjunction with if/then to define several blocks of
statements, one of which is executed. Sterling Gentran:Server tests the first if/then
condition. If the condition is false, the system proceeds to test each sequential condition
until it finds one that istrue. The system executes the corresponding block of statements
for the true condition. If none of the if/then conditions are true, the system executes the
statements following the el se keyword.

Note
Do not end conditions with a semicolon (;) — thisterminating syntax is necessary for
statements only.

Example if condition then
begin
statenent 1;
st at ement 2;
end
el se
begin
st at ement 3;
st at enent 4;
end
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index

I ntroduction

Syntax

Example

Using Extended Rules

Theindex function enables you to determine which instance of a particular loop the
trangdlator is currently accessing.

index(integer_variable);

where: integer_variable = integer variable that indicates the
hierarchical level for which you want to
determine the loop count

i ndex(1)

//This extended rule is located on the ILD group in the diagram
//below. This determ nes the current |oop count for the first |evel
//(CODD) in the hierarchical structure.

INVOIC -M- INVOICE DETAILS £F
00D -M- 993399 £F-
ILD M- 999999 &7
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Using Extended Rules insert

Insert
Introduction  Theinsert function allows information in the database tables to be updated.
Syntax insert into tablenane [ (fieldlist) ] [ (valuelist) ];

where: tablename DivisionLookup | PartnerLookup | DivisionLocation
PartnerLocation | DivisionXref | PartnerXref

fieldlist (fieldname[ , fieldname])
fieldname The name of one of the fieldsin the table.
valuelist (String[ , String] )

Notes
» Alistof thetablesisavailable later in this chapter.

» Thefieldlist listsone or more fieldnames to which datais to be added.
» Thefieldnames can belisted in any order.
» Thevaudist must be in the same order asthe field list.
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Example  updateStatus = update PartnerLookup
set Description = "Lookup Update
Test", Text 1="Text 1Updat ed", Text 2="Text 2Updat ed", Text 3="Text 3Updat ed", T
ext 4="Text 4Updat ed"
where Tabl eNanme = "PartLkp" and Item= "1";

if updateStatus = 1 then

begin
_ messagebox (" Update PartnerlLookup: Record Not Found, Attenpting
Alnsert...",1);

insertStatus = insert into PartnerLookup( PartnerKEY, Tabl eNane,

/E\I tem Descri ption, Text 1, Text 2, Text 3, Text 4)
Aval ues ("PETZONE", "PartLkp","1","Lookup Insert
ATest", " Text 1", " Text 2", "Text 3", " Text 4");
if insertStatus = 0 then
begin
nessagebox ("I nsert PartnerLookup: Failed",1);
end
end

if updateStatus = 2 then
begi n

nessagebox (" Updat e PartnerLookup Failed with GtherError",1);
end
/| Exanpl e assunes that a | ookup table named "PartLkp" has been
//created.
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| eft

Introduction The left function extracts a specified number of character from the left side of a string
variable or field and returns the result as a string.

The syntax is asfollows:
string_variable = left(string_variable,num_char)

where: num_char = integer variable

Note
You may not use an ActiveX property asthe first parameter of the left function because
the length of the property is unknown prior to compilation.

Example  string [25] nane;
string [5]tenp_vari abl e;
nane = "Acme Shi ppi ng Conpany"
tenp_variable = left(nane, 4);
/] "tenp_variable" would contain "Acne"
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len

Introduction The len function is a numerical function that counts and returns the number of characters
in astring. The numerical functions enable you to convert one data type to another.

Syntax  number_char = len(string);

where: num_char = integer variable
Example integer a

a = 0;

a = len("hello");

// "a" contains the value 5
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messagebox

I ntroduction

Syntax

Example

Defined
numbers

messagebox

The messagebox function enables you to display a message box for which you have
designated the format and content. You can specify the number and type of buttons on the
message box, the message icon (e.g., hand, question mark, exclamation point, or asterisk),
and the message displayed. You can also issue areturn value based on the chosen action.

Note
Only String values can be displayed in a message box.

messagebox (" message”,defined_number)

where: message message string
defined number =  defined number of the desired buttons plus the
defined number of the desired icon (if used)

i f messagebox("Do you really want to delete this object?",36) = 6
begin

end

//Di splays a message box with the given string as the nmessage, Yes
//and NO buttons (4) and a question mark icon (32). The nunber and
/1type of buttons (4) plus the icon (32) equals the defined_nunber

/1(36). If the user clicks the Yes button (return value "6"), the
//statenments in the begin/end | oop are executed.

Thistable lists the defined_numbers for the button and icon types.

Defined_Number Button or Icon Types
0 OK button only
1 OK and Cancel buttons
4 Yes and No buttons
16 Icon Hand
32 Icon Question Mark
48 Icon Exclamation Point
64 Icon Asterisk

Application Integration User Guide Sterling Gentran: Server — May 2011



messagebox Using Extended Rules

Messagebox  Thistable lists the message box return values.
return values

Return Value Action Selected
1 OK selected
2 Cancel selected
6 Yes selected
7 No selected
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mid

I ntroduction

Syntax

Example

mid

The mid function extracts from a specified position in a string, either to the end of the
string or for aspecified number of characters and returnsthe resultant string. Thisfunction
is zero-based.

string_variable = mid(string_variable,start_pos,num_char)

where: start pos = integer variable
num _char = integer variable

Note
You may not use an ActiveX property as the first parameter of the mid function because
the length of the property is unknown prior to compilation.

string [25] nane;

string [10]tenp_vari abl e;

nanme = "Acme Shi ppi ng Conpany”
tenp_variabl e = md(nang, 5, 8);

/1 "tenmp_variable" will contain "Shipping"
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ntoa

Introduction The ntoa function is a numerical function that converts integers and real numbers into
strings. The numerical functions enable you to convert one data type to another.

Syntax  string = ntoa(integer/real ,string);

where: integer/real =  integer or real number variable
string = string variable

Example Integer b;
string[8] s;
b = 5.5;
nt oa(b, s);
/1 The variable "s" contains the string "5.5".
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param

Introduction The param function is used to read the value of the PARAM(n) variable. The extended
rule allows you to reference values that have been passed into the translator viathe
command line. The -u switch can be used during the invocation of the translator to pass
valuesin so they can be referenced by an extended rule. Typically, the param extended
rule is not used by maps that are running within the Sterling Gentran: Server environment
because Sterling Gentran: Server does not use the -u switch when invoking the tranglator.
However, if you are invoking the translator to perform tranglation outside of Sterling
Gentran: Server (tx32 -f <inputfile> <templatefile> <outputfile> <reportfile>), you have
the option to pass values into the trandlator via the -u switch and reference those values
using the param extended rule.

Syntax  param(integer_ PARAM_number);
where: interger PARAM_number = the number of the pre-defined variable

Example  For example, if you invoke TX32.EXE in the following manner:

tx32.exe -f input.txt 850.tpl output.txt out.rpt -u
"PurchaseOrder Nunber" -u 12345 -u 500. 25

Then you could write an extended rule in the \GENSRVNT\Tutorial\Pet_850.map that
looks like the following:

string [32] strDescription;
string [32] strPONbr;
string [32] strTotal Cost;
real nTot al Cost;

strDescription = param0);
strPONbr = paran(1);

strTotal Cost = paran(?2);

nTot al Cost = aton(strTotal Cost);

if nTotal Cost > 200 then
begin

nmessagebox (" Get approval from boss", 0);
end

You can run this rule from any scope in your map (e.g., pre-session, post-session, group
onbegin, field, etc.).

Application Integration User Guide Sterling Gentran: Server — May 2011



queryobject Using Extended Rules

gueryobj ect
Introduction The queryobject function is used to request a different interface on an existing object.

Syntax  object2 = queryobject(objectl, "{11D}");

where: object2 isthe result that contains the requested interface to
the object
11D = istheinterfaceidentifier of the requested interface

objectl an existing object

Example  object ob, ob2;
ob = createobject("InternetExplorer. Application");
ob2 = queryobj ect (ob, "{EAB22AC1- 30C1- 11CF- A7EB- AOOOOCO5BAEOB} ") ;
//Uses the Interface ID of the desired interface to obtain another
/1 (different) interface of the existing object (objectl).
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readblock

I ntroduction

Syntax

Example

readblock

The readblock function reads a block of data (segment or record) from the input file and
placesit into the argument of a string variable. The readblock and writeblock functions are
used in conjunction with each other to pass a block of datafrom theinput file to the output
file without compliance checking or testing for proper EDI syntax. Together these
functions provide a more efficient alternative of using “wildcard” segments, which are
typically implemented in build and break maps.

Note

See the“XML Build and Break Maps” appendix in the IBM® Serling Gentran: Server®
for Microsoft Windows XML User Guide for special considerations when using this
function with XML data.

readbl ock(string_variable);

Note
You may not use an ActiveX property asthe first parameter of the readblock function
because the length of the property is unknown prior to compilation.

whi | e readbl ock(tenp_buffer) do

begin
if left(tenmp_buffer,3) = "IEA" then
begi n
f seek(0, Posi tion, begin);
br eak;
end

writebl ock(tenp_buffer);

Position = ftell (0);
end
// Read segnent frominput file and place in tenp_buffer. Look for
/1"1 EA" segment tag. |If found, reset file pointer to where it was
//before the "I EA" segnent was read. Wite contents of tenp_buffer
//to output file. Set "Position" = the current file pointer
/] position.
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readbytes

Introduction The readbytes function reads a number of bytes from the input file. Thisfunction is used
in conjunction with the writebytes function. Used together, the readbytes and writebytes
function provide an efficient method of passing data through a map if the data does not
need to be compliance checked or atered in any way.

Readbytesis similar to the readblock function, but readblock only works with entire
blocks (i.e., an entire segment or record), and readbytes works with any quantity of data,
whether it issmaller or larger than a block.

The readbytes function uses two parameters, first the string variable into which the data
being read will be stored, and second the number of bytes to read.

Syntax  readbytes(read_from_buffer, num_bytes);

where: read from_buffer= string variable into which the data being read will be
stored
num_bytes = integer value representing the number of bytesto read
from the input file.

Note
Readbytes returns the number of bytes it was actually able to read.

Example string [1024] tenpBuffer;
whi |l e readbytes(tenpBuffer,1024) do
begi n
writebytes(tenpBuffer, 1024);
End
/I Read 1024 bytes frominput file and place in string variable
[/ named tenpBuffer.

writebytes("*OD'0A", 2);
/1 Appends a CRLF to the end of the output file.
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right

I ntroduction

Syntax

Example

right

Theright function extracts a specified number of characters from the right side of astring
variable or field.

string_variable = right(string_variable,num_char)

where: num _char = integer variable

Note
You may not use an ActiveX property as the first parameter of the right function because
the length of the property is unknown prior to compilation.

string [25] nane;

string [10]tenp_vari abl e;

nane = "Acme Shi ppi ng Conpany”
tenp_variabl e = right (nane, 7);

/1 "tenmp_variable" would contain "Conpany"
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select

I ntroduction

Syntax

Example

Using Extended Rules

The select function allows information to be retrieved from the database tables. Only the
tables and fields available in the Select standard rule are available for the select extended
rule. In the command syntax “expression” and "receiverlist” can be a string field, string
variable, or string literal. It isimportant to note that the table and field names for the select
extended rule are slightly different than those depicted in the standard rule. A listing of
these table and field names can be found at the end of this chapter.

select fieldname into receiverlist from tablename where key = expression [and key =
expression];

string[10]tenp_varl,tenp_var2,tenp_var3;

sel ect Textl, Text2, Text3 into tenp_varl, tenp var2, tenp _var3 Afrom
Par t nerl ookup where Tabl enane = "Test" and Item ="wi dgit"

/| Exanpl e assunes that a Lookup table named "Test" has been

//created.
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set

Introduction The set function enables you to define individual components of a datetime variable.

Syntax  set datetime_component (datetime variable,integer_variable);

where: datetime_component = individual component of the datetime

variable
datetime variable = datetime variable of which you want to
access a component part
integer_variable = integer variable

Example integer tenp_days;
datetine d;
tenmp_days = 15;
d = '12/25/2001";//A fields value in the map can be
/1 assigned to the datetinme variable "d"
/lor a hard coded val ue can be assi gned.

set days (d,tenp_days);

/1 Defines the days of the datetine variable "d" fromvariable
/1" tenp_days".
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strdate

I ntroduction

Syntax

Example

Format specifiers

Using Extended Rules

The strdate function converts a datetime type into a string using aformat that you specify.
This function allows you to include static characters such as a slash (/), which gives you
accessto full date support.

strdate(datetime,"format”,string);

where: datetime = datetime variable (month specified as 1-12)
format = desired date format
string = string variable

datetine d;

string[8] s;

d = #DateFi el d;
strdate(d, "%/ % %", s);

/1 Converts a datetine variable into an eight character string in
//the format "year/nonth/day".

Thistable lists the format specifiers.

Format Specifier Description

%8 1SO-8601 date format

Format
YYYYMMDDTHHMMSS.mmmZ

Four-digit year, two-digit month, two-digit day, T (time)
indicator, two-digit hour, two-digit minutes, two-digit
secondsin Universal Time (also called Zulu Time or
Greenwich Mean Time), Z (Zulu time) indicator (example:
20031209T123000.000Z2)

Note
This date format cannot be combined with any other
format specifier.

%a Abbreviated weekday name
%A Full weekday name

%b Abbreviated month name
%B Full month name
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(Contd)
Format Specifier Description
%d Day of the month as a decimal number (01 — 31)
%H Hour in 24-hour format (00 — 23)
%l Hour in 12-hour format (01— 12)
%j Day of the year as adecimal number (001 — 366)
%m Month as a decimal number (01 —12)
%M Minute as adecimal number (00 — 59)
%S Second as adecimal number (00 — 59)
%U Week of the year as a decimal number, with Sunday as the
first day of the week (00 —51)

%w Weekday as a decimal number (0 — 6, with Sunday as*“0")
%W Week of the year as adecimal number, with Monday asthe
first day of the week (00 —51)

%y Year without the century as a decimal number (00 — 99)
%Y Year with the century as a decimal number
%% Percent sign

Application Integration User Guide Sterling Gentran: Server — May 2011



strstr

Strstr

I ntroduction

Syntax

Example

Using Extended Rules

The strstr function finds a substring inside a string. This function returns the position of
the first instance of the designated substring within the specified string. If this function
does not find the specified substring in the string, it returns avalue of -1. Thisfunctionis

zero-based.

integer = strstr("string","substring");

where: integer = integer variable
string = string
substring = part of the string
i nteger d;
d = 0;
d = strstr("m ssissippi","is");

//Finds the first instance of the substring "is" inside the string
//"m ssissippi" and returns the position of that first substring.

Sterling Gentran:Server — May 2011

Application Integration User Guide



Using Extended Rules

unreadblock

I ntroduction

Syntax

Example

unreadblock

The unreadblock function provides a method of moving the input file-pointer back one
block (ablock of datais equivalent to one EDI segment or one positional record). This
function unreads the block of data that was just processed by the readblock function.

Note
Unreadblock should only be used in conjunction with the readblock function. The
unreadblock function will only unread the most recent block of data processed.

Unreadblock is provided as an alternative to using the fseek and ftell functions, and is the
preferred method of moving the file pointer back one block of data. Unreadblock allows
the trandator to correctly track the number of bytes read and number of segments read
during the trandation process by moving the file-pointer back and decrementing the
segment and byte counts accordingly.

unreadblock();

string[1024] tenpBuffer;

whi |l e readbl ock(tenpBuffer) do
begi n
if left(tempBuffer,3) = "I EA" then
begin
unr eadbl ock() ;
br eak;
end
writebl ock(tenpBuffer);
end

// Read segment frominput file and place in tenpBuffer variable.
//Look for the "I EA" segnent tag and, if found, reset the file-
//pointer to where it was |ocated before the "I EA" segnent was

/l/read. Wite contents of tenpBuffer to output file.
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update

I ntroduction

Syntax

Example

Using Extended Rules

The update function allows information in the database tables to be updated. This
function is similar to the Update standard rule, except that it provides more flexibility.
Only thetables and fields available in the Update standard rule are available for the update
extended rule. In the command syntax “expression” can be a string field, string variable,
or string literal. It isimportant to note that the table and field names for the update
extended rule are slightly different than those depicted in the standard rule. A listing of
these table and field names can be found at the end of this chapter.

This table describes how the update function is supported in Sterling Gentran: Server.

| F the map/form is of

type... THEN the update function is...
Export Only valid on the input side of the map.
Import Valid on the input or output side of the map.

Break (Interchange,
Group, or Transaction
Set)

Only valid on the input side of the map.

Build (Interchange,
Group, or Transaction
Set)

Only valid on the input side of the map.

Print

Not supported.

Screen entry

Not supported.

update tablename set fieldname =expression [fieldname =expression] where key =
expression [and key = expression];

string[15]tenp_vari abl e;
tenp_variable = "5 Pound Hammer";
update PartnerXref set Textl = tenp_variable where MyItem= " and

ATabl enane = "Tool s";

/| Exanpl e assunes that a cross-reference table named "Tool s" has

/I been creat ed.
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while...do

I ntroduction

Example

while...do

The while...do function executes a statement repeatedly until the specified termination
condition evaluates to zero. The system tests the terminating condition before each
iteration of the loop, so awhile loop executes zero or more times depending on the value

of the termination expression.

Note

Do not end conditions with a semicolon (;) — this terminating syntax is necessary for

statements only.
i nteger i
i =0;

Wil e i <10 do
Begi n

#Total = Total + 50;

i =i +1;

I f #Total > 100000
Br eak;
El se
Conti nue;
End

/IWhile "i" is less than 10 execute the | oop.

Application Integration User Guide
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winexec

I ntroduction

Syntax

Example

Window display
numbers

Using Extended Rules

The winexec function enables you to execute another program while running the
tranglator. This program is executed asynchronously. You specify the program and
determine how you want the program window displayed. You can aso return an error
code, if desired. If the error code is greater than 32, the program ran without errors. If the
error code is less than 32, the program did not run because of an error. If the error codeis
“0,” the system is out of memory. If the error codeis“2,” you didn’t specify afile name.
The error code is not the return value from the program you executed.

Note

» If you specify aprogram on another machine or in another domain, you must have the
appropriate permission to access the specified folder.

» If trandation is executing from an unattended process control command, the user ID
under which that service isrunning must have the appropriate permission to access
the specified file.

winexec("program",window_display)

where: program = executable program name string (if necessary,
including UNC or direct file path)

number that indicates how you want the program
window displayed

window_display

wi nexec(" program exe", 3)

/I Exits Gentran: Server and executes the "program exe"
/] program asynchronously. The system di spl ays the program w ndow
/I maximzed (3).

The window_display numbers that control the appearance of the program window are as
follows (you must use the number to indicate how you want the program window
displayed, not the window_display value):

Number Window_Display Definition
0 SW_HIDE Hides the window and activates another
window.
1 SW_SHOWNORMAL Activates and displays awindow. If the

window isminimized or maximized, itis
restored to the original size and position.
Thisflag should be specified when
displaying awindow for the first time.

1 SW_NORMAL Activates and displays awindow in the
original size and position.
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winexec

(Contd)
Number

Window_Display

Definition

2

SW_SHOWMINIMIZED

Activatesthewindow and displaysitasa
minimized windows.

SW_SHOWMAXIMIZED

Activatesthe window and displaysit asa
maximized window.

SW_MAXIMIZE

M aximizes the window.

SW_SHOWNOACTIVATE

Displays the window in its most recent
size and position, but does not activate it
(the current active window remains
active).

SW_SHOW

Activates the window and displaysit in
its current size and position.

SW_MINIMIZE

Minimizes the window.

SW_SHOWMINNOACTIVE

Displays the window as a minimized
window without activating it (the current
active window remains active).

SW_SHOWNA

Displays the window in its most recent
size and position without activating it
(the current active window remains
active).

SW_RESTORE

Activates and displaysthe window. If the
window was minimized or maximized, it
isrestored to its original size and
position.

10

SW_SHOWDEFAULT

Activates the window and allows
Microsoft Windows to determine the
size and position.

Application Integration User Guide
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writeblock

I ntroduction

Syntax

Example

Using Extended Rules

Thewriteblock function writesthe data containsin the argument of astring variableto the
output file.The readblock and writeblock functions are used in conjunction with each other
to pass ablock of datafrom the input file to the output file without compliance checking
or testing for proper EDI syntax. Together these functions provide a more efficient
alternative of using “wildcard” segments, which are typically implemented in build and
break maps.

Note

See the“XML Build and Break Maps” appendix in the IBM® Serling Gentran: Server®
for Microsoft Windows XML User Guide for special considerations when using this
function with XML data.

writeblock(string_variable);

whi | e readbl ock(tenp_buffer) do

begin
if left(tenmp_buffer,3) = "IEA" then
begi n
f seek(0, Posi tion, begin);
br eak;
end

writebl ock(tenp_buffer);

Position = ftell (0);
end
// Read segnent frominput file and place in tenp_buffer. Look for
/1"1 EA" segnment tag. |f found, reset file pointer to where it was
/I before the "I EA" segnment was read. Wite contents of tenp_buffer
//to output file. Set "Position" = the current file pointer
/] position.
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writebytes

Introduction The writebytes function writes a specified number of bytes to the output file. This
function is used in conjunction with the readbytes function. Used together, the readbytes
and writebytes function provide an efficient method of passing data through amap if the
data does not need to be compliance checked or altered in any way.

Note
The system does not append a segment terminator to the end of the string value written to
the output file.

Writebytesis similar to the writeblock function, but writeblock only works with entire
blocks (i.e., an entire segment or record), and writebytes works with any quantity of data,
whether it issmaller or larger than a block.

The writebytes function uses two parameters, first the string variable containing the data
to be written to the output file, and second the number of bytes to write.

Syntax  writebytes(write_to_buffer, num_bytes);

where:  write to buffer = string variable containing the data to be written to the
output file
num_bytes = integer value representing the number of bytesto read
from the write_to_buffer variable and write to the
output file

Note
If hex values are used in constants, use \Ox instead of .

Example  string [1024] tenp_buffer;
whi |l e readbytes(tenp_buffer, 1024) do
begin
writebytes(tenp_buffer, 1024);
End
writebytes("*OD'0A", 2);

// Read 1024 bytes frominput file and place in string variable Snanmed
tenp_buffer.
/] Appends a CRLF after the while | oop finishes executing.
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Select and Update Available Options

Introduction The following section contains the database table names and the associated field names
that are available when using the select and update extended rules. Additional keys are
also available for certain tables. Where applicable, a description of the key follows the
field name.

Note

When you use extended rules to reference a Sterling Gentran: Server database table, the
syntax used is different from the actual table name. The appropriate referencing syntax is
outlined for each table in this section.

Example
To refer to the Document_tb in an extended rule, you would reference Document.

Document These are the field names that are available when using the select or update extended rules
on the Document Table (Document_tb).

Note
This sub-table can only be accessed from the following map types; Transaction Break/
Build, Import, Export, Print, Screen, Group Build, and Interchange Build.

Theinformation that is accessed will be the information of the last document that was
processed at the table level accessed by the rules. This must be taken into consideration
when using rules that access these tables.

See Table access examples on page 3 - 8 for examples.

Note
Refer to thistable as Document.

» TESTMODE

» AGENCY
» VERSION
» TRANSACTIONSETID
» RELEASE

» DOCUMENTTYPE
» REFERENCEDATA
» DOCUMENTNAME

» APPFIELD1
» APPFIELD2
» APPFIELD3

» APPFIELD4
» APPFIELDS
» APPFIELD6
» DOCUMENTPARTNERKEY
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» CONTROLNUMBER
» PARTNERKEY
» TABLEKEY (Select only)

Partner These are the field names that are available when using the select or update extended rules
for anon-division partner on the Partner Table (Partner_tb).

Note
Refer to thistable as Partner.

» PARTNERNAME
» EDICODE
» APPLICATIONPARTNERKEY

These are the additional keys that are available for the Partner table.
» PARTNERKEY

» ALTERNATEKEY (refersto Application Key)

» APPLICATIONPARTNERKEY (refersto Application Key)

Division  Thesearethefield namesthat are available when using the select or update extended rules
to reference the division partner on the Partner Table (Partner_tb).

Note
Refer to this table as Division.

» PARTNERNAME
» EDICODE
» APPLICATIONPARTNERKEY
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Using Extended Rules

PartnerLocation  Thesearethefield namesthat are available when using the select or update extended rules
for anon-division location on the Location Table (Location_tb).

Note

Refer to thistable as Partner L ocation.

CONTACTNAME
NAME

ADDRESS1
ADDRESS2
ADDRESS3

CITY

STATE

ZIP

COUNTRY
TELEPHONE
PRIMARY REFCODE
SECONDARY REFCODE
FAX

DivisionLocation  Thesearethefield namesthat are available when using the select or update extended rules
to reference a division location on the Location Table (Location_tb).

Note

Refer to thistable as DivisionL ocation.

CONTACTNAME
NAME

ADDRESS1
ADDRESS2
ADDRESS3

CITY

STATE

ZIP

COUNTRY
TELEPHONE
PRIMARY REFCODE
SECONDARY REFCODE
FAX
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Partner L ookup

DivisionL ookup

Select and Update Available Options

These are the field names that are available when using the select or update extended rules
for anon-division lookup on the Lookup Table (Lookup_th).

Note

Refer to this table as Partner L ookup.
» ITEM

» DESCRIPTION

» TEXT1

» TEXT2

» TEXT3

» TEXT4

Thisisan additional key that is available for the PartnerL ookup table.
» TABLENAME

These are the field names that are available when using the select or update extended rules
to reference a division lookup on the Lookup Table (Lookup_tb).

Note

Refer to this table as DivisionL ookup.
» ITEM

» DESCRIPTION

» TEXT1

» TEXT2

» TEXT3

» TEXT4

Thisisan additional key that is available for the DivisionL ookup table.
» TABLENAME
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PartnerXref  Thesearethefield namesthat are available when using the select or update extended rules
for anon-division cross-reference on the Cross-reference Table (CrossReference _tb).

Note
Refer to thistable as Partner Xref.

» MYITEM
» PARTNERITEM
» DESCRIPTION

» TEXT1
» TEXT2
» TEXT3
» TEXT4

Thisisan additional key that is available for the PartnerXref table.
» TABLENAME

DivisionXref  These arethefield namesthat are available when using the select or update extended rules
to reference a division cross-reference on the Cross-reference Table (CrossReference_tb).

Note
Refer to this table as DivisionXref.

» MYITEM
» PARTNERITEM
» DESCRIPTION

» TEXT1
» TEXT2
» TEXT3
» TEXT4

Thisisan additional key that is available for the DivisionXref table.
» TABLENAME
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Interchange  These arethe field names that are available when using the select or update extended rules
on the Interchange Table (Interchange_tb).

Note
This sub-table can only be accessed from the following map types: Interchange Break or
Build, Group Break, Transaction Break, and Export.

The information that is accessed will be the information of the last interchange that was
processed at the table level accessed by the rules. This must be taken into consideration
when using rules that access these tables.

See Table access examples on page 3 - 8 for examples.

Note
Refer to thistable as Interchange.

» TESTMODE
» CONTROLNUMBER

» VERSION

» APPFIELD1
» APPFIELD2
» APPFIELD3

» APPFIELD4
» APPFIELD5

» APPFIELD6

» AGENCY

» PARTNERKEY

» TABLEKEY (Select only)
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Group  Thesearethefield namesthat are available when using the select or update extended rules
on the Group Table (Group_th).

Note
Can only be accessed from the following map types. Group Break or Build, Transaction
Break, Export, and Interchange Build.

The information that is accessed will be the information of the last group that was
processed at the table level accessed by the rules. This must be taken into consideration
when using rules that access these tables.

See Table access examples on page 3 - 8 for examples.

Note
Refer to this table as Group.

TESTMODE
CONTROLNUMBER
FUNCTIONALGROUPID
VERSION

APPFIELD1

APPFIELD2

APPFIELD3

APPFIELD4

APPFIELD5

APPFIELD6

AGENCY

TABLEKEY (Select only)

Sterling Gentran:Server — May 2011 Application Integration User Guide



Using Extended Rules Select and Update Available Options

GenericEnvelope  These are the field names that are available when using the select extended rule on the
Segment Generic Envelope Segment Table (GenericEnvel opeSegment _th).

Note
Refer to this table as GenericEnvelopeSegment.

» CONTROLNUMBER

» SUBCOUNT
» FIELD1
» FIELD2
» FIELD3
» FIELD4
» FIELDS
» FIELDG6
» FIELD7
» FIELDS
» FIELD9
» FIELD10
» FIELD11
» FIELD12
» FIELD13
» FIELD14
» FIELD15
» FIELD16
» FIELD17
» FIELD18
» FIELD19
» FIELD20
» FIELD21
» FIELD22
» FIELD23
» FIELD24
» FIELD25
» FIELD26
» FIELD27
» FIELD28
» FIELD29
» FIELD30
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GenericEnvelope » FIELD31
Segment (contd.) , FELD32

» FIELD33
» FIELD34
» FIELD35
» FIELD36
» FIELD37
» FIELD38
» FIELD39
» FIELDA40
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Overview Error Messages

Overview

Introduction The Sterling Gentran: Server error messages and other informational messages are noted in
the Compile Errors dialog box when you compile the trand ation object or in the Error
section of the Extended Rul es dial og boxes when you compile an extended rule containing
errors prior to compiling the transl ation object, and when you commit an erroneous action
in Sterling Gentran:Server.

Theinformational messages are dependent on the context of the program, and are intended
to be self-explanatory. The error messages are described in the topics accessed below,
along with the actions you can take to correct the problem.

Inthisappendix  This appendix explains how to determine the action you should take when you receive an
error message.
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I ntroduction

Compile Error Messages

The Compile Error Messages are displayed in the Compile Errors dialog box if you
compile atrand ation object with errors. Or, error messages are displayed in the Error
section of an Extended Rule dialog box if you compile the extended rule containing errors
prior to compiling the translation object. After you correct the cause of the errors, click the
Compile button again to ensure that the ruleis error-free.

Messages  The compile error messages are listed by the four- or five-digit message number and the
error message text. The error definitions contain the actions that you can take to correct
the problem (if appropriate) and a description that includes possible causes of the error.

Msg ID M essage Text Explanation/Your Action
1000 expected "' Explanation
The rule does not have the required “.” between a group name
and afield name.
Your action
Insert a“.” between the group name and field name.
1001 no statement to Explanation
compile Theruleis does not contain any statements.
Your action
Add a statement or statements to therule.
1002 unexpected end of Explanation
program The rule was not compl ete.
Your action
Finish therule.
1003 expected ', Explanation
The rule does not have the required “,” between parameters.
Your action
Inserta“,” between parameters.
1004 expected *;’ Explanation
A statement was not terminated properly.
Your action
Terminate the statement in an appropriate manner.
1006 no statementsto Explanation
compile The body of an IF/EL SE or WHILE condition was empty.
Your action
Complete the body of the unfinished condition.

Administration Guide
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Error Messages

(Contd)
Msg ID M essage Text Explanation/Your Action
1007 syntax error ... Explanation
The map component contains a syntax error.
Your action
Correct the syntax error.
1008 expected ‘# Explanation
The rule does not have the required “#’ before afield name.
Your action
Insert a“#” before the field name.
2000 group ... undefined Explanation

The rule references a group that does not exist.

Your action
Change the reference to an existing group or delete the reference.

variables

2001 ...isnot amember of | Explanation
Therule references afield that does not belong to the specified
group.
Your action
Change the reference to an existing field in the specified group.
2002 insufficient indicesto | Explanation
access group ... The rule does not give the full addressing for a group.
Your action
Complete the addressing for the group.
2003 too many indicesto Explanation
access group... The rule uses too many addresses for the group.
Your action
Address the group correctly.
2004 ... has not been Explanation
defined The rule references an undefined variable.
Your action
Define the variable in the declarations section.
2005 out of temporary Explanation

The rule could not be compiled because some expressions are too
complex.

Your action
Simplify the expressions and compile the rule again.

Sterling Gentran:Server — May 2011
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(Contd)
Msg ID M essage Text Explanation/Your Action
2008 field type unknown Explanation
The compiler was unable to determine the type of afield.
Your action
Verify that a Data Typeis selected for thisfield.
2009 cannot reference a Explanation
local field with no Therule (probably pre- or post-session) references alocal field,
current group but is not associated with any group.
Your action
Reference the field using the proper addressing.
2010 instances of '%1' are Explanation
transient and cannot The rule references an output group using full addressing. This
be accessed form of addressing is only appropriate for input groups.
Your action
Reference the output group with the proper address.
2011 no field specified Explanation
Therule omits afield reference.
Your action
Add the field reference to the rule.
2012 group ... ispromoted | Explanation
and cannot be You attempted to access a promoted group in a COUNT or
accessed in this DELETE rule.
manner .
Your action
Do not COUNT or DELETE a promoted group.
2100 ... isnot an array Explanation
variable Therule uses array indexing for avariable that is not an array.
Your action
Use the proper indexing for the variable.
2101 ... array index Explanation
required Therule uses an array variable without using the necessary array
indexing.
Your action
Add the necessary indexing to the array variable.
2102 .... array overflow Explanation
Therule uses an invalid array index.
Your action
Use the proper array index for the array variable.

Administration Guide
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Error Messages

(Contd)
Msg ID M essage Text Explanation/Your Action
2103 only one wildcard Explanation
index is permitted The rule uses more than one wildcard index.
Your action
Only one wildcard index is permitted per rule.
2104 awildcard index must | Explanation
be specified The rule does not specify awildcard index when required.
Your action
Add awildcard index where necessary.
2200 expected a string Explanation
A required string or string variable is not supplied.
Your action
Add the required string or string variable.
2201 string overflow Explanation
A string overflow occurred.
Your action
Verify that the size of atarget string isequal to or greater than the
source string.
3000 array sizeexpectedin | Explanation
declaration of ... Invalid array declaration.
3001 declaration of ... Explanation
missing "' Invalid array declaration.
3002 string size expected Explanation
Invalid string declaration.
3003 string sizemissing']’ | Explanation
Invalid string declaration.
3004 variable name Explanation
expected Invalid variable declaration.
3005 ... dready defined Explanation
Two variables with the same name are defined at the same scope.
Your action
Rename one of the two variables.
3006 expected an Explanation
accumulator number, | Invalid accumulator reference.
found ...
3007 ...isnot avalid Explanation
accumulator number Invalid accumulator reference.
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(Contd)
Msg ID

M essage Text

Explanation/Your Action

4000

expected a numeric
expression, found ...

Explanation
You specified something other than the expected numeric
expression.

Your action
Specify the correct numeric expression.

4001

expected aterm,
found ...

Explanation
You specified something other than the expected term.

Your action
Specify the correct term.

4002

expected '+ or *-'

Explanation
You specified something other than the expected “+” or

Your action
a)mify " +11 Or " _H i

4003

expected *' or /'

Explanation
You specified something other than the expected “*” or
u/n .

Your action
a)a:i fy ek Orn /17 .

4004

expected )’

Explanation
You specified something other than the expected “)”.

Your action
a)mify H)ﬂ .

4005

expected afactor,
found ...

Explanation
Invalid numeric expression.

4006

expected '('

Explanation
You specified something other than the expected “ (".

Your action
Specify “(".

4007

... isof incorrect type

Explanation
The specified expression is of an incorrect type.

Your action
Specify the correct type for the expression.

Administration Guide
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(Contd)
Msg ID

M essage Text

Explanation/Your Action

4008

expected arelational
operator

Explanation
You specified something other than the expected rel ational
operator.

Your action
Specify the correct relational operator.

4009

missing argument

Explanation
A required parameter was omitted.

Your action
Add the required parameter.

4010

assignment expected

Explanation
The assignment operator was omitted from an assignment
statement.

Your action
Add the correct assignment operator to the statement.

4011

operator ... requires
two arguments

Explanation
Only one parameter was supplied for a binary operator.

Your action
Supply a second parameter for the binary operator.

4012

converting real to
integer may lose
significant digits

Explanation
You are converting areal number to an integer.

Your action
Verify that losing decimal places is acceptable in this instance.

4013

expression too
complex, use sub-
expressions

Explanation
A mathematical expression contains too many terms.

Your action
Group some of the terms of the mathematical expressionin
parentheses.

4014

expected an integer,
found ...

Explanation
The compiler expected to find an integer instead of [...].

Your action
Supply the correct value for [...].

4015

no valid condition
specified

Explanation
You did not specify avalid IF or WHILE condition.

Your action
Supply avalid condition in the IF or WHILE statement.
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Msg ID M essage Text Explanation/Your Action
4100 expected adate, found | Explanation
A date isrequired but not supplied.
Your action
Specify adate.
4101 expected adate Explanation
modifier, found ... A date modifier was required but not supplied.
Your action
Specify a date modifier.
4102 ... isnot adate Explanation
Invalid date expression.
5000 THEN expected Explanation
The compiler expected a THEN condition.
5001 DO expected Explanation
The compiler expected a DO condition.
5002 END expected Explanation
The compiler expected a END condition.
5004 FROM expected Explanation
The compiler expected a FROM condition.
5005 INTO expected Explanation
The compiler expected aINTO condition.
5006 END without BEGIN | Explanation
An END statement was found without a corresponding BEGIN
statement.
Your action
Insert a BEGIN statement in the correct location.
5016 misplaced ‘BREAK’ Explanation
The compiler found BREAK outside of aloop.
Your action
Remove the BREAK or placeit inside aloop.
5017 misplaced Explanation
‘CONTINUE The compiler found CONTINUE outside of aloop.
Your action
Remove the CONTINUE or place it inside aloop.

Administration Guide
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(Contd)
Msg ID M essage Text Explanation/Your Action
5018 too many parameters | Explanation
Too many parameters were supplied for afunction.
Your action
Remove the unnecessary parameters.
5019 too few parameters Explanation
Too few parameters were supplied for afunction.
Your action
Add the necessary parameters.
6000 expected a database Explanation
table name The compiler expected a database table name.
Your action
Insert a database table name in the necessary location.
6001 expected a database Explanation
column name The compiler expected a database column name.
Your action
Insert a database column name in the necessary location.
6002 too many column Explanation
receivers specified The number of columns specified did not match the number of
receiversin a SELECT statement.
Your action
Correlate the number of columns specified in the SELECT
statement to the number of receivers.
6003 too few column Explanation
receivers specified The number of columns specified did not match the number of
receiversin a SELECT statement.
Your action
Correlate the number of columns specified in the SELECT
statement to the number of receivers.
6004 WHERE expected Explanation
The compiler expected a WHERE statement.
6005 expected a database Explanation
key Aninvalid database key was specified in a WHERE statement.
Your action
Specify the correct database key in the WHERE statement.
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Msg ID M essage Text Explanation/Your Action
6006 WHERE not allowed | Explanation
with this database A WHERE statement is not necessary to access the specified
table database table.
Your action
Remove the WHERE statement.
6007 invalid key Explanation
combination The combination of keys specified in the WHERE statement is
not avalid unique compound key to the table.
Your action
Specify avalid combination of keysin the WHERE statement.
7000 ... isnot avalid seek Explanation
type You used an invalid seek type in FSEEK.
Your action
Use BEGIN, END, or CURRENT.
20001 | Record ..., Field...: Explanation
datefield missing date | The specified field does not have a date format.
format )
Your action
Edit the field and choose a date format.
20003 | Field ... : constant Explanation
used in standard rule | The standard rule for the specified field uses an invalid constant.
does not exist )
Your action
Correct the standard rule or create the constant.
20004 | Field...: codelist Explanation
used in standard rule | The standard rule for the specified field uses an invalid code list.
does not exist )
Your action
Correct the standard rule or create the code list.
20005 | Field...:thequdifier | Explanation
field specifiedinause | The standard rule for the specified field uses an invalid qualifier.
constant standard rule )
isinvalid Your action
Correct the standard rule.
20006 | Field...: thefield Explanation
specified to storethe | The standard rule for the specified field designates an invalid
code descriptionina | field for the description.
use code standard rule )
isinvalid Your action
Correct the standard rule.

Administration Guide
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Msg ID M essage Text Explanation/Your Action
20007 | Record ...:the Explanation
specified key field ... : | Thekey field for the specified record uses an invalid constant.
uses an undefined )
constant Your action
Correct the key field.
20008 | Record...:the Explanation
specified key field ... : | The key field for the specified record uses an invalid code list.
uses an undefined )
code list Your action
Correct the key field.
20010 Record ... : the Explanation
specified key field ... : | Thekey field for the specified record isinactive.
isinactive )
Your action
Activate the key field.
20700 only one binary data Explanation
and one binary length | You have more than one binary data and/or more than one binary
field are permitted length element in one segment.
Your action
Remove the additional binary data and/or binary length elements
from the segment.
20701 binary length must Explanation
precede binary data The binary length element must be sequenced before the binary
data element in the segment so the translator knows how much
data to expect.
Your action
Move the binary length element to before the binary data
element.
20702 incompl ete binary Explanation
data You marked a segment as binary, but did not include either a
binary length element or abinary data element (or both).
Your action
Add abinary length element and/or a binary data element to the
segment.
20703 group ... hasno active | Explanation
child objects You tried to compile the trand ation object, but the specified
group is empty.
Your action
Activate at |east one child object in the group.
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Msg ID M essage Text Explanation/Your Action
20704 | Element ..., Attribute | Explanation
.... enumerated The specified XML attribute is configured to use an enumeration
attribute declared but there is no code list standard rule that defines the allowed
without values.
accompanying .
standard rule Your action
Define ause code list standard rule for the specified attribute.
20705 | Element ..., Attribute | Explanation
... codelist used in The code list for the specified enumerated XML attribute does
enumerated attribute | not exist.
does not exist. )
Your action
Define the code list.
20706 | Element ..., Attribute | Explanation
.... default valueisnot | The specified default value is not in the code list for this XML
valid ... attribute.
Your action
Ensure that the specified default value isin the code list.
20707 | Codelist ..., Attribute | Explanation
... valueused in A valuein the enumeration code list is not valid for XML.
enumerated attribute )
code list does not Your action - _ _
match XML Verify that al the value specified in the code list are valid (legal)
NMTOKEN for an XML attribute.
production
20708 Entity ... : Entity value | Explanation
isinvalid The value of the specified entity is not valid (legal) in XML.
Your action
Correct the entity value.
20709 | ...: lllegd use of Explanation
reference character An entity reference was not terminated properly.
Your action
Correct the entity reference.
20710 ... - Malformed Explanation
character reference An XML character reference was not terminated properly.
encountered )
Your action
Correct the character reference.
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Msg ID M essage Text Explanation/Your Action
20711 | ...:Invalid character Explanation
referenced An XML character referenceisinvaid.
Your action
Correct the character reference.
20712 | ...: Referenceto Explanation
undefined entity The referenced entity is not defined.
encountered )
Your action
Define the correct entity.
20713 | ...: Circular entity Explanation
references An entity references an entity that in turn references the original
encountered entity.
Your action
Do not reference the original entity in acircular manner.
20714 | ...: default does not Explanation
match the attribute The default value is the wrong type for the attribute.
type .
Your action
Either correct the type of the attribute or the default value.
20715 | ...: Containsillegal Explanation
character (‘<') The default value contains the illegal character ‘<.
Your action
Correct the default value.
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M essages

Administration Guide

The Sterling Gentran: Server error messages are displayed when you commit an erroneous
action. When the system displays an error message, you must first acknowledge the
message by either clicking OK, and then take the appropriate action.

The error messages are listed alphabetically below by thefirst |etter of the error message
text. The error definitions contain the actions that you can take to correct the problem (if
appropriate) and a description that includes possible causes of the error.

M essage Text

Explanation/Your Action

A codelist entry must have a code
value

Explanation
You attempted to add a code without an
associated code value.

A code list must have an e ement id

Explanation
You attempted to create a code list without an
element ID.

A code list for this element already
exists. You must use another element
id or delete the original code list first

Explanation

You attempted to create a code list with the
same element ID as an already existing code
list.

Your action
Either change the element ID or delete the
original codelist.

A condition field is required

Explanation
You established a conditional relationship that
requires acondition field, but did not specify a
condition field.

A datatypeisrequired.

Explanation
You did not specify the Data Type of afield.

A field must have anamethat is
unique within its parent group

Explanation

You tried to give afield aname that is already
in use by another field within the same group
(not necessarily the same record).

A group must have a unique name

Explanation
You tried to give agroup anamethat is already
used by another group or record.

A group or record with a maximum
usage of 1 cannot be split or promoted

Explanation

You attempted to split or promote a single-
occurrence group or record. Thisisnot avalid
action.
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M essage Text Explanation/Your Action

A key field hasbeen selected but no | Explanation

key value has been specified. You established akey field without specifying
akey value.
A Memory Exception has occurred. Explanation

A system error occurred.

Your action
Exit Sterling Gentran: Server and restart
Microsoft Windows.

A name must be entered Explanation
You did not specify a name for an object.

A problem occurred while attempting | Explanation
tocloseloop .... Thisis probably due | Anerror occurred when reading from the
to incorrect standards. standards.

A record must have a unique name Explanation
You tried to give arecord anamethat is
aready used by another group or record.

A Resource Exception has occurred. | Explanation
A system error occurred.

Your action
Exit Sterling Gentran: Server and restart
Microsoft Windows.

A serious error was encountered Explanation

whilst accessing the clipboard and the | The system aborted a cut, copy, or paste

action was abandoned operation because a serious error occurred.
Your action

Perform the cut, copy, or paste operation again.

A system error was encountered Explanation

while compiling the trandation object | While compiling atranslation object, a system-
related problem, such as lack of memory,
prevented the compile from completing.

Your action

Close unnecessary applicationsto free
memory, and reboot your computer (if
necessary), and then recompile the translation
object.
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M essage Text

Explanation/Your Action

A TDF could not be generated due to
alack of available memory. Either
restart Microsoft Windows or close
down other applications, then try

again

Explanation
While generating a TDF, the system ran out of
memory.

Your action
Exit Sterling Gentran: Server, restart Microsoft
Windows and regenerate the TDF.

An accumulator must be chosen for
thisentry

Explanation
You did not specify the accumulator to be used
in aUse Accum standard rule.

Aninvalid usage count has been
entered

Explanation
You entered an invalid usage count for arecord
or group.

No actions have been chosen for this
accumulator entry

Explanation

You selected an accumulator but did not
specify any actionsfor it in aUse Accum
standard rule.

No alternate accumulator has been
selected

Explanation

In aUse Accum standard rule, you attempted
to create an accumulator entry that used an
aternate accumulator, but did not specify
which alternate accumulator should be used.

No character ranges have been
specified for this token.

Explanation
You did not specify the characters allowed for
asyntax token.

No fields have been used in this
relationship

Explanation
You established a conditional relationship but
did not specify the fields involved.

No more accumulator entries can be
created

Explanation

You attempted to create more than six
accumulator entriesin a Use Accum standard
rule.

No more field mappings can be
created

Explanation
You attempted to create more than eight field
mappings for a Select standard rule.

The constant ID must be unique.

Explanation

You entered aliteral constant identifier in the
ID field that is already used in an existing
constant.

Your action
Type aunique literal constant identifier in the
ID field.
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M essage Text

Explanation/Your Action

The contents of the clipboard cannot
be pasted into the trandl ation object at
this point

Explanation

Either the Clipboard does not contain copied or
cut data, or you are trying to paste XML
information into a positional file format or
paste position information into an XML file
format.

The file format cannot be del eted

Explanation
You tried to delete afile format object.

The Maximum Usage must be greater
then zero and not less than the
Minimum Usage.

Explanation
You entered an invalid maximum usage count.

The number of entriesto be split must
be greater than zero and less than the
maximum number of entriesin the
origina

Explanation

You entered an invalid number in the Split
dialog box. The number to be split must be
greater than zero and less than the maximum
number of entriesin the original.

The tranglation object could not be
compiled

Explanation
The tranglation object is not ready to be
compiled.

The token code must be unique.

Explanation

You attempted to create a syntax token with the
same token identifier as an existing syntax
token.

Your action
Type aunique token identifier in the Token
field.

These fields cannot be linked because
theinput field is deeper than the
output field. The translator would be
unable to address the input field.

Explanation

You are attempting to create an invalid link. A
vaid link involvesan Input field and an Output
field that are at the same level.

This code already exists. You must
use another code or delete the original
codefirst

Explanation
You attempted to add a code to a code list that
aready contained that code.

Thisfield cannot be linked to another
field

Explanation

Due to an unknown error, Sterling
Gentran:Server was unable to begin creating
the link.

Thisfileisnot avalid Gentran
translation object

Explanation
You attempted to open (load) afilethat isnot a
tranglation object.
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M essage Text

Explanation/Your Action

You have entered an invalid character
or character code in Record Delimiter
1

Explanation

You entered an invalid Record Delimiter 1 on
the Positional File Format Properties dialog
box.

You have entered an invalid character
or character codein Record Delimiter
2

Explanation

You entered an invalid Record Delimiter 2 on
the Positional File Format Properties dialog
box.

You have entered an invalid decimal
separator or character code.

Explanation
You entered an invalid decimal separator.

You have entered an invalid element
delimiter character or character code

Explanation
You entered an invalid element delimiter.

You have entered an invalid Pad
character or character code

Explanation
You entered an invalid pad character for a
positiona field.

You have entered an invalid release
character or character code

Explanation
You entered an invalid release character.

You have entered an invalid sub-
element delimiter character or
character code

Explanation
You entered an invalid sub-element delimiter.

You have entered an invalid tag
delimiter character or character code

Explanation
You entered an invalid tag delimiter.

You must enter a description of the
tranglation object.

Explanation

You attempted to save the trandlation object
without entering the transl ation object
description on the Translation Object Details
dialog box.

Your action

Type the tranglation object description in the
Description field on the Translation Object
Details dialog box. Thisfield must be unique
because it is used by the system to identify the

map.

You must enter a subtable name.

Explanation

For a Select or Update standard rule, the
selected table requires you to specify atable
name in the Sub Tablefield.

You must enter avalid character
range.

Explanation
You entered an invalid character range for a
syntax token.
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M essage Text Explanation/Your Action

You must enter avalid syntax token. | Explanation
You did not enter avalid token identifier in the
Token field when creating or editing a syntax

token.

You must enter avalue for this Explanation

constant. You did not specify avalue for the constant in
the Value field when creating or editing a
syntax token.

You must enter an ID. Explanation

You did not specify aliteral constant identifier
for the constant in the ID field when creating
or editing a syntax token.

You must enter the name of theauthor | Explanation

of thistrandlation object You attempted to save the translation object
without entering the name of the translation
object author on the Trandation Object Details
dialog box.

You must select a constant type. Explanation
You did not select a constant type from the
Type list when creating or editing a constant.

You need to specify Input and Output | Explanation

File Typesfor the new translation You clicked OK on the Create New

object Tranglation Object dialog box without
selecting both the Input Format Type and
Output Format Type.
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Trangdlator Report Error Messages

I ntroduction

M essage number
column

M essage column

Administration Guide

The Document and Interchange Translator Report error messages are displayed on the
Document Translator Report and the Interchange Translator Report under the Message
Number and Message columns.

The Message Number column on the translator report contains a prefix (INF, EDI, or
POS), adash (“-"), and afour digit number that identifies the error. The prefixes are
described in the following table

Prefix Description
INF Used only with information messages, which are not defined in this chapter
because they are intended to be self-explanatory.
EDI Used with all the messages listed below that are not informational. It isused
if the error isrelated to an EDI file.
POS Used with all the messages listed below that are not informational. It is used

if the error isrelated to a positional flat file.

The Message column on the translator report contains the actual error message text.
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Trandator error Thetrandator report error messages are listed bel ow by the last three digits of the message
messages  number and the error message text.

Msg 1D M essage Text Explanation/Your Action
100 Mandatory Element Explanation
Missing An element that the transl ation object designated as“Mandatory”

was not created in an Outbound document or was not received in
an Inbound document.

Your Action

Use the Segment/Record 1D, Sequence, and Element fields on
the Trand ator Report to determine which mandatory element in
the document is missing.

Outbound

If the document was entered using the Document Editor, open the
document and compl ete the missing field. If you imported the
document into your system, delete the document and then import
that document after the import file has been corrected. See Using
Documentsin the IBM® Serling Gentran: Server® for Microsoft
Windows User Guide for more information on opening and
deleting, and importing documents.

Inbound
Contact your trading partner and determine what action you
should take.
110 Incorrect Element Explanation
Format An element was entered or received with an incorrect format.

Some examples of incorrect format are: a numeric field that
contains non-numeric characters, and afield that exceeds the
maximum length or is less than the minimum length (as defined
in the standard) and invalid dates.

Your Action

Use the Segment/Record 1D, Segquence, and Element fields on
the Trand ator Report to determine which element in the
document isinvalid.

Outbound
Correct the data source.

Inbound
Contact your trading partner and determine what action you
should take.
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(Contd)
Msg ID M essage Text Explanation/Your Action

120 Too Many Explanation

Componentsin A composite element in a document you received has more
Composite component elements (sub-elements) than allowed by the
standard.

Your Action

Use the Segment/Record ID, Segquence, and Element fields on
the Trandator Report to determine which element in the
document isinvalid.

Outbound

If the document was entered using the Document Editor, open the
document and correct the invalid field. If you imported the
document into your system, delete the document, correct the
data, and then import that document again. See Using
Documentsin the IBM® Serling Gentran: Server® for Microsoft
Windows User Guide for more information on opening and
deleting, and importing documents.

[nbound
Contact your trading partner and determine what action you
should take.

130 Invalid Conditional Explanation
Relationship A conditional relationship in the document is not valid.

Your Action
Use the trangdlator report to determine where in the document the
error occurred.

Outbound

If the document was entered using the Document Editor, open the
document and correct the conditional relationship. If you
imported the document into your system, delete the document
and then import that document again.

[nbound
Contact your trading partner and determine what action you
should take.

140 Implicit Rule Failure | Explanation

A validation rule set up against this field failed in the trandl ator.
Typicaly, this occurs when the Exclusive flag is set for a
standard rule, and the field value does not match the data table.

Your Action
Check the data value that you received against the valid data that
is allowed for the field.
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(Contd)
Msg ID

M essage Text

Explanation/Your Action

200

Mandatory
Component Missing

Explanation

A component (sub-element) of a composite element that the
translation object designated as “Mandatory” was not created in
an Outbound document or not received in an Inbound document.

Your Action

Use the Segment/Record 1D, Sequence, Element, and Composite
fields on the Translator Report to determine which mandatory
component in the document is missing.

Outbound

If the document was entered using the Document Editor, open the
document and compl ete the missing field. If you imported the
document into your system, del ete the document and then import
that document again.

[nbound

Contact your trading partner and determine what action you
should take.

210

Incorrect Component
Format

Explanation

A component (sub-element) of a composite element that the
translation object designated as “Mandatory” was entered
(Outbound) or received (Inbound) with an incorrect format.
Some examples of incorrect format are: a numeric field that
contains non-numeric characters, and afield that exceeds the
maximum length or is less than the minimum length (as defined
in the standard).

Your Action

Use the Segment/Record 1D, Sequence, Element, and Composite
fields on the Trand ator Report to determine which element in the
document isinvalid.

Outbound

If the document was entered using the Document Editor, open the
document and correct the invalid field. If you imported the
document into your system, delete the document, correct the
data, and then import that document again.

[nbound
Contact your trading partner and determine what action you
should take.

220

Component Delimiter

Explanation
A component delimiter was encountered instead of the expected
element.

Your Action
Contact either/or your trading partner or the translation object
creator and determine what action you should take.
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(Contd)
Msg ID M essage Text

Explanation/Your Action

300 Mandatory Segment

Explanation

A segment that the trandlation object designated as “ Mandatory”
was not created in an Outbound document or was not received in
an Inbound document.

Note

This error can be generated in avariety of circumstances. The
most common is that the input data sequence does not
correspond to the data sequence defined in the tranglation object
used to trandlate the data. If thisisthe case, the information
provided with the message may indicate a segment in the data.

Your Action
Use the Segment/Record ID field on the Trand ator Report to
determine which mandatory segment in the document is missing.

Outbound

If the document was entered using the Document Editor, open the
document and key datainto the fields that are necessary to
generate the segment. If you imported the document into your
system, delete the document, add the data that is necessary to
generate the segment, and then import that document again.

Inbound
Contact your trading partner and determine what action you
should take.

310 Invalid Loop Start/
End Structure

Explanation
Aninvalid Loop Start/Loop End was found in an Inbound
document.

Your Action

Use the information in the trandlator report to determine which
LS/LE pairing isinvalid. Contact your trading partner and
determine what action you should take.

315 Invalid Segment or
Record Structure

Explanation

A segment (in an EDI file) or arecord (in a positiona flat file) in
an inbound file did not match what the translation object was
expecting.

Your Action

From viewing the information in the translator report and
viewing the “Raw EDI” interchange, determine which segment
or record isinvalid. Contact your trading partner to determine
what action you should take. See How to View Interchangesin
the IBM® Serling Gentran: Server® for Microsoft Windows
User Guide for more information.

Administration Guide
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Error Messages

(Contd)
Msg ID

M essage Text

Explanation/Your Action

405

Unknown Partner

Explanation
An Interchange was received but the system cannot determine
which partner sent it.

Your Action

From viewing the information in the transl ator report and
viewing the “Raw EDI” interchange, determine which partner
sent you the interchange. If the partner is not listed on your
system, create the partner and a relationship, and attach the
interchange to that partner. If the partner already exists on your
system, attach the interchange to that partner and then determine
why the system did not automatically identify the partner.

410

Header/Trailer
Control Numbers do
not match

Explanation
The control numbers on the header and trailer do not match, as
specified by the standard.

Your Action

Check the “Raw EDI” view to determine which control numbers
are in the EDI file, and then contact your trading partner to
determine what action you should take. See How to View a
Document in the IBM® Serling Gentran: Server® for Microsoft
Windows User Guide for more information on viewing a
document.

415

Control Total
Incorrect

Explanation

The EDI control total in the Segment Identified field of the
translator report does not equal the value that was calcul ated by
the Compliance Checker.

Your Action

Check the “Raw EDI” view to determine what the control total
should be, and then contact your trading partner to determine
what action you should take. See How to View a Document in
the IBM® Serling Gentran: Server® for Microsoft Windows
User Guide for more information on viewing a document.
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(Contd)
Msg ID M essage Text Explanation/Your Action

420 Unknown Explanation
Relationship A document was received but the Partner Profile for that partner
does not include a corresponding Inbound Relationship.

Your Action

From the viewing the information in the trans ator report and
viewing the “Raw EDI” interchange, determine which
relationship the document requires and create that inbound
relationship for the partner. See How to View Interchangesin the
IBM® Serling Gentran: Server® for Microsoft Windows User
Guide for more information on viewing interchanges. See How
to Create aNew Inbound Relationship in the IBM® Serling
Gentran: Server® for Microsoft Windows User Guide for more
information on creating inbound relationships.

460 Invalid Test Mode Explanation

Flag The partner relationship was found but the test mode flag in the
data did not match the test mode defined in the inbound partner
relationship.

Your Action

Change the test mode of the inbound partner relationship to
match the test mode of the data. See How to Create a New
Inbound Relationship in the IBM® Serling Gentran: Server® for
Microsoft Windows User Guide for more information on creating
inbound relationships. Then, ask your trading partner to change
the test mode of the data they are sending to match that defined
by the inbound relationship.

User Level Error User-level type errors can occur when extended rules are used in the map.

M essages
The user-level error messages are listed below in numerical order based on their Message
ID. The table also includes an explanation of the error and an action you can take to
correct the error.
Msg 1D M essage Text Explanation/Your Action
800 Batch File Header Explanation
Section Missing The system cannot find a header section record within the batch
file
Your action

Contact your Trading Partner.
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(Contd)

Msg ID M essage Text Explanation/Your Action

801 Unexpected Header Explanation

Segment 1D A value other than “00” isin the header section record segment

Identifier field (701).
Your action
Contact your Trading Partner.

802 Unexpected Explanation

Transmission Type

A transmission value other than T (Transaction), R (Response),
or E (Error) isin the transmission type (880-K 6) field of the
header section record.

Your action
Contact your Trading Partner.

803

Sender ID Missing

Explanation
The system cannot find avaluein the sender ID (880-K1) field in
the Header Section Record.

Your action
Contact your Trading Partner.

804

Invalid Batch Number

Explanation
The batch number field (806-5C) contains aformat other than the
YYDDD format, where:

» YY=Year
» DDD=Julian date

Your action
Contact your Trading Partner.

805

Unexpected File Type

Explanation
A value other than P (Production) or T (Test) isin the File Type
field (702).

Your action
Contact your Trading Partner.

806

Receiver ID Missing

Explanation
The system cannot find avaluein the receiver ID field (880-K7)
of the header section.

Your action
Contact your Trading Partner.

807

Batch File Detail Data
Record Missing

Explanation
The system cannot find a Detail Data Record within the batch
file

Your action
Contact your Trading Partner.
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(Contd)
Msg ID

M essage Text

Explanation/Your Action

808

Unexpected Data
Segment ID

Explanation
A value other than “G1” isin the segment identifier field of the
Detail Data Record (701).

Your action
Contact your Trading Partner.

809

Transaction Reference
Number Missing

Explanation
The system cannot find avaluein the transaction reference
number field of the Detail Data Record (880-K5).

Your action
Contact your Trading Partner.

810

Batch File Trailer
Record Missing

Explanation
The system cannot find the trailer record within the batch file.

Your action
Contact your Trading Partner.

811

Invalid Trailer
Segment ID

Explanation
A value other than “99” isin the segment identifier field (701) of
thetrailer record.

Your action
Contact your Trading Partner.

812

Unexpected Batch
Number

Explanation
The batch number field (806-5C) of the trailer record does not
match the batch number field (806-5C) of the header record.

Your action
Contact your Trading Partner.

813

Invalid Record Count

Explanation
The record count field (751) of the trailer record contains an
invalid number.

Your action
Contact your Trading Partner.

814

Processed DDRs
Mismatch Record
Count

Explanation
The actual count of Detail Data Records is different from the
value in the record count field (751) of the trailer record.

Your action
Contact your Trading Partner.

Administration Guide

Sterling Gentran: Server — May 2011



Tranglator Report Error Messages Error Messages

(Contd)
Msg ID M essage Text Explanation/Your Action

815 Duplicate Segment Explanation
Within Transaction A segment occurs more than one time within the transaction.

Your action
Contact your Trading Partner.

816 Unexpected Explanation

Transaction Code A value other than avalue listed below isin the transaction code
field (103-A3) of the request transaction header segment or
response header segment.

» E1=Eligibility Verification

» Bl=Billing

» B2=Reversa

» Pl=Rehill

» P2=PA.Request & Billing

» P3=PA. Inquiry

» P4=PA.Request Only

» N1 =Information Reporting

» N2 =Information Reporting Reversa

» N3 =Information Reporting Re-bill

» C1=_Controlled Substance Reporting

» C2=_Controlled Substance Reporting Reversal
» C3=Controlled Substance Reporting Re-bill

Your action
Contact your Trading Partner.

817 Invalid Transaction Explanation

Count A vaue other than avalue listed below isin the transaction count
field (109-A9) of the request transaction header segment or the
response transaction header segment.

» Blank = not specified

» 1=0neOccurrence (Default)

» 2 =Two Occurrence (Except Transaction Code E and P)
» 3 =Three Occurrence (Except Transaction Code E and P)
» 4 =Four Occurrence (Except Transaction Code E and P)

Your action
Contact your Trading Partner.
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818 Processed Explanation
Transactions The actual count of the transactionsis different from the valuein
Mismatch Transaction | the transaction count field (109-A9) of the response header
Count segment.
Your action
Contact your Trading Partner.
819 Unexpected Header Explanation

Response Status Code | A value other than A (Accepted) or R (Rejected) isin the header
response status field (501-F1) of the response header segment.

Your action
Contact your Trading Partner.

820 Unexpected Explanation
Transaction Response | A value other than avalue listed below isin the transaction
Status Code response status field (112-AN).
» A =Approved
» C=Captured

» D =Duplicate of Paid
» F=PA Deferred

» P=Pad
» Q=Duplicate of Capture
» R=Regected

» S=Duplicate of Approved

Your action
Contact your Trading Partner.
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Error Messages

Core tranglator type errors can occur when you are receiving or sending data.

The core translator error messages are listed below in numerical order based on their
Message ID. Thetable also includes an explanation of the error and an action you can take

to correct the error.

Msg ID M essage Text

Explanation/Your Action

830 Null Character

Explanation
The data file contains binary data.

Your action
Contact your Trading Partner.

833 Unexpected End of

File

Explanation
A field of a specified length isincomplete.

Your action
Contact your Trading Partner.

835 Unexpected Start of

Text

Explanation
The record does not contain End of Text character.

Your action
Contact your Trading Partner.

836 Unexpected End of

Text

Explanation
The record does not contain Start of Text character.

Your action
Contact your Trading Partner.

837 Missing Stream

Separatorl

Explanation
The system is reading non-streamed data with atemplate from a
map where “ stream segments’ box is unchecked.

Your action
Contact your Trading Partner.

838 Missing Stream

Separator2

Explanation
The system reading non-streamed data with a template from a
map where “ stream segments’ box is unchecked.

Your action
Contact your Trading Partner.

839 Unexpected Separator

Explanation
A group separator, segment separator, field separator, STX, or
ETX is present in the data

Your action
Contact your Trading Partner.
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840 Unexpected Field Explanation
Separator Based on the map, two field separators occur consecutively or a
different separator is expected.

Your action
Contact your Trading Partner.

841 Unexpected Group Explanation
Separator Based on the map, a group separator occurs when none was
specified.

Your action
Contact your Trading Partner.

842 Missing Group Explanation
Separator Based on the map, a group separator is missing.

Your action
Contact your Trading Partner.

843 Unexpected Stream Explanation
Separatorl Based on the map, a stream separatorl is occurs when none was
specified.

Your Action
Contact your Trading Partner.

845 Positional Tag Explanation
Defined Beyond EOS | The position of the transaction code (Positional Record Tag) is
specified to start beyond the end of the segment.

Your action
Change the value of the positional segment under the NCPDP
Properties tag to start before the end of the segment.

855 Delimited Segment Explanation
Has No Fields The delimited segment must have at |east the mandatory fields.

Your action
Contact your Trading Partner.

856 Missing Delimited FS | Explanation
After SS The delimited field separator is not present after the segment
separator.

Your action
Contact your Trading Partner.
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857 Field ID Data Does Explanation
Not Match Map Field | Thefield ID datais different from the defined delimited field ID
ID tag.
Your action
Contact your Trading Partner.
858 Unexpected Char(s)in | Explanation

Delimited Field ID A separator was found in the delimited field ID data.

Your action
Contact your Trading Partner.

859 Null Character in Explanation
Delimited Field ID The delimited field ID contains binary data.

Your action
Contact your Trading Partner.

860 Incomplete Delimited | Explanation
Field ID Thefield ID datais shorter than expected.
Your action

Contact your Trading Partner.

861 Missing Delimited Explanation
Field Data No datais found after adelimited field ID.
Your action

Contact your Trading Partner.

862 Null Character in Explanation
Delimited Field Data | The delimited field data contains binary data.

Your action
Contact your Trading Partner.

865 Segment ID Data Explanation
Does Not Match Map | The segment ID datais different from the defined delimited
Segment 1D segment ID field.
Your action

Contact your Trading Partner.

866 Unexpected Char(s)in | Explanation
Delimited Segment ID | A separator was found in the delimited segment ID.

Your action
Contact your Trading Partner.
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Explanation/Your Action

867

Null Character in
Delimited Segment 1D

Explanation
The delimited segment ID contains binary data.

Your action
Contact your Trading Partner.

868

Incomplete Delimited
Segment ID

Explanation
The delimited segment ID is shorter than expected.

Your action
Contact your Trading Partner.

869

Field ID Size Differs
From Global Field ID
Size

Explanation
The computed size of the segment/field ID is different from the
value of the global field ID length.

Your action
Contact your Trading Partner.

885

No Data after STX in
Batch Segment

Explanation
The batch record does not contain any data.

Your action
Contact your Trading Partner.

886

Unexpected STX in
Batch Segment

Explanation
The batch record does not contain an ETX character.

Your action
Contact your Trading Partner.

887

Missing ETX in Batch
Segment

Explanation
The batch record does not contain an ETX character.

Your action
Contact your Trading Partner.

Administration Guide
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Core Trandator
Error Messages.
sending batch data
using the NCPDP
Data Record field

Error Messages

Core trandlator errors can also occur when you are sending batch data using the NCPDP
Data Record field to your Trading Partner. Many times the error results because the Batch
File string is missing a portion of the Batch File or avalue in the string isincorrect.

To prevent errors from occurring verify that the Batch File string follows the detail data

record (DDR) format:

<separator>filename<separator>StartOff set<separator>EndOff set<separator>.

The core translator error messages are listed below in numerical order based on their
Message ID. Thetable also includes an explanation of the error and an action you can take

to correct the error.

Msg ID M essage Text Explanation/Your Action
888 Could Not Open Explanation
NCPDP DataFile The NCPDP datafile either does not exist or it is not readable.
Your action
Verify that the file you are selecting is the correct filename or
supply the information that is missing from the string field.
890 Missing Separator in | Explanation
DDR Info String A separator is missing from the DDR string field.
Your action
Inserta“;” inthe DDR string field.
891 Missing Filenamein Explanation
DDR Info String Thefilenameis not in the DDR string field.
Your action
Add the filename to the DDR.
892 Invalid Start byte Explanation
Offset in DDR Info The system found non-numeric data at start of set.
String .
Your action
Add avalid start of set (numeric) value.
893 Invalid End Byte Explanation
Offset in DDR Info The system found non-numeric data at end of set.
String .
Your action
Add avalid end of set (numeric) value or remove the dataif data
up to end of file should be processed.
894 Missing Start/End Explanation
Byte Offsetin DDR The Start/End Byte Offset is not in the DDR string field.
Info String )
Your action
Add the Start/End Byte Offset to the DDR string field or remove
extra separators.
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Msg ID

M essage Text

Explanation/Your Action

895

ExtraDatain DDR
Info String

Explanation
The DDR string contains extra data.

Your action
Remove the extra data from the DDR string.

896

Total Bytes Read
Mismatch Total Bytes
to Read

Explanation
The actual number of bytes read is less than the number of bytes
specified in the set.

Your action
Verify the Start/End Byte Offsets or remove the end byte offset if
data up to end of file should be processed.

897

Start Byte Offset is
Beyond End of File

Explanation
The position of the Start Byte Offset is specified to start after the
end of thefile.

Your action
Change the start position of the Start Byte Offset.

898

Start Byte Offset is
Beyond End Byte
Offset

Explanation
The position of the Start Byte Offset starts after the position of
the End Byte Offset.

Your action

Change the position of the Start Byte Offset to start before the
End Byte Offset, or change the position of the End Byte Offset to
start after the Start Byte Offset.

Administration Guide
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Overview

Assumptions  Use of this appendix assumes that you:

» Arefamiliar with the use of ActiveX Automation Servers and languages such as
Visual Basic.

» Know the Trandator Programming Language (TPL) constructs for creating,
manipulating, and deleting ActiveX objects.

» Know the ProgID of the ActiveX object and all its exposed interfaces.
» Understand how and when extended rules are invoked and their scope.
Advanced feature

User exits are an advanced feature of Sterling Gentran: Server that should only be used
with the above prerequisites.

Restrictions  Sterling Gentran: Server extended rules selectively support ActiveX technology.

Supported
Sterling Gentran: Server extended rules support:

» ActiveX Automation Servers.
» Some ActiveX Controls, but only those that work as Automation Servers.

Not supported
Sterling Gentran: Server does not support:

» ActiveX controlsthat are not ActiveX Automation Servers. Such ActiveX controls
must be hosted in a graphical user interface (GUI) display, and therefore cannot be
used from extended rules.

» ActiveX Arrays(e.g., the VT_ARRAY datatype modifier)

» References(e.g., the VT_BY REF datatype modifier) except for output parametersin
method calls. In thisinstance, references are only valid for the duration of the method
cal.

»  Sterling Gentran:Server does not read registry entries or type libraries when
compiling extended rules to verify the accuracy of programmatic identifiers
(ProglDs) or interfaces.

» Extended rulesthat compare two ActiveX properties or method results, or any
combination of properties or method results. This type of comparison isinvalid
because property and method types are unknown prior to compilation and thusit is
not possible to generate the correct comparison code.
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Definition of ActiveX Terminology

What is Activex?

What isan
ActiveX
automation
server?

What isthe
I Dispatch
interface?

What isa method?

What isa
property?

What are ActivexX
controls?

Administration Guide

ActiveX isaterm that encompasses a set of rules that define how applications should
shareinformation. ActiveX grew out of technologies developed by Microsoft, specifically
Object Linking and Embedding (OLE) and Component Object Model (COM).

An ActiveX automation server isan ActiveX component (a.DLL or .EXE program) that
can expose part of its functionality, specifically properties and methods, via the I Dispatch
interface to another program on the system.

Some ActiveX controls function as automation servers.

The|Dispatch interfaceisastandard COM interface. Automation Serverstypically expose
their methods and properties through this interface.

A method is an action or function that is performed by an object (e.g., acalculation or a
search).

A property is acharacteristic or parameter of an object (e.g., type, size, or creation date).

ActiveX controls are a specifically defined method of implementing ActivexX
technologies. Basically an ActiveX control is a software component that executes
common tasks and can integrate into the user interface of an application that provides the
necessary ActiveX control host functionality.

The ActiveX control specification enables you to build component software that interacts
with your application and Sterling Gentran:Server. ActiveX controls require a user
interface, so they are not appropriate for tranglation user exits. These controls can be
developed in avariety of programming languages, including Visual Basic.
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Serling Gentran: Server User Exit Overview

Why use user User exits allow you to enhance your functionality or fulfill specific requirements that
exits?  Sterling Gentran:Server does not perform during normal translation.

User exitswith  Sterling Gentran:Server supports user exitsin all types of translation objects through
Gentran  extended rulesthat enable the use of Microsoft’s ActiveX technology. This feature allows
you to use extended rules to invoke custom functionality that was created as an ActiveX
Automation Server.

Specifically, you can:

» create objects,

» delete objects,

» query objects,

D  access properties, and
» invoke methods.
Note

You can create your own custom functionality as an ActiveX Automation Server, or you
can use third party Automation Servers.

Sterling Gentran: Server supports ActiveX indexed properties, specifically these types of

index:

» variant
» numeric
» string

Theindex support alows you to use these syntaxes (if they are supported by your
Automation server):

n
n
n

ob. property[1];
ob. property[“Count”];
ob. property[ob. nethod()];

Sterling Gentran: Server also supports chaining of ActiveX method calls and properties,
which simplifies extended rules for Automation servers with moderately complex object
models (e.g., ADO).

Example
The following is an example of chaining statements:

recordset.fields.iten]“Mssageld’].val ue
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Examplesof user  User exits may be used in the following manner.
exits » To accessyour database table to perform cross-reference or lookups instead of using
the Sterling Gentran: Server tables.

» To perform complex pricing calculations (e.g., involving multiple customers, where
they are located, and where the product is sold).

Datatypes  Thefollowing table lists the extended rule data types and the corresponding ActiveX data
supported  typesthat are supported for use with user exits:

Extended Rule Data Type ActiveX Data Type
INTEGER VT_14
REAL VT_RS8
DATETIME VT_DATE
STRING VT_BSTR
OBJECT VT_DISPATCH

Datatype  The Sterling Gentran:Server translator automatically converts the extended rule data type
conversion to the ActiveX datatype, whenever possible. If the conversion cannot be performed, a
type mismatch error is written to the Audit Log and the extended rule isimmediately
terminated. An error is also written to the translator report, if oneis used by the operation.
Since an export operation does not generate a translator report, any conversion errors
during export translation are only written to the Audit Log.

Objects  ActiveX automation servers use the datatype OBJECT, which consists of two elements:
properties (a defined set of data) and methods. A method is afunction that is defined by
the interface of the object.

All objects that are automation servers provide the default interface | Dispatch, which
exposes the internal functions of an application to Sterling Gentran: Server. You can also
expose other interfaces.

Example
Internet Explorer exposes the interface |WebBrowser2.
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Syntax  The object must be declared and then created viathe CREATEOBJECT command, by
pointing to the object’s I Dispatch interface. Then, the object’s methods may be invoked
using the syntax object.method(parameters).

The user may specify the Progl D and an optional InterfacelD (11D). If you just specify the
ProgID, Sterling Gentran: Server uses the default IDispatch interface. ThelID isa
machine-readable identifier that uniquely identifies the interface of an object (e.g.,
{00020300-00B000-C00004005300}). Interfaces can also be identified by their human-
readable name (e.g., | Dispatch).

Note
Each 11D must be enclosed in braces{}.

L ocation The location of the user exit in the map depends on what the user exit needs to do and
what you want the scope of the rule to be. Typically, you might:

» declare an object in the On Begin rule of the Input side of the map (Loop Level
Extended Rules dialog box of Input positional file),

» create and use the object in the On Begin rule of the Input side of the map (Loop
Level Extended Rules dialog box of Input positional file), and

» deletethe object in the On End rule of the Output side (Loop Level Extended Rules
diaog box of Output EDI file).

Note

The sample above isintended as an example only. You can declare, create, use, and delete
an object in an extended rule for a map component at any hierarchical level, including
field level extended rules, if appropriate.

Reference
See Defining Extended Rules on page 6 - 12 for more information on creating extended
rules for various map components.
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Examples of User Exits

Examples of User Exits

I ntroduction

Defining object
variable

Creating a default
interface

Creating a specific
interface

Administration Guide

This section contains examples of the construction of user exits. In this section the
following conventions apply:

» Boldtypefaceis used to express what you need to type.

» Linesthat aretoo long to fit on one line in this section may be continued on the next
line using a line-continuation character (A).

» A double dash (//) introduces comments.

This example defines a variable that represents an ActiveX Automation Server:

object ab;

This example creates an instance of the default interface of the Internet Explorer ActiveX
Automation Server:

obj ect ob;

ob = createobject(“Internet Explorer. Application”);

// Creates an instance of the default interface of an ActiveX
/] Aut omati on Server.

This example creates an instance of the Internet Explorer ActiveX Automation Server and
requests a specific interface:

obj ect ob;

ob = createobject(“InternetExplorer. Application”, “{EAB22AC1-30Cl1

A- 11CR- A7EB- 000C05BAEOB} ") ;

/Il Creates an instance of a specific interface of an ActiveX Autonation
//Server. In this case, the IIDis known (specified in braces).

/] Not e:

/1 The createobject command is nore efficient if you use the 11D
/linstead of the interface nane.

This example creates an instance of the Internet Explorer ActiveX Automation Server,
where the interface identifier of the desired interface is unknown, but the name of the
interfaceis IWebBrowser:

obj ect ob;

string[50] iid;

iid = getiid(“lInternetExplorer. Application”, “lWbBrowser2");
ob = createobject(“InternetExplorer. Application”, iid);

/Il Creates an instance of a specific interface of an ActiveX

/1 Automation Server. In this case, the IIDis not known, so the

/1 Progl D and name of the interface (IWbBrowser) are specified and
/1 Gentran: Server |looks up the IID. The IIDis l|loaded into the
/Istring variable “iid” and then that value is used to create the
/] obj ect .
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Deleting an object  An object must be deleted before the end of the map that usesiit. It is more efficient to
delete the object immediately when you no longer need it, although the Sterling
Gentran: Server translator deletes the object automatically at the end of the map. Also, if
you assign one object to another one, both copies of the object must be deleted for that
object to be properly unloaded.

This example deletes the object “ob” that was used in the previous examples:
del et eobj ect (ob);

Gettingaproperty  This example obtains a property value from an ActiveX Automation Server:
value

obj ect ob;

string[50] iid;

iid = getiid(“lInternetExplorer. Application”, “lWbBrowser2”);
ob = createobject(“InternetExplorer.Application”, iid);

IF ob.Visible = 1 THEN

BEG N

/1 The property value is accessed.

END

//Test to see if the systemdisplays the Internet Explorer.

Setting a property  Thisexample sets a property valuein an ActiveX Automation Server:

value obj ect ob;
string[50] iid;
iid = getiid(“lInternetExplorer.Application”, “lWbBrowser2");
ob = createobject(“InternetExplorer. Application”, iid);

ob. Visible = 1;
/1 The property value is set.
/1 Display Internet Explorer on the desktop.

Passing To pass parameters to a method, use the syntax objectname.methodname(parameters).
parameterstoa  The Sterling Gentran:Server translator automatically converts the extended rule data type
method of the property to the ActiveX datatype, whenever possible. If thereis no directly
corresponding type in the extended rules, the conversion is performed as well as possible
by the operating system.

Note

Sterling Gentran: Server relies on default data types. For example, Sterling Gentran: Server
convertsVT_CURRENCY (which isan unknown datatype to the translator programming
language) to areal or numeric datatype. If the conversion cannot be performed, atype
mismatch error iswritten to the Trandlator Report and the extended rule isimmediately
terminated.
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Examples of User Exits

Example
This example navigates to aweb page by passing the URL to the Navigate method of
Internet Explorer:

obj ect ob;

string[50] iid;

iid = getiid(“lInternetExplorer. Application”, “lWbBrowser2");
ob = createobject(“InternetExplorer.Application”, iid);

ob. Navi gat e(“www. st er |l i ngconmer ce. cont) ;

/I Navigates to the | BM web page by passing the URL to

//the Navigate nethod of Internet Explorer. Note: URL nust be
/lenclosed in quotation marks.

To return values in output parameters, use the syntax
objectname.methodname(I nputParameter, OUT OutputParameter).

Note
» Input and output parameters may occur anywhere in the parameter list.

» Output parameters must be preceded by the OUT keyword.

» When an extended rule variable is used as an output parameter, the ActiveX datatype
must match exactly.

Reference
See Data types supported on page B - 5 for alist of ActiveX data types and the analogous
extended rule data type for each.

Example
This example decrypts datain afield:

obj ect ob;
ob = createobject (“Your Conpany. DecryptionUserExit”);
ob. Decrypt (“Encrypti onKey”, OUT #Fi el d_Nane);

This exampl e tests the value of an object against zero to determineif it was correctly
created:

obj ect ob;
ob = createobject (“Your Conpany. DecryptionUserExit");
IF ob = 0 THEN

BEG N

/] Qoj ect not created properly; performtask X

END

//Test to see if the object was created successful. If it was not

/lcreated, performthe specified task.
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Obtaining another ~ Thisexample usesthe IID of an object to obtain a different interface of an existing object
interfaceof an  (objectl):
existing obj ect obj ect ob, ob2;
ob = createobject("InternetExplorer. Application");
ob2 = queryobj ect (ob, "{EAB22ACl-30Cl- 11CF- A7EB- 0000CO5BAEOB} ") ;
If the I D of the desired interface is unknown, use the getiid function
to determne the correct |I1D and then use the queryobject function, as
thi s exanpl e denobnstrates:
obj ect ob, ob2;
string[50] iid;
ob = createobject("InternetExplorer. Application");
iid getiid("InternetExplorer. Application", "IWbBrowser2");
ob2 queryobj ect (ob, iid);

Accessinga  Thisexample uses a user exit to cross-reference a UPC code with avalue in a database to
database  return an SKU number. This example adds the user exit to an invoice (import) map (refer
to the Sterling Gentran:Server TUTORIAL folder, PET_810.MAP for an example). The
user exit code isimplemented by increments in the map, with each section added to the
logical map component.

On Begin Extended Rule
Type the following code into the On Begin extended rule of the INPUT positiona file:

/I Decl are the object

obj ect ob;

// Create an instance of the Visual Basic Active X Automation Server
ob = Creat eObj ect (" SCUPCSKU. SKUResol ve");

/1 To create an instance of the C++ ActiveX Automati on Server

/luse the follow ng conmand i nstead:

/1 ob = CreateCbject(“UpcSku. Application”);

if ob =0 then

begin

MessageBox (" Create Object failed",0);
end

INVDETAIL.UPCCODE Field Extended Rule
Type the following code into the UPCCODE field extended rule on the Input side of the
map (INVDETAIL record):

string [100] nsg;
nsg = "UPC Code = ";
concat ( nmsg, #UPCCODE, 12) ;

//Call the automation server
#UPCCODE = ob. Resol veSKU( #UPCCCDE) ;
concat (nmsg, ", SKU Code = ", 13);
concat ( nsg, #UPCCODE, | en( #UPCCODE) ) ;

/1D splay nessage box to user listing UPC code and SKU nat ches
MessageBox(nsg, 0) ;
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Accessinga  On End Extended Rule
database  Typethefollowing code into the On End extended rule of the INPUT positional file:

(contd)  //pelete the obj ect
del et eobj ect (ob);

Note

See Examples of Automation Servers on page B - 12 for sample automation servers
(written in Visual Basic and C++) that access a Microsoft Access Database to cross-
reference a UPC code with an SKU code.
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Examples of Automation Servers

Introduction The following pages contain sample automation servers that access a Microsoft Access
Database to cross-reference a UPC code with an SKU code. Thefirst exampleiswrittenin
the Visual Basic programming language and the second onein C++.

Note
Both of the following automation servers could be used with the “ Accessing a database”
user exit extended rules on Accessing a database on page B - 10.

Visual Basic  This sample automation server was written in the Visual Basic programming language. It
Automation Server accesses a Microsoft Access Database to cross-reference a UPC code with an SKU code.
The syntax is: ResolveSKU(UPCCode as Sring). Note that after compiling the
Automation Server (SCUPCSKU.EXE), it was registered using REGSRV 32.EXE because
it was not self-registering.

/1 This is a Visual Basic Active X EXE project. Al code shown here
//resides
//in the SKUResol ve class. (Class 1 was renaned to SKUResol ve).
/1 To access the database, the follow ng reference was included in
//the project: Mcrosoft DAO 2.5/3.5 Conpatibility Library.
/1 The following line forces the conpiler to nmake sure all variables
//are declared prior to use within the program
Option Explicit
/1 This function receives a UPC code as it’s only paraneter and
/lcross-references it with a value in the database to get the
/I correspondi ng SKU code.
Publ i ¢ Functi on Resol veSKU(UPCCode As String) As String
Dim DB As Dat abase, RS As Recordset
Set DB = DBEngi ne. Wr kspaces(0) . OpenDat abase
A("c:\ GENSRVNT\t ut ori al \ upcsku. ndb")
Set RS = DB. OpenRecordset (" UPCSKU', dbQpenDynaset)
/1 Make sure there are no trailing spaces on the paraneter passed
//to this function.
UPCCode = Tri m{ UPCCode)
/1Since the database is case-sensitive nake sure that the paraneter
/lhas all capitalized letters init.
UPCCode = UCase( UPCCode)
RS. MoveFi r st
//Loop until we find the UPC code or until the end of the recordset
/1is found.
Whi | e Not RS. ECF
//1f we find the UPC code, return the 'SKU code associated with it.
If RS("UPCCode") = UPCCode Then
Resol veSKU = RS(" SKUCode")
Exit Function
End If
RS. MoveNext
Wend
/1 No mat chi ng UPC code was found for the paraneter passed to the
//function. Returnaval uestatingthat therewas no SKUf ound.
Resol veSKU = "No Record Found"
End Function
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C++ Automation This sample automation server was written in the C++ programming language. It performs
Server exactly the same function as the previous Visual Basic sample user exit—accessing a
Microsoft Access Database to cross-reference a UPC code with an SKU code. Note that
after compiling the Automation Server (UPCSKU.DLL), it was registered using
REGSRV 32.EXE because it was not self-registering.

/1 This is a MFC AppW zard (dll) project with the Automati on option
/lselected. Al code shown here resides in the CUpcSkuMai n cl ass
/Iwhich is derived from CCnrdTarget. Wien the class was created in
/1 Cl assWzard, the ProglD

/1" UpcSku. Appl i cation" was specified in the "Createable by type
/11D field.

/1 This ProglDis different than the one used for the VB exanple so
//that both Autonmtion servers can co-exist in the registry.

/1 To access the database, a class (CUpcSkuDaoRecordset) derived
/1from CDaoRecordset is needed. DAO and Snapshot options were
//selected and the location of the database (Upcsku.ndb) was
//specified during the creation of the class in C assW zard.

/1 Include the header file for the derived recordset class

#i ncl ude "UpcSkuDaoRecordset. h"

/1 This function is called when the |ast reference for this

/' aut omati on object is released

voi d CUpcSkuMai n: : OnFi nal Rel ease()

{
CCndTar get : : OnFi nal Rel ease();
/1 Since we used DAO to access the database,
/1 term nate DAO now so the DLL can unl oad.
if (Afxd eCanExitApp())
Af xDaoTern() ;
}

/1 This function receives a UPC code as it’'s only paraneter and
/lcross-references it with a value in the database to get the
/I correspondi ng SKU code.

BSTR CUpcSkuMai n: : Resol veSKU( LPCTSTR UPCCode)

{
CString strResult;

CString sUPCCode = UPCCode;

CDaoDat abase DB;
DB. Open(" C:\\ GENSRVNT\\ Tut ori al \\ Upcsku. mdb", FALSE, TRUE);

CUpcSkuDaoRecor dset RS( &DB) ;
RS. Qpen() ;
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C++ Automation

Server /'l Make sure there are no trailing spaces on the parameter passed
(contd) /lto this function.

sUPCCode. Tri nRi ght () ;

/!l Since the database is case-sensitive make sure that the
/Il parameter has all capitalized letters init.

sUPCCode. MakeUpper () ;

RS. MoveFirst();

/1 Loop until we find the UPC code or until the end of the recordset
/1is found.

while ( !'RS.ISEOF() )

{
/1 1f we find the UPC code, return the SKU code
/! associated with it.

if ( RS.mUPCCode == sUPCCode )
{

strResult = RS. m SKUCode;

RS. d ose();

DB. C ose();

return strResult.AllocSysString();
}

RS. MoveNext () ;
}

/1 No matching UPC code was found for the paraneter passed to the
/1 function. Return a value stating that there was no SKU found.

strResult = "No Record Found";

RS. d ose();
DB. d ose();

return strResult. Al ocSysString();
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How to Create a User Exit

Beforeyou begin  The ActiveX Automation Server must be installed on the same machine as the Sterling
Gentran: Server trand ator (where you are using the translation object that contains the user
exit).

Procedure  Usethis procedure to create a user exit.

Sep Action
1 Start the Sterling Gentran: Server Application Integration subsystem.
2 Open the map in which you want to apply a user exit.
3 Determine where the user exit will be located in the map (e.g., session
rule or extended rule).
Note

When you apply a user exit to amap component, subordinate map
components may also be able to execute the same user exit.

4 Construct the user exit.
Reference

» SeeDefining Extended Rules on page 6 - 12 for more information on
creating extended rules for various map components.

» See Alphabetic Language Reference on page 6 - 47 for more
information on the createobject, deleteobject, and getiid commands.

Administration Guide Sterling Gentran: Server — May 2011




How to Create a User Exit User Exits

Sterling Gentran:Server — May 2011 Administration Guide



APPENDIX

C

Using GentranEx.DLL

Contents D INtroduction. ... ... C-2
Database ACCESS. . ..ttt e Cc-3

D OVEIVIBIW . o et e Cc-3

» Implementing Database ACCESS ... ..ot C-4

DEbUGgING. . .o C-5

D OVEIVIBW . oot C-5

» Implementing Debugging . . ......cooiii C-6

RUIESEXIENSIONS . .. ..o e e e e e e C-8

D OVEIVIBIN . .. e Cc-8

» Implementing RulesExtensions....................ccoivvn.. c-9

Administration Guide Sterling Gentran: Server — May 2011



Introduction Using GentranEx.DLL

| ntroduction

Inthisappendix  This appendix describes how to use GentranEx.DLL, the Sterling Gentran: Server in-
process automation server.

Note
GentranEx.DLL isautomatically installed during the Sterling Gentran: Server installation
process.

What is  GentranEx.DLL isan in-process automation server that extends the flexibility of the
GentranEx.DLL?  Sterling Gentran:Server MAPPER.EXE (Application Integration) and TX32.EXE
(translator) programs by using COM technology and the I Dispatch interface.

GentranEx.DLL enablesyou to perform several functions that exceed the scope of hormal
Sterling Gentran: Server operation, including:

» accessing any GentranDatabase table,

» gathering information from a translation session and writing that information to alog
file, and

» extending the functionality of Application Integration extended rules.

Assumptions  Thislist contains the items with which this appendix assumes you are familiar.
» Sterling Gentran:Server,
» theApplication Integration subsystem,
D your operating system,
» automation servers,
» how and when extended rules are invoked and their scope, and
» how to create extended rules.
Reference

See Using Extended Rules, chapter 6, for more information on Application Integration
extended rules.
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Database Access

Overview

Introduction  GentranEx.DLL allow access to any GentranDatabase table through the TSgl statements
UPDATES and INSERTS. The GentranEx.DLL uses ODBC and the Sterling
Gentran:Server ODBC DSN (typically GentranDatabase) to connect to the database.

Note

The TSql statement must be generated by the user and passed to the Execute method. To
support a connection to an Oracl €® database the TSql statements must enclose
Tablenames and Columnames in square brackets. These square brackets are automatically
converted to double quotes before the statement is executed.
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| mplementing Database Access

ProgID  "GentranEx. Di spat chDBAccess"
InterfaceID  { 860AAES5- 7DAS- 11D2- ABDB- 00C04FF3971C}

Methods  Thistable contains the database access methods.

M ethod Description
short Execut eSQL(BSTR Returns "1" for success and "-1" for failure. Errors
I pszSQLString) are written to the Application Event Viewer.
BSTR Get Last Error () Returns a string containing the error of the most

recent attempt to invoke the ExecuteSQL method.
If the last attempt was successful this call returnsa
null string.

BSTR Get Last SQL() Returns a string containing the most recently
executed SQL statement using the
ExecuteSQL ( ... ) function.

Properties  None.

Extended rule  Thisisan example of an extended rule using GentranEx.DLL to access the
example  GentranDatabase.

Ohj ect obDBAccess;
Integer result;

String [64] szPartnerKEY;
String [1024] szMsg;

obDBAccess = CreateCbject ("GentranEx.Di spatchDBAccess");
szTSQL = "Update [interchange_tb] Set [AppField6]=""+
#STATUS+
"" where [PartnerKEY]=""+
szPart ner KEY+
"" and [Direction]=1 and [ Control Nunber]=""+#REF+"";
result = obDBAccess. ExecuteSQ(szTSQ);
if result = -1 then
Begi n
szMsg = obDBAccess. GetLastError();
messagebox(szMsg, 0) ;
szMsg = obDBAccess. CGet Last SQL();
messagebox(szMsg, 0) ;
End

del et eobj ect (obDBAcess) ;
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Overview

GentranEx.DLL enables you to gather information from any translation session executed
on the machine on which GentranEx.DLL isinstalled, and write that information to alog
file. Thisfunction does not require any interaction from the user and thusis an efficient
alternative to using the Messagebox function when debugging map.

Each entry made to the log file contains the following information, which provides clarity
and readability to the log:

date and time stamp,
name of the log owner,
source of the message, and

the message.

Note
The name of the log owner, the source of the message, and the message are al supplied by
the user viathe OpenL og() and WriteL og() functions.
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| mplementing Debugging

ProgID  "GentranEx. TraceLog"

Using GentranEx.DLL

Interface|D  {7DA17F77- 8090- 11D2- ABE4- 00C04FF3971C}

Methods  Thistable contains the debugging methods.

M ethod

Description

short OpenLog(BSTR
Pat hFi | ename, BSTR
Owner, short
Wit eMde)

» Returns"1" for success, "-1" for failure, and "-2" if
the file is already open.

» Argument 1isthe path and filename of thelog file
to be created.

» Argument 2isthe owner of thelog. Thisvalueis
written to the log file and isincluded to make the
log easier to read.

» Argument 3isthewritemode (i.e., 1 = append (this
isthe default) and 2 = truncate).

» The"Owner" columnin the generated log fileis 20
characters wide — therefore Argument 2 is
truncated at that value (20) when written to the log
file.

short Open()

Opens atrace log file (named " GentranTrace.log") in
the GENSRVNT home directory. The fileis opened in
Append mode and is assighed an Owner name of
"GentranEx".

short WitelLog(BSTR
Source, BSTR
Message)

» Returns"1" for successand "-1" for failure.

» Argument 1 isthe source of the message that is
written.

» Argument 2 isthe message text. Both Arguments 1
and 2 are written in separate columnsin the log file
for clarity.

» The"Source" columninthelog fileis 20 characters
wide and thus Argument 1 istruncated at that value
(20).

» The"Message" columninthelog fileis 256
characters wide and thus Argument 2 of this
function is truncated at that value when written to
thelog file.

BSTR Get Last Error()

Returns a string containing the error of the most recent
attempt to open thelog file.
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(Contd)
Method Description
short C oseLog() Closesthelog fileand returns"1" for successor "-1" for
failure.
Note

The file should always be closed before your trace
object goes out of scope.

Properties  None.

Extended rule  Thisisan example of an extended rule using GentranEx.DLL for debugging.

example Obj ect obTrace;
I nteger result;
String [32] szPartnerKEY;

obTrace = CreateObject ("GentranEx. TraceLog");
result = obTrace. OpenLog("D:\ GENSRVNT\ TraceTest.txt", "1 CLANA", 2);
if result = -1 then
Begi n
obTrace. WiteLog("Start of Log", "Trace Test");
obTrace. WiteLog("Converted TUN#", szPart ner KEY) ;
End
obTrace. C oselLog();
del et eobj ect (obTrace);
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Rules Extensgons

Overview

Introduction GentranEx.DLL provides methods and properties that extend the functionality of the
Application Integration extended rules logic. For example, there are methods that allow
the conversion of strings from uppercase to lowercase, which allows greater control over
string comparison logic. Also, there are functions available that return the current date
and/or time. GentranEx.DL L also provides a property that can be referenced to determine
whether the automation server is running in a non-interactive environment.
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| mplementing Rules Extensions

Prog ID

Interface D

Methods

Properties
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"Gent ranEx. Rul es"

{ 387C0F34- 82F5- 11D2- ABEA- 00C04FF3971C}

Thistable contains the rules extension methods.

Implementing Rules Extensions

M ethod

Description

DATE Get Dat e()

Returns the current date. The assignment
operator (=) can be used to set any date/time
variable or date/time type field equal to the
value returned by this method.

DATE Get Ti me()

Returns the current time. The assignment
operator (=) can be used to set any date/time
variable or date/time type field equal to the
value returned by this method.

BSTR ToUpper (BSTR szM xedCase)

Uses the string to be converted asits
argument.

Returnsthe original string converted to
uppercase. Any string variable, string
field, or string literal can be supplied as
the first argument.

BSTR ToLower (BSTR szM xedCase)

Uses the string to be converted asits
argument.

Returns the original string converted to
lowercase. Any string variable, string
field, or string literal can be supplied as
the first argument.

short InteractiveState
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Implementing Rules Extensions Using GentranEx.DLL

Extended rule  Thisisan example of an extended rule using GentranEx.DLL to exceed normal extended
example  rulelogic.

Obj ect obRul es;

String [32] szLowerCaseStr;
String [32] szUpperCaseStr;
String [32] szResultString;
date d;

/llnitialize values of string variables
szLower CaseStr = "abcdefg";
szUpper CaseStr = "WKYZ";

/I Create the Rul es object
obRul es = CreateObj ect ("CGentranEx. Rul es");

/] Test string conversion nethods and display results
szResult String = obRul es. ToUpper (szLower CaseStr);
messagebox(szResul t String, 0);

szResult String = obRul es. ToLower (szUpper CaseStr);
messagebox(szResul t String, 0);

// Test date met hods
d = obRul es. GetDate();
#Ti meFi el d = obRul es. Get Ti ne() ;

// Test whether running interactively
if obRules.InteractiveState = 1 then
nmessagebox("We' re running on the desktop",0);
el se
Begi n
//use the TracelLog object to wite to alog file since we're
//runni ng non-interactively
End

del et eobj ect (obRul es);
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Introduction Using the Translator Command Line Interface

| ntroduction

Inthisappendix  This appendix describes how to use translator command line interface to invoke the
services of TX32.EXE, including generating atranslator report in XML format.

Notes
» If youdo not specify the XML format parameter, the report in generated in binary
form by default.

» Thisinterfaceiscurrently used by all applications that invoke the services of the
TX32.EXE trandlator.
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Using the Translator Command Line Interface

Command L ine Syntax

I ntroduction

Syntax parameters

Administration Guide

The syntax of the command lineis:

tx32 [-n] [-q]
[-a server]
[-e eventid]
[-i ipckey [hwnd] ]

Command Line Syntax

[-f infile tenplatefile outfile report file]

[-u param -u param .]
[-t tracefile]
[-x XM.formattedreport]

This table describes the command line syntax parameters.

Par ameter Description
-n Do not move document to InDrawer after print or export
-q Quiet mode (does not display message boxes or status dialog box)
-a Server (name of audit server to which TX32.EXE connects)
-e EventID (identifier of an audit event to which this translator belongs)
-i Inter-process communication (1PC) mode
Subparameter Description
ipckey Key toipcfile (trandator will usethe IpcMsg
folder and add .1PC)
hwnd Number representation of the parent
applications's main window handle
-f Simple-translator mode
Subparameter Description
infile Path to file to be translated
templatefile Path to trandlation object to be used
outfile Path to file to write trand ated output
reportfile Path to create translator report
-u User-defined parameters accessible from extended rules
Subparameter Description
param Parameter value
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Command Line Syntax

Using the Translator Command Line Interface

Par ameter Description
-t Trace mode
Subparameter Description
tracefile Path to trace the file to be used
-X XML formattedreport Generates the trandlator report in XML

format

Note

If you do not specify this parameter the
report in generated in binary form by
default.
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Notices

Thisinformation was devel oped for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other
countries. Consult your local IBM representative for information on the products and
services currently available in your area. Any reference to an IBM product, program, or
service is not intended to state or imply that only that IBM product, program, or service
may be used. Any functionally equivalent product, program, or service that does not
infringe any IBM intellectual property right may be used instead. However, it isthe user's
responsibility to evaluate and verify the operation of any non-IBM product, program, or
service.

IBM may have patents or pending patent applications covering subject matter described in
this document. The furnishing of this document does not grant you any license to these
patents. You can send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785

U.SA.

For license inquiries regarding double-byte character set (DBCS) information, contact the
IBM Intellectual

Property Department in your country or send inquiries, in writing, to:
Intellectual Property Licensing
Legal and Intellectual Property Law

IBM Japan Ltd.
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1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan

Thefollowing paragraph doesnot apply to the United Kingdom or any other country
wheresuch provisionsareinconsistent with local law: INTERNATIONAL BUSINESS
MACHINES CORPORATION PROVIDES THIS PUBLICATION "ASIS' WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT,
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do
not allow disclaimer of express or implied warranties in certain transactions, therefore,
this statement may not apply to you.

Thisinformation could include technical inaccuracies or typographical errors. Changes
are periodically made to theinformation herein; these changes will be incorporated in new
editions of the publication. IBM may make improvements and/or changes in the
product(s) and/or the program(s) described in this publication at any time without notice.

Any references in thisinformation to non-IBM Web sites are provided for convenience
only and do not in any manner serve as an endorsement of those Web sites. The materials
at those Web sites are not part of the materials for thisIBM product and use of those Web
sitesisat your own risk.

IBM may use or distribute any of the information you supply in any way it believes
appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of
enabling: (i) the exchange of information between independently created programs and
other programs (including this one) and (ii) the mutual use of the information which has
been exchanged, should contact:

IBM Corporation

JBAIGA

555 Bailey Avenue

San Jose, CA__95141-1003

U.SA.

Such information may be available, subject to appropriate terms and conditions, including
in some cases, payment of afee.

The licensed program described in this document and al licensed material available for it
are provided by IBM under terms of the IBM Customer Agreement, IBM International
Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment.
Therefore, the results obtained in other operating environments may vary significantly.
Some measurements may have been made on devel opment-level systems and thereis no
guarantee that these measurements will be the same on generally available systems.
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Furthermore, some measurements may have been estimated through extrapolation. Actual
results may vary. Users of this document should verify the applicable data for their
specific environment.

Information concerning non-IBM products was obtained from the suppliers of those
products, their published announcements or other publicly available sources. IBM has not
tested those products and cannot confirm the accuracy of performance, compatibility or
any other claimsrelated to non-IBM products. Questions on the capabilities of non-IBM
products should be addressed to the suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

Thisinformation is for planning purposes only. The information herein is subject to
change before the products described become available. This information contains
examples of data and reports used in daily business operations. To illustrate them as
completely as possible, the examplesinclude the names of individuals, companies, brands,
and products. All of these names are ficticious and any similarity to the names and
addresses used by an actual business enterpriseis entirely coincidental.

COPYRIGHT LICENSE:

Thisinformation contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy, modify,
and distribute these sample programs in any form without payment to IBM, for the
purposes of developing, using, marketing or distributing application programs conforming
to the application programming interface for the operating platform for which the sample
programs are written. These examples have not been thoroughly tested under all
conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or
function of these programs. The sample programs are provided "ASIS", without warranty
of any kind. IBM shall not be liable for any damages arising out of your use of the sample
programs.

Each copy or any portion of these sample programs or any derivative work, must include a
copyright notice as follows:

© IBM 2011. Portions of this code are derived from IBM Corp. Sample Programs.
© Copyright IBM Corp. 2011.

If you are viewing this information softcopy, the photographs and color illustrations may
not appear.

Trademarks I1BM,thelBM logo, and ibm.com are trademarks or registered trademarks of International
Business Machines Corp., registered in many jurisdictions worldwide. Other product and
service names might be trademarks of IBM or other companies. A current list of IBM
trademarks is available on the Web at “ Copyright and trademark information” at
www.ibm.com/legal/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States, and/or
other countries.
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IT Infrastructure Library is aregistered trademark of the Central Computer and
Telecommunications Agency which is now part of the Office of Government Commerce.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or registered
trademarks of Intel Corporation or its subsidiariesin the United States and other countries.

Linux is aregistered trademark of Linus Torvaldsin the United States, other countries, or
both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft
Corporation in the United States, other countries, or both.

ITIL isaregistered trademark, and a registered community trademark of the Office of
Government Commerce, and isregistered in the U.S. Patent and Trademark Office.

UNIX isaregistered trademark of The Open Group in the United States and other
countries.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of
Oracle and/or its affiliates.

Cell Broadband Engine is atrademark of Sony Computer Entertainment, Inc. in the
United States, other countries, or both and is used under license therefrom.

Linear Tape-Open, LTO, the LTO Logo, Ultrium and the Ultrium Logo are trademarks of
HP, IBM Corp. and Quantum in the U.S. and other countries.

Connect Control Center®, Connect:Direct®, Connect:Enterprise, Gentran®,
Gentran:Basic®, Gentran:Control®, Gentran:Director®, Gentran:Plus®,
Gentran:Rea time®, Gentran: Server®, Gentran:Viewpoint®, Sterling Commerce™,
Sterling Information Broker®, and Sterling Integrator® are trademarks or registered
trademarks of Sterling Commerce, Inc., an IBM Company.

Other company, product, and service names may be trademarks or service marks of others.
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GLOSSARY

Glossary

?In Documents  This Sterling Gentran: Server browser contains alist of documents that were received by
the system but failed compliance checking or that do not have an identifiable partner or
transaction set.

?0ut Documents  This Sterling Gentran: Server browser contains alist of documents that were imported into
the system via unattended processing but are invalid.

acknowledgement  Thistermisused to indicate the ANSI 997 functional acknowledgement, the EDIA 999
acceptance/rejection advice, and the EDIFACT CNTRL document.

activation This function enables you to make map components available for use. The system
activates all the groups, segments, composites, and elements that are defined as
“mandatory” (must be present) by the standard. The system does not enable you to
deactivate the mandatory groups, segments, composites, and elements. When trandlating
data, the system does not process groups, segments, composites, and elements (or records
and fields) that are not activated. Therefore, you must activate the groups, segments,
composites, and elements that are not defined as mandatory by the standard, but that you
have determined that you need to use in mapping.

AIAG  TheAutomotive Industry Action Group (AIAG) isthe standards-setting group for the
automotive industry. The standards form a subset of the ANSI X12 standard.

ANA  Article Numbering Association.

ANSI American National Standards Institute. ANSI sets standards for many products and
services, such as safety glasses and battery capacities. The ANSI X12 committeeisthe
chief EDI standards-setting organization for the United States.

application file  If you are creating an import or export map, you must define your application to Sterling
Gentran: Server. In Sterling Gentran: Server terminology, your application fileis aso
referred to as a fixed-format file or a positional file. Your application file must contain all
the information that you either need to extract from your partner’s document (if themap is
inbound) or need to send to your partner (if the map is outbound), so that your system can
accurately process the data.
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application system

application system

browser

button

check box

click

codelist tables

colours

communications
session

Communicator

compile

Glossary

Computer systems, outside of EDI, designed to fulfill specific business functions. These
include accounting, purchasing, materials control, human resources, shipping, and other
systems.

A browser isawindow that displaysalist of items, such as documents (transaction sets),
interchanges, trandation objects, etc. A document browser displays only documents.

A button enables you to execute acommand. You select abutton either by clicking it or by
pressing TAB until the button you want is selected and then pressing ENTER.
Unavailable buttons are dimmed, and the currently selected button has a darker border
than the other buttons.

A check box enables you to select or clear options from alist. You can select as many
options from the list as you need. A selected check box contains a checkmark. The labels
of unavailable options are dimmed.

Click indicates that you should position your cursor on top of the designated item and
press and release your primary mouse button. The primary mouse button is the button you
access with your index finger, regardless of whether you are utilizing right-handed or left-
handed mouse operation.

These are used by EDI standards as repositories for lists of codes. Each EDI standard
provides a code list for each element that can be further defined with a code.

This feature enables you to select foreground and background colours to visually define
the various map components. The use of colour is optional.

Everything sent and received to/from one telephone number in one continuous period of
connection. This could include sending two or three interchange envelopes to a network,
each for adifferent trading partner.

Thisisthe Sterling Gentran: Server communications software. The Communicator enables
you to send, receive, resend, establish communication port definitions, establish
communication profiles, establish communication scripts, and view and delete
communication sessions.

This function compiles the map and creates a trand ation object. The map that you create
using Sterling Gentran: Server is a source map. When that source map is compiled, the
result isa compiled translation object. This translation object must be registered with the
Sterling Gentran: Server system before you can useiit.
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Glossary

compliant

component data
element

composite data
element

conditions

constant

cross-reference
table

date/time

deactivation

default

dialog box

Application Integration User Guide

compliant

This means that the document conformsto the EDI standards as defined by the trandlation
object.

A simple data element that bel ongs to a composite data element. Component data
elements are also called sub-elements.

A contains two or more component data elements or sub-elements. Composites are
defined by the EDI standards that use them (EDIFACT, TRADACOMS, and certain ANSI
X12 standards).

See relational condition on page 1 - 9.

This standard rule enables you to move aliteral constant value to the specified element or
field, indicate a qualifying relationship with another element or field, and map the current
date or time to the specified element or field.

Thistable is created in Partner Editor and is used to convert your values to your trading
partner's values during outbound processing, or your partner's values to your values during
inbound processing.

Thistype of field or element contains adate or time. If you specify that afield or element
is adate/time type, you must specify exactly how the date or time must be formatted.

This function enables you to make map components unavailable for use by the system.
The system does not enable you to deactivate the mandatory groups, segments,
composites, and elements.

A predefined value — programs use these built-in values unless you specifically override
them.

A dialog box contains additional information or options that you need to act on. If you
specify any options, you can select a button to execute the command. Some dialog boxes
display warnings or messages indicating why arequested task cannot be accomplished. If
the dialog box has atitle bar, you can move it to another location on your desktop.
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document Glossary

document One transaction set containing actual data and treated as a single entity. The amount of
data does not affect whether something is a document or not, only the fact that it is treated
as asingle entity. For example, regardless of whether a purchase order contains one item
or ten thousand, if it is one purchase order, it is one document.

If atrading partner sends you a communication containing 10 purchase orders, you have
received 10 documents. If the communication contained 15 invoices, you have received
15 documents.

EANA International Article Numbering Association, Brussels, Belgium.

EDI Electronic Data Interchange (EDI) is the process by which companies can exchange
business documents directly from application to application by computer without paper
documents being produced.

EDI standard  Thisisthe rulesfor turning a business document into an EDI document.

EDIA  The Electronic Data Interchange Association, formerly known as the Transportation Data
Coordinating Committee (TDCC).

EDIFACT  Thisisthe standards organization of the United Nations Economic and Social Council.
The acronym is short for the Electronic Data I nterchange for Administration, Commerce,
and Transport.

eement  The smallest piece of usable information defined by the standards. Examples might
include a quantity, unit price, or description. An individual element can have somewhat
different meanings depending on context. Therefore, elements are normally not
considered to have useful meaning until they are combined into segments. An element is
the EDI map component that is mapped (linked) to a corresponding application field to
move data to and from the EDI file.

There are three types of data elements, asillustrated in the table below:

Data Element Definition
Simple data element A single piece of information defined by the standards.
Composite data element A data element that is made up of multiple component
elements.
Component data element A simple data element that belongs to a composite data
element. Component data elements are also called sub-
elements.
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Glossary

envelope

equalize

export map

export trandation
object

extended rules

field

fixed-format file

font

envelope

A way of separating information in transmissions for ease of processing. Each envelope
contains a header segment and atrailer segment, which separate the envelope from other
envelopes and provide information about the contents of the envelope.

There are three levels of envelopes, asfollows:

» Transaction Set
Each transaction set (business document) is contained within a transaction set
envelope.

» Functiona Group
An envelope containing related business documents. The standards define which
transaction sets should be placed together into afunctional group envelope.

» Interchange Envelope
All material being sent to one trading partner in one communication. The term
Interchange Envelope is the term used by ANSI. EDIA uses the term Transmission
Envelope to refer to thislevel of envelope. Since we use the term transmission for
other uses, we refer to Interchange Envel ope only.

This function enables you to reinstate the two sides of the map with focusin equal
dimensions. The use of the Equalize function is optional.

This map defines how to move datafrom the EDI standard-formatted documents that your
partners send you to your application file (flat file definition). An export map is necessary
for inbound processing.

See export map onpage 1 - 5.

These rules enable you to use a Sterling Gentran: Server proprietary programming
language to perform virtually any mapping operation you require.

The smallest piece of information defined in the application file. A field is the application
map component that is mapped (linked) to a corresponding EDI element to move data to
and from your application file.

See application fileon page 1 - 1.

This feature enables you to globally change the font that is used in the display of al maps.
The default font that Sterling Gentran: Server usesis a Sans Serif 9 point. The Font feature
enables you to change the font type, style, and point size. This gives you the flexibility to
shrink the font if you need to view more of the map on your monitor, enlarge the font, or
change the type and style to be more easily readable by you.
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functional group Glossary

functional group

group

import

import map

import tranglation
object

inbound mapping

In Documents

In Drawer

integer

interchange

A group of transaction sets that the standards-setting body (such as ANSI) has defined as
fitting together with other related transaction sets. An example might be a Functional
Group defined as containing all purchasing transaction sets.

A looping structure that contains related records/segments and/or groups that repeat in
sequence until either the group data ends or the maximum number of timesthat theloopis
allowed to repeat is exhausted. If you create agroup that is subordinate to another group (a
sub-group), this corresponds to a nested looping structure (aloop within aloop). The
application (positional) file and the EDI file are both groups and therefore, they isvisually
represented the same way as other groups and sub-groupsin Sterling Gentran: Server.

This command enables you to import datafrom an external application file. Depending on
the content of the file, the system may prompt you for partner, transaction, or translation
object information.

This map defines how to move data from your application file (flat file definition), which
may contain multiple documents, to the EDI standard-formatted documents that your
partners expect to receive from you. An import map is necessary for outbound processing.

Seeimport map on page 1 - 6.

The system translates your trading partner’s EDI standard formatted business document to
your application file format, so you can receive documents from you partners. To trandate
inbound data, you need to create an export map.

This Sterling Gentran: Server browser contains alist of documentsthat the system received
but that have not yet been processed by the user. Once the documents are processed
(printed or exported) the documents are transferred to the In Drawer.

This Sterling Gentran: Server browser contains alist of documents that were received and
processed.

An integer is a number that has an implied decimal point (e.g., “2.01” isformatted as
“ 201”).

The interchange contains al the functional groups of documents (transaction sets) sent
from one sender to one receiver in the same transmission.
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Glossary Interchanges browser

Interchanges  This Sterling Gentran: Server browser enables you to view ahierarchical list of al the
browser interchanges that were sent or received. It contains status information about the
interchanges, (e.g., whether or not afunctional acknowledgement was received and the
status of that acknowledgement). This browser also enables you to access the documents
within the interchanges. The Interchanges browser can always be accessed.

link  Thisfunction enables you to map afield or element from the Input side of the map to a
field or element on the Output side of the map. The link between two map components
(hereafter referred to asfields) is visually represented with aline connecting the two
fields.

literal constant  These are used by the system as arepository to store information that is used at alater
point in the map. Typically, constants are used in an outbound map to generate a qualifier.

location table  Thisisatable created in Partner Editor that is used to contain address-related information
about the partner.

lookup table  Thisisatable created in Partner Editor that is used to select information related to avalue
in inbound or outbound data.

loop count  This standard rule enables you to count the number of times aloop is repeated, if the
element or field ispart of aloop. If theloop isanested |oop, you can track the current loop
or the outer loop. For example, if the Y loop is nested within the X loop, and the Y loop
has cycled through 15 iterations and the X loop has cycled through 3 iterations, you can
choose to count either the “15” (Y loop) or the“3” (X loop).

loop start/loop end  Certain EDI standards use Loop Start (LS) and Loop End (LE) segments. LS and LE
segments differentiate between two or more loops of the same type. If the transaction
contains LS and L E segments and depending on whether your map is inbound or
outbound, you need to define the LS and LE segments for the loops you are using in the
map in one of two different ways.

map A setof instructions you define in the Sterling Gentran: Server Application Integration
subsystem that indicates the corresponding relationship between your application file and
the EDI standards, and defines how the system should trand ate data.

menu A list of items from which you can choose. Each item represents acommand. Unavailable
items on a menu are dimmed to inform you they are disabled.

Application Integration User Guide Sterling Gentran: Server — May 2011



menu bar

menu bar

networ k

number

ODETTE

outbound mapping

Out Documents

Out Drawer

partner

Partner Editor

positional file

post

predefined

Glossary

This contains the list of menus for the application.

Also known as a Third Party Network or Value-Added Network (VAN) that accepts and
holds transmissions from companies until it is convenient for atrading partner to accept
them.

Thistype of field or element contains either an integer or real number. If you specify that a
field or element isanumber type, you must designate the format by specifying aformat of
either “N” (integer) or “R” (real) and the number of decimal places.

The Organization for Data Exchange by Tele-Transmission in Europe.

The system tranglates your application file format to EDI standard formats, so you can
send documentsto your partners. To translate outbound data, you need to create an import
map and a system import map in Sterling Gentran:Server.

This Sterling Gentran: Server browser contains alist of documents that are ready to be
sent. After the documents are successfully sent, they are automatically transferred to the
Out Drawer.

This Sterling Gentran: Server browser contains alist of documents that were successfully
sent out by the system.

Another firm with which your company trades documents. Also referred to as atrading
partner.

This Sterling Gentran: Server function enables you to define, edit, and delete all partner
information for your company and all of your trading partners.

See application fileon page 1 - 1.

This Sterling Gentran: Server function enables you to move compliant documents from the
Workspace to the Out Documents.

On adataentry translation object, adefault value for aparticular element. You can change
the value as necessary.
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Glossary

printout

promote

qualifier

real number

receive

record

relational
condition

respond

responsible
agency

Application Integration User Guide

printout

Thisis produced when data received from atrading partner passes through a print
tranglation object. You do not have to actually print the data. The printout could beto afile
on your hard disk.

This function extracts one iteration (instance) of a group or repeating segment. This
enables you to map unique data from your application file, and/or enter a specialized
definition. Sterling Gentran: Server specifies that only one-to-one (no loops) or many-to-
many (loop) mapping relationships are valid.

Thisisan element that has a value expressed as a code that gives a specific meaning to the
function of another element. A qualifying relationship is the interaction between an
element and its qualifier. The function of the element changes depending on which code
the qualifier contains.

A real number has an explicit decimal point (e.g., “2.01" isformatted as “2.01"), and
truncates trailing zeroes.

This Sterling Gentran: Server function enables you to manually initiate a communications
session to receive data from your trading partner.

Contains agroup of related fields. A record can occur once or can repeat multiple times.

This function enables to connect fields together for syntax or compliance reasons. For
example, Field A isinvalid unless Field B is present. Therefore, if you set up acondition
that pairs Fields A and B, the system generates a compliance error if one of those fieldsis
not present.

This Sterling Gentran: Server function enables you to create aturnaround document (using
the Turn Around translation object in the partner relationship) in response to one or more
selected documents in the In Drawer.

An organization that develops and updates standards for EDI communications. These
organizationsinclude ANSI, EDIA, AIAG, UCS, EDIFACT, ODETTE, and VICS.
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segment Glossary

segment A group of related elements or composite data elements that combine to communicate
useful data. Segments are defined by the EDI standards. A segment can occur once or can
repeat multiple times. For example, a catalog price segment might consist of elements for
item description, volume, price, lead time, etc. By themselves, none of these elements
would communicate useful information. Together, they provide the information necessary
for someoneto tell if theitem iswhat is desired, whether the priceis reasonable, etc. A
number of segments together form a transaction set.

select This standard rule enables you to select entries from alocation table, cross-reference table,
partner table, or lookup table (all tables created in the Sterling Gentran: Server Partner
Editor). You can then map the fields in those tables to one or more fields in the data. The
Select function uses the value of the current field to perform the selection.

send This Sterling Gentran: Server function enables you to manually start a communications
session to send data to your trading partner. Only selected documents are enveloped and
sent. If no documents are selected, ALL documents are sent. Successfully sent documents
are moved to the Out Drawer.

set See transaction set (document) on page 1 - 12.

simplemapping  Seelinkonpagel-7.

split This function enables you to split (break) a group or repeating segment into two loops.
You typically use this function when you need more than one instance of the same map
component that still occurs multiple times.

standard rules  Theserulesgive you accessto functions that are necessary for mapping operationsthat are
more complex than simple linking, but less involved than extended rules. Each of the
standard rules are mutually exclusive (you can use only one on a particular field).

status bar The status bar of an application window defines information about a selection, command,
or process, defines Menu Bar items as the user highlights each item, and indicates any
current keyboard-initiated modes for typing (e.g., CAP for the “Caps Lock” key or NUM
for the “Num Lock” key, etc.).

string  Thistype of field or element contains one or more printable characters. If you specify that
afield or element isastring type, you must designate the format by specifying a syntax
token.
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system import
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third-party
network

title bar

toolbar

Application Integration User Guide

syntax token

This function enables you to designate a“token” that defines ranges of characters and/or
numbers that are allowed to be used for a string-type element or field. You can then use
the syntax tokens in the Format field of the Field Properties dialog box. This enables you
to define what type of characters should be used while compliance checking each element/
field (i.e., aphanumeric within a certain range, numeric within a certain range, etc.).

The translator uses this map to determine which trading relationship (established in
Partner Editor) corresponds to each document in the application file, so the system knows
which import map to use to process the document. You need a system import map that is
defined in EDIMGRL.INI to translate outbound data.

See system import map on page 1 - 11.

These trandl ation objects control the creation and separation of interchanges, functional
groups, and transaction sets. They also used to generate and reconcile functional
acknowledgements. All the required system translation objects are automatically installed
with the Sterling Gentran: Server system.

See EDIAon page 1l - 4.

TDF isthe Transaction Data File. Thisfile serves as afilter between your document files
and the Sterling Gentran: Server translator. For outbound processing, dataisimported from
aTDF file and translated to EDI format using a TDF Import translation object. The datais
then ready to be posted and sent to your trading partner. For inbound processing, EDI
documents that are received by Sterling Gentran:Server can be exported to a TDF-
formatted file using a TDF Export translation object. This datafile is then ready to be
processed or converted to your internal application files.

See network on page 1 - 8.

Thetitle bar of an application window contains the name of the application and enables
you to move the window to another position on your desktop.

This contains buttons that graphically represent commands available in the Menu Bar.
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TRADACOMS Glossary

TRADACOMS

trading partner

transaction set
(document)

translation object

trandator

transmission

transmission
chain

turnaround
document

The U. K. standards for EDI that are published by the Article Numbering Association
(UK) LTD.

Another firm with which you company trades documents. Also referred to as a partner.

A business form as defined by the standards. Examples include an ANSI 850 purchase
order or an UCS 880 invoice. The standards define each transaction set in terms of the
segments and elements that make up the form, the order in which they appear, and the
relationships among them. Thisis aso known as “message’ in Europe.

A predesigned layout set up to ensure that input or output for a particular transaction set
exists and is presented in a usable fashion. You must specify which translation objects are
used by each partner relationship.

Inbound Translation Objects:

Turn Around: Thistranglation object is used when a document is received, to
create the natural response document that contains as many elements from the
received document as possible.

Export File: Thistrandation object indicates that when a document isreceived, itis
exported to a specified file format.

Print: Thistrandation object isused to print documents.

Outbound Translation Objects:
Import: Thistranglation object is used to import data from an application file.

Print: Thistrandation object is used to print documents.

Data Entry: Thistranslation object is used to enter datainto the Document Editor facility.

Thisisthe engine that processes data for Sterling Gentran: Server, the Application
Integration subsystem, and the Forms I ntegration subsystem.

See communications session on page 1 - 2.

A path an EDI communication could follow, including one company, one trading partner,
and one or more network services.

A document into which data elements from the source document have been automatically
transferred using a turnaround map.
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Glossary turnaround map

turnaround map A seriesof instructions that the system uses to create a turnaround document (alogical
response document to the source) from an inbound (source) document, by transferring
data from the source document to elements in the target document (translation object).

UCS  The Uniform Communications Standard is the standard used by the grocery industry.

update  Thisstandard rule enables you to update a specific field in a document record, envelope
segment, interchange, group, current partner, or document (if the map side format typeis
EDI), with the contents of the element or field.

Warning

This function updates the internal Sterling Gentran:Server database tables. We
recommend that you use thisfunction only if you are sure you really want to update
theinternal database tables.

Typicaly, you only use this function if you want to update the document name and
reference in the document table. Any other use of this function could have disastrous
consequences!

use accum This standard rule gives you access to a set of numeric variables that you can manipulate
via numeric operations, and then transfer to and from fields. This function enables you to
add, change, or delete calculations for the element/field, including hash totals (used to
accumulate numeric field values, i.e., quantity, price, etc.). This function also enables you
to map the accumulated total into a control total field, and use accumulators.
Accumulators are used generally for counting the occurrences of a specific element or
generating increasing or sequential record or line item numbers.

usecode  Thisstandard rule enables you to match an element or field against a predefined code
table, specify whether or not a compliance error is generated if the element or field does
not contain one of the values in the code table, and store a code's description in another
element or field.

user translation These trand ation objects control data entry, importing, exporting, document turnaround,
object and creating printed reports. These translation objects are created using the Application
Integration or Forms Integration subsystems. The Application Integration subsystem
enables you to generate import, export, and document turnaround translation objects. The
Forms Integration subsystem enables you to generate data entry and print translation
objects.

version Each standards-setting body updatesits standards on aregular basis. Each formal updateis
referred to asaversion.
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VICS Glossary

VICS  TheVoluntary Inter-industry Communication Standards is the standards-setting body for
the retail industry, a subset of ANSI X12.

Workspace  This Sterling Gentran: Server browser contains alist of outbound “Work in Progress”
documents. It also contains recently imported or data entry documents.

X12  The ANSI committee that sets and publishes standards for EDI.
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